Because of the variety of uses for the products described in this publication, those responsible for the application and use of this control equipment must satisfy themselves that all necessary steps have been taken to assure that each application and use meets all performance and safety requirements, including any applicable laws, regulations, codes and standards.

The illustrations, charts, sample programs and layout examples shown in this guide are intended solely for purposes of example. Since there are many variables and requirements associated with any particular installation, Allen-Bradley does not assume responsibility or liability (to include intellectual property liability) for actual use based upon the examples shown in this publication.

Allen-Bradley publication SGI-1.1, Safety Guidelines for the Application, Installation, and Maintenance of Solid-State Control (available from your local Allen-Bradley office), describes some important differences between solid-state equipment and electromechanical devices that should be taken into consideration when applying products such as those described in this publication.

Reproduction of the contents of this copyrighted publication, in whole or in part, without written permission of Allen-Bradley Company, Inc., is prohibited.

Throughout this manual we use notes to make you aware of safety considerations:

**ATTENTION**: Identifies information about practices or circumstances that can lead to personal injury or death, property damage or economic loss.

Attention statements help you to:

- identify a hazard
- avoid the hazard
- recognize the consequences

**Important**: Identifies information that is critical for successful application and understanding of the product.
# Table of Contents

## Preface
- Intended Audience ........................................... P-1
- Software Package ........................................... P-1
- Contents of Manual .......................................... P-2
- Conventions .................................................... P-3
- Related Publications ......................................... P-3
- Technical Support Services ................................. P-4
- Software/Firmware Upgrades ............................... P-4

### Overview of PanelBuilder

<table>
<thead>
<tr>
<th>Chapter 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter Objectives</strong> .................................</td>
</tr>
<tr>
<td><strong>What is PanelBuilder?</strong> .............................</td>
</tr>
<tr>
<td><strong>What is an Application?</strong> ...........................</td>
</tr>
<tr>
<td><strong>What is a Project?</strong> .................................</td>
</tr>
<tr>
<td><strong>PanelBuilder Features</strong> .............................</td>
</tr>
<tr>
<td><strong>Typical Application Screens</strong> .......................</td>
</tr>
<tr>
<td><strong>Screen Objects</strong> ........................................</td>
</tr>
</tbody>
</table>

### Installation

<table>
<thead>
<tr>
<th>Chapter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter Objectives</strong> .................................</td>
</tr>
<tr>
<td><strong>System Requirements</strong> ..................................</td>
</tr>
<tr>
<td><strong>Installing PanelBuilder</strong> ..............................</td>
</tr>
<tr>
<td><strong>RSLinx Lite Software</strong> ..................................</td>
</tr>
<tr>
<td><strong>INTERCHANGE Device Configuration Utility</strong> ........</td>
</tr>
<tr>
<td><strong>INTERCHANGE Notes</strong> ....................................</td>
</tr>
</tbody>
</table>

### Planning an Application

<table>
<thead>
<tr>
<th>Chapter 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter Objectives</strong> .................................</td>
</tr>
<tr>
<td><strong>Design Checklist</strong> .....................................</td>
</tr>
<tr>
<td><strong>Applications and Projects</strong> ..........................</td>
</tr>
<tr>
<td><strong>Steps for Creating an Application</strong> ..................</td>
</tr>
<tr>
<td><strong>Safety Considerations</strong> ................................</td>
</tr>
<tr>
<td><strong>Screen Worksheets</strong> .....................................</td>
</tr>
<tr>
<td><strong>Linking Screen Objects to Controller Data</strong> ........</td>
</tr>
<tr>
<td><strong>Controller Data Files</strong> ................................</td>
</tr>
<tr>
<td><strong>Data Types</strong> .............................................</td>
</tr>
<tr>
<td><strong>Data Formats</strong> ..........................................</td>
</tr>
<tr>
<td><strong>Review Addressing</strong> .....................................</td>
</tr>
<tr>
<td><strong>Defining Tags</strong> .........................................</td>
</tr>
<tr>
<td><strong>Memory Requirements/Tips</strong> .........................</td>
</tr>
</tbody>
</table>
## Table of Contents

### Communications Overview

- Chapter 4
  - Chapter Objectives ........................................ 4–1
  - PanelView Terminal Ports .................................. 4–1
  - DH-485 Communications ..................................... 4–2
  - DH+ Communications ......................................... 4–3
  - DF1 Communications ......................................... 4–4
  - DH-485/DH+/DF1 Communication Considerations ........ 4–5
  - Remote I/O Communications ................................ 4–6
  - Discrete I/O .................................................. 4–9
  - Block Transfers .............................................. 4–11

### PanelBuilder Basics

- Chapter 5
  - Chapter Objectives ........................................ 5–1
  - Windows Environment ........................................ 5–1
  - PanelBuilder Windows ....................................... 5–2
  - Menus .................................................................. 5–4
  - Tool Bar ........................................................... 5–5
  - Status Bar .......................................................... 5–5
  - Format Bar .......................................................... 5–6
  - Toolboxes ........................................................... 5–7
  - Keypad Display ................................................... 5–7
  - Color Palette ....................................................... 5–8
  - Dialog Boxes ......................................................... 5–9
  - Spreadsheet Editors ............................................ 5–10
  - PanelBuilder Defaults ......................................... 5–13
  - Getting Help ....................................................... 5–14

### Working with Applications and Screens

- Chapter 6
  - Chapter Objectives ........................................ 6–1
  - Helpful Hints .................................................... 6–1
  - Starting PanelBuilder ......................................... 6–2
  - Creating a New Application .................................. 6–3
  - Opening an Existing Application ......................... 6–5
  - Renaming and Describing an Application ............... 6–8
  - Opening a New Screen ....................................... 6–10
  - Opening an Existing Screen .................................. 6–11
  - Opening Multiple Screens .................................... 6–12
  - Closing Screens ................................................ 6–14
  - Changing Screen Attributes ................................ 6–14
  - Deleting Screens ................................................ 6–15
  - Copying Screens within an Application .................. 6–15
  - Copying Screens to Another Application ................. 6–16
  - Moving Screens to Another Application ................. 6–17
  - Saving an Application ......................................... 6–20
  - Closing an Application ....................................... 6–21
  - Exiting PanelBuilder .......................................... 6–21
Working with Objects

Chapter 7
Chapter Objectives ................................. 7–1
Accessing Objects .................................. 7–2
Draw Pointer ........................................... 7–3
Creating Objects in Display Area ............... 7–4
Aligning Objects ..................................... 7–5
Creating Objects on Function Keys .......... 7–7
Selecting Objects .................................... 7–8
Sizing Objects ........................................ 7–9
Moving Objects ....................................... 7–9
Grouping and Ungrouping Objects .......... 7–10
Stacking Objects ..................................... 7–11
Zooming In and Out ................................. 7–11
Object Inner Text .................................... 7–12
Formatting Objects .................................. 7–13
Setting Default Colors for Objects .......... 7–13
Editing Object Attributes ....................... 7–14
Configuring States of Multistate or List Objects 7–15
Entering a Description for an Object ......... 7–18
Hiding an Object ..................................... 7–19
Copying/Cutting and Pasting Objects ....... 7–20
Deleting Objects ..................................... 7–22
Reversing an Operation ......................... 7–22

Creating Push Buttons

Chapter 8
Chapter Objectives ................................. 8–1
Helpful Hints ......................................... 8–1
Push Button Types .................................. 8–2
Contact Types ........................................ 8–2
Push Button Text and Graphics .............. 8–3
Creating Push Buttons ......................... 8–4
Setting Properties of a Push Button ....... 8–4
Configuring Push Button States .......... 8–8

Creating Control List Selectors

Chapter 9
Chapter Objectives ................................. 9–1
Helpful Hints ......................................... 9–1
Standard Control Lists ......................... 9–2
Piloted Control Lists ............................... 9–2
Control List Options .............................. 9–4
Creating a Control List Selector ............ 9–5
Setting Properties of a Control List Selector 9–6
Configuring States for a Control List Selector 9–10
Creating List Keys ............................... 9–12
### Table of Contents

#### Chapter 10
- Chapter Objectives ........................................ 10–1
- Helpful Hints .................................................. 10–1
- Numeric Entry Controls ........................................ 10–2
  - Keypad Enable Button ......................................... 10–2
  - Entry Cursor Point .............................................. 10–2
  - Scratchpad ...................................................... 10–2
  - Numeric Entry Examples ....................................... 10–3
  - Data Entry Scaling ............................................... 10–4
- Creating a Numeric Entry Object ............................. 10–7
- Setting Properties of a Numeric Entry Object ............. 10–7
- ASCII Entry Controls ............................................. 10–12
  - Keypad Enable Button ......................................... 10–12
  - Entry Cursor Point .............................................. 10–12
- ASCII Scratchpad – Keypad or Keypad/Touch Screen Terminals ................................................................ 10–13
  - ASCII Scratchpad – 550 Touch Screen Terminals .......... 10–14
  - ASCII Scratchpad – 900/1000/1400 Touch Screen Terminals ............................................................ 10–15
  - Scratchpad in other Languages .................................. 10–16
- Creating an ASCII Entry Object ............................... 10–16
- Setting Properties of an ASCII Entry Object ............. 10–17

#### Chapter 11
- Chapter Objectives .............................................. 11–1
- Helpful Hints ..................................................... 11–1
- Goto Screen Button ............................................... 11–2
- Goto Config Screen Button ...................................... 11–2
- Return Screen Button ............................................ 11–2
- Screen List Selector ............................................... 11–2
- Creating Screen Buttons ........................................ 11–3
- Setting Properties of Screen Buttons ....................... 11–4
- Creating a Screen List Selector ................................ 11–5
- Setting Properties of a Screen List Selector ................ 11–6
- Configuring Entries in a Screen List Selector ............. 11–7
- Creating List Keys ................................................. 11–9
- PLC/SLC Controlled Screen Changes ....................... 11–9

#### Chapter 12
- Chapter Objectives ............................................. 12–1
- Helpful Hints ..................................................... 12–1
- Scaling Data ....................................................... 12–2
- Error States ....................................................... 12–3
- Bar Graphs ......................................................... 12–4
  - Types of Bar Graphs ............................................. 12–4
  - Creating a Bar Graph ........................................... 12–5
  - Setting Properties of a Bar Graph ......................... 12–5
  - Creating a Bar Graph Scale ................................... 12–7
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Creating Message Displays</td>
<td>13–22</td>
</tr>
<tr>
<td></td>
<td>Creating Message Displays</td>
<td>13–1</td>
</tr>
<tr>
<td></td>
<td>Chapter Objectives</td>
<td>13–1</td>
</tr>
<tr>
<td></td>
<td>Helpful Hints</td>
<td>13–1</td>
</tr>
<tr>
<td></td>
<td>Types of Messages</td>
<td>13–2</td>
</tr>
<tr>
<td></td>
<td>Triggering Messages</td>
<td>13–4</td>
</tr>
<tr>
<td></td>
<td>Error State</td>
<td>13–5</td>
</tr>
<tr>
<td></td>
<td>Creating a Message Display</td>
<td>13–6</td>
</tr>
<tr>
<td></td>
<td>Setting Properties of a Message Display</td>
<td>13–6</td>
</tr>
<tr>
<td></td>
<td>Configuring Messages</td>
<td>13–8</td>
</tr>
<tr>
<td></td>
<td>Creating an Object to Print Messages</td>
<td>13–10</td>
</tr>
<tr>
<td>14</td>
<td>Using Global Objects</td>
<td>14–6</td>
</tr>
<tr>
<td></td>
<td>Chapter Objectives</td>
<td>14–1</td>
</tr>
<tr>
<td></td>
<td>What is a Global Object?</td>
<td>14–1</td>
</tr>
<tr>
<td></td>
<td>Defining a Global Object</td>
<td>14–4</td>
</tr>
<tr>
<td></td>
<td>Using a Global Object</td>
<td>14–5</td>
</tr>
<tr>
<td></td>
<td>Moving and Resizing a Global Object</td>
<td>14–6</td>
</tr>
<tr>
<td>15</td>
<td>Creating Alarms</td>
<td>15–28</td>
</tr>
<tr>
<td></td>
<td>Chapter Objectives</td>
<td>15–1</td>
</tr>
<tr>
<td></td>
<td>Overview of Alarms</td>
<td>15–1</td>
</tr>
<tr>
<td></td>
<td>Creating the Alarm Banner</td>
<td>15–6</td>
</tr>
<tr>
<td></td>
<td>Creating an Alarm List</td>
<td>15–9</td>
</tr>
<tr>
<td></td>
<td>Configuring Global Parameters for Alarms</td>
<td>15–12</td>
</tr>
<tr>
<td></td>
<td>Defining Alarm Triggers</td>
<td>15–14</td>
</tr>
<tr>
<td></td>
<td>Creating Alarms</td>
<td>15–16</td>
</tr>
<tr>
<td></td>
<td>Defining Optional Trigger Tags</td>
<td>15–22</td>
</tr>
<tr>
<td></td>
<td>Defining Remote Tags used by Controller</td>
<td>15–26</td>
</tr>
<tr>
<td></td>
<td>Alarm Examples</td>
<td>15–28</td>
</tr>
</tbody>
</table>
Adding Graphics

Chapter 16
Chapter Objectives ............................................. 16–1
Helpful Hints ..................................................... 16–1
Graphic Objects .................................................. 16–2
Graphic Tools ..................................................... 16–2
Drawing a Line .................................................... 16–3
Drawing Connected Lines ....................................... 16–4
Drawing Shapes ................................................. 16–5
Freeform Drawings .............................................. 16–6
Adding ISA Symbols .......................................... 16–7
Adding Background Text ....................................... 16–8
Importing/Exporting Bitmap Graphics ...................... 16–10
Using Background Graphics ................................... 16–16

Formatting Objects and Text

Chapter 17
Chapter Objectives ............................................. 17–1
Format Options ................................................... 17–2
Changing the Appearance of Objects ......................... 17–3
  Changing Object Shape ...................................... 17–4
  Changing Line Type .......................................... 17–5
  Changing Fill Pattern ....................................... 17–6
  Using the Blink Option ...................................... 17–7
  Setting Foreground/Background Colors .................... 17–8
  Reversing Foreground/Background Colors ................ 17–9
Working with Inner Text ....................................... 17–10
  Editing Inner Text ........................................... 17–11
  Inserting Time or Date ...................................... 17–13
  Inserting a Numeric Variable .............................. 17–14
  Inserting an ASCII Variable ............................... 17–16
Working with Inner Graphics .................................. 17–19
  Adding Inner Graphic ....................................... 17–20
  Setting Foreground/Background Colors .................... 17–21
  Reversing Foreground/Background Colors ................ 17–22
  Removing an Inner Graphic ................................ 17–23
  Editing Graphics .............................................. 17–23
Changing the Appearance of Text ............................ 17–24
  Sizing Text .................................................... 17–25
  Aligning Text .................................................. 17–26
  Underlining Text .............................................. 17–27
  Using the Blink Option ...................................... 17–28
  Setting Foreground/Background Colors .................... 17–29
  Reversing Foreground/Background Colors ................ 17–30
# Table of Contents

## Using the Text Editor

- Chapter Objectives .................................................. 18–1
- Opening the Text Editor ............................................. 18–2
- Entering New Text .................................................... 18–3
- Editing Text ............................................................ 18–4
- Inserting Variables in Text .......................................... 18–5
- Sorting Text ............................................................ 18–6
- Filtering Text ........................................................... 18–6
- Printing Text ............................................................ 18–7
- Deleting Unused Text .................................................. 18–8
- Renumbering Text ..................................................... 18–9
- Moving Text ............................................................ 18–9
- Copying Text into Objects ........................................... 18–10

## Working with Tags

- Chapter Objectives .................................................. 19–1
- Using the Tag Editor .................................................... 19–1
  - Table View .......................................................... 19–1
  - Form View .......................................................... 19–1
  - Opening the Tag Editor ............................................. 19–2
  - Navigating through the Tag Editor ............................. 19–3
- Validating Tag Addresses ........................................... 19–4
- Defining Tags .......................................................... 19–5
- Saving Tags ............................................................ 19–7
- Viewing Tags ........................................................... 19–7
- Inserting and Deleting Tags ......................................... 19–7
- Copying Tags ........................................................... 19–8
- Duplicating Tags ....................................................... 19–9
- Finding Tags ............................................................ 19–10
- Sorting Tags ............................................................. 19–11
- Printing Tags ........................................................... 19–12
- Using Tools ............................................................. 19–15
- Tag Import/Export Utility ............................................ 19–15
  - Importing Tags ..................................................... 19–16
  - Handling Data Collisions ......................................... 19–17
  - Exporting Tags ..................................................... 19–18
  - Examining the Results of an Import/Export ................. 19–19
  - Interpreting Error Messages ..................................... 19–20
# Terminal and Communication Setup

**Chapter 20**

<table>
<thead>
<tr>
<th>Chapter Objectives</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>20–1</td>
<td></td>
</tr>
<tr>
<td>Terminal Setup Overview</td>
<td>20–2</td>
</tr>
<tr>
<td>Defining DH-485 Communications</td>
<td>20–3</td>
</tr>
<tr>
<td>Defining DH+ Communications</td>
<td>20–5</td>
</tr>
<tr>
<td>Defining DF1 Communications</td>
<td>20–7</td>
</tr>
<tr>
<td>Defining Remote I/O Communications</td>
<td>20–9</td>
</tr>
<tr>
<td>Defining Block Transfers</td>
<td>20–11</td>
</tr>
<tr>
<td>Configuring the Printer Port</td>
<td>20–13</td>
</tr>
<tr>
<td>Changing the Terminal Type</td>
<td>20–15</td>
</tr>
<tr>
<td>Setting Power-Up Options</td>
<td>20–17</td>
</tr>
<tr>
<td>Setting Time/Date Format</td>
<td>20–19</td>
</tr>
<tr>
<td>Setting Advanced Terminal Options</td>
<td>20–21</td>
</tr>
<tr>
<td>Setting a Display Maintenance Schedule</td>
<td>20–23</td>
</tr>
<tr>
<td>Defining PLC/SLC Control Tags</td>
<td>20–24</td>
</tr>
<tr>
<td>Defining Status Tags</td>
<td>20–26</td>
</tr>
</tbody>
</table>

# Managing Projects

**Chapter 21**

<table>
<thead>
<tr>
<th>Chapter Objectives</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>21–1</td>
<td></td>
</tr>
<tr>
<td>About Projects</td>
<td>21–1</td>
</tr>
<tr>
<td>Managing Projects</td>
<td>21–2</td>
</tr>
<tr>
<td>Managing Devices in Projects</td>
<td>21–4</td>
</tr>
<tr>
<td>Copying a Project to Another Computer</td>
<td>21–6</td>
</tr>
<tr>
<td>Restoring a Project</td>
<td>21–7</td>
</tr>
<tr>
<td>Moving an Application to Another Computer</td>
<td>21–7</td>
</tr>
<tr>
<td>Replacing Duplicate Tags and Devices in a Project</td>
<td>21–8</td>
</tr>
<tr>
<td>Adding Unknown Tags or Devices to a Project</td>
<td>21–9</td>
</tr>
<tr>
<td>Setting Preferences for Replacing or Adding Tags and Devices</td>
<td>21–10</td>
</tr>
<tr>
<td>Restoring a Project Created with a Restricted PanelBuilder Release</td>
<td>21–11</td>
</tr>
</tbody>
</table>

# Multilingual Support

**Chapter 22**

<table>
<thead>
<tr>
<th>Chapter Objectives</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>22–1</td>
<td></td>
</tr>
<tr>
<td>What You Will Learn?</td>
<td>22–2</td>
</tr>
<tr>
<td>System Requirements</td>
<td>22–2</td>
</tr>
<tr>
<td>Terminology</td>
<td>22–2</td>
</tr>
<tr>
<td>What is FontTool?</td>
<td>22–3</td>
</tr>
<tr>
<td>Input Method Editor</td>
<td>22–4</td>
</tr>
<tr>
<td>Using FontTool</td>
<td>22–5</td>
</tr>
<tr>
<td>Creating Font Files</td>
<td>22–6</td>
</tr>
<tr>
<td>Viewing Sample Text</td>
<td>22–8</td>
</tr>
<tr>
<td>Opening Font Files</td>
<td>22–8</td>
</tr>
<tr>
<td>Saving Font Files</td>
<td>22–9</td>
</tr>
<tr>
<td>Printing Files</td>
<td>22–10</td>
</tr>
<tr>
<td>Creating an Application Using a Font File</td>
<td>22–11</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>22–15</td>
</tr>
<tr>
<td>Translating Application Text in Excel</td>
<td>22–16</td>
</tr>
</tbody>
</table>
Validating and Transferring Applications

Chapter 23
Chapter Objectives ........................................ 23–1
Helpful Hints ........................................... 23–1
Validating Applications .................................. 23–2
  Correcting Validation Errors ......................... 23–3
  Printing Validation Messages ....................... 23–4
  Sending Validation Messages to File .............. 23–5
Transfer Options ......................................... 23–6
  PanelView Terminal .................................. 23–6
  Memory Card .......................................... 23–7
  DOS File ............................................... 23–7
Transfer Utilities ......................................... 23–8
  PanelBuilder Application Menu .................... 23–8
  Application File Transfer Utility ................. 23–8
  PanelView DOS File Transfer Utility ............. 23–8
Internal DF1 Driver ..................................... 23–9
Downloading Directly to a Terminal ................. 23–10
Downloading on a Local DH+ Link .................... 23–12
Downloading to a Terminal Using Pass-Through .... 23–13
  Remote I/O Pass-Through Setup .................. 23–14
  DH-485 Pass-Through Setup ...................... 23–15
Downloading to a DOS Memory Card ................. 23–16
Downloading to a DOS File ............................ 23–18
Uploading Directly from a Terminal ................. 23–19
Uploading on a Local DH+ Link ....................... 23–21
Uploading from a Terminal Using Pass-Through .... 23–22
Using the Application File Transfer Utility ........ 23–23
  Verifying an Application .......................... 23–24
  Downloading to a PanelView Terminal .......... 23–25
  Uploading from a PanelView Terminal .......... 23–27
Decreasing Size of Application for Downloads .... 23–28
Exceeding RAM Memory in Terminal ............... 23–28

Creating Reports

Chapter 24
Chapter Objectives ........................................ 24–1
Types of Reports ......................................... 24–1
Connecting a Printer ..................................... 24–1
Creating and Printing a Report ....................... 24–2
Changing the Report Setup ............................ 24–3
Setting up a Printer ..................................... 24–5
Sending the Report to a File ......................... 24–6
Appendix A – Command Summary
Appendix B – Tool Summary
Appendix C – PanelBuilder Worksheets
Appendix D – Software Error and Warning Messages
Appendix E – Validation Messages
Appendix F – Troubleshooting
Appendix G – Internal Read Only Tags
Appendix H – Using Extended ASCII Characters
Glossary
Index
Preface

This manual is a reference guide for the PanelBuilder™ Configuration Software. It describes features and procedures used to create control panel applications for the family of PanelView Operator Terminals.

Because this is a reference manual it covers all the features of the software. You may not use or need to use all the features, so use the manual as needed.

If you’re just getting started, you might want to read the Getting Started Manual first. It takes you through all the steps of creating a sample application including how to download and run the application in the terminal.

Intended Audience

This manual is for the individual responsible for designing control panel applications that will run in a PanelView terminal.

The PanelBuilder Configuration Software runs in Microsoft® Windows ®. You should know how to use a mouse, choose commands, and work with windows and dialog boxes.

You should also have a basic understanding of:

- PLC® and SLC™ logic controllers, especially the controller’s program and data files.
- communication network on which application will run.

Software Package

The PanelBuilder Configuration Software package includes:

- 3 1/2 inch installation disks to install
  - PanelBuilder Software
  - INTERCHANGE or RSLinx Lite Software
  - AB Utilities Software
- PanelBuilder Configuration Software user manual
- PanelView Operator Terminal user manual
- Getting Started manual
- PanelView File Transfer Utility manual
This manual is organized as follows:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td></td>
<td>Describes the purpose and contents of the manual, the intended audience and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>conventions used.</td>
</tr>
<tr>
<td>1</td>
<td>Overview of PanelBuilder</td>
<td>Describes PanelBuilder and product features.</td>
</tr>
<tr>
<td>2</td>
<td>Installation</td>
<td>Tells how to install PanelBuilder on a personal computer.</td>
</tr>
<tr>
<td>3</td>
<td>Planning an Application</td>
<td>Gives guidelines for planning an application. Also describes worksheets for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>application planning.</td>
</tr>
<tr>
<td>4</td>
<td>Communications Overview</td>
<td>Gives an overview of DH-485, DH+, and Remote I/O communications.</td>
</tr>
<tr>
<td>5</td>
<td>PanelBuilder Basics</td>
<td>Covers some basics on using PanelBuilder.</td>
</tr>
<tr>
<td>6</td>
<td>Working with Application Files and Screens</td>
<td>Shows how to open, close and save application files and screens. Also tells</td>
</tr>
<tr>
<td></td>
<td></td>
<td>how to exit PanelBuilder.</td>
</tr>
<tr>
<td>7</td>
<td>Working with Objects</td>
<td>Describes how to access, create and edit objects. Also describes basic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>operations such as how to select, size, move, group and zoom objects.</td>
</tr>
<tr>
<td>8</td>
<td>Creating Push Buttons</td>
<td>Shows how to create and configure momentary, maintained, latched and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>multistate push button controls.</td>
</tr>
<tr>
<td>9</td>
<td>Creating Control List Selectors</td>
<td>Shows how to create and configure standard and piloted control lists.</td>
</tr>
<tr>
<td>10</td>
<td>Creating Data Entry Controls</td>
<td>Shows how to create objects that open a scratchpad for numeric or ASCII</td>
</tr>
<tr>
<td></td>
<td></td>
<td>data entry.</td>
</tr>
<tr>
<td>11</td>
<td>Creating Screen Selectors</td>
<td>Shows how to create screen selectors for navigating between screens in an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>application. Screen selectors include goto/goto config screen/return screen</td>
</tr>
<tr>
<td></td>
<td></td>
<td>buttons and a screen list.</td>
</tr>
<tr>
<td>12</td>
<td>Creating Bar Graphs, Indicators and Numeric</td>
<td>Shows how to create and configure multistate indicators, list indicators,</td>
</tr>
<tr>
<td></td>
<td>Displays</td>
<td>bar graphs and numeric data displays.</td>
</tr>
<tr>
<td>13</td>
<td>Creating Message Displays</td>
<td>Shows how to create message displays and print only message devices which</td>
</tr>
<tr>
<td></td>
<td></td>
<td>present status information or instructions to the operator.</td>
</tr>
<tr>
<td>14</td>
<td>Using Global Objects</td>
<td>Tells how to flag an object for global use and access global objects.</td>
</tr>
<tr>
<td>15</td>
<td>Creating Alarms</td>
<td>Describes alarm components (Alarm Banner display, Alarm buttons, Alarm List,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>global alarm parameters, alarm and trigger definitions) and how to use</td>
</tr>
<tr>
<td></td>
<td></td>
<td>those components to trigger alarm conditions.</td>
</tr>
<tr>
<td>16</td>
<td>Adding Graphics</td>
<td>Shows how to add lines, shapes, ISA symbols and background text to screens.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Also shows how to import bitmap graphics from other programs such as</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Paintbrush.</td>
</tr>
<tr>
<td>17</td>
<td>Formatting Objects and Text</td>
<td>Shows how to use formatting options to change the visual appearance of</td>
</tr>
<tr>
<td></td>
<td></td>
<td>objects and text, including how to add inner text/graphics to objects.</td>
</tr>
<tr>
<td>18</td>
<td>Using the Text Editor</td>
<td>Describes how to use the application Text Editor to create, edit, sort,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>filter and print application text, as well as how to reuse text.</td>
</tr>
<tr>
<td>19</td>
<td>Working with Tags</td>
<td>Shows how to use the tag editor to enter/edit tag information, print tags,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and import/export tags.</td>
</tr>
<tr>
<td>20</td>
<td>Terminal and Communication Setup</td>
<td>Tells how to set operating and runtime communication parameters for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PanelView terminal and how to convert applications from one terminal type to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>another.</td>
</tr>
<tr>
<td>21</td>
<td>Managing Projects</td>
<td>Tells how to link a project to an application and how to copy, rename,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>delete projects or devices in projects.</td>
</tr>
<tr>
<td>22</td>
<td>Multi-Lingual Support</td>
<td>Shows how to use the FontTool utility to create and use font files (in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>specific languages) for PanelBuilder applications.</td>
</tr>
<tr>
<td>23</td>
<td>Validating and Transferring Applications</td>
<td>Describes how to validate and transfer a PanelBuilder application between a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>personal computer and a PanelView terminal, PCMCIA memory card or disk file.</td>
</tr>
<tr>
<td>24</td>
<td>Creating Reports</td>
<td>Tells how to create and print application reports.</td>
</tr>
</tbody>
</table>
Conventions

The following conventions are used throughout this manual:

- PanelBuilder refers to the PanelBuilder Configuration Software.
- PanelView or terminal refers to any one of the PanelView terminals unless specifically stated.
- Windows refers to Windows 95, Windows NT, or Windows 3.1 or higher.
- Keys on the keyboard appear in small capital letters. For example, the Ctrl key appears as CTRL in the text, the Alt key as ALT, and so on.
- When keys are to be pressed in combination, you’ll see them connected by a +. For example, ALT+F4 means hold down the ALT key while you press F4.
- Procedures begin with bold text followed by a semicolon.

To open an application file:

- A solid right cursor in the left margin indicates a tip or hint.

Anchor point is the handle opposite the handle you choose. The anchor point doesn’t move when sizing objects.

Related Publications

The following table lists publications related to the PanelBuilder Configuration Software and the PanelView Operator Terminals.

<table>
<thead>
<tr>
<th>Publication Title</th>
<th>Publication No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Terminal User Manual</td>
<td>2711-6.1</td>
</tr>
<tr>
<td>PanelBuilder Getting Started Manual</td>
<td>2711-6.2</td>
</tr>
<tr>
<td>DeviceNet Communications for PanelView Terminals</td>
<td>2711-6.0.4</td>
</tr>
<tr>
<td>ControlNet Communications for PanelView Terminals</td>
<td>2711-6.10</td>
</tr>
<tr>
<td>PanelView File Transfer Utility</td>
<td>2711-805</td>
</tr>
</tbody>
</table>

For information relating to your logic controller, INTERCHANGE or RSLinx Lite Software, or Microsoft Windows, refer to the appropriate documentation.
Technical Support Services

If you have any questions about PanelBuilder, please consult the manuals or the online help first. If you can’t find the answer, contact Rockwell Automation International Support:

Rockwell International
Technical Support
6680 Beta Drive
Mayfield Village, Ohio 44143

Or call 1–440–646–7800 or fax 1–440–646–7801 for technical support between 8 AM and 5 PM (EST), Monday to Friday.

Please have the serial number of your software ready when you call. You can find this number in three places:

• on the registration card you received with the software
• on the screen that appears when you start the PanelBuilder
• in the main Help menu, when you choose About

Documents answering frequently asked questions are available from the Allen-Bradley:

• AutoFax service at 1–440-646-5436
  This service provides an index of available documents and will automatically fax a document 24 hours a day, 7 days a week.
• website www.ab.com on the Technical Support/FAQ menu

Software/Firmware Upgrades

As new features and enhancements become available, you may want to upgrade your PanelBuilder software and PanelView firmware.

To automatically receive free software upgrades, complete and send in your software registration card to Rockwell Software. You can also receive software upgrades by contacting:

• local Allen-Bradley sales office
• Rockwell Software at 1–440-646-7700 or fax 1–440–646–7701
• access the website www.software.rockwell.com. Under Support, select Software Updates and search for PanelBuilder or 2711ND3.

To receive firmware upgrades:

• contact Rockwell Software at 1–440-646-7700
• access the Allen-Bradley website www.ab.com and download the upgrade by selecting Rockwell Automation Technical Support and then file download.
Overview of PanelBuilder

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is PanelBuilder?</td>
<td>1–1</td>
</tr>
<tr>
<td>What is an Application?</td>
<td>1–1</td>
</tr>
<tr>
<td>What is a Project?</td>
<td>1–1</td>
</tr>
<tr>
<td>PanelBuilder Features</td>
<td>1–2</td>
</tr>
<tr>
<td>Typical Application Screens</td>
<td>1–5</td>
</tr>
<tr>
<td>Screen Objects</td>
<td>1–6</td>
</tr>
</tbody>
</table>

What is PanelBuilder?

PanelBuilder is a Microsoft Windows based package that lets you design control panel applications for PanelView terminals. To simplify application design, the software uses menus, dialog boxes and tools which are standard in Windows.

What is an Application?

A PanelBuilder application is a logical arrangement of screens containing objects such as push buttons, indicators, control lists, bar graphs and alarms. When the application is downloaded to a terminal, the operator interacts with these objects by pressing function keys or touching the terminal screen.

Applications are transferred between your computer and a PanelView terminal using a serial connection, memory card or Pass-Through.

PanelBuilder applications communicate with logic controllers on a variety of networks including: DH-485, DH+, DF1, Remote I/O, DeviceNet and ControlNet.

The ports on the PanelView terminal determine the communication protocol used.

What is a Project?

Each PanelBuilder application (.PBA file) is associated with a project. The project identifies:

- controller addresses, called tags, that PanelBuilder objects write or read from. (Tags defined in the Tag Editor.)
- runtime communication parameters for the PanelView terminal and controller (Devices defined in Terminal Setup.)

Different applications can use the same project tags if the applications use the same communication protocol.
PanelBuilder Features

This section gives an overview of PanelBuilder features.

**Tool or Menu Operation**

PanelBuilder runs under Microsoft Windows. Tools, keystrokes or menu commands are used to perform most functions. Use any or all, whichever you find most convenient.

**Spreadsheet Editors**

Spreadsheets are used to simplify many editing operations, for example to:
- edit states of multistate or list objects
- edit application text
- edit alarms and alarm triggers

Many formatting options for text and objects can be configured directly from cells in the spreadsheet.

**Selectable Preferences**

Set features of the workspace window to those you prefer or like to use often. Options like the tool bar and toolboxes can be toggled on or off depending on their usage. PanelBuilder uses the last settings when a new application is created or when you start a new session.

**Help and Status Bar Information**

Status bar and help options provide immediate online assistance.

**Predefined Objects and Drawings**

To simplify application development, PanelBuilder provides a set of predefined objects (such as push buttons, bar graphs, ISA symbols). Additional graphics are available to create your own drawings or to enhance screens. You can also import bitmap graphics (monochrome or color) created with other programs. A variety of format options are available to change the appearance of objects and text.

**Global Objects**

A global object references an object that appears multiple times in an application. Any non-graphic object can be designated as a global object. You can access a global object from any screen. When modifying a global object, PanelBuilder automatically updates all links to it. The PanelView terminal stores one copy of a global object regardless of the number of links to it.
Tag Editor

The Tag Editor is used to enter, update, print, import/export application tags. Each tag has attributes defining how an object interacts with a controller address. Enter all tags at once using the table view or one tag at a time using the tag form dialog.

Color Palette

A fixed color palette is available for creating color or grayscale applications. For color terminals, the palette supports 16 standard EGA colors. For grayscale terminals, the palette supports 4 colors. Use the palette to apply colors to the foreground and background of objects, text and graphics. Color and grayscale applications support both monochrome and color bitmaps.

Foreground and background colors are accessed from the Format menu, the color palette, or the State tab of multistate/list objects.

Alarms

The Alarm System includes:
- Alarm Banner display that pops up over the current screen to notify the operator when an alarm occurs.
- Alarm Buttons to allow the operator to act on an alarm.
- Alarm List displays information on the last 100 alarms including whether they have been acknowledged.
- Alarm List buttons to print or clear alarms in an alarm list.
- Alarm Setup dialog that provides a set of tabs to configure alarms, triggers and global alarm parameters.

Reports

Create customized reports for an application including:
- application description
- object attributes
- application text
- terminal settings
- tags
- alarm definitions
- screen images and alarm banner display

Print reports to a file or a graphic printer supported by Microsoft Windows.
Terminal and Communication Setup

Operating and runtime communication parameters for the PanelView terminal and logic controller are accessed from the Terminal Setup dialog, including:

- RS-232 printer port setup
- power-up defaults
- time/date display format
- font file selection (for a specific language)
- PLC/SLC controlled options (screen and time/date changes)
- auto repeat settings for terminal keys/touch cells, display settings, language setting for terminal messages, and handshake timeout

Application Validation

Use the validation feature to check an application for correct operation. An application is validated automatically when it is downloaded to a terminal. You can also validate an application at any time using a menu command. Warnings or errors detected during validation can be viewed or printed to a printer or file.

Application Upload / Download Capabilities

Transfer applications between the computer running PanelBuilder and a PanelView terminal using a:

- serial connection
- Pass-Through from a computer on the DH+ network
- memory card
- DOS file

Computers with a DataBook TMB-240 or TMB-250 card drive can transfer applications to/from Allen-Bradley’s flash memory cards (Catalog No. 2711-NM11, -NM12, -NM13, -NM14).

Computers with a PCMCIA/ATA card drive can transfer applications to/from Allen-Bradley’s ATA memory cards (Catalog No. 2711-NM22, -NM24, -NM26). Laptops are compatible with the ATA memory cards, supporting Windows 95 Plug and Play devices.
**Typical Application Screens**

Application screens can contain a variety of control, display or graphic objects. The following screens show examples of:

- Control list selector
- Numeric entry cursor points
- Bar graphs
- Goto screen button

On touch screen terminals, the operator activates input functions by touching a screen object. For example, to view the main menu screen, the operator touches the MENU button.

On keypad terminals, the operator activates input functions by pressing the function key assigned to the object. For example, to view the main menu screen, the operator presses the F8 or MENU function key. To activate the cursor point objects, the operator presses the function keys labeled F6 or F7 (SP or CV).
The table below lists objects you can place on a screen. An object is either dynamic or static.

- **Dynamic objects** interact with a controller address.
- **Static objects** do not interact with a controller address.

<table>
<thead>
<tr>
<th>Screen Objects</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Momentary Push Button</td>
<td>Changes state when pressed and returns to original state when released.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Maintained Push Button</td>
<td>Changes state when pressed and remains in this state when released. Press and release again to return push button to its original state.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Latched Push Button</td>
<td>Changes state when pressed and remains in state until unlatched by controller.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Multistate Push Button</td>
<td>Supports 2 - 16 states. Changes state each time button is pressed. After the last state, the button returns to its initial state and repeats cycle.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Standard Control List</td>
<td>Allows operator to select a control option from a scrolling list of up to 255 options. The terminal's up and down arrow keys are used to move through the list. The selected option is sent to the controller immediately or when the Enter key is pressed. Pressing Enter is an option selected during application configuration.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Piloted Control List</td>
<td>Restricts control list access to the controller, operator or both. A piloted control list allows the controller to select a state from the list.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Cursor Point</td>
<td>Displays current value at controller address in a data box. When selected, the scratchpad opens allowing you to change the value using the keypad.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Keypad Enable Button</td>
<td>When pressed, opens the scratchpad and activates the terminal keypad or touch screen keypad for numeric data entry.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Cursor Point</td>
<td>Displays current string at controller address in a data box. When selected, the scratchpad opens allowing you to change the character string using the keypad.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Keypad Enable Button</td>
<td>When pressed, opens the scratchpad and activates the terminal keypad or touch screen keypad for ASCII data entry.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Multistate Indicator</td>
<td>Displays one of up to 2,000 unique states. The value at a controller address determines which state to display.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>List Indicator</td>
<td>Highlights a state in a scrolling list supporting up to 255 states. The value at a controller address determines which state to highlight.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Bar Graph</td>
<td>Monitors changing conditions such as temperature, pressure or fluid levels. Create bar graphs with or without scales.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Numeric Data Display</td>
<td>Shows current value at a controller address (binary, BCD, integer, float). Use scaling (y=mx+b) to display value in appropriate units.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Message Display</td>
<td>Presents status information or instructions to operator. The controller triggers messages from a predefined list of up to 2,000 messages.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Print Only Message Object</td>
<td>Similar to a message display but messages print out on the connected printer when triggered rather than display on the terminal screen.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Time</td>
<td>Inserts a time variable within a text string.</td>
<td>Static</td>
</tr>
<tr>
<td>Date</td>
<td>Inserts a date variable within a text string.</td>
<td>Static</td>
</tr>
<tr>
<td>ASCII Variable</td>
<td>Inserts an ASCII variable within a text string.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Numeric Variable</td>
<td>Inserts a numeric variable within a text string.</td>
<td>Dynamic</td>
</tr>
<tr>
<td>Goto Screen Button</td>
<td>Moves to a specific application screen.</td>
<td>Static</td>
</tr>
<tr>
<td>Goto Config Screen Button</td>
<td>Displays the PanelView terminal’s Configuration Mode menu.</td>
<td>Static</td>
</tr>
<tr>
<td>Return Screen Button</td>
<td>Returns to previous screen.</td>
<td>Static</td>
</tr>
<tr>
<td>Screen List Selector</td>
<td>Displays a screen selected from a list of screens. The terminal’s up and down arrow keys are used to move through the list.</td>
<td>Static</td>
</tr>
<tr>
<td>Screen Objects</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Move Up</strong></td>
<td>Moves cursor up one item in a control list or screen list selector.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Move Down</strong></td>
<td>Moves cursor down one item in a control list or screen list selector.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td>Moves cursor to the first item in a control list or screen list selector.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Moves cursor to the last item in a control list or screen list selector.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Page Up</strong></td>
<td>Moves cursor up one page in a scrolling control list or screen list.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Page Down</strong></td>
<td>Moves cursor down one page in a scrolling control list or screen list.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Backspace</strong></td>
<td>Returns cursor to currently highlighted selection in a control or screen list.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Enter</strong></td>
<td>Displays screen selected from a screen list selector or confirms a control list selection and sends that selection to the controller.</td>
<td>Static</td>
</tr>
</tbody>
</table>

### List Keys

<table>
<thead>
<tr>
<th>Screen Objects</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acknowledge Button</strong></td>
<td>Acknowledges the alarm displayed in the Alarm Banner and removes the Alarm Banner from the terminal display.</td>
<td>Dynamic</td>
</tr>
<tr>
<td><strong>Clear Button</strong></td>
<td>Clears the Alarm Banner from the terminal display without acknowledging the alarm.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Print Button</strong></td>
<td>Prints the current message displayed in the Alarm Banner.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Acknowledge All Button</strong></td>
<td>Acknowledges all alarms (current and pending) and removes the Alarm Banner from the terminal display.</td>
<td>Dynamic</td>
</tr>
<tr>
<td><strong>Alarm List</strong></td>
<td>Displays a list of triggered alarms. The operator can acknowledge alarms in the list, clear the list or print the list.</td>
<td>Dynamic</td>
</tr>
<tr>
<td><strong>Print Alarm List Button</strong></td>
<td>Prints all alarms in the Alarm List.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Clear Alarm List Button</strong></td>
<td>Clears the Alarm List. Also clears the Alarm Banner even though the alarm condition may still exist.</td>
<td>Static</td>
</tr>
</tbody>
</table>

### Alarms

<table>
<thead>
<tr>
<th>Screen Objects</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line/Connected Line</strong></td>
<td>Creates a line or connected lines.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Rectangle</strong></td>
<td>Creates a rectangle or square.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Circle/Ellipse</strong></td>
<td>Creates a circle or ellipse.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Freeform</strong></td>
<td>Creates a freehand drawing.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Creates scale with tick marks for bar graph or other purpose.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Background Text</strong></td>
<td>Creates screen titles or background text not linked to object.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>ISA Symbols</strong></td>
<td>Select one of 32 predefined drawings such as a valve to place in an object or on the screen.</td>
<td>Static</td>
</tr>
<tr>
<td><strong>Imported Graphics</strong></td>
<td>Imports/exports bitmaps created with other programs.</td>
<td>Static</td>
</tr>
</tbody>
</table>

---

PanelView 900, 1000 and 1400 Touch Screen terminals require list keys to move the cursor through a control list, screen list selector, or alarm list. The list keys are also supported on the keypad versions of these terminals.
Chapter 2

Installation

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>2–1</td>
</tr>
<tr>
<td>Installing PanelBuilder Software</td>
<td>2–2</td>
</tr>
<tr>
<td>RSLinx Lite Software</td>
<td>2–7</td>
</tr>
<tr>
<td>INTERCHANGE Device Configuration Utility</td>
<td>2–10</td>
</tr>
<tr>
<td>INTERCHANGE Notes</td>
<td>2–16</td>
</tr>
</tbody>
</table>

System Requirements

The minimum hardware and software requirements for installing and running PanelBuilder are:

- personal computer using a 386 or higher processor
- MS-DOS™ operating system version 5.0 or later
- Windows 3.1 or later (Windows for Workgroups version 3.11 or later), Windows 95, or Windows NT 4.0.

The RAM requirements for each operating system are as follows:

<table>
<thead>
<tr>
<th>Software</th>
<th>3.X</th>
<th>95</th>
<th>NT 4.0</th>
<th>NT 4.0/486</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelBuilder</td>
<td>8 MB</td>
<td>16 MB</td>
<td>32 MB</td>
<td>32 MB</td>
</tr>
<tr>
<td>External Font Support</td>
<td>8 MB</td>
<td>8 MB</td>
<td>16 MB</td>
<td>16 MB</td>
</tr>
<tr>
<td>RSLinx Lite ⚫️</td>
<td>N/A</td>
<td>16 MB</td>
<td>16 MB</td>
<td>32 MB</td>
</tr>
</tbody>
</table>

⚫️ RSLinx Lite only runs in Windows 95 or Windows NT 4.0.

Note: To determine the RAM required to run PanelBuilder with other components use the maximum specified. For example, to run PanelBuilder and RSLinx in NT 4.0, 32 MB is required.

- 500K free conventional memory
- at least 40 MB available hard disk space
- VGA or other high-resolution display supported by Windows
- Mouse or other Windows pointing device
- One of the following for downloading or uploading applications:
  - Personal Computer Interface Converter (Catalog No. 1747-PIC) and cable (Catalog No. 1747-C10,-C11,-C20) for transferring applications between a computer and a DH-485 PanelView terminal.
  - Cable (Catalog No. 2711-NC13, -NC14, 2706-NC13) for transferring applications directly between a computer and the RS-232/DF1 port of a PanelView terminal.
  - ATA card drive or DataBook TMB240/TMB250 (Windows 3.x or 95 only) card drive for transferring applications to/from a memory card.
  - Appropriate communications card and cables if transferring applications using Pass-Through over a DH+ network.
Optional Equipment

- Graphic printer that’s supported by Windows
- Power Supply (Catalog No. 1747-NP1) for desktop transfers between a personal computer and a DH-485 PanelView terminal. Provides power to Personal Computer Interface Converter when terminal isn’t connected to controller.

Installing PanelBuilder

The PanelBuilder installation installs:

- PanelBuilder Software
- AB Utilities Software
- INTERCHANGE or RSLinx Lite Software

INTERCHANGE or RSLinx Lite Software

To download applications to a PanelView terminal, the appropriate communication driver must be configured on your system. You can configure a driver using:

- RSLinx Lite Software (Windows 95 or Windows NT 4.0) or
- INTERCHANGE Software (Windows 95 or Windows 3.x)

INTERCHANGE is a common set of real mode DOS TSR communication drivers that can be shared by different Windows programs. INTERCHANGE may already be installed on your computer. The APS and 6200 Programming Software use INTERCHANGE in DOS or Windows.

To check the version of INTERCHANGE running on your computer, type DTLVER at the DOS prompt.

RSLinx Lite provides a set of communication drivers that can be shared by Windows programs. To check the version of RSLinx on your computer, select About RSLinx from the Help menu.

Installation Notes

- Before installing PanelBuilder on a computer running Windows 95, check the C:\Windows\System folder for these files:
  - VDF1.386
  - V485.386
  If these files exist, delete them.
- Check that your computer has sufficient system resources and memory available.
- Close all Windows applications before installing PanelBuilder. Press ALT+TAB to check for open applications.
## Installation Setup

The setup options available when installing the PanelBuilder are:

- **Typical Setup** – installs all components listed under the custom setup except External Font File Support and either INTERCHANGE or RSLinx communication software.
  
  Note that on Windows 95/NT systems, RSLinx is the default communication software installed.

- **Compact Setup** – installs all communication protocols, all terminal types, and the PanelBuilder Software.

- **Custom Setup** – installs only specific components that you select and the PanelBuilder Software. Enable/disable options by selecting/deselecting check boxes. The custom setup lists the disk space used by each component with available disk space.

<table>
<thead>
<tr>
<th>Custom Components</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelBuilder Main</td>
<td>Installs all the files necessary to run PanelBuilder. The target folder for installing files is C:\AB.</td>
</tr>
<tr>
<td>Terminal Types</td>
<td>Load all or specific terminal types. You must select at least one terminal type.</td>
</tr>
<tr>
<td></td>
<td>To select all terminal types, click the Terminal Types check box.</td>
</tr>
<tr>
<td></td>
<td>To access the list of terminals, click the Terminal Types check box and then the Change button.</td>
</tr>
<tr>
<td>Communication Protocols</td>
<td>Loads all or specific communication protocols. You must select at least one protocol.</td>
</tr>
<tr>
<td></td>
<td>To select all communication protocols, click the Communication Protocols check box.</td>
</tr>
<tr>
<td></td>
<td>To access the list of protocols, click the Communication Protocols check box and then the Change button.</td>
</tr>
<tr>
<td>External Font File Support</td>
<td>Loads the FontTool utility which is used to create font files for PanelBuilder applications. Font files are created in \AB\PBWIN\FONT.</td>
</tr>
<tr>
<td>Getting Started</td>
<td>Installs sample applications referenced in the Getting Started manual. Files are copied to \AB\PBWIN\GS.</td>
</tr>
<tr>
<td>Bitmap Library</td>
<td>Installs .BMP files used by the Import/Export Graphics function in \AB\PBWIN\PBLIB.</td>
</tr>
<tr>
<td>Demo Files</td>
<td>Installs demo application files for the PanelView terminals. Demo files are copied to \AB\PBWIN\DEMOS.</td>
</tr>
<tr>
<td>INTERCHANGE</td>
<td>Loads INTERCHANGE software which allows you to configure communication drivers for transferring applications. Files are copied to C:\RSI.</td>
</tr>
<tr>
<td></td>
<td>INTERCHANGE is the default selection in Windows 3.x.</td>
</tr>
<tr>
<td></td>
<td>You can load INTERCHANGE or RSLinx, not both.</td>
</tr>
<tr>
<td>RSLinx</td>
<td>Loads RSLinx software which allows you to configure communication drivers for transferring applications. Files are copied to Program Files\Rockwell Software.</td>
</tr>
<tr>
<td></td>
<td>RSLinx is the default selection in Windows 95/NT.</td>
</tr>
<tr>
<td></td>
<td>You can load RSLinx or INTERCHANGE, not both (in Windows 95).</td>
</tr>
</tbody>
</table>
Installation Procedure

If the installation procedure detects the same version of PanelBuilder, AB Utilities, INTERCHANGE or RSLinx Lite software, you are given the option of reinstalling these components. If the installation detects a newer version of software than what you are installing, you are given the option of downgrading.

If you try to install RSLinx in Windows 95, and INTERCHANGE is installed, you are warned of the conflict. The same is true if you try to install INTERCHANGE and RSLinx is already installed.

To install PanelBuilder in Windows 95 or Windows NT:
1. Insert PanelBuilder disk 1 in Drive A: or Drive B:.
2. Click the Start button, click Settings and then click the Control Panel.
3. Double-click the Add/Remove Programs icon.
4. On the Install/Uninstall tab, click the Install button.
5. Follow the install instructions on the screen.

To install PanelBuilder in Windows 3.x:
1. Insert PanelBuilder disk 1 in Drive A: or Drive B:.
2. In Program Manager, choose Run from the File menu (ALT+F, R).
3. Type the location you’re installing from plus the word setup. For example, type a:setup
4. Click OK and follow the install instructions on the screen.

PanelBuilder setup with INTERCHANGE
To successfully transfer applications using INTERCHANGE drivers, you must install PanelBuilder with INTERCHANGE. You cannot install PanelBuilder and INTERCHANGE as separate components.

1. Enter and verify registration information. The serial number is on your registration card.
2. Select setup option. Typical or Custom will install PanelBuilder with INTERCHANGE.
3. Select destination folder for files.
   - Default for PanelBuilder and AB Utility files is C:\AB.
   - Default for INTERCHANGE files is C:\RSI.
4. Installation files are copied to the appropriate folders.

5. Specify whether you want to update your AUTOEXEC.BAT file. The CALL ABICRUN.BAT statement must be correctly placed. The file may contain multiple configurations which require updating. Below is a sample AUTOEXEC.BAT file.

```batch
SET ABIC_CONFIG=C:\RSI\IC\BIN
PATH= C:\DOS;C:\WINDOWS
SET PATH= C:\AB\BIN;%PATH%;C:\RSI\IC\BIN

SHARE.EXE  (Windows 3.x only)

① CALL ABICRUN.BAT
WIN
① CALL statement ensures that the remaining lines of AUTOEXEC.BAT execute (used only with DOS version 5.0 or later). The CALL statement (CALL ABICRUN.BAT) must be the last driver (TSR) loaded before running Windows (WIN).

6. In Windows 95, select the PanelBuilder folder for storing program icons.
   In Windows 3.x, program icons are stored in the PanelBuilder group under Program Manager.

7. The INTERCHANGE Device Configuration utility opens. Optionally, select and configure the communication driver that your computer will use to transfer PanelView applications.

8. Review the release note that appears at the end of the installation.

9. When the installation is complete, you must exit Windows and reboot your computer.

When the setup utility finishes:
- In Windows 95, PanelBuilder programs and INTERCHANGE appear on the Start menu under Programs►PanelBuilder.
- In Windows 3.x, PanelBuilder programs and INTERCHANGE appear as icons in the PanelBuilder group.
PanelBuilder Setup with RSLinx

1. PanelBuilder setup utility
   • Enter and verify registration information. The serial number is on your registration card.
   • Select setup option. Typical or Custom will install PanelBuilder with RSLinx.
   • Select destination folder for installing PanelBuilder files and the AB Utilities software. The default is C:\AB.
   • PanelBuilder files are copied to the appropriate folders.
   • Select the PanelBuilder folder (\Windows\Start Menu\Programs) for storing program icons.

   When the setup utility finishes, PanelBuilder programs will appear on the Start menu under Programs ➤ PanelBuilder.

2. RSLinx setup utility
   • Select destination folder for RSLinx files. The default is C:\Program Files\Rockwell Software\RSLinx\.
   • Select the Rockwell Software folder (\Windows\Start Menu\Programs\) for storing program icons.
   • RSLinx files are copied to appropriate folders.

   When the setup utility finishes, RSLinx programs will appear on the Start menu under Programs ➤ Rockwell Software.

PanelBuilder Programs

In Windows 95, PanelBuilder programs are accessed using the Start button. In Windows 3.1 program icons are accessed from the PanelBuilder group icon.

PanelBuilder includes the following components:
• Application File Transfer Utility – transfers converted applications (.PVA files) between a computer and PanelView terminal within Windows, but outside of PanelBuilder.
• Font Tool (optional) – creates font files for specific languages which can be accessed within PanelBuilder.
• PanelBuilder – creates applications for PanelView terminals.
• PanelBuilder Release Notes – displays the most updated information, including problems and workarounds for the PanelBuilder software.
• PBUninstall – uninstalls PanelBuilder from your system.

If INTERCHANGE was installed, the INTERCHANGE Device Config. Utility and release notes will also appear.
RSLinx Lite Software

In Windows 95 or Windows NT, use the RSLinx Lite software to configure communication drivers that your computer requires to transfer PanelBuilder applications.

To transfer applications using a serial connection (Internal DF1 driver), memory card or DOS file (using the PanelView File Transfer Utility for DH-485 terminals), RSLinx is not required.

To access RSLinx Lite:

- In Windows 95 or Windows NT, click the Start button, click Programs, click Rockwell Software, click the RSLinx submenu and select RSLinx.
- Or choose the Workstation Setup command from the File menu of the PanelBuilder software.

Configuring RSLinx Communication Drivers

The following procedures show how to configure a DF1 or 1747-PIC driver for transferring PanelBuilder applications. For details on how to configure other RSLinx drivers, refer to RSLinx documentation.

To configure a DF1 or 1747-PIC (DH-485) driver:

1. From the Communications menu, click Configure Drivers.

<table>
<thead>
<tr>
<th>For Direct Transfers Select</th>
<th>For These Terminals:</th>
<th>To Transfer Applications:</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 DF1 Devices</td>
<td>DF1, Remote I/O, DH+, DeviceNet, ControlNet</td>
<td>between the RS-232/DF1 port of a Remote I/O PanelView terminal and a computer using DF1 (RS232) communications.</td>
</tr>
</tbody>
</table>

1 Driver is not required. PanelBuilder has an Internal DF1.
2. From the Available Drivers List, click the desired driver by double-clicking it or by clicking it and then clicking Add New.

The configuration dialog for the selected driver opens.

**DF1 Driver**

![DF1 Driver configuration dialog]

- **Serial COM port on computer**: The port where the device is connected.
- **DF1 parameters for a PanelView terminal must be set to:**
  - Baud: 19200
  - Parity: None
  - Error Detect: CRC
  - Stop Bits: 1
  - Protocol: Full Duplex
- **Automatically detects the settings of the DF1 driver on the serial COM port (when connected to a PanelView terminal).**

![Device Type of DF1 driver on computer]

**1747-PIC Driver**

![1747-PIC Driver configuration dialog]

- **Serial COM port on computer**: The port where the device is connected.
- **Station address of computer is typically 0.**

![Default name assigned to driver]

3. Edit the driver parameters and click OK.

The driver appears in the Configured Drivers list. Click Close to exit the Configure Devices dialog.
To assign a communication driver to a port:

After configuring a driver, you must map the driver to one of driver ports.

1. From the Communications menu, choose Configure Client Applications.

![Maps the configured DF1 driver to 1KT:0.](image)

2. On the Port Mapping tab, assign the communication driver to one of the logical ports (1KT:0, 2KT:0, ..., 8KT:0).

You can assign the driver to any one of the port mappings and it will still operate on COM1 (port configured in Device dialog).

If you map the same driver to more than one logical port (1KT:0, ..., 8KT:0) these ports are viewable in the PanelBuilder Download/Upload dialog when clicking the Setup button.

**Important:** If you do not configure the Client Application, RSLinx drivers will not be accessible from the Download/Upload dialogs in PanelBuilder.
In Windows 95 or Windows 3.x, use the INTERCHANGE Device Configuration Utility to configure communication drivers that your computer requires to transfer applications using Pass-Through. This utility lets you:

- View active communication drivers
- Select and configure a communication driver
- Edit a communication driver
- Remove a communication driver
- Access advanced driver parameters

The utility automatically updates the CFG_KT.INI, ABICRUN.BAT, ABICSTOP.BAT, and the SYSTEM.INI files when drivers are added, configured and removed.

To transfer applications using a Pass-Through connection, you must first configure the appropriate driver.

To transfer applications using a serial connection (Internal DF1 driver), memory card or DOS file (using the PanelView File Transfer Utility for DH-485 terminals), INTERCHANGE software is not required.

**To access the INTERCHANGE Device Configuration Utility:**

- In Windows 95, click the Start button, click Programs, click PanelBuilder, then click INTERCHANGE Device Config. Utility.
- In Windows 3.x, double-click the INTERCHANGE Device Config. Utility icon in the PanelBuilder Group.
- Or choose the Workstation Setup command from the File menu of the PanelBuilder software.
- The utility also opens at the end of the PanelBuilder installation.

The INTERCHANGE Device Configuration dialog shown on the next page opens.
## Configuring an INTERCHANGE Driver

To select and configure an INTERCHANGE driver:

1. Select a driver from the Available Drivers list.

Use the table below as a guide in selecting a driver.

### For Direct Transfers Select:

<table>
<thead>
<tr>
<th>PanelView terminal type and the communication card installed in your computer determines the driver selection.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>For Direct Transfers Select</th>
<th>For These Terminals</th>
<th>To Transfer Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>DF1 on COM Port</td>
<td>Remote I/O, DF1, DH+, ControlNet, DeviceNet</td>
<td>between the RS-232/DF1 port of a PanelView terminal and a computer using DF1 (RS232) communications.</td>
</tr>
</tbody>
</table>

**Driver is not required. PanelBuilder has an Internal DF1.**

### For Pass-Through Select:

<table>
<thead>
<tr>
<th>For Pass-Through Select</th>
<th>For These Terminals</th>
<th>To Transfer Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>1784-KL on DH+</td>
<td>Remote I/O</td>
<td>between a computer on the DH+ link using a 1784-KL communications card and the Remote I/O port of a PanelView terminal on a Remote I/O network.</td>
</tr>
<tr>
<td></td>
<td>RS-232 (DH-485)</td>
<td>between a computer on the DH+ link using a 1784-KL communications card and the RS-232 port of a DH-485 PanelView connected to Port 0 of an SLC 5/04.</td>
</tr>
<tr>
<td></td>
<td>DH+</td>
<td>between a computer on the DH+ link using a 1784-KL communications card and the DH+ port of a PanelView terminal on the DH+ link.</td>
</tr>
<tr>
<td>1784-KT/1784-KT2 on DH+</td>
<td>Remote I/O</td>
<td>between a computer on the DH+ link using a 1784-KT/B, -KT2 communications card and the Remote I/O port of a PanelView terminal on a Remote I/O network.</td>
</tr>
<tr>
<td></td>
<td>RS-232 (DH-485)</td>
<td>between a computer on the DH+ link using a 1784-KT/B, -KT2 communications card and the RS-232 port of a PanelView terminal, connected to Port 0 of an SLC 5/04.</td>
</tr>
<tr>
<td></td>
<td>DH+</td>
<td>between a computer on the DH+ link using a 1784-KT/B, -KT2 communications card and the DH+ port of a PanelView terminal on the DH+ link.</td>
</tr>
<tr>
<td>1784-KTC on ControlNet</td>
<td>ControlNet</td>
<td>between a computer on the ControlNet network using a 1784-KTC communications card and the ControlNet port of a PanelView terminal.</td>
</tr>
<tr>
<td>1784-KTX on DH485</td>
<td>DH-485</td>
<td>between a computer on the DH-485 network using a 1784-KTX communications card and the DH-485 port of a PanelView terminal.</td>
</tr>
</tbody>
</table>
### For Pass-Through Select:

<table>
<thead>
<tr>
<th></th>
<th>For These Terminals:</th>
<th>To Transfer Applications:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1784-KTX on DH+</td>
<td>Remote I/O</td>
<td>between a computer on the DH+ link using a 1784-KTX communications card and the Remote I/O port of a PanelView terminal on a Remote I/O network.</td>
</tr>
<tr>
<td></td>
<td>RS-232 (DH-485)</td>
<td>between a computer on the DH+ link using a 1784-KTX communications card and the RS-232 port of a PanelView terminal, connected to Port 0 of an SLC 5/04.</td>
</tr>
<tr>
<td></td>
<td>DH+</td>
<td>between a computer on the DH+ link using a 1784-KTX communications card and the DH+ port of a PanelView terminal on the DH+ link.</td>
</tr>
<tr>
<td>1784-PCMK on DH+</td>
<td>Remote I/O</td>
<td>between a computer on the DH+ link using a 1784-PCMK communications card and the Remote I/O port of a PanelView terminal on a Remote I/O network.</td>
</tr>
<tr>
<td></td>
<td>RS-232 (DH-485)</td>
<td>between a computer on the DH+ link using a 1784-PCMK communications card and the RS-232 port of a PanelView terminal, connected to Port 0 of an SLC 5/04.</td>
</tr>
<tr>
<td></td>
<td>DH+</td>
<td>between a computer on the DH+ link using a 1784-PCMK communications card and the DH+ port of a PanelView terminal on the DH+ link.</td>
</tr>
<tr>
<td>1784-PCMK on DH-485</td>
<td>DH-485</td>
<td>between a computer on the DH-485 network using a 1784-PCMK communications card and the DH-485 port of a PanelView terminal.</td>
</tr>
</tbody>
</table>

2. Click the Add Device button.

   A configuration dialog opens for the selected driver.

   The following dialog opens for the **DF1 (RS-232) on COM Port** driver.

   ![DF1 on COM Port Device Configuration](image)

   **DF1 parameters for a PanelView terminal must be set to:**
   - Baud: 19200
   - Parity: None
   - Error Detect: CRC

   **COM Port Parameters should be set to:**
   - COM Port 2 typically uses Interrupt (IRQ) 3
   - COM Port 1 typically uses Interrupt (IRQ) 4

   **Default Driver Name** (can be edited)

   **Unique number assigned to INTERCHANGE driver**
   (This is not the computer’s COM port.)

   **Disables driver configuration temporarily without removing it from Configured Devices list.**

If you change the COM Port setting, change the Interrupt to the appropriate setting.
This dialog opens for the **1747-PIC (DH485)** on COM Port driver.

**Unique number assigned to INTERCHANGE driver**
(This is not the computer’s COM port.)

**DH-485 Station Address (or Node Address) of the Computer is typically 0.**

**COM Port Parameters should be set to:**
- COM Port 2 typically uses Interrupt (IRQ) 3
- COM Port 1 typically uses Interrupt (IRQ) 4

**Default Driver Name**
(can be edited)

**Disables driver configuration temporarily without removing it from Configured Devices list.**

3. **Edit parameters and click OK when done.**

The parameters are specific to the communications card installed in your computer or the type of connection you will be using to transfer files.

**Important:** You must set Interrupts for all INTERCHANGE drivers.

The configured driver appears under the Configured Devices list.

**Configured Devices:**
- **NAME** Refers to driver name
- **DEVICE** Refers to selected driver
- **PORT** Refers to unique number assigned to INTERCHANGE driver
- **STATUS** Shows whether driver is enabled/disabled

**Important:** Do not configure more than one driver for the same communication port.
4. Click OK to exit the dialog.

5. Exit Windows and reboot the computer to load the driver and its configuration.

   **Important:** You must reboot your computer any time you add or remove a driver or change configuration parameters of a driver.

After rebooting the computer, messages display indicating that the INTERCHANGE driver was successfully configured and loaded. For example, the following messages appear for the DF1 driver.

```
CFG_DF1 (001A) Reading device configuration from C:\RSI\IC\BIN\CFG_KT.INI.
CFG_DF1 (0000) TSR configured, no errors detected
```

**Important:** Errors that occur during a reboot indicate an incomplete or incorrect configuration of the INTERCHANGE drivers. Reconfigure the drivers.

**Editing INTERCHANGE Driver Parameters**

**To edit the configuration parameters of an active driver:**

1. Select the driver from the Configured Devices list.
2. Click the Edit Device button.
3. Edit configuration parameters in the driver’s dialog.
4. Click OK to close dialogs.
5. Reboot your computer to load the new configuration.

**Removing INTERCHANGE Driver**

**To remove a current driver configuration:**

1. Select the driver from the Configured Devices list.
2. Click the Remove Device button.
   
   You are prompted to confirm the operation. If you click Yes, the driver is removed from the Configured Devices list.
3. Click OK to close dialog.
4. Reboot your computer to unload the driver.
Setting Advanced INTERCHANGE Parameters

To specify advanced parameters for drivers:
1. Click the Advanced button from the INTERCHANGE Device Configuration dialog.

   - Specifies whether self-diagnostics are run on KT devices before loading driver configuration. The default is to perform test.

   - Specifies whether to use upper MS-DOS memory for packet buffer space. The default is to use upper memory.

   - Allocates number of packet buffers (1 to 200). Each buffer uses 300 bytes of memory. The default is 20.

   - Allocates space for the number of unsolicited messages (0 to 200). The default is 0, which indicates no space.

   - Specifies whether to load INTERCHANGE drivers (executables) into high memory. Drivers are not loaded until you reboot computer.

   - Specifies the memory manager in use on your system.

   - Specifies Enabler to use for the 1784-PCMK on DH+ Device Driver.

     - **Specific Enabler** uses PCMKINIT or RSIPCMK.
       This enabler requires you to enter the socket number containing the card in the driver dialog. The INTERCHANGE socket numbers are (0-7). In Windows 95, the sockets are numbered (0 – 8).

     - **Generic Enabler** uses PCENABLE.
       This enabler requires that you enter a Memory address and an IRQ (Interrupt).

2. Edit parameters and click OK.
INTERCHANGE Notes

Conflicts with INTERCHANGE Drivers

The INTERCHANGE drivers may cause conflicts with other drivers sharing common interrupts or memory areas of the system. Here are some problems that may occur and what to do about them.

- If you are using a special Windows video driver, try using the standard Windows VGA driver. You may also have to edit the EMM386 line in the CONFIG.SYS file to remove specific memory exclusions added by the special video driver.
- If you experience lockups when using a serial mouse in a DOS application, wait several seconds for the mouse to initialize. If mouse operation is still a problem, run ABICSTOP.

1. Exit Windows.
2. Type **abicstop** at the DOS prompt.

   \[c:\>abicstop\]

   If ABICSTOP is not successful, comment out ABICRUN in AUTOEXEC.BAT and reboot. Then run ABICSTOP again.

- Error messages during a system reboot may indicate an incomplete or incorrect configuration of the INTERCHANGE driver. Reconfigure the driver.

For more details on INTERCHANGE Software, refer to the INTERCHANGE Software user manuals. Allen-Bradley publications are available through Allen-Bradley local distributors.

Disabling INTERCHANGE

INTERCHANGE Software uses 40 to 80K of base memory. The AUTOEXEC.BAT file is configured to automatically load INTERCHANGE drivers at system reboot.

To disable INTERCHANGE, place REM before the CALL statement in the AUTOEXEC.BAT file. For example:

\[rem call abicrun.bat\]

Disabling INTERCHANGE frees up base memory and also makes the computer’s COM port available to other applications.
Other Software that Uses INTERCHANGE

To run other software (such as APS) that uses a different INTERCHANGE driver on the same communication port as PanelBuilder software, follow the steps below.

**Note:** If the software packages use the same INTERCHANGE driver on a communication port (except for the DF1 driver), you can ignore these steps.

1. Exit from Windows if necessary.
2. Type **ABICSTOP** at the DOS prompt, for example:
   
   ```
   c:\> ABICSTOP
   ```
3. Run the other software.

Before running PanelBuilder software again, or other software that uses different INTERCHANGE drivers:

1. Exit from Windows if necessary.
2. Type **ABICRUN** at the DOS prompt

Adding or Updating Communication Card

Update the CONFIG.SYS file when you add or modify a hardware configuration for a communication card such as the KT or PCMK card. Refer to the INTERCHANGE README and CFG_KT.TXT files for details on how to do this. The memory manager you use determines the type of, and syntax of, the (communications card) entry required in CONFIG.SYS.
Chapter 3

Planning an Application

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Checklist</td>
<td>3–1</td>
</tr>
<tr>
<td>Applications and Projects</td>
<td>3–2</td>
</tr>
<tr>
<td>Steps for Creating an Application</td>
<td>3–3</td>
</tr>
<tr>
<td>Safety Considerations</td>
<td>3–4</td>
</tr>
<tr>
<td>Screen Worksheets</td>
<td>3–4</td>
</tr>
<tr>
<td>Linking Screen Objects to Controller Data</td>
<td>3–6</td>
</tr>
<tr>
<td>Data Types</td>
<td>3–8</td>
</tr>
<tr>
<td>Data Formats</td>
<td>3–9</td>
</tr>
<tr>
<td>Review Addressing</td>
<td>3–12</td>
</tr>
<tr>
<td>Defining Tags</td>
<td>3–13</td>
</tr>
<tr>
<td>Memory Requirements/Tips</td>
<td>3–14</td>
</tr>
</tbody>
</table>

Design Checklist

Before creating an application, check the following:

- Plan and document application
- Consider safety requirements
- Design screens
- Review data types
- Review data formats
- Review addressing of objects
- Review memory requirements
**Applications and Projects**

An application is the basic unit of PanelBuilder software. It is designed to be loaded in a specific type of PanelView terminal and run using a specific type of logic controller. It includes:

- screens with controls, indicators, graphics, text and screen controls
- tags, which are named references to data addresses in a logic controller
- alarm controls
- runtime communication parameters
- operating parameters of terminal

A project is assigned or created when an application is created. It links the application to:

- tag database
- specific devices – PanelView terminal and controller – that the application will interact with

PanelBuilder software can convert an application to run in a different PanelView terminal or different type of controller by assigning it to a different application. See page 21–2. In this case, some of the tags and objects may have to be edited.

An application is validated for correct operation before it can be downloaded to a terminal. All incompatibilities are caught during validation.
The general steps for creating an application are:

1. Document the application carefully including:
   - purpose of the application
   - information the operator needs to make good decisions
   - choices the operator will have to make

Review this document with the operator before the application is run.

2. Create the application including:
   - screens (each screen may include controls, indicators graphics, text and screen controls).
   - alarm controls
   - runtime communication parameters
   - operating parameters of terminal

The application is associated with a project when the application is created. The project database is a collection of tags and devices (PanelView terminal and logic controller) that are used by the application. A project can support more than one application, provided that they are all designed for the same type of terminal and the same type of logic controller.

3. Values associated with alarms, objects and variables are stored in controller memory addresses, and are referenced by the application via named tags. Enter tags in the Tag Editor using:
   - Table View of the Tag Editor before the application is created
   - Tag Form dialog when creating objects

4. Validate and download the application to the PanelView terminal.

5. Run the application.

While the application is running, triggered alarms are added to the Alarm List.
Planning an Application

**Safety Considerations**

When placing push buttons on a screen:

### ATTENTION:

- Don’t place emergency stop buttons or controls critical for safe operation on a screen. Use separate hard-wired operator interface devices. The inside cover of this manual references appropriate standards.

- Don’t place important buttons in the center of touch screens where they may be blocked temporarily by terminal messages, the Alarm Banner, or the scratchpad.

- Don’t place push buttons in the same area on screens that follow one another. An operator may press the same position, mistaking a stop button on one screen for a start button on another.

### ATTENTION:

- Don’t press multiple touch screen objects at the same time. Pressing multiple objects simultaneously may result in unintended operation.

- Place touch screen objects far enough apart so the operator would naturally lift a finger to move to the next object. Touch screens are intended for a single object press.

Push buttons are **disabled for \( \frac{1}{2} \) second** after a screen change. Also, when a new screen appears, push buttons from the previous screen must be released before the terminal responds to push buttons on the new screen.

**Screen Worksheets**

Figures 3.1 – 3.2 show the Keypad and Touch Screen Worksheets for the PanelView 900 terminals. Worksheets for other terminals are in Appendix C. Use these worksheets to draw your application screens.

At the top of each screen, enter the application name, screen name/number and project name that you want to link to the application. The project defines tag addresses and devices (PanelView terminal and controller) that will communicate.

The number and size of objects you can place on a screen is limited only by screen space. On touch screen terminals, each input control should occupy at least 1 touch cell. The number of available touch cells depends on the terminal size. The PanelView 900/1000/1400 Touch Screen terminal has 384 touch cells. The PanelView 550/600 Keypad & Touch Screen terminal has 128 touch cells.

Each screen must contain a screen selector allowing the operator to navigate between screens in an application. You can assign a screen selector to a touch cell and/or a function key.

Review Chapters 7 – 14 on screen objects before completing the worksheets. Also review memory requirements (at end of chapter) for hints on reducing the byte size of an application.
Figure 3.1
PanelView 900 Keypad Terminal Worksheet

Project Name: _____________________________
Application Name: ________________________ Screen Name / Number: ________________________

Figure 3.2
PanelView 900 Touch Screen Terminal Worksheet

Project Name: _____________________________
Application Name: ________________________ Screen Name / Number: ________________________

Touch screen push buttons must occupy at least one touch cell.
Linking Screen Objects to Controller Data

Each dynamic screen object must be linked to a controller data table. (This is not always true for DeviceNet. See publication *DeviceNet Communications for PanelView Terminals*). The PanelView terminal either reads data for indicators such as bar graphs or writes data for controls like push buttons.

Values in the logic controller data table are updated on a regular basis. This process is called scanning. In each scan:

- the logic controller and the terminal write data to specific addresses updating values
- the logic controller reads the entire data table and updates values at other addresses according to the PanelBuilder application

PanelBuilder uses read and write tags to link objects with specific controller addresses. Each tag has a unique name and specifies attributes such as the location and size of an address, the type of data to read from or write to the address and scaling parameters.
A tag can be assigned to any file type that the PLC, SLC or MicroLogix 1000 supports.

### PLC-5 File Types

<table>
<thead>
<tr>
<th>File Type</th>
<th>Read / Write</th>
<th>Identifier</th>
<th>File Number</th>
<th>Element</th>
<th>Integer Sub-Element</th>
<th>Bit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Read</td>
<td>O</td>
<td>0</td>
<td>0-277</td>
<td>NA</td>
<td>0-17</td>
</tr>
<tr>
<td>Input</td>
<td>Read②</td>
<td>I</td>
<td>1</td>
<td>0-277</td>
<td>NA</td>
<td>0-17</td>
</tr>
<tr>
<td>Status</td>
<td>Read / Write</td>
<td>S</td>
<td>2</td>
<td>0-127</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>Bit (Binary)</td>
<td>Read / Write</td>
<td>B</td>
<td>3-999</td>
<td>0-999</td>
<td>PRE, ACC</td>
<td>EN, TT, DN</td>
</tr>
<tr>
<td>Timer</td>
<td>Read / Write</td>
<td>T</td>
<td>3-999</td>
<td>0-999</td>
<td>PRE, ACC</td>
<td>CU, CD, DN, OV, UN</td>
</tr>
<tr>
<td>Counter</td>
<td>Read / Write</td>
<td>C</td>
<td>3-999</td>
<td>0-999</td>
<td>PRE, ACC</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>Read / Write</td>
<td>R</td>
<td>3-999</td>
<td>0-999</td>
<td>LEN, POS</td>
<td>EN, EU, DN, EM, ER, UL, IN, FD</td>
</tr>
<tr>
<td>Integer</td>
<td>Read / Write</td>
<td>N</td>
<td>3-999</td>
<td>0-999</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>BCD</td>
<td>Read / Write</td>
<td>D</td>
<td>3-999</td>
<td>0-999</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>Float</td>
<td>Read / Write</td>
<td>F</td>
<td>3-999</td>
<td>0-999</td>
<td>NA</td>
<td>0-31</td>
</tr>
<tr>
<td>ASCII</td>
<td>Read / Write</td>
<td>A</td>
<td>3-999</td>
<td>0-999</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>String</td>
<td>Read / Write</td>
<td>ST</td>
<td>3-999</td>
<td>0-999</td>
<td>LEN</td>
<td>NA</td>
</tr>
</tbody>
</table>

① Octal format, all other values are decimal.
② Remote I/O allows the PanelView to write its own output words.
③ ControlNet terminals do not support the reading/writing of input/output tags.

### SLC File Types

A tag can be assigned to any file type the SLC controller supports, except M0 and M1.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Read / Write</th>
<th>Identifier</th>
<th>File Number</th>
<th>Element</th>
<th>Integer Sub-Element</th>
<th>Bit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Read</td>
<td>O</td>
<td>0</td>
<td>1-31</td>
<td>0-255</td>
<td>0-15</td>
</tr>
<tr>
<td>Input</td>
<td>Read</td>
<td>I</td>
<td>1</td>
<td>1-31</td>
<td>0-255</td>
<td>0-15</td>
</tr>
<tr>
<td>Status</td>
<td>Read / Write</td>
<td>S</td>
<td>2</td>
<td>①</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>Bit (Binary)</td>
<td>Read / Write</td>
<td>B</td>
<td>3, 9-255</td>
<td>0-255</td>
<td>NA</td>
<td>0-4095</td>
</tr>
<tr>
<td>Timer</td>
<td>Read / Write</td>
<td>T</td>
<td>4, 9-255</td>
<td>0-255</td>
<td>PRE, ACC, 1, 2</td>
<td>13-15, EN, TT, DN</td>
</tr>
<tr>
<td>Counter</td>
<td>Read / Write</td>
<td>C</td>
<td>5, 9-255</td>
<td>0-255</td>
<td>PRE, ACC, 1, 2</td>
<td>11-15, CU, CD, DN, OV, UN</td>
</tr>
<tr>
<td>Control</td>
<td>Read / Write</td>
<td>R</td>
<td>6, 9-255</td>
<td>0-255</td>
<td>LEN, POS, 1, 2</td>
<td>8-15, EN, EU, DN, EM, ER, UL, IN, FD</td>
</tr>
<tr>
<td>Integer</td>
<td>Read / Write</td>
<td>N</td>
<td>7, 9-255</td>
<td>0-255</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>Float</td>
<td>Read / Write</td>
<td>F</td>
<td>8-255</td>
<td>0-255</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>ASCII</td>
<td>Read / Write</td>
<td>A</td>
<td>9-255</td>
<td>0-255</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>String</td>
<td>Read / Write</td>
<td>ST</td>
<td>9-255</td>
<td>0-255</td>
<td>LEN, 0-41</td>
<td>0-15</td>
</tr>
</tbody>
</table>

① Number of Status File elements depends on controller (e.g., SLC 5/03 has 0-99 and SLC 5/04 has 0-163).
### MicroLogix 1000 File Types

<table>
<thead>
<tr>
<th>File Type</th>
<th>Read / Write</th>
<th>Identifier</th>
<th>File Number</th>
<th>Element</th>
<th>Integer Sub-Element</th>
<th>Bit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Read</td>
<td>O</td>
<td>0</td>
<td>0</td>
<td>0-4</td>
<td>0-15</td>
</tr>
<tr>
<td>Input</td>
<td>Read</td>
<td>I</td>
<td>1</td>
<td>0</td>
<td>0-7</td>
<td>0-15</td>
</tr>
<tr>
<td>Status</td>
<td>Read / Write</td>
<td>S</td>
<td>2</td>
<td>0-32</td>
<td>NA</td>
<td>0-15</td>
</tr>
<tr>
<td>Bit (Binary)</td>
<td>Read / Write</td>
<td>B</td>
<td>3</td>
<td>0-31</td>
<td>NA</td>
<td>0-511</td>
</tr>
<tr>
<td>Timer</td>
<td>Read / Write</td>
<td>T</td>
<td>4</td>
<td>0-39</td>
<td>PRE, ACC, 1, 2</td>
<td>13-15, EN, TT, DN</td>
</tr>
<tr>
<td>Counter</td>
<td>Read / Write</td>
<td>C</td>
<td>5</td>
<td>0-31</td>
<td>PRE, ACC, 1, 2</td>
<td>11-15, CU, CD, DN, OV, UN</td>
</tr>
<tr>
<td>Control</td>
<td>Read / Write</td>
<td>R</td>
<td>6</td>
<td>0-15</td>
<td>LEN, POS, 1, 2</td>
<td>8-15, EN, EU, DN, EM, ER, UL, IN, FD</td>
</tr>
<tr>
<td>Integer</td>
<td>Read / Write</td>
<td>N</td>
<td>7</td>
<td>0-104</td>
<td>NA</td>
<td>0-15</td>
</tr>
</tbody>
</table>

### Data Types

The PanelView terminal can read or write a single bit or value.

#### Bit Data

Bit data occupies a single bit and represents an On (closed) or Off (open) condition.

\[
\begin{align*}
\text{DH-485 or DH+ Address B3/10} & : & \begin{cases} 
1 & = \text{On} \\
0 & = \text{Off} 
\end{cases} \\
\text{Remote I/O Address B20:0} & : & \begin{cases} 
1 & = \text{On} \\
0 & = \text{Off} 
\end{cases}
\end{align*}
\]

Bit addresses greater than 15 (B3/24) are not valid when a DH+ PanelView terminal is communicating with a PLC-5.

#### Least Significant Bit

Least Significant Bit (LSB) triggering is available for multistate indicators, list indicators, message displays and alarms. If priority is important in triggering a series of states or messages, use Least Significant Bit triggering:

- Triggering for messages or states are assigned a word of memory (or more than one word if more than 16 messages or states are to be prioritized). Each message or state trigger corresponds to a specific bit, starting from the right (least significant bit).
- When the word or sequence of words is read right to left by the terminal, it ignores bits that are not set (0) and displays the message or state corresponding to the first bit that is set (1). The controller clears/sets this bit, the terminal only reads the bit.
- The next time the word is read, a different bit is the first one set (1), then its message or state displayed.
Value Data

Value data occupies a word (2 bytes or 16 bits) that represents a numeric value. No matter how large or small the value, a whole word must be assigned unless it is a bit array.

Floating point values occupy 4 bytes or 32 bits.

Data Formats

PanelView (Tag) Formats

The PanelView terminal recognizes and transfers 7 data formats.

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>0 or 1</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Signed Integer</td>
<td>-32768 to +32767</td>
</tr>
<tr>
<td>IEEE Floating Point</td>
<td>-99,999,997,952 to 999,999,995,904</td>
</tr>
<tr>
<td>4BCD</td>
<td>0 to 9999</td>
</tr>
<tr>
<td>Bit Array</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Character Array</td>
<td>Protocol Dependent</td>
</tr>
</tbody>
</table>

Bit

A bit data type occupies one bit of memory. Its address is given not as a word (N7:2), but as a bit (N7:2/10). A bit is a location, and depends on its position in the word. It can be set or reset.

Signed and Unsigned Integers

Signed and unsigned integer values occupy one word (2 bytes or 16 bits) of memory, no matter how small the value.

Every bit has a value that depends on its position in the word. The value encoded is the sum of the bits that are sent.
Floating Point

The 32-bit floating point format supports IEEE single precision formatted values in the range -99,999,997,952 to 999,999,995,904. The floating point range is limited by the number of display and data entry character positions available (12) or by the processor. The PLC-5, SLC 5/03 and SLC 5/04 support 7 digits.

The maximum decimal point precision is 9 places for negative values (-0.000000001) and 10 places for positive values (0.0000000001). The negative sign occupies 1 character position, values without a sign are positive. Decimal point values are entered or displayed with at least one digit to the left of the decimal point.

When large numbers are entered, values to the right of the decimal may be changed because of the 32-bit floating representation. For example, if you enter 1.1111111801, PanelBuilder displays 1.1111111641. PanelBuilder uses the closest approximation to represent your input.

4 BCD

Data in BCD format (also called 4-BCD) occupy one word of memory. Every four bits encodes a single digit 0 → 9.

Each value occupies one word even if it is less than 9999.
Bit Array

A bit array is an unsigned integer format that is assigned to part of a word. You can assign the rest of the word to other bits or bit arrays.

The length of the array is from 1 to 16 bits. The maximum value stored in a bit array varies from 1 (1-bit array) to 65,535 (16-bit array). This format allows you to specify the actual number of bits to be assigned to an object. Unused bits can then be assigned to other object(s).

<table>
<thead>
<tr>
<th>Array Size</th>
<th>Range</th>
<th>Array Size</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0 or 1</td>
<td>9</td>
<td>0 to 511</td>
</tr>
<tr>
<td>2</td>
<td>0 to 3</td>
<td>10</td>
<td>0 to 1023</td>
</tr>
<tr>
<td>3</td>
<td>0 to 7</td>
<td>11</td>
<td>0 to 2047</td>
</tr>
<tr>
<td>4</td>
<td>0 to 15</td>
<td>12</td>
<td>0 to 4095</td>
</tr>
<tr>
<td>5</td>
<td>0 to 31</td>
<td>13</td>
<td>0 to 8191</td>
</tr>
<tr>
<td>6</td>
<td>0 to 63</td>
<td>14</td>
<td>0 to 16383</td>
</tr>
<tr>
<td>7</td>
<td>0 to 127</td>
<td>15</td>
<td>0 to 32767</td>
</tr>
<tr>
<td>8</td>
<td>0 to 255</td>
<td>16</td>
<td>0 to 65535</td>
</tr>
</tbody>
</table>

For example, a value that will never be greater than 277 is assigned a bit array with length = 9. Other bits or bit arrays could then be assigned to locations starting at N7:2/9.

```
000000010001010
```

**Important:** A bit array can occupy only one word. The length of a bit array starting at N7:2/9 must be 7 or less.

Character Array

Data in a character array are assigned to ASCII variables. The length of the character array is protocol dependent.
Review Addressing

Before entering tags in the Tag Editor, you may want to record tag addresses using the Address Worksheet in Appendix C. For proper address formats, refer to your controller’s user manual. The illustration below shows an example of recording addresses.
Defining Tags

Read/write tags that define controller addresses for objects are entered in the Tag Editor. A tag has the following attributes.

<table>
<thead>
<tr>
<th>Tag Attributes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Name(^1)</td>
<td>Unique name identifying tag address</td>
</tr>
<tr>
<td>Data Type</td>
<td>Bit, 4BCD, Unsigned/Signed Integer, Bit Array, Character Array, Float</td>
</tr>
<tr>
<td>Array Size</td>
<td>Number of bits in a bit array</td>
</tr>
<tr>
<td>Description</td>
<td>General description of tag</td>
</tr>
<tr>
<td>Node Name</td>
<td>Name of controller associated with tag</td>
</tr>
<tr>
<td>Tag Address</td>
<td>Specifies data table word or bit</td>
</tr>
<tr>
<td>Initial Value(^2)</td>
<td>Value stored at tag address on powerup</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Rate at which tag address value is updated</td>
</tr>
<tr>
<td>Scaling(^2)</td>
<td>Scale and offset scale values</td>
</tr>
<tr>
<td>Data Entry Limits(^2)</td>
<td>High and low limits of data stored at tag address</td>
</tr>
</tbody>
</table>

\(^1\) The tag name appears in the object’s dialog and in the Tag Editor.
\(^2\) Usage dependent on object.

The Tag Editor supports two different ways for entering tags:
- table view to enter and edit multiple tags
- form view to enter a single tag

Tags are stored in a database that is referenced by a project name. The project name is entered when creating a new application file.

The tag name entered in an object’s dialog links the object to the tag name entered in the Tag Editor.
The memory available for applications varies for the PanelView terminals.

**Screen Tips on Reducing Memory**

Review the following list for hints on ways to reduce the size of an application.

- For DH-485, DH+ or DF1 applications, group tag addresses for each screen in the same 40 word block.
- For multistate or list objects, create the exact number of states or entries required by the application.
- Don’t use multistate indicators, list indicators, or message displays if a numeric data display can provide the same function. Likewise, don’t use a control list selector if a numeric entry object is sufficient.
- If a multistate indicator uses the same text for all states, use a solid indicator with outer text instead of inner text for each state.
- Reuse text that exists in the application rather than creating the same string multiple times. See Chapter 18 for details on how to copy existing text into objects or object states.
- Limit the amount of text in screen names, messages and objects.
- When drawing rectangles, use a shape instead of individual lines. Each line requires the same amount of memory as a single shape.
- Freeform drawings are memory intensive.
- Rectangular objects or graphics of the same size use less memory because the terminal uses the same data to display the objects. If 2 push buttons are the exact same size, the terminal (keypad or touch) uses the same data to display the rectangle of both buttons.
- Use a global object if the application requires the same object on several screens. A global object can be accessed from any screen. The PanelView stores only 1 copy of the object. See Chapter 14.
- Limit the use of bitmap graphics.
- Use multiple embedded variables within a single text string rather than using multiple numeric data displays.
- Maximum number of screens is 255.
- Maximum number of tags and objects is unlimited but must not exceed runtime memory.
- Maximum number of bitmaps and text is unlimited but must not exceed application memory.
Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Terminal Ports</td>
<td>4–1</td>
</tr>
<tr>
<td>DH-485 Communications</td>
<td>4–2</td>
</tr>
<tr>
<td>DH+ Communications</td>
<td>4–3</td>
</tr>
<tr>
<td>DF1 Communications</td>
<td>4–4</td>
</tr>
<tr>
<td>DH-485/DH+/DF1 Communication Considerations</td>
<td>4–5</td>
</tr>
<tr>
<td>Remote I/O Communications</td>
<td>4–6</td>
</tr>
<tr>
<td>Discrete I/O</td>
<td>4–9</td>
</tr>
<tr>
<td>Block Transfers</td>
<td>4–11</td>
</tr>
</tbody>
</table>

PanelView Terminal Ports

The PanelView terminals have ports that support a variety of communication options, including:

- Remote I/O communications
- DH-485 communications
- DH+ communications
- DF1 communications
- DeviceNet communications
- ControlNet communications

For details on how to configure a PanelView terminal to communicate on a DeviceNet network, see publication *DeviceNet Communications for PanelView Terminals.*

For details on how to configure a PanelView terminal to communicate on a ControlNet network, see publication *ControlNet Communications for PanelView Terminals.*

The catalog number of the terminal determines the physical ports and communication protocol supported by that terminal. Many of the terminals have an additional RS-232 port which is used for printing and/or transferring applications.

The PanelView terminal type and communication parameters are selected and configured as a part of the application.

- PanelView terminal is defined when the application is created (New Application dialog) and is also accessed from the Terminal Setup dialog. See Chapter 6.
- Communication parameters for the logic controller and terminal are defined in the Communication Setup dialog (Comms. Setup button on Terminal Setup dialog). See Chapter 20.
DH-485 Communications

The following PanelView terminals communicate on a DH-485 link:
- DH-485 PanelView terminals communicate with an SLC controller using a point-to-point or network connection.
- RS-232 PanelView terminals communicate point-to-point with the Channel 0 port of an SLC 5/03 or 5/04 controller using DH-485 protocol.

The PanelView terminal operates as a unique DH-485 node (0 to 31).

DH-485 parameters for the PanelView DH-485/RS-232 terminal and controller are defined in the Communication Setup dialog (accessed from the Terminal Setup dialog).

The following table defines DH-485 parameters and defaults for a PanelView DH-485 or RS-232 Terminal and controller.

<table>
<thead>
<tr>
<th>DH-485 Device</th>
<th>DH-485 Parameter</th>
<th>Options</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Terminal</td>
<td>Node Address</td>
<td>0 – 31</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Maximum Node Address</td>
<td>1 – 31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>1200, 2400, 9600, 19.2K</td>
<td>19.2K</td>
</tr>
<tr>
<td>Network Node</td>
<td>Node Name</td>
<td>User supplied</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Node Address</td>
<td>0 – 31</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Node Type</td>
<td>See above figure</td>
<td>None</td>
</tr>
</tbody>
</table>
DH+ Communications

The DH+ PanelView terminals communicate with a PLC or SLC 5/04 controller on the Allen-Bradley DH+ link.

Addressing for a DH+ application is similar to a DH-485 application except the DH+ link supports 64 nodes (0 - 77 octal) and higher baud rates. The DH-485 link supports 32 nodes.

The DH+ parameters for the terminal and controller are defined in the Communication Setup dialog (accessed from Terminal Setup dialog).

The following table defines DH+ parameters and defaults for a PanelView DH+ terminal and logic controller.

<table>
<thead>
<tr>
<th>DH+ Device</th>
<th>DH+ Parameter</th>
<th>Options</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Terminal</td>
<td>Node Address</td>
<td>0 – 77 octal</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>57.6K, 115.2K, 230.4K</td>
<td>57.6 K</td>
</tr>
<tr>
<td>Network Node</td>
<td>Node Name</td>
<td>User supplied</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Node Address</td>
<td>0 – 77 octal</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Node Type</td>
<td>See above figure</td>
<td>None</td>
</tr>
</tbody>
</table>
DF1 Communications

The DF1 PanelView terminals communicate with an SLC, PLC or MicroLogix 1000 controller over a point-to-point DF1 link or using DF1 network communications. The DF1 terminals support full duplex communications.

The DF1 parameters for the terminal and controller are defined in the Communication Setup dialog (accessed from Terminal Setup dialog).

The following table defines DF1 parameters and defaults for a DF1 PanelView terminal and logic controller.

<table>
<thead>
<tr>
<th>DF1 Device</th>
<th>DF1 Parameter</th>
<th>Options</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Terminal</td>
<td>Node Address</td>
<td>0 – 254 decimal</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>1200, 2400, 4800, 9600, 19.2K</td>
<td>9600</td>
</tr>
<tr>
<td></td>
<td>Parity/Stop Bits</td>
<td>Odd/1, Even/1, None/1, None/2</td>
<td>None/1</td>
</tr>
<tr>
<td></td>
<td>Error Detection</td>
<td>BCC or CRC</td>
<td>CRC</td>
</tr>
<tr>
<td></td>
<td>Handshaking</td>
<td>On (CTS/RTS enabled), Off (CTS/RTS disabled)</td>
<td>Off</td>
</tr>
<tr>
<td>Network Node</td>
<td>Node Name</td>
<td>User supplied</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Node Address</td>
<td>0 – 254 decimal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Node Type</td>
<td>See above figure</td>
<td>None</td>
</tr>
</tbody>
</table>
The PanelView terminal writes information (write tags) to the processor only when a change of state occurs. The terminal reads information (read tags) from the processor continually. The read and write tags can use the same address.

Scan Group

A scan group consists of 40 consecutive words within the same data file and processor. The group starts at the lowest address in the data file. The scan group must have the same update frequency. For an application with tag addresses: N7:0, N7:39, N7:40, N11:0, N12:5 and N12:40, the scan groups are:

- N7:0 – N7:39
- N7:40
- N11:0
- N12:5 – N12:40

Minimize the number scan groups per screen. Maintain the same update frequency for each 40 word block.
Remote I/O Communications

On a Remote I/O network, the PanelView Remote I/O terminals appear like a Remote I/O rack. The PanelView terminal can occupy all of or part of a single rack (128 I/O). You can assign 2 types of addresses to objects on a Remote I/O network:

- Discrete - a single input or output bit address
- Block transfer - a series of contiguous word addresses

Data is transferred over a remote I/O link as either a:

- Read or Input = data to the PLC from the PanelView
- Write or Output = data from the PLC to the PanelView

The processor continually scans the PanelView terminal for inputs and updates the outputs. Read and write tags must have different discrete I/O addresses and are not linked in the terminal.

Rack Sizes and Module Groups

The PanelView I/O can occupy a 1/4, 1/2, 3/4, or Full rack. Each 1/4 rack contains two module groups (32 input and 32 output bits). An entire rack contains 8 module groups that are numbered from 0 to 7.

![Diagram showing rack sizes and module groups]

If a PanelView terminal does not occupy a complete I/O rack, you can assign another PanelView or other devices to the same rack.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>1st PanelView</th>
<th>Other Rack Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Number</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Starting Module Group</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>Rack Size</td>
<td>3/4</td>
<td>1/4</td>
</tr>
<tr>
<td>Last Chassis</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The PLC type determines the maximum rack number for the PanelView.
Remote I/O Scan Group

A Remote I/O scan groups consists of words or address contained within a discrete I/O rack or within a block transfer. For example, an application with a full rack, block transfer read N7:0, length 64 and a block transfer write N7:128, length 62 has these scan groups:

- O:010 – O:017
- I:010 – I:017
- N7:0 – N7:63
- N7:64 – N7:127
- N7:128 – N7:190

Controller Types

The PanelView Remote I/O terminals communicate with the controllers below. For each controller, the table lists supported rack numbers and support for Pass-Through and block transfers.

<table>
<thead>
<tr>
<th>Controller/Scanner</th>
<th>Lowest Rack #</th>
<th>Highest Rack #</th>
<th>Pass-Through Support</th>
<th>Block Transfer Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM PC 6008-SI</td>
<td>0</td>
<td>7</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>VME 6008-SV</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEC QBUS 6008-SQ</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC 5/11</td>
<td>3</td>
<td>3</td>
<td>All Series, All Revisions</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/15</td>
<td>1</td>
<td>3</td>
<td>Series B, Revision N or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/20</td>
<td>1</td>
<td>3</td>
<td>All Series, All Revisions</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/25</td>
<td>1</td>
<td>7</td>
<td>Series A, Revision J or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/30</td>
<td>1</td>
<td>7</td>
<td>Series A, Revision B or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/40</td>
<td>1</td>
<td>7\text{ octal}</td>
<td>Series A, Revision E or later, Series B, Revision B or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/60</td>
<td>1</td>
<td>27\text{ octal}</td>
<td>Series A, Revision E or later, Series B, Revision B or later</td>
<td>Yes</td>
</tr>
<tr>
<td>SLC 1747-SN Series A</td>
<td>0</td>
<td>3</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>SLC 1747-SN Series B</td>
<td>0</td>
<td>3</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Other 1771-SN Subsystem</td>
<td>1</td>
<td>7</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Remote I/O Communication Parameters

Remote I/O communication parameters are defined in the Communication Setup dialog which is accessed from the Terminal Setup dialog.

The table below defines Remote I/O communication parameters for the PanelView terminal.

<table>
<thead>
<tr>
<th>Remote I/O Device</th>
<th>Remote I/O Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC/Scanner</td>
<td>Type</td>
<td>Type of PLC controller/scanner that will communicate with the PanelView Remote I/O terminal.</td>
<td>See table on page 4–7.</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Unique name assigned to controller. This name is also used in the Node Name field in the Tag Editor.</td>
<td>User supplied</td>
</tr>
<tr>
<td></td>
<td>Rack Address</td>
<td>Unique address of PanelView terminal on Remote I/O link.</td>
<td>0 – 27&lt;sub&gt;octal&lt;/sub&gt;</td>
</tr>
<tr>
<td>PanelView Terminal</td>
<td>Module Group</td>
<td>Module groups occupied by PanelView terminal in the rack. The Module groups must be contiguous.</td>
<td>0,1 2,3 4,5 6,7</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>The baud rate of the Remote I/O link determines the maximum cable length.</td>
<td>57.6K 115.2K 230.4K 10,000 feet 5,000 feet 2,500 feet</td>
</tr>
<tr>
<td></td>
<td>Last Chassis</td>
<td>Specifies whether the terminal occupies the last module group (no higher module groups assigned) within the rack.</td>
<td>Yes, No</td>
</tr>
</tbody>
</table>
Discrete I/O

Discrete I/O addresses communicate directly with the controller and provide faster updates than block transfers. Discrete I/O is recommended for:

- Push buttons (for rapid response times)
- Any critical values that you want updated immediately

A PLC rack has 128 discrete I/O points (8 input words/8 output words). If additional rack space is needed for an application, use block transfers.

You must assign a read or display tag to an output address. If you assign a read tag to an input address, a validation error occurs. The read and write tags must have different tag names and reference different addresses.

Discrete I/O Addressing for 1771-SN Scanners

The I/O addressing syntax for the 1771-SN Scanner (Series A) is:

\[ I:YYW/BB \quad O:YYW/BB \]

where:

<table>
<thead>
<tr>
<th>YY</th>
<th>Rack number</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Word or group address</td>
</tr>
<tr>
<td>BB</td>
<td>Bit address, 0-7, 10-17 octal</td>
</tr>
</tbody>
</table>

For example:

\[ I:024/10\]

addresses input bit 10, Rack 2, Module 4.

Discrete Addressing for 1747-SN Scanner, Series A and B

The addressing syntax for the 1747-SN Scanner (Series A and B) is:

\[ I:X.WW/BB \quad O:X.WW/BB \]

where:

<table>
<thead>
<tr>
<th>X</th>
<th>Slot where 1747-SN is installed in rack</th>
</tr>
</thead>
<tbody>
<tr>
<td>WW</td>
<td>Word address, 0 - 31 decimal</td>
</tr>
<tr>
<td>BB</td>
<td>Bit address, 0-15 decimal</td>
</tr>
</tbody>
</table>

For example:

\[ I:1.7/13\]

addresses input bit 13 of Word 7, Slot 1 (where 1747-SN Scanner resides).
Discrete I/O Example

The PanelView terminal occupies rack #3 in which its starting module group is 0. An On/Off push button object is addressed as I:032/03 and a corresponding indicator as O:032/00.

1. The PanelView monitors the status of the 8 input words in its rack assignment.

   Rack #3
   01234567 01234567
   PanelView I/O
   8 Input Words 8 Output Words

2. The PLC ladder program monitors address I:032/03.

3. The operator presses the object push button, the PanelView terminal sets the corresponding address bit.

4. The ladder program determines input bit 03 is On.

5. The controller ladder program moves the input bit to the output bit.

   The PanelView terminal reads the indicator address and displays the new state.
Remote I/O links allow the transfer of blocks (up to 64 words) between a PLC and a PanelView terminal. Block transfers are assigned to a single byte of input data (module control byte) and output data (module status byte) in the PanelView rack. These two bytes control the operation of the block transfer and are no longer available for discrete I/O.

The status and control byte always occupy the low byte of the lowest module group in the PanelView rack assignment. For example, if the starting module group is 0:

No matter how many block transfers are assigned (1 to 10), only one byte is reserved in the input rack and one in the output rack.

Block transfer directions are in reference to the PLC:
- Block Transfer Reads (BTR) are inputs to the PLC and transfer data from control devices such as push buttons on the PanelView.
- Block Transfer Writes (BTW) are outputs from the PLC and transfer data to indicators such as bar graphs on the PanelView.
Setting Up a Block Transfer

Configure PanelView block transfers using the Block Transfer dialog, which is accessed from the Communication Setup dialog.

For each block transfer (1 - 10), specify the parameters below:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Enables or disables the block transfer.</td>
</tr>
<tr>
<td>Address</td>
<td>Specifies starting address for the block transfer read or write.</td>
</tr>
<tr>
<td>Mode</td>
<td>Specifies R for a Read operator or W for a Write operation.</td>
</tr>
<tr>
<td>Length</td>
<td>Specifies the number of words (1 to 64) to transfer. The length 63 is reserved for Pass-Through. Each block transfer read must be a unique length and each block transfer write must be a unique length. However, a read and write block transfer can be the same length. The PanelView uses the length to identify data blocks.</td>
</tr>
<tr>
<td>Pass-Through</td>
<td>Enables or disables Pass-Through for application transfers between a computer on the DH+ network and a PanelView terminal on the Remote I/O network. Pass-Through is a dedicated block transfer fixed at 63 words in length.</td>
</tr>
<tr>
<td>Block Transfer Timeout</td>
<td>Specifies a timeout value for block transfers. A value of 0 disables the timeout.</td>
</tr>
</tbody>
</table>

Each block transfer requires a corresponding Block Transfer Write (BTW) or Block Transfer Read (BTR) instruction in the ladder program for the controller. The Address and Length settings must match the Data File and Length settings in the instructions.
Helpful Hints for Block Transfers

- Read and write blocks can use the same addresses.
- Read and Write Blocks may overlap partially or completely.
- Improve response times by compacting the data into the fewest possible blocks (no unused bits) or keep all data for a screen in a single block. Remote I/O scanners generally perform one block transfer in a single I/O scan.
- Ladder logic can use the PanelView’s current screen tag (status tag) to enable block transfers as necessary. The screen data is automatically updated when an operator selects the screen. See Chapter 20 for a description of the status tags.
- Minimize the number of block transfers.

Block Transfer Read Example

The following example illustrates a block transfer read. The PanelView terminal is assigned to rack #3, starting module group 0. One of the PanelView objects, a numeric entry display addressed as N7:2, writes to a part of the data block being transferred.

1. The operator enters the data into the numeric entry display.

![Numeric Entry Cursor Point with Tag Name = Motor_Speed Tag Address = N7:2]

2. Using information in the Block Transfer dialog, the PanelView determines the position of the data and the block size.

3. The PanelView terminal places the data in the first word of a 4 word block.

<table>
<thead>
<tr>
<th>Word 1</th>
<th>123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word 2</td>
<td></td>
</tr>
<tr>
<td>Word 3</td>
<td></td>
</tr>
<tr>
<td>Word 4</td>
<td></td>
</tr>
</tbody>
</table>

4. The PLC reads the 4 word block of data and stores it at the Data File address.

<table>
<thead>
<tr>
<th>BTR</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLOCK TRANSFER READ</td>
</tr>
<tr>
<td>Rack</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Module</td>
</tr>
<tr>
<td>Control Block</td>
</tr>
<tr>
<td>Data File</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Continuous</td>
</tr>
</tbody>
</table>
Block Transfer Write Example

The following example illustrates a block transfer write. The PanelView terminal is assigned to rack #3, starting module group 0. One of the PanelView objects, a bar graph display addressed as N7:0, reads a portion of the data block being transferred.

1. The PLC receives and stores data from an input device, in this example a flow sensor.

2. The PLC ladder logic program initiates a block transfer of a data block (10 words) containing the screen display data.

3. The PanelView terminal receives the data and determines the starting address for the write operation by matching the block size with the address entered in the Block Transfer dialog.

4. The PanelView now carries a copy of that segment of the logic controllers data table.

5. The PanelView updates the bar graph display using the data from the controller.
Transferring Multiple Blocks

Multiple block transfers use a single channel (single Module Control and Status Bytes defined). Each block transfer read or write must be a unique length since the PanelView terminal uses the block size to determine the starting location of the read or write. The following example illustrates a block transfer write of two blocks.

1. The PLC ladder logic program initiates multiple block transfers of 2 data blocks (7 words and 60 words).

<table>
<thead>
<tr>
<th>BLOCK TRANSFER WRITE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Module</td>
</tr>
<tr>
<td>Control Block</td>
</tr>
<tr>
<td>Data File</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Continuous</td>
</tr>
</tbody>
</table>

BTW

The PanelView terminal receives the first data block and determines the starting address N7:0 for the write operation by matching the block size with the address entered in the Block Transfer dialog.

The PanelView handles the second block in the same manner.

2. The PanelView carries a copy of the logic controller data tables N7:0 to N7:6.

N7:0
N7:1
N7:2
N7:3
Block 1 Transfer
N7:4
N7:5
N7:6
N7:7
N7:8
N7:9

3. The PanelView carries a copy of the logic controller data tables N90:10 to N90:69.

N90:8
N90:9
N90:10
N90:11
Block 2 Transfer
N90:12
· ·
N90:67
N90:68
N90:69
N90:70
N90:71

4. The PanelView screen objects are updated using the new data.
Remote I/O Communication Loss

When communication fails on a Remote I/O network:

- Object states are maintained and the message “No PLC Communication” is displayed on the terminal screen.
- If Block Transfers are defined for the application, but no BTR or BTW instructions are received, another message is displayed when the Block Transfer Timeout occurs.

These messages continue to display until communications is established. If a write operation is attempted to the logic program controlling the PanelView objects, the terminal will display the message “Error: Write to Logic Controller failed.

If a PanelView object is activated during a communication loss, the object retains its new state and sends this state value to the controller when communications is established.
Chapter Objectives

This chapter covers basics on using PanelBuilder Software.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Environment</td>
<td>5–1</td>
</tr>
<tr>
<td>PanelBuilder Windows</td>
<td>5–2</td>
</tr>
<tr>
<td>Menus</td>
<td>5–4</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>5–5</td>
</tr>
<tr>
<td>Status Bar</td>
<td>5–5</td>
</tr>
<tr>
<td>Format Bar</td>
<td>5–6</td>
</tr>
<tr>
<td>Toolboxes</td>
<td>5–7</td>
</tr>
<tr>
<td>Keypad Display</td>
<td>5–7</td>
</tr>
<tr>
<td>Color Palette</td>
<td>5–8</td>
</tr>
<tr>
<td>Dialog Boxes</td>
<td>5–9</td>
</tr>
<tr>
<td>Spreadsheet Editors</td>
<td>5–10</td>
</tr>
<tr>
<td>PanelBuilder Defaults</td>
<td>5–13</td>
</tr>
<tr>
<td>Getting Help</td>
<td>5–14</td>
</tr>
</tbody>
</table>

Windows Environment

PanelBuilder runs in the Microsoft Windows environment. You should be familiar with window operations. That is, you should know how to use the mouse, choose menu commands, and work with windows and dialogs.

If you use a mouse, here are the basic terms used:

<table>
<thead>
<tr>
<th>Term</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Position the mouse pointer on the object, area or field, then press and release the left mouse button once.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Position the mouse pointer on the object, area, or field and then click the left mouse button twice quickly.</td>
</tr>
<tr>
<td>Select item or command</td>
<td>Click to highlight the item to be affected by the next command, or click on a dialog box option.</td>
</tr>
<tr>
<td>Choose item or command</td>
<td>Click on a tool, menu command or an item in a dialog box or Help window.</td>
</tr>
<tr>
<td>Drag</td>
<td>Click where to start a selection and hold down the left mouse button. Move pointer to end of selection and release the mouse button. Use drag to highlight a text string.</td>
</tr>
</tbody>
</table>

If you prefer to use the keyboard:

<table>
<thead>
<tr>
<th>Term</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose menu command</td>
<td>Press the ALT key and type the underlined letter in the menu name. Then type the letter underlined in the command name.</td>
</tr>
<tr>
<td>Select item or command</td>
<td>Use the arrow keys (or in a dialog, both the TAB and arrow keys) to move to the item.</td>
</tr>
<tr>
<td>Choose item or command</td>
<td>Highlight an item, then press the ENTER key.</td>
</tr>
</tbody>
</table>
PanelBuilder Windows

Each time you start PanelBuilder, a PanelBuilder window opens. This is where you create an application. Window elements are described below.

<table>
<thead>
<tr>
<th>Feature</th>
<th>How to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>Click a name on the menu bar to open a menu and display its commands.</td>
</tr>
<tr>
<td></td>
<td>Or press ALT-X, where X is the underlined letter in the menu name.</td>
</tr>
<tr>
<td>Command</td>
<td>Click a command to choose it or carry out its action.</td>
</tr>
<tr>
<td></td>
<td>Or type the underlined letter in the command name.</td>
</tr>
<tr>
<td>Title Bar</td>
<td>Drag to move a window.</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>Click a tool to carry out a frequently used command. The tool bar toggles on</td>
</tr>
<tr>
<td></td>
<td>and off from the View menu.</td>
</tr>
<tr>
<td>*Format Bar</td>
<td>Click a tool to format an object or text. The format bar doesn’t appear until</td>
</tr>
<tr>
<td></td>
<td>you open an application.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Shows what PanelBuilder is doing at the moment. The status bar toggles on</td>
</tr>
<tr>
<td></td>
<td>and off from the View menu.</td>
</tr>
<tr>
<td>Control-Menu</td>
<td>Click to open the Control menu. Double-click to close a window.</td>
</tr>
<tr>
<td>Minimize button</td>
<td>Click to reduce window to an icon.</td>
</tr>
<tr>
<td>Maximize button</td>
<td>Click to enlarge a window.</td>
</tr>
<tr>
<td>Close button</td>
<td>Closes the window.</td>
</tr>
<tr>
<td>Border</td>
<td>Drag to change the size of a window.</td>
</tr>
<tr>
<td>Mouse pointer</td>
<td>Use to select an item or object.</td>
</tr>
</tbody>
</table>
**Application File Window**

When you open an application, the application file window opens listing all screens in the application by number and name.

![Application File Window Diagram](image)

**Application Screen Window**

Each application screen looks like the PanelView terminal (touch, keypad, or keypad and touch) for which you are creating the application. Objects are placed inside the display area. On keypad terminals, you can also place objects on function keys. Screens are moved and sized like any other window. Multiple screens can be open at one time.

![Application Screen Diagram](image)
The menu bar dynamically updates when application files and application screens are opened. Each name on the menu bar is a menu with its own set of commands.

**To open a menu:**

- Point to a name on the menu bar and click the left mouse button. (To move directly to a menu command, drag the pointer down the menu until the command is highlighted, then release the mouse.)
- Or press ALT and then press the underlined letter in the menu name. For example, to open the File menu, press ALT+F.

**To choose a menu command:**

- Click the command name.
- Or type the underlined letter in the command name.
- Or use the UP and DOWN ARROW keys to select an item; then press ENTER.

Menu conventions are listed below.

<table>
<thead>
<tr>
<th>Menu convention</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimmed command name</td>
<td>The command is unavailable.</td>
</tr>
<tr>
<td>An ellipsis (...) after the name</td>
<td>Opens a dialog box that contains options you need to select before PanelBuilder can carry out the command.</td>
</tr>
<tr>
<td>A check mark (✓) next to the name</td>
<td>The command is a toggle that is activated (turned on). A toggle command alternately turns on or off each time you select it. When turned off, the check mark is removed.</td>
</tr>
<tr>
<td>A key combination after the name</td>
<td>A shortcut for the command. You can use the key combination to choose the command.</td>
</tr>
<tr>
<td>A triangle (▲) at the right side of a menu command</td>
<td>Opens another menu of choices.</td>
</tr>
</tbody>
</table>

**To close a menu:**

- Click the menu name or anywhere outside the menu.
- Or press ALT or F10 to cancel and move back to the workspace.
- Or press ESC to cancel the menu but remain on the menu bar.
Tool Bar

The tool bar appears at the top of the PanelBuilder window and provides tools for frequently used menu commands. You click a tool to carry out an action. Some tools complete the action immediately; others place you in a mode to complete the action.

To toggle the tool bar on or off:

Choose Tool Bar from the View menu.

A check mark (✓) appears next to the Tool Bar command when it's active. To turn the tool bar off, choose the command again.

Status Bar

The status bar appears at the bottom of the PanelBuilder window and indicates what PanelBuilder is doing at the moment. When placing and selecting objects, the right element of the status bar shows the object type.

To toggle the status bar on or off:

Choose Status Bar from the View menu.

A check mark (✓) appears next to the Status Bar command when it's active. To turn the status bar off, choose the command again.
Format Bar

The format bar appears near the top of the PanelBuilder window and provides easy access to commonly used formatting commands. Format tools change the appearance of objects and text.

Most format tools toggle on and off. Click the tool once to turn it on, click it again to turn it off. The same settings are accessed from the Format menu.

The format bar has different views depending on what mode you’re in. Each view is shown below.
Toolboxes

PanelBuilder provides toolboxes, in addition to menu commands, to create screen objects. The main toolbox contains controls, displays, list keys and graphics. The ISA Symbols toolbox contains standard ISA symbols. Appendix B describes each tool. To choose an object, click the appropriate tool in the toolbox.

The toolboxes can be moved like any other window.

To toggle a toolbox on or off:

Choose Toolbox or ISA Symbols from the View menu.

A check mark (✓) appears next to the command when the toolbox is active. To close a toolbox, choose the appropriate command again.

You can view application screens with or without the numeric keypad.

To toggle the keypad on or off:

Choose Keypad from the View menu.

A check mark (✓) appears next to the command when the keypad is active. Select the command again to turn off the keypad.
Applications developed for color and grayscale terminals use a color palette to define the colors of objects and text. For color terminals, the palette supports 16 standard EGA colors. For grayscale terminals, the palette supports 4 colors (shades of gray).

To toggle the color palette on or off:

Choose Color Palette from the View menu.

A check mark (✓) next to the command means the palette is active. To turn the palette off, choose the command again.

The palette moves like other windows. Click the right mouse button in the palette to switch between a vertical or horizontal format.

Use the palette to set the foreground and background colors of objects, text and graphics. On color terminals, the default background color is blue and the foreground color is white. On grayscale terminals, default background color is black and the foreground color is white.

Foreground colors are located on the top row of the palette, background colors on the bottom row. To select a color, just click on a cell. A box around the cell indicates the selected color.

The view box on the left of the palette updates as you change the foreground and background colors.

Foreground colors are used for:

- all text (text, background text, list text)
- lines
- borders of shapes (rectangle, circle, ellipse)
- borders of control objects
- list cursor
- fill pattern
Background colors are used for:
- area containing text string
- solid fill area of objects (buttons and lists)

You can also set foreground/background colors for monochrome bitmaps.

The default screen background is black but can be changed using the Attributes command on the Screen menu.

Dialog Boxes

PanelBuilder uses dialog boxes to request information it needs to carry out a command. After supplying the requested information, click a command button to carry out the command.

Some dialog boxes provide sets of options, each on a separate tab. You click on a tab to work with a specific set of options.

Dialog boxes also display additional information and warnings, or explain why a requested task could not be accomplished.

An ellipses (…) after a menu command means a dialog box will open when you choose that command. Below is a sample dialog.

To move around a dialog box:
- Move mouse pointer to field and click the left mouse button.
- Or press TAB to move forward through fields and SHIFT+TAB to move backward through fields.
- Or press the ALT key and the underlined letter of a field name. For example, to move to the Terminal Name field, press ALT+T.
Spreadsheet Editor

PanelBuilder uses a spreadsheet editor to:
• edit states of multistate and list objects
• view and edit all text in the application
• edit alarms and triggers

The conventions of using the spreadsheet are the same regardless of what PanelBuilder operation you are performing.

Each row defines data for one state of a multistate or list object, one alarm, one trigger or one text string in the application. Each cell represents one field of data in a row.

Some cells require you to:
• enter text
• select an option from a drop-down list
• click a box to toggle an option on (X) or off

Selecting Rows, Cells, or Columns

To select a cell:
Click on the cell, or press TAB or the arrow keys.
A gray border around the cell indicates the cell is selected.

To select a block of cells:
1. Select a cell in one corner of the block you want to select.
2. Hold down the left mouse button and drag the mouse until the desired selection is highlighted.
   Or hold down the SHIFT key and use the arrow keys to highlight the block.
To select a single row:
Click on the row number at the left edge of the worksheet.
The row is highlighted, indicating it is selected.

To select more than one row:
1. Click on the row number of the first row you want to select, hold down the left mouse button and drag the mouse to the last row you want to include in the selection.
2. Release the mouse button.
Selected rows are highlighted.

To select a single column:
Click on the column header at the top of the spreadsheet.
The column is highlighted, indicating that it is selected.

To select more than one column:
1. Click on the column header of the first column you want to select, hold down the left mouse button and drag the mouse to the last column you want to include in the selection.
2. Release the mouse button.
Selected columns are highlighted.

To select the entire spreadsheet:
Click the empty box in the upper left corner of the spreadsheet.

Changing Column Width and Row Height

The spreadsheet opens with default column and row settings. While working in the spreadsheet, you can shrink or stretch the width of the columns and the height of the rows.

To change the width of a column:
1. Place the cursor on the line dividing the columns.
The cursor changes to a double arrow.
2. Hold the left mouse button down and drag the cursor to stretch or shrink the column width.
You can hide a column by shrinking it until it disappears. To show the column, stretch it.
To change the height of all rows:

1. Place the cursor on the line dividing the rows.  
   The cursor changes to a double arrow \( \vdash \)

2. Hold the left mouse button down and drag the cursor to stretch or 
   shrink the height of all rows. 
   You can hide all rows by shrinking them until they disappear. To 
   show the rows, stretch them.

Changing Order of Columns

To change the order of columns:

1. Select the column you want to move.

2. Hold down the \texttt{SHIFT} key and drag the column to a new location. 
   Columns are reordered. 

The column order is maintained when you exit the spreadsheet.

Cutting or Copying and Pasting Selections

To copy or cut and paste cells, rows or columns:

1. Select the area you want to copy.

2. Hold down the right mouse button and choose \texttt{Cut (Ctrl+X)} or 
   \texttt{Copy (Ctrl+C)} from the popup menu. 
   The data is placed on the clipboard, replacing the clipboard’s 
   previous contents.

3. Select the area in which you want to paste the contents of the 
   clipboard, or click on a single cell.

4. Click the right mouse button and choose \texttt{Paste (Ctrl+V)} from the 
   popup menu. 
   The contents of the clipboard are pasted into the selected area. 
   Or, if you selected a single cell, the contents are pasted into the 
   area starting with the cell.

Cells, rows and columns can be copied/cut/pasted to and from Excel 
using commands (or keys) on the popup menu.
Adding, Inserting and Deleting Rows

Regardless of what operation you are performing, rows are added, inserted and deleted in the same way. Select a row and choose the appropriate command from the spreadsheet popup menu.

To add a new row:

Click the right mouse button and choose Append from the menu. A new row is added after the last row. The row is created with defaults from the last row.

To insert a row:

1. Click the row number below where you want to insert a new row.
2. Click the right mouse button and choose Insert from the popup menu.

   A new row is inserted above the selected row.

To delete a row:

1. Click the row number you want to delete.
2. Click the right mouse button and choose Delete from the menu.

   The row is permanently deleted.

PanelBuilder Defaults

When you exit PanelBuilder, it remembers if the window bars and toolboxes are on or off and shows them in that same condition the next time you start PanelBuilder.
Help for PanelBuilder is available by choosing a command from the Help menu or pressing the F1 key. The following help window opens when you choose Index from the Help menu.

<table>
<thead>
<tr>
<th>Help feature</th>
<th>How to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents button</td>
<td>Choose to see a list of topics.</td>
</tr>
<tr>
<td>Search button</td>
<td>Choose to search for topics by keywords.</td>
</tr>
<tr>
<td>Back button</td>
<td>Choose to view the previous topic. Continue to choose the button to step back through all the topics.</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Choose to display the next topic in a series of topics.</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Choose to display the previous topic in a series of topics.</td>
</tr>
</tbody>
</table>

**When Calling for Technical Assistance**

When calling Rockwell International Technical Services for assistance, you’ll need to provide the release date and version number of the PanelBuilder software and the AB Utilities software. This information is available by choosing About PanelBuilder from the Help menu. Below is an example of what the dialog looks like.
Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>6–1</td>
</tr>
<tr>
<td>Starting PanelBuilder</td>
<td>6–2</td>
</tr>
<tr>
<td>Creating a New Application</td>
<td>6–3</td>
</tr>
<tr>
<td>Opening an Existing Application</td>
<td>6–5</td>
</tr>
<tr>
<td>Renaming and Describing an Application</td>
<td>6–8</td>
</tr>
<tr>
<td>Opening a New Screen</td>
<td>6–10</td>
</tr>
<tr>
<td>Opening an Existing Screen</td>
<td>6–11</td>
</tr>
<tr>
<td>Opening Multiple Screens</td>
<td>6–12</td>
</tr>
<tr>
<td>Closing Screens</td>
<td>6–14</td>
</tr>
<tr>
<td>Changing Screen Attributes</td>
<td>6–14</td>
</tr>
<tr>
<td>Deleting Screens</td>
<td>6–15</td>
</tr>
<tr>
<td>Copying Screens within an Application</td>
<td>6–15</td>
</tr>
<tr>
<td>Copying Screens to Another Application</td>
<td>6–16</td>
</tr>
<tr>
<td>Moving Screens to Another Application</td>
<td>6–17</td>
</tr>
<tr>
<td>Saving an Application</td>
<td>6–20</td>
</tr>
<tr>
<td>Closing an Application</td>
<td>6–21</td>
</tr>
<tr>
<td>Exiting PanelBuilder</td>
<td>6–21</td>
</tr>
</tbody>
</table>

Helpful Hints

- PanelBuilder applications use these file types:
  - .PBA – PanelBuilder application
  - .BAK – Backup of PanelBuilder application
  - .PVA – Translated .PBA file that is downloaded to terminal

- To make a copy of a PanelBuilder application, copy the .PBA file to a new file name.

- To save the previous version of an application each time you close it, place the following line in the [Files] section of the C:\WINDOWS\PB550.INI file:
  
  BackupPBAFiles=1

  The application is saved with the same file name and the .BAK file type.
Starting PanelBuilder

PanelBuilder opens like any other Windows application.

To start PanelBuilder:

• For computer running Windows 3.x:
  – At the DOS prompt, type win and press ENTER.
  – Double-click the PanelBuilder group icon in the Program Manager. Or use the Run command in the File menu of the Program Manager or File Manager.
  – Double-click the PanelBuilder icon.

• For computers running Windows 95:
  – Click the Start button.
  – Click on Programs. You will see the Programs submenu.
  – Click PanelBuilder to open the PanelBuilder submenu.
  – Click the PanelBuilder icon.

The startup screen opens showing copyright and release information.

The PanelBuilder window opens ready for you to open a new or existing application file.
Creating a New Application

A PanelBuilder application is a set of screens with associated tags and devices (terminal and controller). When creating an application, you define:

- application name
- project name containing tag and device information
- terminal in which the application will run

To create and open a new application file:

1. Click the New File tool on the tool bar

Or choose New from the File menu.

2. In the Application Name box, enter a 1 to 32 character name for the application.

When saving the application, PanelBuilder uses the first 8 characters of the application name as the default file name (with the .PBA file type).

3. In the Project Name box, enter a 1 to 32 character name for the project. The name can’t start with a number or contain spaces.

The Project Name list box contains the names of all existing projects. Select one of these if the new application will use the same tag definitions and devices as another application.

The Project Name links the application with a database of tag definitions and device (terminal and controller) information.
4. In the Terminal Name box, enter a 1 to 32 character name for the
terminal. This name identifies the terminal to the project.

If the selected project contains existing terminal devices, you can
select the name of a terminal from the Terminal Name box.

To copy, rename or delete devices from a project, see page 21–4.

5. Under Terminal Type Information, define the PanelView terminal
in which the application will run, by selecting:

– Terminal option from the PV Type box
– Keypad, Touch, or Keypad & Touch (PV550/PV600 only)
– Catalog number and firmware version installed in the terminal
  from the Catalog and Version list. The list is filtered based on
  the previous two selections.

The Ports area displays the physical ports and protocols of the
selected terminal.

If you selected an existing terminal from the Terminal Name box, the
dialog displays the defined terminal information.

6. Click the OK button.

The application file window opens showing the name of the
application and the selected terminal. Because the file does not
contain any screens the Screens box is empty.

You are ready to create a new application screen. See page 6–10.
To open an existing application file:

The bottom of the file menu lists the 4 most recently opened applications. To reopen one of these files, choose a file.

1. Click the Open File tool on the tool bar.

Or choose Open from the File menu.

The File Name list box shows all PanelBuilder application (.pba) at the current location.

- To locate a file on another drive, select the drive name in the Drives list box.
- To locate a file in another folder, select a folder from the Folders list. Scroll through the filenames until you find the one you’re looking for.

2. From the File Name list box, select the file you want to open and click the OK button.

Or double-click on the file name.

3. A dialog opens to verify a one-to-one correspondence between tags/devices in the application and tags/devices in the project.

You can perform the verification without displaying this dialog. For details on how to hide the dialog, see the next page.

The dialog displays the name of the first application tag in the project.
Respond as follows:

<table>
<thead>
<tr>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Replace the project tag with the application tag. Select Yes, if you know that a specific tag has been modified and you want to update the project database.</td>
</tr>
<tr>
<td>No</td>
<td>Ignore the application tag. Do not replace the tag in the project database with the application tag.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Replace all project tags with the application tags.</td>
</tr>
<tr>
<td>Replace None</td>
<td>Ignore all application tags. Do not replace any tags in the project.</td>
</tr>
<tr>
<td>Cancel Open</td>
<td>Cancel the open.</td>
</tr>
</tbody>
</table>

After processing the tags, the dialog opens again to verify a one-to-one correspondence between the devices in the application and the devices in the project.

4. When the application is loaded, the application file window opens with a list of screens (by number and name) in the file.

Open a screen in the application file window as described on page 6–11 or open a new screen as described on page 6–10.
Setting Preferences for Opening Applications

You can control the behavior of PanelBuilder when opening an application. Choose Preferences from the Application menu.

Show Project Database Restore Dialog

Select this check box to display the Project Database Restore dialog each time you open an application. This dialog prompts you to:

- replace duplicate tags and devices in the project database with those in the application.
- add application tags and devices to the project database if they are missing.

This is the default option. To add missing tags and replace duplicate tags in the project database without showing the Project Database dialog, disable this check box and select the other two boxes.

Always Add Missing Tags & Devices

Select this check box and disable the first check box to add missing tags and devices to the project data database without opening the Project Database dialog. This option is equivalent to clicking the Add All button on the Project Database dialog.

Always Replace Duplicate Tags & Devices

Select this check box and disable the first check box to replace duplicate tags and devices in the project database without opening the Project Database dialog. This option is equivalent to clicking the Replace All button on the Project Database dialog.

Important: If you disable all check boxes, the verification process will not occur and you may lose tag or device data.
Renaming and Describing an Application

Use the Description command on the Application menu to:
- Rename an application
- Enter an application description which you can include in a report
- View the version number and last save date of an application

To open the Application Description dialog:
- Choose Description from the Application menu.
- Or click the Description button from the New Application dialog.

If entering a description from the New Application dialog, the Application Name and Project Name do not appear.

To change the application name:
1. Click in the Application Name box to rename the application.
   Drag pointer over text to highlight it, then type a new name.
2. Click OK to close dialog.

The new application name appears in the Application File Window and the title bar of the PanelBuilder workspace.
**Important:** The description is downloaded to the terminal with the application which means it uses terminal memory.

**To enter or edit an application description:**

1. Enter a description in the Description box. The text automatically wraps.

   To change the location of the insertion point in the Description box, move the I-beam pointer or use the arrow keys. When using the scroll bar, the insertion point remains where it is until you move it.

   - To start a new line, press CTRL+ENTER.
   - To delete text, drag pointer over text to highlight it, then press BACKSPACE or DELETE.
   - To replace text, drag pointer over text to highlight it, then type the new text.
   - To add text, position cursor where you want to insert text and then type the new text.

   Use any of the standard Window editing functions to edit text.

2. When done, click the OK button.
Opening a New Screen

To create a new screen in the application:

1. Click the New Screen tool on the tool bar or choose New from the Screen menu.

PanelBuilder assigns a default number starting with 1 and a default name to each screen (Screen 1, Screen 2, Screen 3,...).

The maximum number of screens in a file is 255. The actual number allowed depends on available memory in the terminal.

2. Accept the name or enter a unique name (up to 32 characters) in the Name box. Use descriptive names to identify screens.

3. Accept the number, representing the screen’s position in the application file window, or enter a number in the Number box.

4. In the Background box, select the screen background color. The default is black. This field applies only to color and grayscale terminals.

5. Click the OK button.

A blank PanelView screen opens showing the screen number and name in the title bar.

An * after the application file name in the title bar means the application has been modified but not saved.

You are ready to create screen objects. The next chapter provides an overview on working with screen objects.
To open an existing screen in the application:

- Double-click a screen name in the application file window.
- Or select a screen from the application file window and click the Open Screen tool on the tool bar.
- Or select a screen from the application file window and choose Open from the Screen menu.

The screen opens with its name and number in the title bar.
Multiple screens can be open in the workspace. You might want to copy or move objects from one screen to another or you might need to access information on another screen.

Each screen opened overlaps the previous screen and PanelBuilder adds the screen name to the Windows menu. The last opened screen becomes the active screen. A check mark (✓) appears next to the active screen. The title bar of the active screen is also highlighted.

**To open multiple screens in an application:**

1. Click the first screen you want to select in the application file window, then drag the pointer to the last screen.

   To cancel the selection, click any screen in the list.

   Or click the first screen, press and hold down the SHIFT key, and click the last screen you want to select.

   To cancel the selection, release the SHIFT key and click on any screen.

2. Click the Open Screen tool on the tool bar.

   Or Choose Open from the Screen menu.

   The selected screens open.

**Important:** Too many open screens may result in a Windows resource or low memory message, and slow screen updates. Close the application file and any open Windows programs. Open the screens one at a time.
Activating a Screen

When multiple screens are open only one screen is active and that is the screen with the highlighted title bar.

To activate a screen:
- Choose a screen from the lower portion of the Windows menu.
- Or click anywhere inside the screen.

A check mark (✓) appears next to a screen name when it is active and the title bar is highlighted.

Arranging Open Screens

Overlap screens diagonally across the workspace with the title bar of each screen visible, or line them as horizontal or vertical tiles.

To arrange open screens:
Choose Cascade, Tile Horizontally or Tile Vertically from the Window menu.

Reducing Screens to Icons

You can reduce an application file and screens to icons leaving more space in the workspace but still making them available.

To reduce an open file or screen to an icon:
Click the Minimize button on the window.

The application file and screens reduce to icons as shown below.

To evenly space icons across the bottom of the workspace, choose Arrange Icons from the Window menu.
Closing Screens

When you are finished with an application screen, close it. Screens are automatically saved when you save the application.

To close an application screen:
- Choose Close from the Screen menu.
- Or double-click the control-menu box on the screen.

The screen closes leaving you in the PanelBuilder workspace.

To close all open application screens:

Choose Close All from the Window menu.

Changing Screen Attributes

Use the Attributes command on the Screen menu to:
- rename a screen
- renumber a screen
- change the background color of the screen (color terminals only)

To change the attributes of a screen:
1. From the application file window, select a screen to rename.
   Or activate an open screen.
2. Choose Attributes from the Screen menu.
3. In the Name box, type a new screen name (32 characters maximum).
4. Accept the number in the Number box or enter a new one.
5. In the Background box, select another color for the screen background. The current color is shown.
6. Click the OK button.
   The new screen name and number will appear in the title bar of the screen and in the application file window.
Deleting Screens

Use the Delete Screen command to remove screens from an application file without placing them on the clipboard.

**To delete screens:**

1. From the application file window, select the screens to delete.
2. Choose Delete Screen from the Edit menu.

The screens are removed from the Edit menu.

Numbers of deleted screens are used when new screens are created.

Copying Screens within an Application

This section shows how to copy screens within an application using the Copy and Paste commands on the Edit menu.

**To copy a screen within an application:**

1. Select the screen you want to copy from the application file window.
2. Click the Copy tool on the tool bar or Choose Copy Screen from the Edit menu.

PanelBuilder copies the screen to the clipboard.

3. Click the Paste tool on the tool bar or choose Paste Screen from the Edit menu.
4. PanelBuilder pastes the screen into the application file window at the lowest available screen number.

In the following example, screen 2 – Feed Pump is copied to screen 5 with the same screen name.

Use the Attributes command on the Screen menu to change the name of the copied screen.
This section shows how to copy screens from one application to another using the Copy and Paste commands on the Edit menu. Only one application can be open in the workspace but you can run multiple sessions of PanelBuilder.

See page 6–18 for details on what to do when copying or moving a screen to an application that was created for a different type of terminal.

To copy screens from one application to another:

1. Select the screens you want to copy from the application file window.

2. Click the Copy tool on the tool bar or Choose Copy Screen from the Edit menu.

   PanelBuilder copies the screens to the clipboard.

3. Save the application file (if necessary).

4. Close the application file.

   Or start another session of PanelBuilder.

5. Open the application file to receive the screen.

6. Click the Paste tool on the tool bar or choose Paste Screen from the Edit menu.

7. PanelBuilder pastes the screen into the application file window of the target application with the same name and number.

   If the screen number exists in the target application, the screen is assigned the next available number.

In the following example, the Feed Pump screen is copied from the Sample application file to the Test application file.
This section shows how to move screens from one application to another using the Cut and Paste commands on the Edit menu. Only one application can be open in the workspace but you can run multiple sessions of PanelBuilder.

See page 6–18 for details on what to do when copying or moving a screen to an application that was created for a different type of terminal.

To move screens from one application to another:

1. Select the screens to move from the application file window.

2. Click the Cut tool on the tool bar or choose Cut Screen from the Edit menu.

   PanelBuilder removes the screen from the file and puts it on the clipboard.

3. Save the application file (if necessary).

4. Close the application file.

   Or start another session of PanelBuilder.

5. Open the application file to receive the screen.

6. Click the Paste tool on the tool bar or choose Paste Screen from the Edit menu.

7. PanelBuilder pastes the screen into the application file window of the target application with the same name and number.

   If the screen number exists in the target application, the screen is assigned the next available number.

In the example below, the Feed Pump screen is moved from the Sample to the Test application using the lowest available number.
Converting Copied Screens

Converting from Touch Screen to Keypad
If copying or moving a screen from a touch screen to a keypad application, you must assign function key input to screen objects.

Converting to another Terminal Type
If copying or moving a screen to an application created for a different terminal type (for example, 900 to 550), you may need to resize or adjust the location of objects on the pasted screen.

Converting to another Communication Protocol
If copying or moving a screen to an application that uses a different communication protocol (for example, Remote I/O to DH-485), you must update the terminal setup and tags appropriately.

Converting Monochrome to Color or Grayscale
If copying or moving a screen from a monochrome application to a color or grayscale application, the following dialog opens.

You are asked to supply the following colors:
- background color of screen (default is black)
- foreground color of objects (default is white)
- background color of objects (default is black)

Select the colors you want and click OK. The screen is pasted into the color or grayscale application using the selected colors.
Converting Color to Monochrome

If copying or moving a screen from a color application to a monochrome application, all colors are removed from the screen.
- screen background is converted to white
- brighter colors are converted to white
- darker colors are converted to black
- color bitmaps are converted to monochrome bitmaps

Also, text sizes are converted to the closest matching font in the new application. You may want to resize the text.

Converting Color to Grayscale

If copying or moving a screen from a color application to a grayscale application, all colors are removed from the screen.
- colors are converted to the closest shade of gray
- color bitmaps are converted to grayscale bitmaps

Also, text sizes are converted to the closest matching font in the new application. You may want to resize the text.
The File menu provides two commands for saving an application.

- Use the **Save** command to save the application to the default drive and folder overwriting the previous version.
- Use the **Save As** command to save a revised application with a new name so the previous version is not overwritten.

The first time an application is saved, the Save As dialog opens so the file can be named.

**To save an existing application file:**

- Click the Save File tool on the tool bar.
- Or choose Save from the File menu.

PanelBuilder replaces the previous version of the application on disk with the new version. A backup file is also created.

**To save a new or existing application with a new name:**

1. Choose Save As from the File menu.

   The first time you save the application, the default file name is the first 8 characters of the application name.

2. In the File Name box, accept the default or enter another 1 to 8 character name. PanelBuilder automatically adds the .PBA file type to the name.

   **Note:** You can save the file with another file type. Do not use .PVA which is the translated file that runs in the terminal.

   To save the file to another location, select a folder. To select another drive, click a drive name in the Drives box.

3. Click the OK button.

   The name under which you save the application becomes the default for the next save operation (Save or Save As command). A backup file is also created with the same file name and the .BAK file type.

PanelBuilder tracks the date/time and version of an application when it is saved. This information is available by choosing Description from the Application menu.
The Close command on the File menu closes the application file but leaves you in the PanelBuilder workspace.

**To close an application file:**
- Choose Close from the File menu.
- Or double-click the control-menu box on the application file window.

If you’ve made changes to the application since the last save, PanelBuilder gives you the option of saving the file before closing it.

The Exit command on the File menu quits PanelBuilder and returns you to the Windows desktop. All opened applications are closed.

**To quit PanelBuilder:**
- Choose Exit from the File menu.
- Or double-click the control-menu box on the application file window.

If any applications are open and unmodified, they are closed automatically.

If you’ve made changes to the application since the last save, PanelBuilder gives you the option of saving the file before closing it.
Working with Objects

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing Objects</td>
<td>7–2</td>
</tr>
<tr>
<td>Draw Pointer</td>
<td>7–3</td>
</tr>
<tr>
<td>Creating Objects in Display Area</td>
<td>7–4</td>
</tr>
<tr>
<td>Aligning Objects</td>
<td>7–5</td>
</tr>
<tr>
<td>Creating Objects on Function Keys</td>
<td>7–7</td>
</tr>
<tr>
<td>Selecting Objects</td>
<td>7–8</td>
</tr>
<tr>
<td>Sizing Objects</td>
<td>7–9</td>
</tr>
<tr>
<td>Moving Objects</td>
<td>7–9</td>
</tr>
<tr>
<td>Grouping and Ungrouping Objects</td>
<td>7–10</td>
</tr>
<tr>
<td>Stacking Objects</td>
<td>7–11</td>
</tr>
<tr>
<td>Zooming In and Out</td>
<td>7–11</td>
</tr>
<tr>
<td>Object Inner Text</td>
<td>7–12</td>
</tr>
<tr>
<td>Formatting Objects</td>
<td>7–13</td>
</tr>
<tr>
<td>Setting Default Colors for Objects</td>
<td>7–13</td>
</tr>
<tr>
<td>Editing Object Attributes</td>
<td>7–14</td>
</tr>
<tr>
<td>Configuring States of Multistate or List Objects</td>
<td>7–15</td>
</tr>
<tr>
<td>Entering a Description for an Object</td>
<td>7–18</td>
</tr>
<tr>
<td>Hiding the View of an Object</td>
<td>7–19</td>
</tr>
<tr>
<td>Copying/Cutting and Pasting Objects</td>
<td>7–20</td>
</tr>
<tr>
<td>Deleting Objects</td>
<td>7–22</td>
</tr>
<tr>
<td>Reversing an Operation</td>
<td>7–22</td>
</tr>
</tbody>
</table>
All objects (controls, displays, graphics, ISA symbols) are accessed from the Objects menu or a toolbox.

The toolboxes toggle on and off from the View menu.
Draw Pointer

You can place objects in the display area of the application screen or on a function key, depending on the terminal type.

When selecting an object and moving the mouse into either of these areas, the mouse pointer changes to a crosshair (+). The crosshair indicates where an object appears when you place it and also aids in positioning and aligning the object.

The pointer changes back to ✱ after exiting the object mode.

If moved to an illegal area of the screen, the crosshair changes to ☢.
Objects are created in the display area using the same technique.

**To create an object in the display area:**

1. Choose an object from the Objects menu.
   
   Or click the appropriate tool in the toolbox.

2. Position the pointer (+) where you want to place the object.

3. Click the left mouse button to place the default size.
   
   Or hold down the left mouse button and drag the pointer to size the object. Release the mouse when the object is the right size. The object is automatically selected.

4. To place another object of the same type, move the pointer to a new location and repeat step 3.

5. Click the right mouse button to exit the object mode.
   
   Or click the selection tool in the toolbox.

   Or press the ESC key.

For each object placed on the screen, the status bar shows:

- Object ID number (assigned by PanelBuilder)
- X and Y coordinates of upper left corner of object (in pixels). Coordinates are referenced from upper left corner of display (x=0, y=0).
- Width and height of object (in pixels)
- Object type (right element of status bar)
Aligning Objects

Two grids are available for sizing and aligning objects:
- Touch grid (available only on touch screen terminals)
- Screen grid

**Touch Grid**

Touch screen terminals use a touch grid to align control objects (push button controls, screen buttons, keypad enable button) with the touch cells. Push button objects are moved and sized in increments of touch cells. The default push button occupies 4 (2 x 2) touch cells but can be sized differently.

The touch grid is present in every screen but isn’t visible unless turned on.

The touch grid does not control the placement of graphics or display objects; they can be placed anywhere on the screen. Use the screen grid to align graphics and displays.

**To show the touch grid:**

Choose Touch Grid from the Align menu.

A check mark (✓) appears next to Touch Grid when it’s active. Choosing Touch Grid again hides the grid.

On PanelView 900/1000/1400 Touch Screen terminals, the touch grid has 384 (24 x 16) touch cells. On PanelView 550/600 Touch Screen & Keypad terminals, the touch grid has 128 (16 x 8) touch cells.
Screen Grid

Keypad terminals use a screen grid to size and position objects. You can turn the grid on or off and size the grid in increments of pixels. The Snap to Grid feature forces each object to the nearest intersection of the grid.

On touch screen terminals, use the screen grid to position graphics and displays. Control objects are aligned using the touch grid.

To show the grid:
Choose Grid from the Align menu. The grid displays with the current grid attributes.
A check mark (✓) appears next to Grid when it’s active. Choose Grid again to hide the grid.

To snap objects to the grid:
Choose Snap to Grid from the Align menu.
A check mark (✓) appears next to the command when it’s active. Choose Snap to Grid again to turn the feature off.

To resize the grid:
1. Choose Grid Attributes from the Align menu.
   The Grid Spacing dialog box opens showing the current grid size in pixels on the X and Y-axis.

   - Default grid for PV550 terminal is 8 x 8.
   - Default grid for PV600 terminal is 10 x 29.
   - Default grid for PV900 monochrome terminal is 13 x 25.
   - Default grid for PV900/PV1000 color and grayscale terminals is 13 x 30.
   - Default grid for PV1400 color terminal is 33 x 37.

2. To increase or decrease the spacing of the grid lines on the X-axis, click the up or down arrow next to the X box.
   Or type a number in the box. A value of 13 creates horizontal grid lines every 13 pixels.

3. To increase or decrease the spacing of the grid on the Y-axis, click the up or down arrow next to the Y box.
   Or type a number in the box. A value of 25 creates vertical grid lines every 25 pixels.

4. Click the OK button.
Creating Objects on Function Keys

If screen space is limited, you can place button objects on function keys. You can relegend the function keys using the Function Key Legend Kit available for your terminal.

The following objects can be placed on a function key:

- Push button controls (momentary, maintained, latched, multistate)
- Screen selector buttons (Go To and Return)
- Keypad enable button
- Alarm buttons, Alarm History and Print History buttons
- List keys

To create an object on a function key:

1. Choose an object from the Objects menu.
   Or click the appropriate tool in the toolbox.

2. Position the pointer (+) over a function key and click the left mouse button.
   If the function key is already assigned to an object, the pointer changes to ●. Reposition pointer over another key.

A graphic appears on the function key showing the object type. An asterisk also appears next to the key number.

3. Click the right mouse button to exit the object mode.
   Or click the selection tool in the toolbox.
Selecting Objects

Before you can move, size or format an object you must first select the object. A selected object has handles.

To select an object:

Position the mouse pointer anywhere on the object and press the left mouse button. Handles appear on the object.

A line has one handle at each end. Rectangles and squares have handles around their edges. Other objects (ellipses and circles) have handles around an invisible bounding box.

To deselect an object:

• Position pointer outside the object and press the left mouse button.
• Or select another object.

To select multiple objects:

1. Position pointer above and to the left of the objects you want to group.

2. Press the left mouse button and drag a selection rectangle around the objects.

3. Release the mouse button.

The other way to select multiple objects is to hold down the SHIFT key and click on each object. To add or remove an object from the selection, hold down the SHIFT key and click on the object.

To select all objects:

Choose Select All from the Edit menu.

Handles appear on all objects to show that they’re all selected.
Sizing Objects

To size an object:

1. Select the object by clicking anywhere on the object. Handles appear on the object.

   ![Handle](image)

2. Position the pointer over one of the handles. The pointer changes to show the direction you can size the object.

   ![Size Horizontally](image)
   ![Size Vertically](image)
   ![Size Diagonally](image)

3. Press the left mouse button and drag the handle. The object stretches from the anchor point to the position of the pointer, expanding and contracting as you move the mouse.

   The anchor point is the handle opposite the handle you choose. It does not move when objects are sized.

4. Release the mouse button when the object is the right size.

   Objects with inner graphics can’t be sized smaller than the graphic. You might have to move or delete the inner graphic to size the object appropriately.

Moving Objects

To move an object:

1. Move the pointer anywhere inside the object.

2. Hold down the left mouse button and drag the object to its new location. The pointer changes to show that you are moving the object. An outline appears as you drag the object.

   ![Old Location](image)
   ![New Location](image)

3. Release the mouse button.
You can group objects so they can be moved or edited as a single unit. When moving objects in a group, they maintain their positions relative to each other. Grouped objects remain together until ungrouped.

A global object can consist of grouped objects. For example, you can group a bar graph, scale and tick-mark labels, and then define the group as a global object by double-clicking the group. This opens the Options dialog which lets you create a global object.

**To group a set of objects:**

1. Select the objects you want to group.
   Handles appear on all objects that are selected.

2. Click the Group tool on the tool bar.
   Or choose Group from the Edit menu.
   An outline appears around the objects that are grouped.

   ![Grouped Objects Diagram]

Selecting any one of the objects selects the entire group. When a group is selected you can move, cut/copy/paste or delete objects in a single operation. You can also size a selected object while maintaining its group status.

**To ungroup a set of grouped objects:**

1. Select the group.

2. Click the Ungroup tool on the tool bar.
   Or choose Ungroup from the Edit menu.
   The objects are now separate again. Deselect the group before selecting an individual object.

PanelBuilder remembers the last assembled group. To reassemble a former group of objects choose Regroup from the Edit menu.
Stacking Objects

You can change the stacking order of objects that overlap. You can stack objects on top of each other and then change the order in which they appear.

To bring an object to the front of the object stack:
1. Select the object.
2. Click the Bring to Front tool on the format bar.
   Or choose Bring To Front from the Edit menu.

To send an object to the back of the object stack:
1. Select the object.
2. Click the Send to Back tool on the format bar.
   Or choose Send To Back from the Edit menu.

Use the Bring Dynamic Objects To Front command to move all objects that interact with a controller address in front of other objects on the screen.

You can increase or decrease the view of the screen so that objects look larger or smaller than their actual size. Changing the view affects only the appearance of objects, not their actual size.

To zoom in or enlarge the view of the screen:
- Click the Zoom In tool on the tool bar.
- Or choose Zoom In from the View menu.

You can increase the view several times. If starting from Full Size, the view increases each time you click Zoom In.

To zoom out or reduce the view of the screen:
- Click the Zoom Out tool on the tool bar.
- Or choose Zoom Out from the View menu.

You can decrease the view several times. If starting from Full Size, the view decreases each time you click Zoom Out.

To return the screen to its normal size, choose Full Size from the View menu.
## Object Inner Text

Most objects, when created, have default inner text. The text varies depending on the object type.

Inner text can be edited and can include a time, date or numeric variable. In addition, you can replace the text with an inner graphic or include a graphic with the text.

<table>
<thead>
<tr>
<th>Object</th>
<th>Inner Text</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Buttons</td>
<td>Inner text for 2-state push buttons is ST 0 (State 0) and ST 1 (State 1). For multistate push buttons, the text can increment to ST 15 (State 15). For multistate indicators, the text can increment from ST 0 (State 0) to ST 1999 (State 1999).</td>
<td></td>
</tr>
<tr>
<td>Multistate Indicator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List Indicator</td>
<td>Inner text for list indicators can increment from ST 0 (State 0) to ST 254 (State 254).</td>
<td></td>
</tr>
<tr>
<td>Control List Selector</td>
<td>Inner text for control list selectors can increment from ST 0 (State 0) to ST 254 (State 254). The asterisk * means the text exceeds the size of the object. Resize object.</td>
<td></td>
</tr>
<tr>
<td>Standard Piloted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeric Entry Objects</td>
<td>Inner text for numeric entry and display objects is a numeric variable placeholder (######). You can add text before or after the variable.</td>
<td></td>
</tr>
<tr>
<td>Numeric Data Display</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASCII Entry Object</td>
<td>Inner text for an ASCII entry objects is a variable placeholder (#). You can add text before or after the variable.</td>
<td></td>
</tr>
<tr>
<td>Message Display</td>
<td>Inner text for message displays can increment from MSG 0 (Message 0) to MSG 1999 (Message 1999).</td>
<td></td>
</tr>
<tr>
<td>Goto Screen Button</td>
<td>Inner text is GoTo.</td>
<td></td>
</tr>
<tr>
<td>Goto Config Screen Button</td>
<td>Inner text is Goto Config Screen. The asterisk * means the text exceeds the size of the object. Resize object.</td>
<td></td>
</tr>
<tr>
<td>Return Button</td>
<td>Inner text is Return.</td>
<td></td>
</tr>
<tr>
<td>Screen List Selector</td>
<td>Inner text for screen list selectors can increment from ST 0 (State 0) to ST 254 (State 254). The asterisk * means the text exceeds the object size. Resize object.</td>
<td></td>
</tr>
<tr>
<td>Print Alarm Button</td>
<td>Inner text is Print.</td>
<td></td>
</tr>
<tr>
<td>Clear Alarm Button</td>
<td>Inner text is Clear.</td>
<td></td>
</tr>
<tr>
<td>Acknowledge Alarm Button</td>
<td>Inner text is Ack.</td>
<td></td>
</tr>
<tr>
<td>Acknowledge All Button</td>
<td>Inner text is Ack All.</td>
<td></td>
</tr>
<tr>
<td>Clear Alarm List Button</td>
<td>Inner text is Clear Alarm List.</td>
<td></td>
</tr>
<tr>
<td>Print Alarm List Button</td>
<td>Inner text is Print Alarm List.</td>
<td></td>
</tr>
</tbody>
</table>
Formatting Objects

In addition to adding inner text and graphics to objects, you can apply different formatting options to objects and text including color.

For objects, you can:
- change shape
- change border
- change fill pattern
- toggle blinking on/off
- change foreground/background colors
- toggle foreground/background colors

For text, you can:
- change text size
- change text alignment (left, right, center)
- toggle blinking on/off
- change foreground/background colors
- toggle foreground/background colors

Formatting options are applied to objects and states from the:
- Format menu or Format bar (see Chapter 17).
- State tab of object’s dialog (see page 7–15).

Setting Default Colors for Objects

On color and grayscale terminals, you can apply color defaults to objects of the same type. For example, you might want all push buttons in the application to use the same colors. Create one push button, edit it, and then use the Set Object Color Defaults command. All new push buttons will be created with the default colors.

1. Create the object that you want to use as the default for others.

2. Edit the object. Change the line or border, colors and size. If the object has several states, configure the different states. You cannot add text as the default.

3. Select the object and choose Set Object Color Defaults from the Edit menu.

Every new object of this type that you create will appear like the one just created.

Or if you want to apply defaults using an object that already exists, select the object and choose the Set Object Color Defaults command.

Color defaults are maintained across applications and across sessions of PanelBuilder.
Each object (except for graphics) has attributes that define its operation. View or edit the attributes by opening the object’s dialog.

**To view or edit the attributes of an object:**

- Double-click the object.
- Or select object and click the Object Attributes tool.
- Or select object and choose Object Attributes from the Edit menu.

The dialog that opens has 2 or 3 tabs depending on whether the object is a multistate or list object.

<table>
<thead>
<tr>
<th>Use this tab:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Configure the operating parameters of an object.</td>
</tr>
<tr>
<td>States</td>
<td>Configure the states of a multistate object or list object. Does not appear for other objects.</td>
</tr>
<tr>
<td>Options</td>
<td>Enter a description for the object, flag the object for global selection, or hide the view of the object.</td>
</tr>
</tbody>
</table>

Each object dialog has the same command buttons. Objects that do not interact with the controller will not have the Edit Tag button.

<table>
<thead>
<tr>
<th>Press:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Save changes and exit the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Exit the dialog without saving any changes.</td>
</tr>
<tr>
<td>Edit Tag</td>
<td>Open dialog to view or enter attributes for a data tag.</td>
</tr>
</tbody>
</table>
Configuring States of Multistate or List Objects

States are configured for multistate and list objects from the States tab of the object’s dialog.

When you click the States tab in an object’s dialog, a spreadsheet opens. Each object state is entered as a separate row in the spreadsheet. The fields or cells in each row configure text for each state and other visual attributes.

- to select a row, click the row number.
- to select a column, click the column header.
- to select a cell, click on the cell, or press TAB or arrow keys.

Most state operations are performed by clicking a row number and then choosing a command from this menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Insert and Paste</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Append State</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Insert State</td>
<td>Ins</td>
</tr>
<tr>
<td>Delete State</td>
<td>Del</td>
</tr>
<tr>
<td>Move State Up</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Move State Down</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Embedded Variable</td>
<td></td>
</tr>
<tr>
<td>Use Existing Text</td>
<td></td>
</tr>
<tr>
<td>New Tag ID</td>
<td></td>
</tr>
</tbody>
</table>

The fields that appear in each row depend on whether the object is a multistate object or a list object.

The multistate objects are:
- 2-state and multistate push buttons
- multistate indicator
- message display

The list objects are:
- control list selector
- screen list selector
- list indicator
The table below shows the fields that appear for multistate and list objects. When you open the States tab, the fields are arranged in order of importance. Fields that require editing will appear first. Optional fields appear later.

Fields that are unique to a specific object are discussed in the chapter describing the object.

<table>
<thead>
<tr>
<th>Use this Field:</th>
<th>To:</th>
<th>Multistate Objects</th>
<th>List Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Fill</td>
<td>Select a fill pattern (from a list) for the state. The Fill field does not appear for objects that are not rectangular.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Blink</td>
<td>Toggle blinking on or off for the state. Click the box to turn blinking on or off. An X in the box indicates the blink option is active. The default is off.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Object Foreground</td>
<td>Select a foreground color (from a list) for the object state. The default is white.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Object Background</td>
<td>Select a background color (from a list) for the state. The default is blue.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Graphic</td>
<td>Select a graphic to appear for the state. The list of graphics includes ISA symbols and imported bitmaps. Chapter 17 shows how to position a graphic.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Graphic Foreground</td>
<td>Select a foreground color for the inserted graphic. The default is white.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Graphic Background</td>
<td>Select a background color for the inserted graphic. The default is blue.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Text ID</td>
<td>Unique number assigned to text string. The number is automatically generated when a new state is created.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text</td>
<td>Define the inner text string for the object state. Default text appears for each state (ST 0, ST 1, ST 2). You can insert a time, date or numeric variable in the text string.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text Size</td>
<td>Select the size of the text string. The default size depends on the terminal type. For list objects, the selection applies to all states in the list.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text Blink</td>
<td>Toggle blinking on or off for the text string. Click the box to turn blinking on or off. The default is off. An X in the box indicates the blink option is active.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Underline</td>
<td>Toggle underlining on or off for the text string. Click the box to turn underlining on or off. The default is off. An X in the box indicates underlining is active.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Align Text</td>
<td>Select whether the text will align left, right, or center in the object. For list objects, the selection applies to the entire list. The default is left.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Word Wrap</td>
<td>Toggle word wrap on or off for the text string. Click the box to turn word wrap on or off. The default is on. An X in the box indicates word wrap is active. With word wrap on, text wraps at the end a word rather than breaking in the middle.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Text Foreground</td>
<td>Select a foreground color (from a list) for the inner text. For list objects, the selection applies to the entire list. The default is white.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text Background</td>
<td>Select a background color (from a list) for the area containing the text string. The default is blue.</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

* Cells that are unique to an object do not appear in this list.*
State Operations

Operations you can perform on states are accessed from a popup menu. To open the menu, hold down the right mouse button or type CTRL+M.

<table>
<thead>
<tr>
<th>Select</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut the selected state to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected state to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste the previously cut or copied row from the clipboard.</td>
</tr>
<tr>
<td>Insert and Paste</td>
<td>Paste the copied or cut state above the current row.</td>
</tr>
<tr>
<td>Append State</td>
<td>Add a new state after the last state. The new state is created with the defaults from state 0.</td>
</tr>
<tr>
<td>Insert State</td>
<td>Insert a state above the current row.</td>
</tr>
<tr>
<td>Delete State</td>
<td>Permanently remove the selected state.</td>
</tr>
<tr>
<td>Move State Up</td>
<td>Moves the selected state up one row.</td>
</tr>
<tr>
<td>Move State Down</td>
<td>Moves the selected state down one row.</td>
</tr>
</tbody>
</table>

Embroided Variable

A placeholder is inserted in the text for the variable.

- */T* Time placeholder
- */D* Date placeholder
- */A:12 */ ASCII placeholder
- */V:12 NOFILL FIX:0*/ Numeric placeholder

The time and date are formatted according to settings in the Terminal Setup dialog.

A dialog opens when Variable or ASCII is selected, allowing you to format the variable. The placeholder is updated with the specified format (/*V:6 NOFILL FIX:0*/ or */A8 */).

To edit a numeric or ASCII variable, select the placeholder and choose Edit Variable from the Embedded Variable menu.

Use Existing Text

Open the Use Existing Text dialog (in read only mode) allowing you to use a message that already exists in the application. See Chapter 18 for details.

New Text ID

Change the message number associated with the text for the current row to the next available number.
You can enter a description for an object from the Options tab of the Object’s dialog. Descriptions can be entered for all objects except graphics. The description appears in the application report.

To enter a description for an object:

1. Click the Options tab from the dialog of the selected object.

The insertion point appears at the beginning of the Description box. You can move the insertion point by moving the I-beam pointer or using the arrow keys. When using the scroll bar, the insertion point remains where it is until you move it.

2. Enter text in the Description box. The text automatically wraps. To start a new line, press CTRL+ENTER.

Use standard Window editing and cursor functions to edit text.

3. When done, click the OK button.
You can hide the view of an object to reduce the number of objects on a screen. Only input objects assigned to a function key or touch cell can have the view turned off. These objects are:

- Push button controls
- Screen selector buttons
- Keypad enable button

When the view is off, the object isn’t displayed. However, the object’s function key or touch cell is still active.

**ATTENTION:** When turning off the view of a touch cell object, you must place a graphic on that area of the screen. Otherwise, an operator could inadvertently touch that screen area and activate the function.

**To hide the view of an object:**

1. Click the Options tab from the dialog of the selected object.

2. Click the Turn Object View On box to show the object view.

   When the view shows, the box contains an X. To hide the view, clear the check box.

3. When done, click OK to exit the dialog.
Use the Copy/Cut and Paste commands on the Edit menu to:
- copy an object on the screen
- copy/cut an object to another screen
- copy/cut an object to another application

An object retains all attributes during copy and cut operations unless the target application was created for a different terminal type. See page 7–21.

Global objects cannot be copied/cut and pasted. To use an object globally, you must use the Global Objects command (Chapter 14).

To copy an object on the screen:
1. Select the object you want to copy.
2. Click the Copy tool or choose Copy from the Edit menu. PanelBuilder copies the object to the clipboard.
3. Click the Paste tool or choose Paste from the Edit menu. An outline of the object appears.
4. Move the outline to a new location and click the left mouse button to paste the object.

To change the attributes of the pasted object, double-click the object.

To copy or cut an object from one screen to another:
1. Select the object you want to copy or cut.
2. Click the Copy or Cut tool from the tool bar.
   Or choose Copy or Cut from the Edit menu. PanelBuilder copies/cuts the object to the clipboard.
3. Open the screen to receive the object.
   If already open, activate the screen by selecting the screen name from the Window menu.
4. Click the Paste tool or choose Paste from the Edit menu. An outline of the object appears.
5. Move the outline to a new location and click the left mouse button to paste the object.

To change the attributes of the pasted object, double-click the object.
To copy or cut an object from one application to another:

1. Select the object you want to copy or cut.

2. Click the Copy or Cut tool from the tool bar.
   Or choose Copy or Cut from the Edit menu.
   PanelBuilder copies/cuts the object to the clipboard.

3. Close the application screen.

4. Save the application file (if necessary).

5. Close the application file.
   Or start another session of PanelBuilder.

6. Open the application file to receive the object.

7. Open the screen on which you want to paste the object.

8. Click the Paste tool or choose Paste from the Edit menu.
   An outline of the object appears.

9. Move the outline to a new location and click the left mouse button to paste the object.

To change the attributes of the pasted object, double-click the object.

When Copying/Cutting Objects to a Different Application Type

When copying or moving objects to an application that was created for a different terminal type, you will need to update the pasted objects appropriately.

Monochrome to Color or Grayscale Application

When copying/moving objects from a monochrome to a color or grayscale application, a dialog opens asking you to select:

- foreground color for the pasted objects (default is white)
- background color for the pasted objects (default is black)

Color to Monochrome Application

When copying or moving an object from a color to a monochrome application, objects are pasted as follows:

- brighter colors of objects are converted to white
- darker colors of objects are converted to black
- color bitmaps are converted to monochrome bitmaps
Color to Grayscale Application
When copying or moving an object from a color to a grayscale application, objects are pasted as follows:
• colors of objects are converted to the closest shade of gray
• color bitmaps are converted to grayscale bitmaps

Touch Screen to Keypad Application
When copying/moving objects from a touch screen to a keypad application, you must assign function keys to the pasted objects.

Different Communication Protocol
When copying/moving objects to an application that uses a different communication protocol, you must update the tags appropriately for the pasted objects.

Deleting Objects
Use the Delete command to remove objects from an application screen without placing them on the clipboard.

To delete objects from a screen:
1. Select the objects you want to delete.
2. Choose Delete from the Edit menu.

To delete all objects from a screen:
1. Choose Select All from the Edit menu.
2. Choose Delete from the Edit menu.

To delete an object from a function key:
1. Select the function key.
2. Choose Delete from the Edit menu.

PanelBuilder deletes the object and graphic from the function key.

Reversing an Operation
PanelBuilder lets you cancel the previous editing operation. If an operation cannot be canceled, PanelBuilder lets you know. You cannot cancel the previous screen operation if the screen is closed.

To cancel the previous editing operation:
• Click the Undo tool on the tool bar.
• Or choose Undo from the Edit menu.

The Edit menu shows the name of the operation that will be undone. For example, lets say you delete an object and then want to cancel the delete. When you open the Edit menu, choose Undo Cut/Delete.
Creating Push Buttons

Chapter Objectives

This chapter shows how to create push button controls. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>8–1</td>
</tr>
<tr>
<td>Push Button Types</td>
<td>8–2</td>
</tr>
<tr>
<td>Contact Types</td>
<td>8–2</td>
</tr>
<tr>
<td>Push Button Text and Graphics</td>
<td>8–3</td>
</tr>
<tr>
<td>Creating Push Buttons</td>
<td>8–4</td>
</tr>
<tr>
<td>Setting Properties of a Push Button</td>
<td>8–4</td>
</tr>
<tr>
<td>Configuring Push Button States</td>
<td>8–6</td>
</tr>
</tbody>
</table>

Helpful Hints

When creating push button controls, consider:

- On touch screen terminals, each push button aligns with a default of 4 (2h x 2w) touch cells.
- Use a global object if the same button will appear on one or more screens. The PanelView terminal only stores one copy of a global button regardless of the number of links to it.
- Multistate push buttons support 16 states (numbered 0 to 15). Use only the number of states required.
- Push buttons can have unique inner text and/or a graphic for each state as well as other formatting options.
- Configure push button states from the States tab on the Push Buttons dialog or using the procedures described in Chapter 17.

**ATTENTION:** Some combinations of format options could result in a control object not being visible (object blends into screen background). All touch screen controls must be visible or have a graphic which shows the location of the object. Failure to do so may result in accidental or unpredictable operation.
Push Button Types

Push buttons can function like mechanical push buttons. A logic value of 0 represents open contacts and a logic value of 1 represents closed contacts. Push buttons can also have a numeric value for pressed, released or multiple states. The terminal sends the value to the controller for each change of state.

Each push button state can have unique visual characteristics such as inner text or graphic, fill pattern and line type.

**Momentary Push Buttons** change state (close or open contacts) when pressed and return to their initial (0) state when released.

**Maintained Push Buttons** change state (close or open contacts) when pressed and remain in this state when released. Pressing and releasing the push button a second time returns the button to its selected initial state. Maintained push buttons retain their state following screen changes. The state of a maintained push button after a power-up is determined by the powerup option selected in the Terminal Setup dialog.

**Latched Push Buttons** change state (close or open contacts) when pressed and remain in this state when released. The button does not return to its initial (0) state until unlatched by a handshake bit or value in the controller. The latched status is not maintained after a power-up but is retained following a screen change.

**Multistate Push Buttons** have between 2 and 16 states. Each state sets a bit or value at a controller address. Every time the push button is pressed and released, it changes to the next state. After the last state, the push button returns to its selected initial state. Multistate push buttons retain their current state following screen changes. The state after a powerup is determined by the powerup option selected in the Terminal Setup dialog.

Contact Types

Momentary, maintained and latched push buttons can have either normally open or normally closed contacts. You also assign normally open or normally closed contacts to a multistate push button with two states.

- Normally Open Contacts have a logic value of 0 as the initial push button state. Pressing the button changes the value to 1.
- Normally Closed Contacts have a logic value of 1 as the initial push button state. Pressing the button changes the value to 0.
Push buttons can have inner text and/or an inner graphic. Both appear inside the push button and can change with each state. The inner text or graphic is attached to the button. When you move or delete the button, the inner text or graphic is also moved or deleted.

Push buttons are created with ST 0 as the default inner text. For example, the default inner text for on/off push buttons is ST 0 and ST 1. For multistate push buttons, the default inner text increments from ST 0 to ST 15.

Inner text can also include a date, time or numeric variable.

Push buttons can have a variety of visual appearances. In addition to text and graphics, you can format the button using options such as:
- Fill pattern
- Border type
- Toggle foreground/background colors
- Blinking
- Shape

You can format each push button state directly from the States tab of the object’s dialog or using the formatting procedures in Chapter 17. Possible combinations are shown below.
Creating Push Buttons

All push buttons look the same when placed on a screen. On touch screen terminals, push buttons align with the touch grid even when it’s not visible.

To create a push button:

1. Choose a push button from the Objects > Push Buttons submenu. Or click the appropriate tool in the toolbox.

2. Position the pointer (+) and click the left mouse button to place the default button size. Or drag the pointer to size the button.

3. To place another button of the same type, move the pointer to a new location and click again.

4. Click the right mouse button to exit push button mode. Or click the selection tool on the toolbox.

Setting Properties of a Push Button

To set properties of a push button:

1. Double-click the push button object.

Depending on the push button type, some options are dimmed.

2. On the Properties tab, set the operating parameters of the button.

The descriptions that follow define properties of momentary, maintained and latched push buttons.
Creating Push Buttons

Type
Changes the push button type without having to create a new object.

Write
Specifies the type of data to send to controller: Single Bit or Value.
- For Single Bit, the terminal writes to a bit address.
- For Value, the terminal writes to a word address.
Select the format of the data from the Data Format list box. The data type of the write tag must be compatible with the selected format for the application to validate.

<table>
<thead>
<tr>
<th>Use this Format</th>
<th>With this Tag Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signed Integer</td>
<td>Signed Integer</td>
</tr>
<tr>
<td>4-BCD</td>
<td>4BCD</td>
</tr>
<tr>
<td>Binary</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>Octal</td>
<td></td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td></td>
</tr>
</tbody>
</table>

Contacts
If Single Bit was selected in the Write area, select Normally Open or Normally Closed contacts for the 2-state push button. Momentary and latched push buttons have a default initial state of 0.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normally Open</td>
<td>Send value of 0 when push button is in state 0 and value of 1 when push button is in state 1.</td>
</tr>
<tr>
<td>Normally Closed</td>
<td>Send value of 1 when push button is in state 0 and value of 0 when push button is state 1.</td>
</tr>
</tbody>
</table>

The Contacts area is dimmed if Value was selected in the Write area.

Initial State
Specifies the initial state of a maintained or multistate push button and the initial value sent to the write tag address. The value of the initial state overrides the initial value in the Tag Editor.

Hold Time
Specifies the length of time a momentary push button remains in the next state after being released. The hold time should exceed the scan time of the controller to insure that each state change is read by the controller at least once. Hold time values are: 0, 50, 250, 500, 750 or 1000 milliseconds. The default is 500.
Write Tag

Specifies the name of the tag address to write the single bit or value. Edit the tag definition using the Edit Tag button or the Tag Editor.

Indicator Tag

Specifies the name of a tag address that controls when the push button changes appearance with each state. Each state can have unique visual characteristics (inner text, inner graphic, fill). Edit the tag definition using the Edit Tag button or the Tag Editor.

<table>
<thead>
<tr>
<th>This Option</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Indicator Tag (default)</td>
<td>Push button changes to next state when pressed.</td>
</tr>
<tr>
<td>Indicator Tag same as Write Tag</td>
<td>Push button changes state after bit or value is written to the Write Tag address.</td>
</tr>
<tr>
<td>Indicator Tag different from Write Tag</td>
<td>Push button changes state after:</td>
</tr>
<tr>
<td></td>
<td>• bit or value is written to the Write Tag address</td>
</tr>
<tr>
<td></td>
<td>• state value is read from Indicator Tag address</td>
</tr>
</tbody>
</table>

Important: If the indicator tag and write tag are different, the indicator state is controlled by the controller program regardless of the push button state. For example, the indicator tag address may specify that push button state 1 is displayed while the write tag address is at state 0.
Handshake Tag (Required for Latched Push Button)

Specifies the name of a tag address that unlashes a latched push button. The button is unatched when the value at the handshake tag address is set to a non zero value by your controller program. Edit the tag definition using the Edit Tag button or the Tag Editor.

The handshake tag applies only to latched push buttons, not other push buttons.

Input

Specifies whether the operator presses a function key or a touch cell to operate the push button.

- For a keypad terminal, select a function key from the list box.
- For a touch screen terminal, touch cell is automatically enabled.

PanelView 550/600 Keypad & Touch Screen terminals support function key and touch cell input.

The selected function key displays a graphic of the push button and an asterisk next to the key number, indicating the key is used.
Use the States tab to:

- edit text for each state
- enter a value for each state (if required)
- insert a graphic for each state
- edit format options for each state
- add or delete states for a multistate push button

To configure the states of a push button:

1. Click the States tab on the Push Buttons dialog.

   A spreadsheet opens for state editing. Each row represents a push button state (row 0 represents state 0, row 1 represents state 1).
   - For 2-state push buttons, 2 rows appear (states 0 and 1)
   - For a multistate push button, 4 rows appear (states 0 – 3)

   Each row has fields which define the visual characteristics of each state.

2. Edit the fields as necessary.

3. Click OK to exit the Push Buttons dialog.

   The Value field appears only if Value was selected in the Write area of the Properties tab.

   For a description of all the fields for a state, see page 7–15.
Creating Push Buttons

Editing Number of States for a Multistate Push Button

A multistate push button supports a maximum of 16 states. Use only the number of states required.

**To add states to a multistate push button:**

1. Hold down the right mouse button and choose Append State from the popup menu.

   A new row is added after the last row with the next available state number.

2. Repeat step 1 for each state you want to add.

   Each state you add is created with the defaults from State 0 and default text (ST 0, ST 1, ..., ST 15).

To delete states from a multistate push button, select a row number and choose Delete State from the popup menu.

Editing State Text

The Text field contains the text that will appear for each state. The default text is the state number (ST 0). Double-click in the cell and edit the text.

Other text fields control how the text is formatted for each state.
**Entering State Values**

If Value was selected in the Write area of the Properties tab, the Value field appears for each state.

The Value field specifies a numeric value to send to the write tag address for each push button state. The default value for each state is the state number (0 to 15).

The value you enter must be within the range of the Data Format selected on the Properties tab.

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>0000 0000 0000 0000 to 1111 1111 1111</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Signed Integer</td>
<td>-32768 to +32767</td>
</tr>
<tr>
<td>4-BCD</td>
<td>0 to 9999</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0 to FFFF</td>
</tr>
<tr>
<td>Octal</td>
<td>0 to 177777</td>
</tr>
</tbody>
</table>

① Formats provided for data entry. The terminal does not display or transfer these formats.

The value is converted when a different data format is selected.
Creating Control List Selectors

This chapter describes how to create list type controls. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>9-1</td>
</tr>
<tr>
<td>Standard Control Lists</td>
<td>9-2</td>
</tr>
<tr>
<td>Piloted Control Lists</td>
<td>9-2</td>
</tr>
<tr>
<td>Control List Options</td>
<td>9-4</td>
</tr>
<tr>
<td>Creating a Control List Selector</td>
<td>9-5</td>
</tr>
<tr>
<td>Setting Properties of a Control List Selector</td>
<td>9-6</td>
</tr>
<tr>
<td>Configuring States of a Control List Selector</td>
<td>9-10</td>
</tr>
<tr>
<td>Creating List Keys</td>
<td>9-12</td>
</tr>
</tbody>
</table>

Control list selectors can perform some of the same functions as push buttons, including set value and on/off controls.

Helpful Hints

When creating list type controls, consider:

- Configure entries for a control list from the States tab of the Control List Selector dialog or using the procedures described in Chapter 17.
- A control list selector supports a maximum of 255 states (numbered 0 to 254). Use only the number of states required.
- Each state in a control list is limited to one line of text.
- Changing the text size applies to the entire list.
- On color and grayscale terminals each item can have a different color, but the background color is the same for the entire list.
- On keypad terminals, the operator moves the cursor through a control list using the terminal’s up and down arrow keys. The selection is sent to the controller immediately or when the Enter key is pressed on the terminal.
- Touch screen only terminals require list keys on the screen, enabling the operator to move the cursor through the control list. List keys are similar to the arrow keys on keypad terminals.
- A screen can contain multiple control lists. On standard control lists, the operator selects a list by pressing a function key or touch cell (touch screen terminals). Another way to activate a list is to press the left or right arrow keys on the terminal until the list is selected.
Standard Control Lists

On Standard control lists, the operator moves a cursor to select an item. On keypad terminals, the up ▲ and down ▼ arrow keys are used to move the selection cursor. The currently selected item is highlighted. The selection is sent to the controller immediately or when Enter key is pressed on the terminal.

Piloted Control Lists

Piloted control lists can be controlled by the logic controller. To select a control list item, the logic controller sets the control tag value to 1 and writes the value of the item to a search tag address. The PanelView terminal reads the search tag data and then highlights the corresponding item on the control list. The terminal then writes the same value to the control list write tag(s).
Piloted control lists have additional options:

- Block Write
- Inactive States

**Block Write Tag**

If a block write tag is assigned, the terminal writes the values of all items displayed in the control list to a block of addresses starting with the block write start tag address. The maximum number of items supported by the block write tag varies for each terminal:

- 15 values for PanelView 550 terminals
- 25 values for PanelView 600 terminals
- 24 values for PanelView 900 monochrome and 1000 grayscale terminals
- 29 values for PanelView 900/1000/1400 color terminals

**Inactive States**

Inactive states are states that appear on the control list but cannot be selected by an operator. The cursor appears as a hollow head cursor when moved to an inactive state. An operator cannot highlight or select an inactive item. Inactive states are included as part of the data sent with a block write of the displayed list items (see above).
A control list can contain up to 255 operations.

**Control List with Value Data**

The following example shows a control list used to input set values into a controller address. The fluid level of a tank is varied by a control list.

**Control List with Bit Data**

The next example shows a control list used for on/off type controls. The list controls the opening and closing of a feed hopper.
Multiple Control Lists

You can assign a standard control list to a function key or touch cell to activate the list for operator input. Multiple control lists can appear on the same screen. Another way to select a standard control list is to use the left or right arrow keys on the terminal.

This section shows how to create a control list selector. On touch screen terminals, the control list aligns with the touch grid even if it’s not visible.

To create a control list selector

1. Choose Standard or Piloted from the Objects ▶ Control List Selectors submenu.
   Or click the Control List Selector tool from the toolbox.
2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the control list.
3. To place another control list, move the pointer to a new location and click again.
4. Click the right mouse button to exit control list selector mode.
   Or click the selection tool on the toolbox.
To set properties of a control list selector:

1. Double-click the control list selector object.

2. On the Properties tab, set the operating parameters of the Control List Selector.

The following descriptions define properties of a control list selector:

**Type**

Specifies the type of control list: Standard or Piloted.
- For a Standard list, control list items are selected by an operator.
- For a Piloted list, control list items are selected by either the operator or the logic controller writing to the search tag address.

**Initial State**

Specifies the control list selection on initial powerup of the terminal and the initial value sent to the write tag address. The value of the initial state overrides the initial value in the Tag Editor.
Write

Specifies the type of data to send to controller: Single Bit or Value.

- For Single Bit (2-state control list selector only), the terminal writes to a bit address.
  
  To enable Single Bit as an option, you must reduce the number of states to 2 on the States tab.

- For Value, the terminal writes to a word address.
  
  Select the format of the data from the Data Format list box. The data type of the write tag must be compatible with the selected format for the application to validate.

<table>
<thead>
<tr>
<th>Use this Format</th>
<th>With this Tag Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signed Integer</td>
<td>Signed Integer</td>
</tr>
<tr>
<td>4-BCD</td>
<td>4BCD</td>
</tr>
<tr>
<td>Binary</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>Octal</td>
<td>or Bit Array</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td></td>
</tr>
</tbody>
</table>

Contacts

If Single Bit was selected in the Write area, select Normally Open or Normally Closed contacts for the 2-state selector.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normally Open</td>
<td>Send value of 0 when control list is in state 0 and value of 1 when control list is in state 1.</td>
</tr>
<tr>
<td>Normally Closed</td>
<td>Send value of 1 when control list is in state 0 and value of 0 when control list is in state 1.</td>
</tr>
</tbody>
</table>

The Contact area is dimmed if Value was selected in the Write area.

Write Tag

Specifies the name of the tag address to write the single bit or value. If the tag doesn’t exist, enter a tag name. Edit the tag definition using the Edit Tag button or the Tag Editor.
Search Tag (Piloted Control Lists only)

Specifies the name of the tag address to which the controller writes to select an item on a control list. A control list item is selected when the value assigned to the item equals the value at the search tag address.

Control Tag (Piloted Control Lists only)

Only applies to Piloted Control Lists with “User and Controller” or “Controller Only” selected in the Access box. The controller uses this tag to determine whether the control list is controlled by an operator or a controller. When the value at this tag address is 0, the operator has control of the control list. A value other than 0 enables the controller to select items on the control list.

Note on “User and Controller” Access

When the operator has control of the list, the write tag is updated in the logic controller, but the search tag retains the same value present when the logic controller relinquished control. When the controller regains control of the list, it uses the value in the search tag to update the write tag value, which changes the selected state. This behavior is appropriate when the controller is operating as a master device.

To bypass this behavior, add the following rung of ladder logic for each search tag address.

```
MOV
MOVE
Source: Write Tag Address
Destination: Search Tag Address
```

Block Write Start Tag (Piloted Control Lists only)

Specifies the starting point for the block write data. The block write data contains all values for items currently displayed on the control list. The maximum number of entries supported by the block write tag varies for each terminal.

- 15 values for PanelView 550 terminals
- 25 values for PanelView 600 terminals
- 24 values for PanelView 900 monochrome and 1000 grayscale terminals
- 29 values for PanelView 900/1000/1400 color terminals

When using block write data, do not assign functions to the addresses following the Block Write Start Tag. Reserve an address for each visible row on a control list.
Input
Specifies whether the operator presses a function key or a touch cell to activate a control list.
- For a keypad terminal, select a function key from the list.
- For a touch screen terminal, touch cell is automatically enabled.

PanelView 550/600 Keypad & Touch Screen terminals support function key and touch cell input.

The selected function key displays a graphic of a control list and an asterisk next to the key number, indicating the key is used.

Wrap Around
Specifies whether the selection cursor moves to the top or bottom of the list when the operator presses the down or up arrow key on the last or first item in the control list.

Click the check box to activate wrap around. To disable wrap around, clear the check box.

Write on Enter
Specifies whether the list selection is sent to the controller immediately or when the terminal’s Enter key is pressed.

By default, the operator is required to press the Enter key. To disable Write on Enter, clear the check box.
Configuring States for a Control List Selector

Use the States tab on the Control List Selector dialog to:
- edit and format the text for each state
- enter a value for each control list state
- restrict access to states in a Piloted Control List
- add or delete states as necessary

To configure the states of a control list selector:
1. Click the States tab on the Control List Selector dialog.

   Each row in the spreadsheet represents a state in the control list selector. The fields in each row define the text and visual characteristics for each state.

   The initial default is 16 states (row 0 to row 15).

2. Edit the fields as necessary.

3. Click OK to exit Control List Selector dialog.

Editing Number of States

A Control List Selector supports a maximum of 255 states (0 to 254 rows). Use only the number required.

To add states to a control list selector:
1. Hold down the right mouse button and choose Append State from the popup menu.
   
   A row is added at the end with the next available state number.

2. Repeat step 1 for each state you want to add.

Each state you add is created with the defaults from State 0 and default text (ST 0, ST 1, ..., ST 254).

To delete states, select a row number and choose Delete State from the popup menu.
Creating Control List Selectors

Editing State Text

The Text field defines the text that will appear for each state in the Control List Selector. Double-click the cell and edit the text.

Other text fields control how the text is formatted for each state:
- text size (selection applies to entire list)
- underline
- text blink
- alignment (left, right, center)
- foreground color

Entering State Values

If Value was selected on the Properties tab, the Value field appears for each state. This field specifies a numeric value to send to the word address for each state. The default value is the state number.

The value you enter must be within the range of the Data Format selected on the Properties tab. The default value is the state number.

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>0000 0000 0000 0000 to 1111 1111 1111 1111</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Signed Integer</td>
<td>-32768 to +32767</td>
</tr>
<tr>
<td>4-BCD</td>
<td>0 to 9999</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0 to FFFF</td>
</tr>
<tr>
<td>Octal</td>
<td>0 to 17777</td>
</tr>
</tbody>
</table>

① Formats allowed for data entry. The terminal does not display/transfer these formats.

The value is converted when a different data format is selected.

Restricting Access to States (Piloted Control Lists only)

The Access field appears only for Piloted Control Lists. This field allows you to specify who can access the control list state.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>User and Controller</td>
<td>Allow the operator and controller to select the control list state.</td>
</tr>
<tr>
<td>User Only</td>
<td>Allow only the operator to select the control list state.</td>
</tr>
<tr>
<td>Controller Only</td>
<td>Allow only the controller to select the control list state.</td>
</tr>
<tr>
<td>None</td>
<td>Create an inactive state.</td>
</tr>
</tbody>
</table>

Important: Do not select “Controller Only” or “None” for the initial state defined on the States tab. These settings will result in a validation error. One state must allow user access or the application will fail to validate
Creating Control List Selectors

Creating List Keys

Touch screen only terminals require List keys on the screen, enabling the operator to move the cursor in a Control List and select a list item. List keys are also supported on keypad terminals.

The available List Keys and functions are listed below.

<table>
<thead>
<tr>
<th>List Key</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Move Up</td>
<td>Moves the cursor to the previous item in the list. Required.</td>
</tr>
<tr>
<td></td>
<td>Move Down</td>
<td>Moves the cursor to the next item in the list. Required.</td>
</tr>
<tr>
<td></td>
<td>Home</td>
<td>Moves the cursor to the first item in the list. Optional.</td>
</tr>
<tr>
<td></td>
<td>End</td>
<td>Moves the cursor to the last item in the list. Optional.</td>
</tr>
<tr>
<td></td>
<td>Page Up</td>
<td>Moves the cursor up a page in a scrolling list. Optional.</td>
</tr>
<tr>
<td></td>
<td>Page Down</td>
<td>Moves the cursor down a page in a scrolling list. Optional.</td>
</tr>
<tr>
<td></td>
<td>Backspace</td>
<td>Returns the cursor to the currently highlighted selection. Optional.</td>
</tr>
<tr>
<td></td>
<td>Enter</td>
<td>Confirms a selection and sends the item value to the controller. Required if Write on Enter was configured as a control list attribute.</td>
</tr>
</tbody>
</table>

To create a list key:

1. Click a List Key tool in the toolbox.

   Or choose a List Key from the Objects > List Keys submenu.

2. Position the pointer (+) and click the left mouse button.

3. Click the right mouse button to exit List Key mode.

   Or click the selection tool on the toolbox.

To access the properties of a list key:

1. Double-click the list key object.

2. Under Input, specify how the operator will activate the list key.

   - For keypad terminals, select a function key from the list.
   - For touch screen terminals, touch cell is automatically enabled.

3. When done, click OK.
Chapter Objectives

Creating Data Entry Controls

This chapter describes how to create objects that activate a scratchpad for numeric or ASCII data entry including the keypad enable button and the cursor point.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>10–1</td>
</tr>
<tr>
<td>Numeric Entry Controls</td>
<td>10–2</td>
</tr>
<tr>
<td>Keypad Enable Button</td>
<td>10–2</td>
</tr>
<tr>
<td>Cursor Point</td>
<td>10–2</td>
</tr>
<tr>
<td>Scratchpad</td>
<td>10–2</td>
</tr>
<tr>
<td>Numeric Entry Examples</td>
<td>10–3</td>
</tr>
<tr>
<td>Data Entry Scaling</td>
<td>10–4</td>
</tr>
<tr>
<td>Creating a Numeric Entry Object</td>
<td>10–7</td>
</tr>
<tr>
<td>Setting Properties for a Numeric Entry Object</td>
<td>10–7</td>
</tr>
<tr>
<td>ASCII Entry Controls</td>
<td>10–12</td>
</tr>
<tr>
<td>Keypad Enable Button</td>
<td>10–12</td>
</tr>
<tr>
<td>Cursor Point</td>
<td>10–12</td>
</tr>
<tr>
<td>Scratchpad – Keypad or Keypad/Touch Screen Terminals</td>
<td>10–13</td>
</tr>
<tr>
<td>Scratchpad – 550 Touch Screen Terminals</td>
<td>10–14</td>
</tr>
<tr>
<td>Scratchpad – 900/1000/1400 Touch Screen Terminals</td>
<td>10–15</td>
</tr>
<tr>
<td>ASCII Scratchpad for other Languages</td>
<td>10–16</td>
</tr>
<tr>
<td>Creating an ASCII Entry Object</td>
<td>10–16</td>
</tr>
<tr>
<td>Setting Properties for an ASCII Entry Object</td>
<td>10–17</td>
</tr>
</tbody>
</table>

Helpful Hints

When creating numeric entry objects, consider:

- You can add inner text and/or an inner graphic to keypad enable buttons and cursor point objects as well as other formatting options. See Chapter 17 for formatting details.

- An application screen can have more than one cursor point object. To activate a cursor point, the operator presses a function key or touch cell. Another way to activate a cursor point is to press the left/right arrow keys on the terminal until the cursor point is selected.

- When the keypad enable button is pressed or the cursor point is activated, the scratchpad opens in the center of the terminal screen.
Creating Data Entry Controls

Numeric Entry Controls

Keypad Enable Button

A keypad enable button is a momentary push button which can display a value at a controller address. The initial value on power-up is set from the Tag Editor. When pressed, this button opens the scratchpad and enables the terminal keypad for data entry.

![Keypad Enable Button](image)

You can create keypad enable buttons with inner text and/or an inner graphic and other formatting options. See Chapter 17.

Cursor Point

A cursor point is a data box that can display a value at a controller address. The initial value on power-up is set from the Tag Editor. When the cursor point is selected and the Enter key or a numeric key is pressed, the scratchpad opens and the terminal keypad is enabled for data entry.

Each cursor point can be assigned a function key or touch cell to activate the object for operator input. Multiple cursor point objects can appear on the screen. Another way to select a cursor point is to use the left or right arrow keys on the terminal.

![Cursor Point](image)

Scratchpad

The scratchpad opens in the center of the terminal screen when the operator presses the keypad enable button or activated a cursor point.

![Scratchpad](image)

The top of the scratchpad shows the current value entered. Below the current value is the range of values the operator can enter. The range is set by supplying data entry limits in the Tag Editor.

The operator enters a value and presses the Enter key.
Numeric Entry Examples

The following examples show how numeric entry objects are used to adjust the temperature and inflow of a tank.

Cursor Point Example
The operator selects one of the cursor point objects in the EDIT box using a function key, touch cell or left/right arrow keys on the terminal and then presses [cursor_point_objects].

The scratchpad opens in the center of the screen. The operator enters a new value using the terminal keypad.

Keypad Enable Example
The operator selects the Enter Temp or Enter Deg keypad enable button using a function key or touch cell.

The scratchpad opens in the center of the screen. The operator enters a new value using the terminal keypad.
Data Entry Scaling

Data entered by an operator can be scaled from engineering units such as gallons or pounds per square inch to machine control values. Terminal values are scaled using the formula:

\[ y = mx + b \]

- \( y \) = scaled value (entered by operator)
- \( m \) = scale (multiplier)
- \( x \) = controller value
- \( b \) = offset

To calculate value \( x \) stored at the controller address, use:

\[ x = \frac{y - b}{m} = \frac{\text{Entered Value} - \text{Offset}}{\text{Scale}} \]

The scale and offset values are entered in the Tag Editor. Scaled values affect the controller value as follows:

- Scale (m) value > 1 generates an \( x \) value smaller than \( y - b \).
- Scale (m) value < 1 generates an \( x \) value larger than \( y - b \).

**Example: Scaling a Data Entry Variable**

The operator enters 30 (pounds) for \( y \). The offset (b) value is 2. The scale (m) value is .01.

\[ x = \frac{y - b}{m} = \frac{30 - 2}{.01} = 2800 \]

The terminal provides a controller match value of 2,800 for a weigh scale transducer:

The value displayed in a numeric entry object may or may not be scaled. The displayed value may be assigned a tag name independent of the value written to the controller (write tag) address.
Data Limits for a Scaled Value

If a scaled value exceeds the range for the selected data type, the terminal will display a ‘Value Not In Range’ warning. When using scaling, we recommend that you limit the minimum and maximum values an operator can enter. These values are set in the Tag Editor form view. (see page 19–5).

Calculate the range for scaled values before entering values in the Tag Editor. Use the following formulas to determine scaled minimum and maximum values:

\[
\text{Maximum Input Value} = (\text{Maximum Value for Data Type} \times \text{Scale}) + \text{Offset}
\]

\[
\text{Minimum Input Value} = (\text{Minimum Value for Data Type} \times \text{Scale}) + \text{Offset}
\]

For example:
- Scale = 1.8 and Offset = 32 (Fahrenheit to Celsius conversion)
- Data type is Signed Integer (-32,768 to +32,767)

The minimum / maximum values an operator can enter without truncating:

\[
\text{Maximum Input Value} = 32,767 \times 1.8 + 32 = 59012
\]

\[
\text{Minimum Input Value} = -32,768 \times 1.8 + 32 = -58950
\]

Initial Value of a Scaled Value

The initial value specified in the Tag Editor is written to the controller on powerup or reset. This initial value is not scaled, so it must be entered in units used by the logic controller.

For example, the terminal uses °C and the controller uses °F. To initialize the terminal to a value of 32°F, the initial value in the Tag Editor needs to be 32, not 0.

The terminal does not scale the initial value before sending it to the controller if the specified tag has an:
- initial value and
- a scale and/or
- offset

The value stored in the terminal may be different than the value sent to the controller because of rounding that occurs during pre-scaling. A warning message is displayed during validation if this occurs. If the scaled initial value exceeds the range limits (because of a rounding error), an error message is displayed.
Creating Data Entry Controls

Precision and Rounding

Except for floating point values, the logic controller stores values as integers, rounding off any digits to the right of the decimal point. However, the terminal can scale decimal values to or from integer values.

In this illustration, the entered value of 7.5 is rounded up to 8. When this value is displayed, or used in a mathematical formula, the result may be incorrect.

\[
\text{Entered Value} = 7.5 \quad \text{Displayed Value} = 8
\]

\[
\text{Controller Value} = 8 \quad \text{rounded}
\]

If decimal precision is needed, select appropriate values for scale and offset.

Example

Use scaling to convert a decimal value from degrees Fahrenheit to degrees Celsius. The precision is determined by the value the operator enters and the decimal position of the scale.

\[
\text{Controller Value} = \frac{\text{Entered Value} - \text{Offset}}{\text{Scale}}
\]

PanelView

\[
\text{Displayed Value} = \text{Controller Value} \times \text{Scale} + \text{Offset}
\]

Fixed Decimal

\[
\text{Entered Value} = 121.36
\]

\[
\text{Storred Value} = \frac{121.36 - 32}{0.018} = 4964.44 = 4964
\]

\[
\text{Display Value} = (4964 \times 0.018) + 32 = 121.35
\]

Keypad Controlled Decimal

\[
\text{Entered Value} = 122.9
\]

\[
\text{Storred Value} = \frac{122.9 - 32}{1.8} = 50.5 = 51
\]

\[
\text{Display Value} = (51 \times 1.8) + 32 = 123.8
\]

The decimal point is positioned to provide a display appropriate to the scaled value.

The terminal stores the full precision value and the controller stores the rounded value (if writing to an integer file).
Creating a Numeric Entry Object

This section shows how to create a cursor point or keypad enable button. On touch screen terminals, both objects are aligned with the touch grid even if it’s not visible.

To create a Cursor Point or Keypad Enable button:

1. Click the appropriate tool in the toolbox.
   
   Or choose Cursor Point or Keypad Enable from the Objects Numeric Entry submenu.

2. Position the pointer (+) and click the left mouse button to place the default object size. Or drag the pointer to size the object.

3. To place another object of the same type, move the pointer to a new location and click again.

4. Click the right mouse button to exit numeric entry mode.
   
   Or click the selection tool on the toolbox.

Setting Properties of a Numeric Entry Object

This section shows how to set the properties for a Keypad Enable button or a Cursor Point Object.

To set properties of a Cursor Point or Keypad Enable button:

1. Double-click the numeric entry object.

2. On the Properties tab, set operating parameters for the numeric entry objects (as defined on following pages).

3. When done, click OK.
**Type**
Changes the type of numeric entry object.

**Input**
Specifies whether the operator presses a function key or a touch cell to activate the numeric entry object.
- For keypad terminals, select a function key from the list.
- For touch screen terminals, touch cell is automatically enabled.

The PanelView 550/600 Keypad & Touch screen terminal supports function key and touch cell input.

The selected function key displays a graphic of the numeric entry object and an asterisk next to the key number.

![Keypad Enable](image1.png)  ![Cursor Point](image2.png)

**Write Tag**
Specifies the name of the tag address where the terminal writes the entered value. If the tag doesn’t exist, enter a tag name. Edit the tag definition (including data entry limits, scale values, initial value) using the Edit Tag button or the Tag Editor.

Valid data types for the write tag are unsigned/signed integer, 4BCD or floating point.
Display

The Display area defines properties of the data that displays in the numeric entry object.

Display Tag specifies the name of the tag address from which to read the display data. Usually, the write tag and display tag are the same. One-directional protocols, such as DeviceNet, however, require different addresses for the Display tag and Write tag. The Write tag is an input and the Display tag is an output.

Data displayed in a numeric entry object may or may not be scaled.

- To display the entered value regardless of the value stored at the controller, don’t enter a display tag (leave field blank).
- To display a non-scaled value (not the entered value), use different tag names for the display and write tags. Both tags should have the same tag address but the display tag shouldn’t have scaling.
- To display an entered value based on the value stored at the controller, use the same tag name for the display and write tags. Because of rounding, the displayed value may not be identical to the entered value.

```
Entered Value = 5

Scaled (x - (-10)) .5
scale = 2
offset = -10

Terminal Value = 8 (rounded)

Display Value = 6

Scaled (2) (8) + (-10)
scale = 2
offset = -10
```

Except for floating point values, the controller only stores integer values, the scaled result of 7.5 is rounded to 8. The same scale used for data entry is used to convert the rounded value for display.

Fill with Zeros specifies whether zeroes are entered in unused entry positions to the left and right of the decimal point. For example, if the value 32100 is entered (fixed decimal point position = 2):

<table>
<thead>
<tr>
<th>Zero Filled</th>
<th>No Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>000321.00</td>
<td>___321.00</td>
</tr>
</tbody>
</table>
Format

Field Width specifies the maximum number of digits that can be entered. The default is 6.

If the entered value is a decimal, it may be scaled or rounded to an integer or both, before it is sent to the controller. See page 10–4.

Decimal Point specifies whether the decimal is fixed (formatted) or keypad controlled (floating) for display and entry values.

- Select **Fixed** to fix the decimal point in the data display and the scratchpad. As an operator enters values in the scratchpad the numbers are shifted to the left of the decimal point.

  The Position box specifies the position of the decimal point for fixed decimal point values. You can position the decimal 0 to 10 places to the left of the rightmost character.

<table>
<thead>
<tr>
<th>Select</th>
<th>For this position</th>
<th>Select</th>
<th>For this position</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>97</td>
<td>6</td>
<td>97.276767</td>
</tr>
<tr>
<td>1</td>
<td>97.2</td>
<td>7</td>
<td>97.276767</td>
</tr>
<tr>
<td>2</td>
<td>97.27</td>
<td>8</td>
<td>97.276767</td>
</tr>
<tr>
<td>3</td>
<td>97.276</td>
<td>9</td>
<td>97.27676767</td>
</tr>
<tr>
<td>4</td>
<td>97.2767</td>
<td>10</td>
<td>9.7276767676</td>
</tr>
<tr>
<td>5</td>
<td>97.27676</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If Position is **≠** 0, then the field width must be 2 > decimal position for positive numbers. One position is used for the digit to the left of the decimal and one for the decimal point. If the decimal position is 2 and the field width is 6, an entered value of 225 is displayed as 225.00 not 2.25.

For negative numbers the field width must be 3 > decimal position. For example, to display the number −0.1234, set the field width to 7 and the decimal position to 4.

- Select **Keypad Controlled** to allow the operator to enter the decimal point using the terminal keypad. Data is displayed as a floating point.

  The terminal stores the full precision value and the controller stores the rounded value (if writing to an integer file).
Notification and Handshake Tags

Notification and handshake tags are options to ensure that data is written to the write tag address before the scratchpad is closed.

The notification tag address is set to 1 when an operator presses the enter key. The scratchpad remains open until the controller program checks for notification that the value was written to the tag address and then sets the handshake tag address to 1.

The terminal automatically clears the notification bit when the handshake bit is set by the controller. The controller’s ladder logic must set the handshake bit before a timeout occurs. The default handshake timeout is 4 seconds (valid range is 1 – 60 seconds). See page 20–21 to adjust the handshake timeout.

Select tags from the appropriate list boxes. If the tags don’t exist, enter tag names. Edit definitions of the tags using the Edit Tag button or the Tag Editor.
ASCII Entry Controls

The ASCII Entry object allows the operator to send an alphanumeric string (up to 128 characters) to a controller.

Like numeric entry objects, the ASCII Entry object can appear on an application screen as a keypad enabled button or a cursor point.

Keypad Enable Button

The keypad enable button is a momentary push button which displays an ASCII character string at a controller address. The button’s initial value is sent to the controller when the application is first run and may also be displayed in the button. When pressed, this button opens the ASCII scratchpad allowing the operator to enter and send a new character string to the controller.

Cursor Point

The cursor point is a data box that displays an ASCII character string at a controller address. The object’s initial value is sent to the controller when the application is first run. The initial value may also be displayed in the box. When the cursor point is selected and the Enter key is pressed, the ASCII scratchpad opens allowing the operator to enter and send a new character string to the controller.
The operator selects characters from the Character Keyboard by moving the cursor (with the keypad arrows) over a character and pressing the SEL-F1 function key. The character appears in the Display Area. This area scrolls so the operator can enter a character string that is longer than the Display Area. All characters are sent to the controller even if not visible.

After entering all the characters, the operator sends the string to the controller by pressing ENTER on the keypad. The leftmost character is placed in the high byte of the first word (of the write tag address), the next character in the low byte and so on.

**Note:** DeviceNet ASCII Entry allows for byte swapping.
To select characters from the Character Keyboard, the operator presses the cursor control keys to move the cursor over a character and then presses the SEL key. The character is entered in the Display Area. This area scrolls so the operator can enter a character string that is longer than the Display Area. All characters are sent to the controller even if not visible.

After entering all the characters, the operator sends the string to the controller by pressing \[\text{\textasciicircum}\text{\textasciicircum}\]. The leftmost character is placed in the high byte of the first word (of the write tag address), the next character in the low byte, and so on.

**Note:** DeviceNet ASCII Entry allows for byte swapping.
The operator selects characters by touching the Character Keyboard on the screen. The character is entered in the Display Area. This area scrolls so the operator can enter a character string that is longer than the Display Area. All characters are sent to the controller even if not visible.

After entering all the characters, the operator sends the string to the controller by pressing ENTER on the touch screen keypad. The leftmost character is placed in the high byte of the first word (of the write tag address), the next character in the low byte and so on.

**Note:** DeviceNet ASCII Entry allows for byte swapping.
ASCII Scratchpads in Other Languages

The ASCII Scratchpad is available with Character Keyboards in:
- French
- German
- Italian
- Spanish

If the PanelView terminal is configured for operation in one of these languages, the ASCII scratchpad will display the Character Keyboard appropriate to the language.

The SHF control toggles between SHF/SHF2. In SHF mode, the Character Keyboard displays the shifted state characters (e.g. a to A and 3 to #). In the SHF2 mode, the Character Keyboard displays additional characters available for the desired language.

The values of the extended ASCII characters match those in Appendix H.

Creating an ASCII Entry Object

1. Choose Cursor Point or Keypad Enable from the Objects ▶ ASCII Entry menu.

2. Click the left mouse button to place the default object size or drag the crosshair to size the object.

3. To place another object of the same type, move the pointer to a new location and click again.

4. Click the right mouse button to exit ASCII entry mode.

   Or click the selection tool on the toolbox.
Setting the Properties of an ASCII Entry Object

1. Double-click the object to access its dialog parameters.

2. On the Properties tab, set the operating parameters of the ASCII Entry object (as defined below).

3. When the dialog is closed, the object appears with # characters to match the string width.

If you select Format ➤ Inner Text while the object is selected, the inner text box contains an ASCII placeholder /* Z:10 */}, where 10 is the specified string width for the object.

Like other objects, you can add inner text around the placeholder or change the appearance of the object using formatting options. See Chapter 17 for details.

**Type**
Changes the ASCII entry object to Keypad Enable or Cursor Point.

**Input**
Specifies whether the operator presses a function key or a touch cell to activate the ASCII entry object.
- For keypad terminals, select a function key from the list.
- For touch screen terminals, touch cell is automatically enabled.

The PanelView 550/600 Keypad & Touch screen terminal supports function key and touch cell input.

The selected function key displays a graphic of the object and an asterisk next to the key number.
Write Tag
Specifies the name of the tag address where the terminal writes the ASCII string. The data type of the write tag must be Character Array. You can write the tag data to any data file that supports the Character Array data type. The Array Size must be the same size as the String Width field.

Edit the tag definition using the Edit Tag button or the Tag Editor. Reserve word block addresses for each ASCII Entry object.

Notification and Handshake Tags
Optional tags that ensure data is written to the write tag address before the scratchpad closes.

When the operator presses the Enter key to send the ASCII string to the write tag address, the notification tag is set to 1. The scratchpad remains open until the controller checks for notification that the value was written to the write tag address and then sets the handshake tag address to 1. The terminal clears the notification bit when the handshake bit is set by the controller.

String Width
The maximum number of characters that can be entered in the ASCII scratchpad. You must enter an even integer.

<table>
<thead>
<tr>
<th>For</th>
<th>Maximum String Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>DH+/DH-485/DF1</td>
<td>80</td>
</tr>
<tr>
<td>Remote I/O</td>
<td>128</td>
</tr>
<tr>
<td>DeviceNet</td>
<td>128</td>
</tr>
</tbody>
</table>

If the ASCII string is less than the string width, the NULL character is appended before the string is sent to the controller. The NULL character does not affect the display of the string.

Display Tag
Specifies the source of the data displayed in the ASCII scratchpad. If a display tag is not defined, the scratchpad displays the last value entered. The data type of the display tag must be Character Array. The Array Size must be the same size as the String Width.

Show Current String on ASCII Scratchpad
If selected, the ASCII scratchpad displays the character string stored at the write tag address. If not selected, the string is not displayed.

Mask Characters
A security feature that prevents the display of characters entered in the ASCII scratchpad. The mask character # replaces each ASCII character. For example, the characters PASSWORD would appear as ####### in the scratchpad.
Chapter Objectives

Creating Screen Selectors

This chapter shows how to create screen selectors allowing an operator to navigate between screens in an application. You can create screen buttons or a screen list. The chapter sections are:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>11–1</td>
</tr>
<tr>
<td>Goto Screen Button</td>
<td>11–2</td>
</tr>
<tr>
<td>Goto Config Screen Button</td>
<td>11–2</td>
</tr>
<tr>
<td>Return Screen Button</td>
<td>11–2</td>
</tr>
<tr>
<td>Screen List Selector</td>
<td>11–2</td>
</tr>
<tr>
<td>Creating Screen Buttons</td>
<td>11–3</td>
</tr>
<tr>
<td>Setting Properties of Screen Buttons</td>
<td>11–4</td>
</tr>
<tr>
<td>Creating a Screen List Selector</td>
<td>11–5</td>
</tr>
<tr>
<td>Setting Properties of a Screen List Selector</td>
<td>11–6</td>
</tr>
<tr>
<td>Configuring Entries in a Screen List Selector</td>
<td>11–7</td>
</tr>
<tr>
<td>Creating List Keys</td>
<td>11–9</td>
</tr>
<tr>
<td>PLC/SLC Controlled Screen Changes</td>
<td>11–9</td>
</tr>
</tbody>
</table>

Helpful Hints

When creating screen selectors, consider:

- A screen list can have a maximum of 255 entries (numbered 0 to 254). Use only the number of entries required by the application.
- Each entry in a screen list is limited to a single line.
- On keypad terminals, the cursor is moved through the screen list using the terminal’s up and down arrow keys. The screen displays when the operator presses Enter.
- Touch screen only terminals require list keys on the screen, enabling the operator to move cursor through a list.
- An application screen can have more than one screen list. To activate a screen list, the operator presses a function key or touch cell. Another way to activate a list is to press the left/right arrow keys on the terminal until the list is selected.
- Screen list can be used on a main menu screen. A screen button on each application screen returns the operator to the main menu.
- When screen space is limited, use screen buttons.
- Place screen buttons in same position on each screen. This allows an operator to quickly locate and navigate between screens.
- Create screen buttons with inner text and/or inner graphic.
- Changing the text size applies to the entire screen list.
11–2 Creating Screen Selectors

Goto Screen Button
The Goto screen button, when pressed, displays a specific screen.

Goto Config Screen Button
The Goto Config Screen button, when pressed, displays the PanelView Terminal Configuration Mode menu.

Return Screen Button
The Return screen button, when pressed, displays the previous screen. This button doesn’t provide a continuous link back to the first screen.

Screen List Selector
A Screen List Selector contains a menu or list of screens from which the operator can make a selection. A cursor indicates the current selection. The operator uses the up ▲ and down ▼ arrow keys on the terminal to move the cursor and the Enter → key to enter the selection.

Touch screen only terminals require list keys on the screen, enabling the operator to move the cursor through the list.

Each screen list selector is assigned a function key or touch cell to activate the list for operator input. This allows multiple lists to appear on a screen. Another way to activate a screen list selector on keypad terminals is to use the left ◀ or right ▶ arrow keys on the terminal’s keypad.
Creating Screen Selectors

This section shows how to create a Goto, Goto Config Screen or Return screen button. All appear the same when positioned on a screen. On touch screen terminals, screen buttons are aligned with the touch grid even if it’s not visible.

To create a Goto, Goto Config Screen or Return button:

1. Click the appropriate tool on the toolbox.
   Or choose Goto, Goto Config Screen or Return from the Objects \( \downarrow \) Screen Selectors submenu.

2. Position the pointer (+) and click the left mouse button to place the default button size. Or drag the pointer to size the button.

3. To place another screen button of the same type, move the pointer to a new location and click again.

4. Click the right mouse button to exit screen button mode.
   Or click the selection tool on the toolbox.
To set properties of a screen selector button:

1. Double-click the screen button object.

2. From the Screen List box, select the screen that you want to display when the screen button is pressed.

3. Under Input:
   - For keypad terminals, select a function key from the list.
   - For touch screen terminals, touch cell is automatically enabled.

   PanelView 550/600 Touch Screen & Keypad terminals support function key and touch cell input.

4. When done, click OK.

The selected function key displays a graphic of the screen button and an asterisk next to the key number, indicating the key is used.
Creating Screen Selectors

This section shows how to create and edit properties of a screen list selector. On touch screen terminals, the screen list aligns with the touch grid even if it’s not visible.

To create a Screen List Selector:

1. Click the Screen List Selector tool from the toolbox.
   Or choose Screen List Selector from Objects ▶ Screen Selectors submenu.

2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the screen list.

3. To place another Screen List Selector, move the pointer to a new location and click again.

4. Click the right mouse button to exit screen list selector mode.
   Or click the selection tool on the toolbox.
To set properties of a Screen List Selector:

1. Double-click the screen list selector object.

2. Under Input, specify whether the operator presses a function key or a touch cell to activate the screen list.
   - For keypad terminals, select a function key from the list.
   - For touch screen terminals, touch cell is enabled.

PanelView 550/600 Touch Screen & Keypad terminals support function key and touch cell input.

When exiting the dialog, the selected function key displays a graphic of a screen list selector and an asterisk next to the key number.

3. Select the Wrap Around check box to enable or disable wrap around for the selection cursor. The default is disabled.

Wrap around moves the selection cursor to the top or bottom of the list when the down ▼ or up ▲ arrow keys are pressed on the last or first screen in the list.
Creating Screen Selectors

Configuring Entries in a Screen List Selector

Use the States tab to:

- select a screen to associate with each entry
- edit text to display for each entry
- edit text formatting options (text size, underlining, blinking, alignment and foreground color)
- add or delete screen list entries

To configure the entries in a Screen List Selector:

1. Click the States tab on the Screen List Selector dialog.
   
   A spreadsheet opens. Each row represents an entry in the screen list. The initial default is 16 entries (row 0 to row 15).

2. Edit the fields as necessary.

3. Click OK to exit dialog.

---

Editing Number of Screen List Entries

A Screen List Selector supports a maximum of 255 entries (0 to 254 rows). Use only the number required.

To add states to a Screen List Selector:

1. Hold down the right mouse button and choose Append State from the popup menu.
   
   A new row is added after the last row.

2. Repeat step 1 for each state you want to add.

   Each state you add is created with the defaults from Row 0 and default text (ST 0, ST 1, ..., ST 254).
To delete states from a Screen List Selector:

1. Select the row number you want to delete.
2. Hold down the right mouse button and choose Delete State from the popup menu.
3. Repeat steps 1 and 2 for each state you want to delete.

Selecting Screen Names

The Screen field contains a list of screens in the application. Select a screen to associate with each entry in the screen list.

Editing Text Entries

The Text field specifies the text that will actually appear in the list for the assigned screen. The row number indicates the position of the text in the list.

The default text assigned for each list entry is ST and the row number. Double-click in the cell and edit the text.

Other text fields control how the text is formatted for each entry:
• text size (changes to text size apply to entire list)
• underline
• text blink
• alignment (left, right, center)
• foreground color
Creating List Keys

Touch screen only terminals require List keys on the screen, enabling the operator to move the cursor in a Screen List Selector and to select a screen. List keys are also supported on keypad terminals.

The available List Keys and functions are listed below.

<table>
<thead>
<tr>
<th>List Key</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲</td>
<td>Move Up</td>
<td>Moves the cursor to the previous screen in the list. Required.</td>
</tr>
<tr>
<td>▼</td>
<td>Move Down</td>
<td>Moves the cursor to the next screen in the list. Required.</td>
</tr>
<tr>
<td>Home</td>
<td></td>
<td>Moves the cursor to the first screen in the list. Optional.</td>
</tr>
<tr>
<td>End</td>
<td></td>
<td>Moves the cursor to the last screen in the list. Optional.</td>
</tr>
<tr>
<td>Page Up</td>
<td></td>
<td>Moves the cursor up a page in a scrolling list. Optional.</td>
</tr>
<tr>
<td>Page Down</td>
<td></td>
<td>Moves the cursor down a page in a scrolling list. Optional.</td>
</tr>
<tr>
<td>Backspace</td>
<td></td>
<td>Returns the cursor to the currently highlighted screen. Optional.</td>
</tr>
<tr>
<td>Enter</td>
<td></td>
<td>Confirms a selection and displays the selected screen. Required.</td>
</tr>
</tbody>
</table>

To create a list key:

1. Click a List Key tool in the toolbox.
   Or choose a List Key from the Objects ➔ List Keys submenu.
2. Position the pointer (+) and click the left mouse button.
3. Click the right mouse button to exit List Key mode.
   Or click the selection tool on the toolbox.

To access the properties of a list key:

1. Double-click the list key object.
2. Under Input, specify how the operator will activate the list key.
   • For keypad terminals, select a function key from the list.
   • For touch screen terminals, touch cell is enabled.
3. When you’re done, click OK.

The SLC or PLC can control screen changes and return the current screen value to the controller. Chapter 20 shows how to use control and status tags to perform these controller functions.
Creating Bar Graphs, Indicators, Numeric Displays

Chapter Objectives

Bar graphs, indicators and numeric data displays show a numeric value or a graphic representation of data stored at a controller tag address. This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>12–1</td>
</tr>
<tr>
<td>Scaling Data</td>
<td>12–2</td>
</tr>
<tr>
<td>Error States</td>
<td>12–3</td>
</tr>
<tr>
<td>Bar Graphs</td>
<td>12–4</td>
</tr>
<tr>
<td>Numeric Data Displays</td>
<td>12–9</td>
</tr>
<tr>
<td>Multistate Indicators</td>
<td>12–12</td>
</tr>
<tr>
<td>List Indicators</td>
<td>12–18</td>
</tr>
</tbody>
</table>

Helpful Hints

When creating bar graphs, indicators and displays, consider:

- Indicators reading a value do not have a “dead band” in which a range of values are interpreted as a single state. For most applications, the controller ladder logic should allow a range of values above and/or below the specified value for each state to be interpreted as the same state.

- Multistate indicators support up to 2,000 states or entries (numbered 0-1,999).

- List indicators support up to 255 states or entries (numbered 0-254).

- For multistate or list indicators, use only the number of states or entries required by the application.

- Multistate indicators include an error state (State E). The error state notifies an operator that the data read isn’t within the expected ranges.
Scaling Data

Standard Data Displays

Standard data and bar graph displays show a numeric value stored at a controller tag address.

Scaled Data Displays

Scaled data and bar graph displays take raw numeric values and mathematically manipulate them so that values are shown in standard units such as gallons, feet per second, and pounds per square inch. Values from the logic controller are scaled using the formula:

\[ y = mx + b \]

- \( y \) = scaled (displayed) value
- \( m \) = scale (multiplier)
- \( x \) = controller value
- \( b \) = offset

The scale and offset values are entered in the Tag Editor. The following example shows the use of a scaled data display.
Error States

Multistate Indicators

Multistate indicators have an error state to notify an operator when data is out of range or when multiple states are triggered. The error state (State E) is accessed from the States tab of the dialog or from the State box on the tool bar. The inner text for State E is Error. You can assign different inner text or display attributes to the error state.

Bar Graphs

A bar graph is either empty or filled if a value is not within the allowable range of values.

List Indicators

No list entry is highlighted if the data is outside of the allowable range or if multiple states are triggered.

Numeric Data Displays

If a value exceeds the specified field width for the numeric data display, the overflow value is replaced with asterisks.
Bar Graphs

Bar graphs monitor changing conditions such as temperature or fluid levels. You can create various types of bar graphs.

Types of Bar Graphs

Create bar graphs as individual displays or in a cluster. You can orient bar graphs either vertically or horizontally. A variety of fill patterns and options allow for a variety of appearances.

Use stacked bar graphs to create the effect of bidirectional graphs, graphs with multiple fill patterns, or graphs showing relative values to a total.
Creating a Bar Graph

This section shows how to create a bar graph. You can create a bar graph with or without a scale. The scale is a separate object.

To create a bar graph:

1. Click the Bar Graph tool in the toolbox.
   Or choose Bar Graph from the Objects menu.

2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the bar graph.

3. To place another bar graph, move the pointer to a new location and click again.

4. Click the right mouse button to exit bar graph mode.
   Or click the selection tool on the toolbox.

Setting Properties of a Bar Graph

To set bar graph properties:

1. Double-click the bar graph object.

2. Set the bar graph properties as defined on the next page.

3. When done, click OK.
The following descriptions define properties of a bar graph.

**Fill From**
Sets the direction for filling the bar graph. Click the arrow at the right of the box to list and select an option.

<table>
<thead>
<tr>
<th>Select</th>
<th>To Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Left to right</td>
</tr>
<tr>
<td>Right</td>
<td>Right to left</td>
</tr>
<tr>
<td>Top</td>
<td>Top to bottom</td>
</tr>
<tr>
<td>Bottom</td>
<td>Bottom to top</td>
</tr>
</tbody>
</table>

The bar graph fills with black on monochrome displays and white on color displays. You can select a fill pattern from the Format > Fill Pattern submenu and turn the bar graph border off from the Format > Line Type submenu.

**Range**
Sets the minimum and maximum values the bar graph can display. The range of values you can enter in the Min/Max boxes depends on the data type of the read tag.

<table>
<thead>
<tr>
<th>Min to Max Value Range</th>
<th>For this Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 9,999</td>
<td>4BCD</td>
</tr>
<tr>
<td>-32768 to +32767</td>
<td>Signed Integer</td>
</tr>
<tr>
<td>0 to 65535</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>-99,999,997,952 to +999,999,995,904</td>
<td>Floating Point</td>
</tr>
</tbody>
</table>

If the value exceeds the maximum, the entire bar graph fills. If the value is below the minimum, the bar graph appears as an empty box.

**Read Tag**
Specifies the name of the tag address to read for filling the bar graph. If the tag doesn’t exist, enter a tag name. Edit the tag definition using the Edit Tag button or the Tag Editor.
Creating a Bar Graph Scale

This section shows how to create a bar graph scale.

To create a bar graph scale:

1. Click the Scale tool in the toolbox.
   Or choose Scale from the Objects menu.

2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the bar scale.

3. To place another scale, move the pointer to a new location and click again.

4. Click the right mouse button to exit scale mode.
   Or click the selection tool on the toolbox.

To set scale properties:

1. Double-click the scale object.

2. From the Location box, select the orientation of the scale relative to the bar graph.

3. In the Number box, enter the number of tick marks for the scale. The number of tick marks allowed depends on the size of the scale. Tick marks are spaced evenly along the scale.

4. When done, click OK.
Creating Tick-Mark Labels

Use the graphics text tool to add tick-mark labels to the bar graph scale. The labels aren’t attached to the scale but are handled as separate objects.

![Tick-mark Labels](image)

You can group the bar graph, scale and tick-mark labels so that they’re handled as a single unit.

**To create a tick-mark label:**

1. Click the Text tool in the toolbox.
   Or choose Text from the Objects ➤ Graphics submenu.

2. Position the pointer and drag the text block to the size you want.
   The text block is selected and you are placed in inner text mode.

3. Enter the label in the Text box.
   As you enter the label, it’s also entered in the text block. An asterisk (*) appears if the text exceeds the size of the block.

4. To create another label, repeat steps 2 and 3.

5. Click the right mouse button to exit background text mode.
   Or click the selection tool in the toolbox.

6. When done, click to exit inner text mode.

7. Resize the text blocks, if necessary, to fit all text.
   When you deselect the text object, the border becomes invisible.
Numeric Data Displays

Numeric data displays provide a numeric readout of a value stored at a controller tag address.

Types of Numeric Data Displays

Numeric data displays can display an actual value or a scaled value. In addition, numeric displays can have:
- fixed or floating decimal point
- zero fill
- text
- time or date

If a value exceeds the specified field width for the numeric data display, the overflow value is replaced with asterisks. Here are some typical examples:

Pressure is 90 PSI → Value without zero fill

Pressure is 090 PSI → Value with zero fill

Pressure is 90.25 PSI → Value with decimal point

To add a date, time or text to a numeric data display, see Chapter 17.

Creating a Numeric Data Display

This section shows how to create a numeric data display.

To create a numeric data display:

1. Click the Numeric Data Display tool in the toolbox.
   Or choose Numeric Data Display from the Objects menu.

2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the numeric display.
   The object is automatically selected and contains # characters representing a numeric variable.

3. To place another numeric data display, move the pointer to a new location and click again.

4. Click the right mouse button to exit numeric data display mode.
   Or click the selection tool on the toolbox.
Setting Properties of a Numeric Data Display

To set the properties of a numeric data display:

1. Double-click the object.

2. Set the numeric display properties as defined on the next page.

3. When done, click OK.

Digits

The Field Width box specifies the maximum number of characters (including 0-9 + - . ) that can appear in the display. The default is 6. If the value from the logic controller exceeds the specified field width, the field on the terminal display fills with asterisks ****.

Unfilled data positions are left blank. To fill empty data positions with zeroes, click the Fill with Zeroes check box.
Decimal Point

A value may be stored as an integer, then scaled by the terminal so it can be displayed as a decimal. See page 12–2 on scaling.

The Decimal Point area specifies whether a scaled value displays with a fixed or floating point decimal.

- Select **Fixed Point** to position the decimal point 0 to 10 places to the left of the rightmost character. A value of 0 displays a value without a decimal point.

<table>
<thead>
<tr>
<th>Select</th>
<th>For this position</th>
<th>Select</th>
<th>For this position</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>97</td>
<td>6</td>
<td>97.2767677</td>
</tr>
<tr>
<td>1</td>
<td>97.2</td>
<td>7</td>
<td>97.2767676</td>
</tr>
<tr>
<td>2</td>
<td>97.27</td>
<td>8</td>
<td>97.2767676</td>
</tr>
<tr>
<td>3</td>
<td>97.276</td>
<td>9</td>
<td>97.2767676</td>
</tr>
<tr>
<td>4</td>
<td>97.2767</td>
<td>10</td>
<td>9.727676767</td>
</tr>
</tbody>
</table>

**Note:** If Position is ≠ 0, then the field width must be 2 > decimal position for positive numbers. One position is used for the digit to the left of the decimal and one for the decimal point. For negative numbers the field width must be 3 > decimal position.

For example, to display the number –0.1234, set the field width to 7 and the decimal position to 4.

- Select **Floating Point** to have the terminal position the decimal.

Read Tag

Specifies the name of the tag address from which to read the display data. If the tag doesn’t exist, enter a tag name. Edit the tag definition using the Edit Tag button or the Tag Editor.

Valid data types for the read tag are unsigned/signed integer, 4BCD and floating point.
**Multistate Indicators**

Multistate indicators can show up to 2,000 states (including error state). Each state can have unique inner text and/or a graphic with different fill patterns.

**Types of Multistate Indicators**

Use multistate indicators for a variety of effects including limited animation of displays.

Inner text and/or graphics for multistate indicators are entered the same as for multistate push buttons. For details on how to do this and use other formatting options, see Chapter 17.
Triggering an Indicator State

One of 3 data types can trigger the display of an indicator state:

- Single Bit
- Least Significant Bit
- Value

Single Bit

Single Bit is only valid for 2-state multistate indicators. The state is controlled by the status of a single bit. Turning the tag address bit on or off toggles the indicator display between state 0 and state 1.

Least Significant Bit

The terminal displays the state corresponding to the Least Significant Bit (LSB) at the tag address data words (0 to 1,999 bits). More than one bit may be set at the tag address allowing states to display in a priority sequence (state 0 displays when bit 0 is ON, state 1 displays when bit 1 is ON, ..., state 1,999 displays when bit 1,999 is ON).

An error state occurs when all bits are OFF (low). The message defined for the error state (State E) displays, if defined. The default message is “Error”.

The controller program must clear the last bit displayed. The next time the terminal reads the tag address, the state corresponding to the next least significant bit is displayed. The following example shows what happens if bits 1 and 24 are set at tag address N7:2.

Value

The controller triggers a state when the tag address contains a specific value. The specified state is displayed until the value at the tag address is changed.
Creating a Multistate Indicator

This section shows how to create a multistate indicator and edit its properties.

To create a multistate indicator:

1. Click the Multistate Indicator tool in the toolbox.
   Or choose Multistate from the Objects ➔ Indicators submenu.

2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the indicator.

3. To place another multistate indicator, move the pointer to a new location and click again.

4. Click the right mouse button to exit multistate indicator mode.
   Or click the selection tool on the toolbox.

Setting Properties of a Multistate Indicator

To set properties of a multistate indicator:

1. Double-click the indicator object.

2. On the Properties tab, set operating parameters of the indicator.
Read

Specifies the type of data that triggers the display of a state.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Bit</td>
<td>Trigger a 2-state indicator by setting or clearing a bit at the read tag address. The number of states must be set to 2 before the single bit option is available.</td>
</tr>
<tr>
<td>Least Significant Bit</td>
<td>Trigger multiple states. Entries display in a sequence corresponding to bits set at word address(es) starting with the read tag address. The read tag data type is unsigned integer.</td>
</tr>
<tr>
<td>Value</td>
<td>Trigger a state based on a value at the read tag address. Each state is linked to a different value.</td>
</tr>
</tbody>
</table>

**Note:** If using more than 16 states for the Least Significant Bit (LSB) trigger, reserve up to 124 consecutive word addresses after the tag address. Every 16 states = 1 word address, with up to 2,000 total states. The LSB will only use up to the word of the last state.

For the **Value** option, you must select the format of the data from the Data Format list box. The data type of the read tag must be compatible with the selected format for the application to validate.

<table>
<thead>
<tr>
<th>Use this Format</th>
<th>With this Tag Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signed Integer</td>
<td>Signed Integer</td>
</tr>
<tr>
<td>4-BCD</td>
<td>4BCD</td>
</tr>
<tr>
<td>Binary</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>Unsigned Integer or Bit Array</td>
</tr>
<tr>
<td>Octal</td>
<td></td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td></td>
</tr>
</tbody>
</table>

**Trigger State 0 When:**

If Single Bit was selected in the Read area, you must specify whether State 0 triggers on Bit 0 or Bit 1.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit 0</td>
<td>Trigger state 0 when bit is set to 0 and trigger state 1 when bit is set to 1</td>
</tr>
<tr>
<td>Bit 1</td>
<td>Trigger state 0 when bit is set to 1 and trigger state 1 when bit is set to 0</td>
</tr>
</tbody>
</table>

**Read Tag**

Specifies the name of the tag address that triggers the display of a state. If the tag does not exist, enter a tag name. Edit the tag definition using the Edit Tag button or the Tag Editor.

**Print**

Select the Print check box to print states as they are triggered. When a state is triggered, the text associated with the state is printed on the connected printer.
Configuring States for a Multistate Indicator

Use the States tab to:

- edit text for each state
- enter a value for each state (if required)
- edit format options for each state
- insert a graphic for a state
- add or delete states as required

To configure states for a multistate indicator:

1. Click the States tab on the Multistate Indicator dialog.
   A spreadsheet opens. Each row indicates an indicator state. The default is 4 states (row 0 to row 3) and an error state (row E).
   The fields in each row define visual characteristics for each state.

2. Edit the states as necessary.

3. Click OK to exit the Multistate Indicator dialog.

Editing Number of States

A multistate indicator supports a maximum of 2,000 states (0 to 1,999). Use only the number of states required.

To add states to a multistate indicator:

1. Choose Append State from the popup menu.
   A new state is added after the last state but before the error state.

2. Repeat step 1 for each state you want to add.

Each state you add is created with values from the last state. New states are added without default text in the Text field.

To delete states, select the row number and choose Delete State from the popup menu.
Editing State Text

The Text field contains the text that will appear for each state. The default text is the state number (ST 0). Double-click in the cell to edit the text.

Other text fields control how the text is formatted for each state.

Entering State Values

If Value was selected in the Read area of the Properties tab, the Value field appears for each state. This field defines the numeric value at the read tag address that triggers the state to display.

The range of the value you enter must be within the range of the Data Format selected on the Properties tab. The default value for each state is the state number (0 to 1,999).

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>0000 0000 0000 0000 to</td>
</tr>
<tr>
<td></td>
<td>1111 1111 1111 1111</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Signed Integer</td>
<td>-32768 to +32767</td>
</tr>
<tr>
<td>4-BCD</td>
<td>0 to 9999</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0 to FFFF</td>
</tr>
<tr>
<td>Octal</td>
<td>0 to 17777</td>
</tr>
</tbody>
</table>

① Formats provided for data entry. The terminal does not display/transfer these formats.
List Indicators

A list indicator is a scrolling list containing up to 255 entries with the current list entry highlighted.

Types of List Indicators

List indicators are controlled by a bit or value at a controller address.

List Indicator Using Value Data

This example shows an indicator list using values from a tank level sensor to display the status of a tank.

List Indicator With Bit Data

This example shows a list indicator used to display conditions associated with on/off type controls such as limit switches. The list displays the status of a robot arm based on the condition of four proximity switches.
**Triggering a List Entry**

One of 3 data types can trigger the display of a list indicator entry:
- Single Bit
- Least Significant Bit
- Value

**Single Bit**

Single Bit is only valid for a 2-entry indicator list. The highlighted entry in a list is controlled by the status of a single bit. Turning the tag address bit on/off toggles the highlight between the 2 list entries.

**Least Significant Bit**

The terminal highlights the entry corresponding to the Least Significant Bit (LSB) at the tag address data words (0 to 254 bits). Setting more than one bit at the tag address allows entries to display in a priority sequence (state 0 is highlighted when bit 0 is ON, state 1 is highlighted when bit 1 is ON, ...., state 254 is highlighted when bit 254 is ON).

An error state occurs when all bits are OFF (low). No entry in the list is highlighted when an error occurs.

The controller program must clear the last bit displayed. The next time the terminal reads the tag address, the list entry corresponding to the next least significant bit is highlighted. The example below shows what happens if bits 1 and 24 are set at tag address N7:2.

**Value**

The controller triggers a list entry when the tag address contains a specific value. The entry is highlighted until the value at the tag address changes.
Creating a List indicator

This section shows how to create a list indicator.

To create a list indicator:

1. Click the List Indicator tool in the toolbox.
   Or choose List from the Objects ▶ Indicators submenu.

2. Position the pointer (+) and click the left mouse button to place
   the default size. Or drag the pointer to size the indicator.

3. To place another list indicator, move the pointer to a new location
   and click again.

4. Click the right mouse button to exit list indicator mode.
   Or click the selection tool on the toolbox.

Setting Properties of a List Indicator

To set properties of a list indicator:

1. Double-click the list indicator object.

2. On the Properties tab, set the operating parameters of the
   indicator.
Read

Specifies the type of data that triggers the display of a list entry.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Bit</td>
<td>Trigger a 2-entry list indicator by setting or clearing a bit at the read tag address. The number of states must be set to 2 before the single bit option is available.</td>
</tr>
<tr>
<td>Least Significant Bit</td>
<td>Trigger multiple entries. Entries display in a sequence corresponding to bits set at word address(es) starting with the read tag address. The tag data type for least significant bit is unsigned integer.</td>
</tr>
<tr>
<td>Value</td>
<td>Trigger a list entry based on a value at the read tag address. Each entry is linked to a different value.</td>
</tr>
</tbody>
</table>

**Note:** If using more than 16 entries for the Least Significant Bit (LSB) trigger, reserve up to 15 consecutive word addresses after the tag address. Every 16 entries = 1 word address, with up to 255 total entries. The LSB will only use up to the word of the last entry.

For the **Value** option, you must select the format of the data from the Data Format list box. The data type of the read tag must be compatible with the selected format for the application to validate.

<table>
<thead>
<tr>
<th>Use this Format</th>
<th>With this Tag Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signed Integer</td>
<td>Signed Integer</td>
</tr>
<tr>
<td>4-BCD</td>
<td>4BCD</td>
</tr>
<tr>
<td>IEEE Float</td>
<td>IEEE Float</td>
</tr>
<tr>
<td>Binary</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>Unsigned Integer or Bit Array</td>
</tr>
<tr>
<td>Octal</td>
<td></td>
</tr>
</tbody>
</table>

**Trigger State 0 When:**

If Single Bit was selected in the Read area, you must specify whether entry 0 triggers on Bit 0 or Bit 1.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit 0</td>
<td>Trigger entry 0 when bit is set to 0 and trigger entry 1 when bit is set to 1</td>
</tr>
<tr>
<td>Bit 1</td>
<td>Trigger entry 0 when bit is set to 1 and trigger entry 1 when bit is set to 0</td>
</tr>
</tbody>
</table>

**Read Tag**

Specifies the name of the tag address the terminal reads to highlight a displayed entry. If the tag does not exist, enter a tag name. Edit the tag definition using the Edit Tag button or the Tag Editor.
Configuring Entries of a List Indicator

Use the States tab to:
• edit and format text for each list entry
• enter a value for each list entry (if required)
• add or delete entries as required

To configure entries of a list indicator:

1. Click the States tab on the List Indicator dialog.
   A spreadsheet opens. Each row indicates an entry in the indicator list. The default is 16 entries (row 0 to row 15).
   The fields in each row define the text that will appear for each entry and how it will be formatted.

2. Edit the entries as necessary.

3. Click OK to exit the List Indicator dialog.

Editing Number of Entries

A list indicator supports a maximum of 255 entries (0 to 254). Use only the number of entries required.

To add entries to a list indicator:

1. Choose Append State from the popup menu.
   A new entry is added after the last entry.

2. Repeat step 1 for each entry you want to add.
   Each entry you add is created with the defaults from Entry 0.

To delete entries, select the row number and choose Delete State from the popup menu.
Editing List Text

The Text field contains the text that will appear for each entry in the List Indicator. Double-click on the field and edit the text.

Other text fields control how the text is formatted for each state:

- text size (the default varies for each terminal type, the selection applies to entire list)
- underline (default is off)
- text blink (default is off)
- left, right or center alignment (default is left)
- foreground color (default is white for color and grayscale terminals, black for monochrome terminals)

Entering State Values

If Value was selected in the Read area of the Properties tab, the Value field appears for each state. This field defines the numeric value at the read tag address that triggers a specific entry to be highlighted.

The range of the value you enter must be within the range of the Data Format selected on the Properties tab. The default value for each entry is the entry number (0 to 254).

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>0000 0000 0000 0000 to 1111 1111 1111 1111</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Signed Integer</td>
<td>-32768 to +32767</td>
</tr>
<tr>
<td>IEEE Float</td>
<td>-99,999,997,952 to +999,999,995,904</td>
</tr>
<tr>
<td>4-BCD</td>
<td>0 to 9999</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0 to FFFF</td>
</tr>
<tr>
<td>Octal</td>
<td>0 to 177777</td>
</tr>
</tbody>
</table>

 Formats provided for data entry. The terminal does not display/transfer these formats.
Creating Message Displays

Chapter Objectives

It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>13–1</td>
</tr>
<tr>
<td>Types of Messages</td>
<td>13–2</td>
</tr>
<tr>
<td>Triggering Messages</td>
<td>13–4</td>
</tr>
<tr>
<td>Error State</td>
<td>13–5</td>
</tr>
<tr>
<td>Creating a Message Display</td>
<td>13–6</td>
</tr>
<tr>
<td>Setting Properties of a Message Display</td>
<td>13–6</td>
</tr>
<tr>
<td>Configuring Messages</td>
<td>13–8</td>
</tr>
<tr>
<td>Creating an Object to Print Messages</td>
<td>13–10</td>
</tr>
</tbody>
</table>

Helpful Hints

When creating message displays:

- Messages should not cover control objects when displayed.
- Message displays support up to 2,000 messages (numbered 0 to 1999).
- Create message displays with the exact number of messages required by the application. Don’t create blank messages.
- Message text is formatted and edited like other objects with inner text.
- Message displays include an error state (State E) to notify the operator when an error occurs while triggering a message.
- If screen space is limited, create a Print Only object. When messages are triggered, they are printed rather than displayed on the screen.
Types of Messages

Message displays present status information or instructions to an operator.

Message displays can show different types of information including the status of a process, operator prompts, time, date, numeric or ASCII variable.

The following examples show status information for Tank #1.
Message displays can contain variable data. For details on how to insert a variable in a message display, see Chapter 17.

Message displays can contain time and date information based on the terminal’s real time clock. For details on how to insert a time/date variable in a message display, see Chapter 17.
Triggering Messages

The 3 types of data that can trigger a message to display are:

- Single Bit
- Least Significant Bit
- Value

Single Bit

Single Bit is valid only for 2-state message displays. The display is controlled by the status of a single bit. Turning the tag address bit on or off toggles the display between message 0 and message 1.

Least Significant Bit

When Least Significant Bit is selected, the terminal displays the message corresponding to the Least Significant Bit (LSB) at the tag address data words (0 to 1,999 bits). More than one bit may be set at the tag address allowing messages to display in a priority sequence (message 0 displays when bit 0 is ON, message 1 displays when bit 1 is ON, ..., message 1,999 displays when bit 1,999 is ON.)

An error state occurs when all bits are OFF (low). The message defined for the error state (State E) displays, if defined. The default message is “Error”.

The controller must clear the last bit displayed. The next time the terminal reads the tag address, the message corresponding to the next least significant bit is displayed. The following example shows what happens if bits 1 and 24 are set at tag address N7:2.

Value

When Value is selected, the controller triggers a message when the tag address contains a specific value. The message is displayed until the value at the tag address is changed.
Error State

Message displays have an error state to notify an operator when data is out of range or unavailable.

You cannot delete the error state. The only way to access the error state is to select the object and then select state E from the State box on the tool bar. The inner text that appears in the object for state E is Error. You can assign different inner text or display attributes to the error state.

<table>
<thead>
<tr>
<th>State 0</th>
<th>TANK LEVEL HIGH</th>
</tr>
</thead>
<tbody>
<tr>
<td>State 1</td>
<td>TANK LEVEL LOW</td>
</tr>
<tr>
<td>State E</td>
<td>ERROR</td>
</tr>
</tbody>
</table>

Default Inner Text for Error (E) State
Creating a Message Display

This section shows how to create a message display.

To create a message display:

1. Click the Message Display tool in the tool box.
   Or choose Message Display from the Objects submenu.

2. Position the pointer (+) and click the left mouse button to place the default size. Or drag the pointer to size the display.

3. To place another message display, move the pointer to a new location and click again.

4. Click the right mouse button to exit message display mode.
   Or click the selection tool on the toolbox.

Setting Properties of a Message Display

To set properties of a message display:

1. Double-click the message display object.

2. On the Properties tab, set the operating parameters of the message display.
Creating Message Displays

Read

Specifies the type of data that triggers a message to display.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Bit</td>
<td>Trigger a 2-message display by setting or clearing a bit at the read tag address. The number of states must be set to 2 before the single bit option is available.</td>
</tr>
<tr>
<td>Least Significant Bit</td>
<td>Trigger multiple messages. Messages display in a sequence corresponding to bits set at word address(es) starting with the read tag address. The tag data type for least significant bit is unsigned integer.</td>
</tr>
<tr>
<td>Value</td>
<td>Trigger a message based on a value at the read tag address. Each message is linked to a different value.</td>
</tr>
</tbody>
</table>

Note: If using more than 16 messages for the Least Significant Bit (LSB) trigger, reserve up to 124 consecutive word addresses after the tag address. Every 16 messages = 1 word address (maximum of 2,000 messages). The LSB only uses up to the word of the last message.

For the Value option, you must select the format of the data from the Data Format list box. The data type of the read tag must be compatible with the selected format for the application to validate.

<table>
<thead>
<tr>
<th>Use this Format</th>
<th>With this Tag Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signed Integer</td>
<td>Signed Integer</td>
</tr>
<tr>
<td>4-BCD</td>
<td>4BCD</td>
</tr>
<tr>
<td>Binary</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>Unsigned Integer or Bit Array</td>
</tr>
<tr>
<td>Octal</td>
<td></td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td></td>
</tr>
</tbody>
</table>

Trigger

If Single Bit was selected in the Read area, you must specify whether message 0 (state 0) triggers on Bit 0 or Bit 1.

<table>
<thead>
<tr>
<th>Select</th>
<th>To Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit 0</td>
<td>Message 0 when bit is set to 0 and trigger message 1 when bit is set to 1.</td>
</tr>
<tr>
<td>Bit 1</td>
<td>Message 0 when bit is set to 1 and trigger message 1 when bit is set to 0.</td>
</tr>
</tbody>
</table>

Read Tag

 Specifies the name of the tag address that triggers a message. If the tag doesn’t exist, enter a tag name. Edit the tag definition using the Edit Tag button or the Tag Editor.

Print

Select the Print check box to print messages as they are triggered. When a state is triggered, the text associated with the state is printed on the connected printer.
Configuring Messages

Use the States tab to:
• edit and format text for each message
• enter a value to trigger each message (if required)
• insert a graphic for each message
• edit format options for the message display
• add or delete the number of messages for the display

To configure messages:
1. Click the States tab on the Message Display dialog.
   A spreadsheet opens. Each row represents a message. The default is 2 messages (row 0 and row 1) and an error state (row E).
   The fields in each row define the message text and the visual characteristics of each message.
2. Edit message fields as necessary
3. Click OK when done to exit the Message Display dialog.

Editing Number of Messages

A message display supports a maximum of 2,000 messages (0 to 1,999). Use only the number of messages required.

To add messages to a message display:
Choose Append State from the popup menu for each message you want to add.

A new message is added after the last message but before the error state. Each state you add is created with the defaults of message 0.

To delete a message, select the row number of the message you want to delete and choose Delete State from the popup menu.
Entering Message Text

The Text field contains the text that will display for each message. Double-click in the cell and replace the default text (Msg 0) with the new message text.

Other text fields control how the text is formatted.
- text size (default size varies for each terminal type)
- underline (default is off)
- text blink (default is off)
- left, right or center alignment (default is left)
- foreground color

To insert variables in a message:

1. Position the cursor in the text where you want to insert the variable.

2. From the popup menu, choose Time, Date, Variable, or ASCII from the Embedded Variable submenu.

A placeholder is inserted in the message for the time and date variable (/*T*/ for time or /*D*/ for date). The time and date are formatted using the settings in the Terminal Setup dialog.

A dialog opens when Variable or ASCII is selected, allowing you to format how the numeric or ASCII variable will display (see page 17–14 and 17–16). When you exit this dialog a placeholder is inserted in the message with embedded formatting details.

Entering State Values

If Value was selected in the Read area of the Properties tab, the Value field appears for each message. This field defines the numeric value at the read tag address that will trigger the message to display.

The range of the value you can enter must be within the range of the Data Format selected on the Properties tab. The default value for each message is the row number (0 to 1,999).

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>0000 0000 0000 0000 0000 0000 0000 0000 0000 to 1111 1111 1111 1111</td>
</tr>
<tr>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
</tr>
<tr>
<td>Signed Integer</td>
<td>-32768 to +32767</td>
</tr>
<tr>
<td>4-BCD</td>
<td>0 to 9999</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0 to FFFF</td>
</tr>
<tr>
<td>Octal</td>
<td>0 to 177777</td>
</tr>
</tbody>
</table>

① Formats provided for data entry. The terminal does not display/transfer these formats.
Creating an Object to Print Messages

You can create an object to send all triggered messages to a printer rather than displaying them in a Message Display. Any variables embedded within the message also print.

A print object has the same properties as a message display. However, when configuring the message you enter only the text that will print, no formatting options.

Print objects are not linked to specific screens like display objects. Therefore, messages can be triggered any time an application is running.

The print object is only supported on terminals equipped with an RS-232 serial printer port.

To create an object that will only print messages:

1. Choose Print Only Object Setup from the Application menu.

2. Click the New button.

3. In the Create text box, enter a unique name (1 to 32 characters) for the print object. The name can include spaces and symbols.

4. Click OK to open a dialog to configure the print object.

Print Only Messages do not support Internal tags.
5. Configure the properties for triggering print messages. They are identical to the Message Display on page 13–6.

6. Click the States tab.

Initially a Print Only Object is created with 2 messages and one error state.

7. Choose Append State from the popup menu for each message you want to add to the print object. Use the exact number required.

8. If the Value field appears for each message, enter the value that will trigger the message to print.

9. In the Text field, enter the text that will print when the message is triggered. To insert a time, date or numeric variable in a message, choose an Embedded Variable option from the popup menu.

10. Click OK when done to exit dialog.

The Print Only Object Setup dialog reopens. The print object just created now appears in the Existing Objects list.

11. Click OK to exit dialog.
### Managing Print Objects

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| **Edit a print object** | 1. From the list of Existing Objects, select the print object you want to edit.  
2. Click the Edit button to open the print object’s dialog.  
3. Edit the Properties tab (if necessary).  
4. Click the States tab to edit the text (and variables) associated with the print object.  
5. Click OK to exit the print object dialog. |
| **Rename a print object** | 1. From the Existing Objects list, select the name of the print object you want to rename.  
2. Click the Rename button.  
3. In the dialog that opens, enter a new 1 to 32 character name for the print object. The name can include spaces and symbols.  
4. Click the OK button.  
The print object appears in the Existing Objects list under the new name; not the old. |
| **Copy a print object** | 1. From the Existing Objects list, select the name of the print object you want to copy.  
2. Click the Copy button.  
3. In the dialog that opens, enter a new 1 to 32 character name for the copied print object. The name can include spaces and symbols.  
4. Click the OK button.  
Two versions of the print object now exist; one under the original name and one under the new name.  
Edit the properties of the copied print object as described above. |
| **Delete a print object** | 1. From the list of Existing Objects, select the print object you want to delete.  
2. Click the Delete button. You are asked to confirm the deletion.  
3. Click Yes.  
All tag definitions associated with the print object are permanently removed. |
Chapter 14

Using Global Objects

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is a Global Object?</td>
<td>14–1</td>
</tr>
<tr>
<td>Defining a Global Object</td>
<td>14–4</td>
</tr>
<tr>
<td>Using a Global Object</td>
<td>14–5</td>
</tr>
<tr>
<td>Moving and Resizing a Global Object</td>
<td>14–6</td>
</tr>
</tbody>
</table>

What is a Global Object?

A global object is a single object that can be referenced on multiple screens in an application. A global object is created and stored once regardless of the number of times it is used.

For example, if you want to use the same control or display object on different screens, define the object as a global object. You can reference a global object from any screen (without recreating it).

The benefits of using a global object are:

- **reduced development time**
  Reference a global object on multiple screens without having to recreate the object. When properties of a global object are edited, all instances of that object are automatically updated.

- **reduced application size**
  Global objects reduce memory because they are stored once regardless of the number of links to it. Only one copy of a global object is downloaded to the terminal.
Each object placed on an application screen has a corresponding:

- **device object** – defines the properties of the object.
- **screen object** – defines the screen position and input type (touch cell or function key) of the object.

The following illustration shows how an object is reused globally.

- Object on Screen 1 was initially created with a device object (defining object properties) and a screen object (defining screen location and input type).
- Object on Screen 1 was defined as a global object by clicking the Mark for Global Selection in the object’s Options dialog.
- Global object is reused on Screen 2. Global objects are accessed from Global Objects dialog. A screen device was created linking the global object to the new screen.
- Global object is reused again on Screen 3. Another screen device was created linking the global object to the new screen.

If the properties of a global object are changed, all other links to that object are also updated.
Copying an Object

When copying an object to another screen, a new object is created with the same properties and also updated screen information. The original object and the copied object are two unique objects. Changes to the original object do not affect the copied object.
Defining a Global Object

This section shows how to define an object for global use. Defining an object for global use adds it to the Global Object dialog. From this dialog, you select a global object and place it on a screen.

**Note:** Each control object must have a unique write tag unless the object is defined as a global object. If you create separate but identical control objects on different screens with the same write tag, the application will not validate.

**To define an object for global use:**

1. Click the Options tab from the dialog of the selected object.

2. Check the Mark for Global Selection check box, indicating the object is available for global selection. The object is added to a list of objects available for global use. The next section shows how to access global objects.

   To disable the global setting, clear the check box.

3. When done, click OK to exit the object’s dialog.

**To define a group of objects available for global use:**

1. Group the objects.

2. Double-click the group or select the group and press ENTER to open the Options dialog.

3. Check the Mark for Global Selection check box, identifying the group as available for global selection. To disable the global setting, clear the check box.

4. Click OK to exit the dialog.

**Note:** The first few characters of the Description text will appear in the Global Objects list to help identify the grouped global selection. However, from screen to screen, you can enter a unique description for each instance of a grouped global object.
This section shows how to access a global object. Remember, you can access a global object from any screen in an application.

You cannot use the same global object more than once on a screen. You can, however, use different global objects on a screen.

Global objects cannot be copied and pasted. You must place a global object on a screen using the Global Object command.

**To select and place a global object:**

1. Click the Global Object tool in the toolbox.
   Or Choose Global Object from the Objects menu.

   The Global Object dialog opens. The Control box lists all objects marked for global use from the Options dialog. Each global object is identified by its tag name, object ID and object type. Objects without tag names are listed by object type.

2. Select a global object from the Control list box and click OK.
   Or double-click the global object.

3. Position the pointer (+) where you want to place the object.
   Global objects can have different locations on different screens.

4. Click the left mouse button.

5. Click the right mouse button to exit global object mode.
   Or click the selection tool on the toolbox.

Any changes to a global object, except for screen location and function key assignment, apply to all instances of that object. A global object can have different function key and/or touch cell assignments from screen to screen.
Moving and Resizing a Global Object

This section shows the effects of moving and sizing a global object. You can change the location of a global object on one screen without affecting its location on another screen. Location is not a global attribute. When you resize a global object on one screen, it is resized on all other screens because size is a global attribute.

Resizing a global object

When the global object on Screen 1 is resized, it is also resized on Screen 2.

Moving a global object

When the global object on Screen 1 is moved, the object on Screen 2 retains its original position.

Resizing and moving a global object.

When the global object on Screen 1 resized and moved, the object on Screen 2 retains its original location (as defined by the upper left corner) but is resized.
Creating Alarms

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Alarm System</td>
<td>15–1</td>
</tr>
<tr>
<td>Creating the Alarm Banner</td>
<td>15–6</td>
</tr>
<tr>
<td>Creating an Alarm List</td>
<td>15–9</td>
</tr>
<tr>
<td>Configuring Global Alarm Parameters</td>
<td>15–12</td>
</tr>
<tr>
<td>Defining Alarm Triggers</td>
<td>15–14</td>
</tr>
<tr>
<td>Creating Alarms</td>
<td>15–16</td>
</tr>
<tr>
<td>Defining Optional Tags for Triggers</td>
<td>15–22</td>
</tr>
<tr>
<td>Defining Remote Tags used by Controller</td>
<td>15–26</td>
</tr>
<tr>
<td>Alarm Examples</td>
<td>15–28</td>
</tr>
</tbody>
</table>

Overview of Alarms

The alarm system in PanelView notifies an operator when specific trigger values appear at specific controller addresses.

Before the terminal can display alarms, you must:

• define the alarms in your application
• program the logic controller to generate the alarms

ATTENTION: Do not rely on your terminal as a primary warning device in applications that could result in physical injury, product damage or significant process down time.

All critical alarm indications and any critical logic controller responses must employ redundant and hard-wired or mechanical interlocks.

In PanelBuilder, you define a series of alarms. For each alarm, you define a message and a trigger value. You can also specify whether the alarm must be acknowledged, displayed and/or printed.

You must also define the trigger tag that links the alarm messages and the controller program. The program monitors values for alarm conditions. When the program detects an alarm condition, it sets the bit or value at the address defined by the trigger tag. The terminal reads this value and triggers the corresponding alarm.

For example, to monitor the level of a tank, define an alarm with a trigger value of 1 and the message text “Tank too Full”. Then program the controller to set the bit (1) at the trigger address when the tank is full. This triggers the message “Tank too Full”.

ATTENTION: Do not rely on your terminal as a primary warning device in applications that could result in physical injury, product damage or significant process down time.

All critical alarm indications and any critical logic controller responses must employ redundant and hard-wired or mechanical interlocks.
Alarm Banner

The Alarm Banner is an optional display that pops up over the current screen when an alarm is triggered. The banner contains a message describing the alarm condition and alarm buttons (acknowledge alarm, clear alarm) which allow the operator to act on the alarm.

When alarms are triggered, they are added to an Alarm List. When the alarm in the banner is acknowledged or cleared, the next alarm is displayed. The banner displays messages in chronological order (oldest triggered alarm to most recent triggered alarm).

The Alarm Banner is a global display that is created once in an application, but appears in the same place on every screen. Only alarms configured to display, when triggered, appear in this popup.

You can configure which objects are disabled when the Alarm Banner is displayed. The options are:
- all screen objects are disabled (default) or
- only covered objects are disabled

Below is a sample Alarm Banner with all of the alarm objects.

Clearing the Alarm Banner

The Alarm Banner remains on the terminal display until:
- the operator presses the Acknowledge button
- the operator presses the Clear button
- the operator presses the Ack All button
- the controller acknowledges the alarm
- the controller clears the alarm
- the terminal enters Configuration Mode
## Alarm Buttons

You can place alarm buttons in the Alarm Banner which allow the operator to act on the alarm. Some of the buttons appear only in the Alarm Banner, while others can also appear on other screens.

<table>
<thead>
<tr>
<th>This button:</th>
<th>Does This:</th>
<th>Alarm Banner</th>
<th>Any Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>Acknowledges receipt of the alarm currently displayed in the Alarm Banner. Pressing the Ack button removes the Alarm Banner from the terminal display but <strong>does not clear the alarm condition</strong>. The alarm is marked acknowledged in the Alarm List. <strong>Note:</strong> The highlighted alarm in the Alarm List is not the acknowledged alarm, but the most recent alarm. The acknowledged alarm may not be visible.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>Clears the Alarm Banner from the terminal display without acknowledging the alarm. Pressing the Clear button <strong>does not clear the alarm condition</strong>. If no alarms are configured for acknowledgement, then the Alarm Banner must contain a Clear button.</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
| Print       | Prints the current message in the Alarm Banner. This button operates on a single alarm. With each message, you can print:  
  • alarm date and time  
  • acknowledge date and time  
  • trigger value  
 Only terminals equipped with an RS-232 printer port support the Print Alarm button. You can also configure an alarm message to automatically print when triggered. | ✓            |            |
| Ack All     | Acknowledges all alarms in the Alarm List that have not been acknowledged. Pressing the Ack All button removes the Alarm Banner from the terminal display but **does not clear the alarm conditions**. Each alarm is marked acknowledged in the Alarm List. | ✓ ✓         |            |
| Clear Alarm List | Clears the Alarm List. Also clears the Alarm Banner even though the alarm condition may still exist. The Alarm List is automatically cleared when an application is downloaded. A warning message is displayed asking the operator to confirm or abort the clear operation. | ✓ ✓         |            |
| Print Alarm List | Prints all alarms in the Alarm List. With each alarm message, you can print:  
  • alarm date and time  
  • acknowledge date and time  
  • trigger value  
 Only terminals equipped with an RS-232 printer port support the Print Alarm List button. | ✓ ✓         |            |
Creating Alarms

The Alarm List records information on triggered alarms. The maximum number is 100 or as many alarms (up to 100) the terminal can hold in nonvolatile RAM. You can set the number of alarms stored in the Alarm List (1-100). The default is 25.

The Alarm List can be used multiple times in an application. It can appear in the Alarm Banner and on other application screens.

Each time an alarm is triggered, it is added to the Alarm List. The most recent alarm is displayed at the top of the list.

Each alarm can be configured to occupy multiple lines in the Alarm List. The following data displays for each alarm, in the order shown:

• acknowledge indicator (required)
  
  ✓ = Acknowledged Alarm
  ◼ = Unacknowledged Alarm
  ■ = No Acknowledgement Required

• alarm date and time (optional)
• acknowledge date and time (optional)
• alarm trigger value (optional)
• alarm text including variables (required)

If the Alarm List is full when an alarm is triggered, the most recent alarm is added to the top of the list and:

• the oldest alarm not requiring acknowledgement is removed from the list (this includes alarms that have been acknowledged or alarms that do not require acknowledgement).
• if all alarms not requiring acknowledgement have been removed, then the oldest alarm is removed.

If a permanent Alarm List is required, use the Print Alarm List button to print the Alarm List on a regular basis, or configure alarms to print on occurrence.

The operator can acknowledge an alarm in the Alarm List by using the up or down arrow keys on the terminal to select an alarm and then pressing the Enter key.

Touch screen terminals require List keys to move the cursor up and down the Alarm List. You can optionally use the Enter list key to enable the operator to acknowledge an alarm in the list.

List keys are accessed from the Objects ▶List Keys submenu.
Alarm List Examples

- **ACK Indicator**
  - ☑ = Acknowledged Alarm
  - ☐ = Unacknowledged Alarm
  - ■ = No Acknowledgement Required

### 1-Line Alarm List

- 06/19/96 16:55 Oven T*
- 06/19/96 16:30 LS101 *
- 06/18/96 15:00 06/18/96 15:03 Oven T*
- 06/18/96 15:00 06/18/96 15:03 Tank O*

### 2-Line Alarm List

- 16:55 123456789.1 Oven Temp High
- 16:30 2001 LS101 Triggered
- 15:00 400.00 Oven Temp High
- 15:00 600000 Tank Overflow !!!!
Creating the Alarm Banner

This section shows how to create the Alarm Banner for an application. The alarm banner is created as a separate screen that is global to all screens in the application. Control objects covered by the banner are disabled when the banner displays on the terminal.

To create the Alarm Banner:

1. Choose Create Alarm Banner from the Screen menu.

   The Alarm Banner screen opens. The default banner appears at the top of the screen and is created with:
   - one line alarm message display (cannot be deleted)
   - Clear button

   On color terminals, the default background color of the Alarm Banner and alarm objects is red and the foreground color is white. On grayscale terminals, the background is black and the foreground is white. You can change these colors using the Color Palette.

   The Alarm Banner can be moved and sized but cannot be sized smaller than the objects on the banner itself.

2. Create other alarm buttons you want to appear in the Alarm Banner by choosing the appropriate objects from the Objects menu. If the Alarm Banner is selected, you must deselect it before selecting an object inside the banner. To deselect the banner, click anywhere outside the banner.

3. On keypad terminals, double-click each Alarm object to open its dialog and select the function key that will activate the button.

   Touch cell input is automatically selected for touch screens.
4. Choose Close from the Screen menu to Close the Alarm Banner screen or double-click the Control-menu box on the screen.

The Alarm Banner appears in the Application File window as a separate screen. It cannot be renamed like other screens.

Alarm Message Display

With the Alarm Message Display selected in the Alarm Banner, you can access other alarm text in the application.

To scroll through alarm text in the application:

1. Select Alarm Message Display in the Alarm Banner.
2. Press the up and down arrow keys to scroll through available alarm text.

To select alarm text to appear in the Alarm Message Display:

1. Double-click the Alarm Message Display in the Alarm Banner.
   The Alarms tab (Alarm Setup dialog) opens.
2. Select the row number of the alarm text you want to appear in the display.
3. Click OK to exit the Alarm tab.
   The Alarm Message Display is updated with the selected text.

You can also create and edit alarm text directly from the Alarm Message Display.
Showing Alarm Banner Position

You can show the location of the Alarm Banner from any screen in the application. By showing the banner, you can see which objects are covered and which are not. This is important if you want to disable only those objects that are covered by the banner or to place objects on the screen where they will not be covered.

To toggle the Alarm Banner on or off:

Choose Alarm Banner Position from the View menu. A check mark (✓) next to the command indicates the banner is active.

The banner appears as a rectangle (white on color/grayscale terminals and black on monochrome terminals). You cannot move or size the banner unless you are in the Alarm Banner screen.
Creating an Alarm List

The Alarm List operates like a control list selector. The Alarm List can appear in the Alarm Banner or on another application screen.

Touch screen terminals require List keys to move the cursor up and down the Alarm List. You can optionally use the Enter list key to enable the operator to acknowledge an alarm in the list. The List keys are accessed from the Objects ▶ List Keys submenu.

To create an Alarm List:

1. Choose Alarm List from the Objects menu.

2. Place and size the object.

3. Double-click the object to open its dialog.

4. Under Display Fields, select:
   - fields to display for each alarm. The fields are displayed in the order shown with the alarm text appended to the fields.
   - text size of the characters in the list (the text sizes vary for the PanelView terminals).
   - number of lines (1 to 9) to display for each alarm entry. The maximum number of lines varies depending on the text size and the size of the Alarm List object.

The format of the entries in the Alarm List does not appear until you create alarm text (Alarms tab/Alarm Setup dialog).
5. Under Alarm Display Options, specify the alarm conditions and acknowledge statuses to appear in the list. Initially, all options are enabled. This means all alarms are displayed regardless of their condition or state providing the terminal buffer has space.

**Important:** Each Alarm List must display at least one alarm condition and one acknowledge status. If you deselect all check boxes, an error message appears.

For Alarm Conditions, you can display:
- active alarms – whose trigger conditions have been met. This option is only appropriate for bit triggered alarms.
- inactive alarms – that were triggered but no longer meet their trigger condition or were cleared.

For Acknowledge Status, you can display the following statuses of alarms (in the terminal):
- acknowledged alarms
- unacknowledged alarms
- no acknowledgement required

The next page shows examples of Alarm List configurations.

6. Under Input:
- select the function key to activate the list on keypad terminals
- disable or enable wrap around for the list cursor

Wrap around specifies whether the selection cursor moves to the top or bottom of the list when the operator presses the up or down arrow key on the first or last item in the list.
Alarm List Examples

You can create multiple alarm lists to display specific types of information for alarms.

• Active Alarms that have not been acknowledged. When a bit triggered alarm is acknowledged in the terminal, the alarm is automatically removed from the list. If an active alarm is cleared or no longer meets its trigger condition, it becomes inactive and is removed from the list. If the alarm is triggered again, the original alarm is not reactivated. A new instance of the alarm is created.

• Active Alarms that have been acknowledged. When a bit triggered alarm in the terminal is acknowledged, the alarm is automatically added to the list.

• Inactive Alarms that have been acknowledged. When an unacknowledged alarm in the terminal is acknowledged, the alarm is automatically added to the list.

For Alarm Lists with active alarms, when an active alarm becomes inactive, it is automatically removed from the list.
This section shows how to configure global parameters that apply to all alarms and alarm objects including:

- which screen objects to disable when Alarm Banner is displayed
- size of Alarm List and whether to clear the list on powerup
- data to print with alarm text when an alarm is printed
- acknowledge hold time and snapshot timeout

To configure global parameters for alarms:

1. Choose Alarm Setup from the Application menu.
2. Select the Setup tab.

3. Under Banner Popup, specify whether:

   - covered objects or partially covered objects are disabled when the Alarm Banner is displayed.
   - all screen objects are disabled when the Alarm Banner is displayed. This is the initial default.
4. Under Alarm Lists, specify:

<table>
<thead>
<tr>
<th>Clear Lists on Powerup</th>
<th>Select this option to clear all entries in Alarm Lists when the terminal is reset or power cycled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Specify the maximum number of alarms to store in the Alarm List. Select a value between 1 and 100. The default is 25. The maximum number of alarms actually stored depends on nonvolatile RAM available in terminal.</td>
</tr>
</tbody>
</table>

5. Under Print Items, select the data to print with alarm text when:

- Print Alarm button is pressed
- Alarm is configured to automatically print when triggered
- Print Alarm List button is pressed

The print items are:

- alarm date
- alarm time
- alarm acknowledge date
- alarm acknowledge time
- alarm trigger value

The items are printed in the order listed, with the alarm text appended to the items.

To print alarms, your terminal must be equipped with an RS-232 printer port.

6. Under Time Values specify:

<table>
<thead>
<tr>
<th>ACK Hold Time</th>
<th>Length of time the terminal holds the trigger value at the address defined by the Acknowledge tag. The hold time should exceed the scan time of the controller to ensure that it is read at least once. Hold time values are 0, 50, 250, 500, 750, or 1,000 milliseconds. The initial default is 500.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot Timeout</td>
<td>Length of time the terminal waits for the controller to complete I/O scans when an alarm is triggered. If the message contains embedded variables, the controller may have to complete several scans. Variables appear in the alarm message as ???? until the data is read. If the data is not read before the timeout occurs, the variable appears as **** . The timeout is entered in seconds. The initial default is 2 seconds.</td>
</tr>
</tbody>
</table>

7. Click OK to exit.
Defining Alarm Triggers

This section shows how to define triggers for alarms. For each trigger, you must define:

- trigger tag (Controller address the terminal monitors for an alarm trigger value. Most application use only one alarm trigger tag.)
- trigger type (Bit, LSBit, or Value)

Triggers are assigned to alarms in the Alarm Setup tab.

To create or edit alarm triggers:

1. Choose Alarm Setup from the Application menu.
   Or double-click the Alarm Message Display in the Alarm Banner.

2. Select the Alarm Triggers tab.
   
   Each alarm trigger is entered as a separate row in a spreadsheet. The cells in each row define specific information for each trigger.
   
   - to select a row, click the row number.
   - to select a cell, click on the cell, or press TAB or arrow keys.

   Some cells require you to enter text and some have drop-down lists to select options.

3. Click the Trigger Tag field.

   Select or enter a name for the address where the controller will write a bit or value to trigger an alarm condition.

   While in the Trigger Tag field, choose Edit Tag from the popup menu to edit the tag definitions. The Tag Form dialog opens. When done, click OK to close the dialog.

   The controller address of trigger tag must be the lowest address of the corresponding alarms.
4. In the Trigger Type field, select the type of trigger associated with the Trigger Tag address.

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>Trigger an alarm as it occurs. Multiple alarms can be triggered at once. The bit position can be within: • a word (bit 0 to bit 15) • a block of consecutive words. Reserve up to 16 consecutive words (bit 0 to bit 255) after the tag address. Each bit that changes from 0 to 1 will trigger an alarm whose trigger value corresponds to that bit. The controller program must reset each bit (0) after the corresponding alarm is displayed.</td>
</tr>
<tr>
<td>LSB</td>
<td>Trigger an alarm in a priority sequence (least significant bit to most significant bit) based on its bit position within: • a word (bit 0 to bit 15) • a block of consecutive words. Reserve up to 16 consecutive words (bit 0 to bit 255) after the tag address. The lowest order bit that changes from 0 to 1 will trigger an alarm whose trigger value corresponds to that bit. Higher order bits are ignored until the lower order bit is cleared by the controller program.</td>
</tr>
<tr>
<td>Value</td>
<td>Trigger an alarm based on a value at the Trigger Tag address. Trigger values for alarms are defined on the Alarms tab. Only one alarm can be triggered at a time for each trigger.</td>
</tr>
</tbody>
</table>

5. To add additional triggers, choose Append Trigger from the popup menu for each trigger you want to add.

Repeat steps 3 and 4 to define each trigger.

6. Select the Alarms tab to assign the triggers to alarm messages.

**Trigger Operations**

Many trigger operations are accessed from a menu. To open the menu, hold down the right mouse button or type CTRL+M.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut the selected trigger to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected trigger to the clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste the contents of the clipboard at the current row.</td>
</tr>
<tr>
<td>Insert and Paste</td>
<td>Paste the copied or cut trigger above the current row.</td>
</tr>
<tr>
<td>Append Trigger</td>
<td>Add a new trigger after the last trigger.</td>
</tr>
<tr>
<td>Insert Trigger</td>
<td>Insert a new trigger above the current trigger.</td>
</tr>
<tr>
<td>Delete Trigger</td>
<td>Permanently remove the current trigger.</td>
</tr>
<tr>
<td>Edit Tag</td>
<td>Open the Form View dialog while in the Trigger Tag field to enter or edit a tag definition for the selected tag.</td>
</tr>
<tr>
<td>Move Trigger Up</td>
<td>Move the current trigger up one row.</td>
</tr>
<tr>
<td>Move Trigger Down</td>
<td>Move the current trigger down one row.</td>
</tr>
<tr>
<td>Use Optional Fields</td>
<td>Display additional tag fields that can be assigned to a trigger. You can also enable the optional fields from the Setup tab.</td>
</tr>
</tbody>
</table>
Creating Alarms

This section shows how to create alarms for an application. Each alarm has the following attributes:

- alarm text (including time, date, numeric, or ASCII variable)
- value or bit to trigger alarm
- trigger tag (predefined on Alarm Triggers tab)
- whether alarm requires acknowledgement
- whether alarm is printed and/or displayed in the Alarm Banner when triggered
- background/foreground colors of alarm text

The trigger tag, variables in text, and other alarm tags (if used) must be in the same scan group.

To create or edit alarms:

1. Choose Alarm Setup from the Application menu.
   Or double-click the Alarm Message Display in the Alarm Banner.

2. Select the Alarms tab.
   Each alarm is entered as a row in a spreadsheet. Each row contains cells or fields which define the attributes of the alarm.
   - to select a row, click the row number.
   - to select a cell, click on the cell, or press TAB or arrow keys.
   Some cells require you to enter text, some have drop-down lists and others have check boxes to enable/disable an option.

3. Edit the alarm fields as necessary.

4. Add alarms by choosing Append Alarm from the popup menu for each alarm you want to add.

5. When done, click OK to exit dialog or select another tab.
## Alarm Fields

<table>
<thead>
<tr>
<th>Alarm Fields</th>
<th>Description</th>
<th>Notes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Enter the alarm text that will appear in the Alarm Banner and Alarm List when the alarm is triggered.</td>
<td>Maximum characters = 255. The text can include time, date or numeric variables. Embedded variables must be in the same scan group as the alarm tags.</td>
</tr>
<tr>
<td>Value/Bit</td>
<td>Specify the value or bit offset the controller writes to the Trigger Tag address when it detects an alarm condition. This causes the alarm text to appear in the Alarm Banner or Alarm List.</td>
<td>For Bit or LSBit, enter the bit offset from the trigger tag address that will trigger the alarm. • valid range is 0 to 255 for bit, unsigned/signed integer, or BCD data types. For bit array, the range is the array size. • 0 is a valid alarm message For Value: • valid range depends on data type of the trigger tag. • 0 is reserved.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Select the name of the trigger tag to associate with the alarm text.</td>
<td>The trigger tag and its attributes are defined on the Alarm Triggers tab.</td>
</tr>
<tr>
<td>Ack</td>
<td>Specifies whether the alarm text displayed in the Alarm Banner must be acknowledged by an operator or the controller.</td>
<td>Select the box to enable or disable the Ack option. An X in the box enables acknowledgement. The Display box must also be checked to acknowledge an alarm. The initial default is Ack disabled.</td>
</tr>
<tr>
<td>Print</td>
<td>Specifies whether the alarm text prints when the alarm is triggered. The alarm text is printed with the print options selected on the Alarms Setup tab.</td>
<td>Select the box to enable or disable the Print option. An X in the box enables the Print option. The initial default is Print disabled.</td>
</tr>
<tr>
<td>Display</td>
<td>Specifies whether the alarm text displays in the Alarm Banner when the alarm is triggered.</td>
<td>Select the box to enable or disable the Display option. An X in the box enables the display option. To acknowledge an alarm, you must enable this option. The initial default is Display enabled.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Defines the foreground color of the alarm message.</td>
<td>• black is the default for monochrome terminals • white is the default for color/grayscale terminals</td>
</tr>
<tr>
<td>Background</td>
<td>Defines the background color of the message.</td>
<td>• white is the default for monochrome terminals • red is the default for color terminals • black is the default for grayscale terminals</td>
</tr>
<tr>
<td>Text ID</td>
<td>Unique number assigned to alarm text.</td>
<td>The next available number is automatically generated each time new alarm text is created.</td>
</tr>
</tbody>
</table>
Value Triggered Alarms

This section shows an alarm setup using a Value type trigger. Trigger values must not exceed the range of the data type selected for the trigger tag (signed/unsigned integer, BCD).

The following setup shows 3 alarms (A,B,C) assigned to the alm_tag trigger. The Trigger Type is Value. The Value/Bit field shows a different trigger value (1, 2, 3) for each alarm. The value 0 is reserved.

In the Tag Editor, the tag definition for alm_tag is:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Tag Address</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>alm_tag</td>
<td>Unsigned Integer</td>
<td>N15:0</td>
<td>SLC_1</td>
</tr>
</tbody>
</table>

When the value 1 is entered in N15:0, Alarm C is triggered. When the value 2 is entered in N15:0, Alarm B is triggered and when the value 3 is entered in N15:0, Alarm A is triggered.
Bit or LSBit Triggered Alarms

This section shows an alarm setup using a Bit type trigger. The value/bit range for a bit trigger is 0 – 255 (bit, signed/unsigned integer, BCD data types). For bit array, the range is the array size. If using the Ack tag, the value/bit range begins with 1, instead of 0.

The following setup shows 3 alarms (A,B,C) assigned to the alm_tag trigger. The Trigger Type is Bit. In this case, the Value/Bit field is a bit offset from the Trigger Tag address (not a value).

In the Tag Editor, the trigger tag definition for alm_tag is:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Tag Address</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>alm_tag</td>
<td>Bit</td>
<td>N15:0/0</td>
<td>SLC_1</td>
</tr>
</tbody>
</table>

This tag handles up to 256 consecutive bits/alarms (0 – 255), N:15:0/0 to N15:15:15.

The controller address of the alarm trigger bit is the number in the Value/Bit field plus the Trigger Tag address.

Trigger Tag Address + Value/Bit = Trigger Bit Address

- Alarm C triggers when N15:0/1 changes from 0 to 1.
  \[ 1 + N15:0/0 = N15:0/1 \]
- Alarm B triggers when N15:0/2 changes from 0 to 1.
  \[ 2 + N15:0/0 = N15:0/2 \]
- Alarm A triggers when N15:0/3 changes from 0 to 1.
  \[ 3 + N15:0/0 = N15:0/3 \]

For the LSBit trigger, an alarm triggers when the trigger bit changes from 0 to 1 and all other bits between the Trigger Tag address and the trigger bit address are cleared. If the Trigger Tag address is N7:12/4 and the Value/Bit is 6, an alarm is triggered when N7:12/10 changes from 0 to 1. It is the only bit set between N7:12/4 and N7:12/10 inclusive.

If N7:12/4 is 1 when N7:12/10 changes to 1, the alarm corresponding to N7:12/10 will not trigger until N7:12/4 is reset to 0.
Alarm Operations

Operations you can perform on alarms are accessed from a menu. To open the menu, hold down the right mouse button or type CTRL+M.

<table>
<thead>
<tr>
<th>Select:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut selected cells, rows or columns to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected cells, rows or columns to the clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste the previously cut or copied cells, rows or columns to a spreadsheet area.</td>
</tr>
<tr>
<td>Insert and Paste</td>
<td>Paste the copied or cut alarm above the current row.</td>
</tr>
<tr>
<td>Append Alarm</td>
<td>Add a new alarm after the last alarm. The alarm is created with the next available number.</td>
</tr>
<tr>
<td>Insert Alarm</td>
<td>Insert a new alarm above the current alarm. The alarm is created with the next available number.</td>
</tr>
<tr>
<td>Delete Alarm</td>
<td>Permanently remove the selected alarm.</td>
</tr>
<tr>
<td>Embedded Variable</td>
<td>Opens a submenu to insert a time, date or numeric variable in the alarm Text. To edit a numeric variable, select Edit Variable.</td>
</tr>
<tr>
<td>Use Existing Text</td>
<td>Opens the Use Existing Text dialog allowing you to copy a message to the current row.</td>
</tr>
<tr>
<td>New Text ID</td>
<td>Changes the ID number of the text to the next available number.</td>
</tr>
</tbody>
</table>

Using Existing Text

When creating alarm text, you can create new text or reuse text that already exists in the application.

Reusing text saves time and memory. Text is only stored once regardless of the number times it is used.

To use existing text:

1. Select the row number of the alarm in which you want to copy existing text.
2. Click the right mouse button and choose Use Existing Text from the popup menu.
   
   The Existing Text dialog opens (in Read Only mode).
3. Select the row number of the text you want to copy.
4. Click the Apply button.
5. Click Close.

Both the Text and Text ID number are copied to the row of the selected alarm.

You can also enter the number of an existing text string in the Text ID field and the text will be copied.
Adding Variables to Alarm Text

In the Text field, you enter alarm text including a time, date or numeric variable. Embedded variables must be within the same scan group (40 words of the alarm tags).

To insert a time, date, numeric variable in a text string:

1. Double-click the Text field in which you want to insert a variable.
2. Position the cursor where you want to insert the variable.
3. From the popup menu, choose Embedded Variable » Time, Date, Variable, or ASCII.

For the Time and Date variable, a placeholder is inserted in the text (/*T*/ for time, /*D*/ for date). The format of the time and date is set in the Terminal Setup dialog.

A dialog opens when Variable (p. 17–14) or ASCII (p. 17–17) is selected. The dialog defines the format of the variable in the text string. When you exit the dialog, a placeholder is inserted within the text with embedded formatting details.

To edit a numeric or ASCII variable:

1. Double-click the Text field of the alarm containing the variable.
2. Click on the numeric /*V:12 NOFILL FIX:0*/ or ASCII /*A:12 */ variable placeholder.

The embedded data within the placeholder will vary depending on the options you selected in the Variable dialog.

3. From the popup menu, choose Embedded Variable » Edit Variable.
4. Edit the settings in the Variable dialog.
5. When done, click OK to exit dialog.

The placeholder is updated with the new formatting details.

Important: The tag which updates the numeric or ASCII variable should be scanned with the alarm trigger.

To delete a variable:

Click on the placeholder and choose Cut from the popup menu, or press BACKSPACE or DELETE.
The Alarm Triggers tab has optional tag fields that you can enable for each trigger:
- acknowledge (Ack) tag
- handshake tag used with trigger tag
- remote acknowledge (Ack) tag
- remote (Ack) handshake tag
- acknowledge all value

**To define optional tags:**

1. Enable the optional fields.
   - On the Setup tab, select the Use Optional Fields check box (X in box).
   - Or on the Alarm Triggers tab, hold down the right mouse button and choose Use Optional Fields from the popup menu.
   
   Both the Remote tags on the Setup tab and the optional tag fields on the Alarm Triggers tab are enabled.

   If the Use Optional Fields check box is cleared, all of the optional fields (and the Remote Tags on the Setup dialog) are disabled. PanelBuilder ignores any data in these fields.

2. In the tag fields, enter the tag names you want to use for each optional function.

   To edit the definition for each tag, select the tag name and click the Edit Tag button. The Tag Form dialog opens. Edit the tag definition and close the dialog.

3. In the Acknowledge All Value field, enter a value that will be used when acknowledging multiple alarms for a trigger (or when the controller acknowledges all active alarms).

4. Click another Setup tab or OK to exit Alarm Setup dialog.
<table>
<thead>
<tr>
<th><strong>Optional Fields</strong></th>
<th><strong>Tag Direction</strong></th>
<th><strong>Description</strong></th>
<th><strong>Notes:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack Tag</td>
<td>PanelView ➔ Controller</td>
<td>Name of address where the terminal writes a value to notify the controller when an alarm has been acknowledged. The terminal writes the trigger value or bit position value (Value/Bit field) of the trigger to the Ack tag address when: • operator presses Ack button • operator presses Enter key to acknowledge alarm in Alarm List • controller writes a value or triggers a bit at the Remote Ack tag address The terminal writes the Acknowledge All value to this address when: • Ack All button is pressed • Controller acknowledges all active alarms using the Ack, All Alarm tag (Setup tab).</td>
<td>This tag is ignored if the Ack option is disabled on the Alarms tab. The terminal clears the value at the Ack tag address when the Ack or Ack All button is released or the Acknowledge Hold time has expired, whichever is longer.</td>
</tr>
<tr>
<td>Handshake Tag (for Trigger)</td>
<td>PanelView ➔ Controller</td>
<td>Name of address where the terminal toggles a bit to indicate that it received new Alarm Trigger data from the controller.</td>
<td>This field is used in conjunction with the Trigger Tag.</td>
</tr>
<tr>
<td>Remote Ack Tag</td>
<td>Controller ➔ PanelView</td>
<td>Name of address where the controller acknowledges one or all alarms for a trigger. <strong>For Value Triggers</strong>, the controller writes the alarm’s trigger value to the Remote Ack address to acknowledge a single alarm. The controller writes the Acknowledge All value to the Remote Ack address to acknowledge all alarms for a trigger. <strong>For Bit/LSBit triggers</strong>: Remote Ack tag uses the same bit pattern as the trigger tag. To acknowledge all alarms for a trigger, the controller writes a 1 to the bit position that is one greater than the last trigger bit used (in the Value/Bit field). If the Ack tag is not used, the controller can acknowledge more than one alarm at a time. If the Ack tag is used, the controller can only acknowledge one alarm and must reset the bit before acknowledging the next alarm.</td>
<td>If the controller is acknowledging alarms, it is the responsibility of the controller program to reset/clear the value at the Remote Ack address. If the value is not reset/cleared, the operator will not be able to acknowledge alarms locally (at the terminal). The Remote Ack tag must be in the same scan group as the alarm trigger.</td>
</tr>
<tr>
<td>Remote (Ack) Handshake Tag</td>
<td>PanelView ➔ Controller</td>
<td>Name of address where the terminal toggles a bit to indicate that it received a new Remote Acknowledge value from the controller.</td>
<td>This tag is used only in conjunction with the Remote Ack tag.</td>
</tr>
<tr>
<td>Acknowledge All Value</td>
<td></td>
<td>Value written to the Ack tag or Remote Ack tag address when all alarms are acknowledged for a trigger. • operator presses the Ack All button • controller acknowledges all active alarms using the Ack, All Alarm tag (Setup tab). • controller acknowledges all alarms for a trigger by writing the Acknowledge All Value to the Remote Ack tag address. <strong>For Value triggers</strong>, the value is written to the Ack tag by the PanelView or Remote tag address by the controller. <strong>For Bit/LSBit triggers</strong>, the value is written to the Ack tag address only.</td>
<td>The Acknowledge All Value can be any value except for the trigger value assigned to alarms. Do not use the value 0 since PanelBuilder uses 0 as a reset value. Each trigger may have a different Acknowledge All Value.</td>
</tr>
</tbody>
</table>

① The PanelView terminal sets all handshake bits to 1 on powerup, regardless of whether an alarm is triggered or not.
Using the Remote Ack Tag with Value Triggered Alarms

This section shows how the controller acknowledges one or all value triggered alarms using the Remote Ack tag.

The following setup shows 3 alarms (A,B,C) assigned to the alm_tag trigger. The Trigger Type is Value. The Value/Bit field shows a different trigger value (1,2,3) for each alarm. The value 0 is reserved.

<table>
<thead>
<tr>
<th>Setup</th>
<th>Alarm Triggers</th>
<th>Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Trigger Tag</td>
<td>Trigger Type</td>
</tr>
<tr>
<td>1</td>
<td>alm_tag</td>
<td>Value</td>
</tr>
</tbody>
</table>

In the Tag Editor, alarm tag definitions are:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Tag Address</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>alm_tag</td>
<td>Unsigned Integer</td>
<td>N15:0</td>
<td>SLC_1</td>
</tr>
<tr>
<td>ack_tag</td>
<td>Unsigned Integer</td>
<td>N16:0</td>
<td>SLC_1</td>
</tr>
<tr>
<td>rem_ack</td>
<td>Unsigned Integer</td>
<td>N15:1</td>
<td>SLC_1</td>
</tr>
</tbody>
</table>

When the value 2 is entered at N15:0, Alarm B is triggered. When the controller returns this trigger value to N15:1 (rem_ack tag address), Alarm B is acknowledged. When the value 3 is entered at N15:0, Alarm A is triggered. When the controller returns this value to N15:1, Alarm A is acknowledged.

The Ack Tag must be a value/word address and returns the value of the alarm. The PanelView will input a value when you or the controller acknowledges an alarm.
Using the Remote Ack Tag with Bit Triggered Alarms

This section shows how the controller acknowledges one or all bit triggered alarms using the Remote Ack tag.

The following setup shows 3 alarms (A, B, C) assigned to the alm_tag trigger. The Trigger Type is Bit. The contents of the Value/Bit field is a bit offset from the Trigger Tag address.

One tag handles up to 256 consecutive bits/alarms (0 – 255), for example, N:15:0/0 to N15:15/15.

In the Tag Editor, alarm tag definitions are:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Tag Address</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>alm_tag</td>
<td>Bit</td>
<td>N15:0/0</td>
<td>SLC_1</td>
</tr>
<tr>
<td>ack_tag</td>
<td>Unsigned Int</td>
<td>N16:0</td>
<td>SLC_1</td>
</tr>
<tr>
<td>rem_ack</td>
<td>Bit</td>
<td>N15:16/0</td>
<td>SLC_1</td>
</tr>
</tbody>
</table>

When N15:0/2 changes from 0 to 1, Alarm B is triggered. Based on the contents of the Value/Bit field, this is a 2 bit offset from the Trigger Tag address (N15:0/0). When the controller writes a 1 to N15:16/2 (rem_ack tag address), Alarm B is acknowledged.

To acknowledge all alarms for the alm_tag trigger, the controller must write 1 to the bit position that is one greater than the highest value in the Value/Bit field. For example, setting N15:0/4 to 1 acknowledges all alarms. If the highest value in the Value/Bit field is 239 (N15:14/15), setting N15:15/0 to 1 acknowledges all alarms.

If you use the Ack Tag, the controller must acknowledge one alarm at a time and reset the bit (0) before acknowledging the next alarm. If you do not use the Ack Tag, the controller can acknowledge more than one alarm at a time.

The Ack Tag must be a value/word address and returns the value of the alarm, not the bit pattern. The PanelView will input a value when you or the controller acknowledges an alarm.
You can define optional tags that the controller will use to:

- acknowledge all active alarms
- clear all alarms in the terminal

These tags affect the alarm displayed in the Alarm Banner and alarms in the Alarm List.

**To define remote tags:**

1. Select the Setup tab from the Alarm Setup dialog.
2. Select the Use Optional Fields check box (X in box).
   
   The Remote Tags area of the dialog is made available for editing.
   
   This check box also enables the display of optional tag fields on the Alarm Triggers tab.

   If the Use Optional Fields check box is cleared, the Remote tags and the optional fields on the Alarm Triggers tab are disabled.

   PanelBuilder ignores any data in these fields.

3. Under Remote Tags, enter the tag names that you want the controller to use to acknowledge or clear all alarms.
   
   To edit the tag definition for each tag, select the tag name and click the Edit Tag button. The Tag Form dialog opens. Edit the tag definition and close the dialog.

4. When done, select another tab or click OK to exit dialog.
### Creating Alarms

<table>
<thead>
<tr>
<th>Remote Tags</th>
<th>Tag Direction</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack. All Alarms Tag</td>
<td>Controller → Terminal</td>
<td>Name of address where the controller sets a bit (1) or value to acknowledge all active alarms regardless of the trigger. The terminal monitors this address for a nonzero value. When the terminal sees a nonzero value, it writes the Acknowledge All Value defined for each trigger to the Ack tag address defined for each trigger. The Alarm Banner is removed from the terminal display and all alarms not acknowledged in the Alarm List are flagged as acknowledged. The value is held at the Ack tag address until the Acknowledge Hold Time expires and the controller has cleared the Ack All Alarms tag. It is the responsibility of the controller’s program to clear the value.</td>
<td>The Ack tag and Acknowledge All Value for alarm triggers are defined on the Alarm Triggers tab. While the Ack All Alarms address contains a nonzero value, the operator cannot acknowledge alarms locally (at the terminal) if the Ack tag is defined.</td>
</tr>
<tr>
<td>Ack. All Handshake Tag</td>
<td>Terminal → Controller</td>
<td>Name of address where the terminal toggles a bit to indicate that it received the Ack All Alarms value from the controller.</td>
<td>This tag is optional and used only in conjunction with the Ack. All Alarms tag.</td>
</tr>
<tr>
<td>Clear All Alarms Tag</td>
<td>Controller → Terminal</td>
<td>Name of address where the controller sets a bit or nonzero value to clear all alarms in the terminal. The Alarm Banner is removed from the terminal display and all alarms are removed from the Alarm List.</td>
<td></td>
</tr>
<tr>
<td>Clear All Alarms Handshake Tag</td>
<td>Terminal → Controller</td>
<td>Name of address where the terminal toggles a bit to indicate that it received the Clear All Alarms value from the controller.</td>
<td>This tag is optional and used only in conjunction with the Clear All Alarms tag.</td>
</tr>
</tbody>
</table>
Alarm Examples

This section provides examples of different alarm configurations ranging from simple to more complex.

Operator Acknowledges Alarm

In the example below, the operator presses the Ack button to acknowledge an alarm. Because the Acknowledge tag is not defined for the trigger, the controller is not notified. Optional Fields are not enabled for the alarm triggers.

Alarm Configuration

- Four alarms are assigned to the Pump trigger tag, each with a different trigger value
- All alarm messages are configured to display in the Alarm Banner and must be acknowledged

<table>
<thead>
<tr>
<th>Setup</th>
<th>Alarm Triggers</th>
<th>Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Text</td>
<td>Value/Bit</td>
</tr>
<tr>
<td>1</td>
<td>Msg A</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Msg B</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Msg C</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>Msg D</td>
<td>25</td>
</tr>
</tbody>
</table>

1. The PanelView reads the value 15 from the Trigger (Pump) address in the controller. This value triggers alarm Msg B.

2. Alarm Msg B is placed in the List

3. Alarm Banner displays alarm text.

4. Operator presses Ack button
   - Alarm Msg B is flagged acknowledged in the Alarm List
   - Alarm Banner is cleared from display
Operator Acknowledges Alarm and Notifies Controller

The operator presses the Ack button to acknowledge an alarm. The terminal notifies the controller by writing the alarm’s trigger value to the Ack address defined for the trigger. Optional Fields are enabled for the alarm triggers.

Alarm Configuration
– Four alarms are assigned to the Pump trigger tag, each with a different trigger value
– All alarm messages are configured to display in the Alarm Banner and must be acknowledged

① The PanelView reads the value 15 from the Trigger (Pump) address in the controller. This value triggers alarm Msg B.

② Alarm Msg B is placed in the Alarm List

③ Alarm Banner displays alarm text.

④ Operator presses Ack button
– Alarm Msg B is flagged acknowledged in the Alarm List
– Alarm Banner is cleared from display

⑤ The PanelView notifies the controller by writing the alarm’s trigger value (15) to the Ack address (PumpAck) defined for the trigger.
Controller Acknowledges a Single Alarm for a Specific Trigger

The controller acknowledges a single alarm activated twice by the same trigger. The controller writes the alarm’s trigger value to the Remote Ack address defined for the trigger. The terminal notifies the controller that it acknowledged the alarm by writing the alarm’s trigger value to the Ack address.

Optional Fields are enabled and defined for the alarm triggers.

Alarm Configuration
– 4 alarms are assigned to the Extruder1 trigger, each with a different trigger value
– 6 alarms are assigned to the Extruder2 trigger, each with a different trigger value
– All alarms messages are configured to display and must be acknowledged
– A Remote Ack tag and Ack tag are defined for each trigger

### Alarm Configuration

<table>
<thead>
<tr>
<th>Trigger Tag</th>
<th>Trigger Type</th>
<th>Ack Tag</th>
<th>Remote Ack Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extruder1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extruder2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

③ The PanelView writes the trigger value 15 to the Ack address (Ex1Ack) defined for the Extruder1 trigger.

④ Both occurrences of Msg B activated by the Extruder 1 trigger are acknowledged in the Alarm List.

Alarm List
- Extruder1 Msg B – Acknowledged
- Extruder2 Msg B
- Extruder2 Msg E
- Extruder1 Msg A
- Extruder1 Msg D
- Extruder1 Msg B – Acknowledged
- Extruder2 Msg A

① The controller acknowledges Msg B activated by the Extruder1 trigger by writing the alarm’s trigger value 15 to the Remote Ack address (Ex1RemoteAck) of the trigger.

② The PanelView reads the value 15 from the Remote Ack address in the controller.
Creating Alarms

Controller Acknowledges All Alarms for a Specific Trigger

The controller acknowledges all alarms activated by the same trigger. The controller writes the Acknowledge All Value defined for the trigger to the trigger’s Remote Ack address. The terminal notifies the controller that it acknowledged all alarms for the trigger by writing the Acknowledge All Value to the trigger’s Ack address.

Optional Fields are enabled and defined for the alarm triggers.

Alarm Configuration
- 6 alarms are assigned to the Extruder2 trigger, each with a different trigger value
- All alarm messages are configured to display and must be acknowledged
- A Remote Ack tag, Ack tag, and Acknowledge All Value are defined for each trigger
- 4 alarms are assigned to the Extruder1 trigger, each with a different trigger value

① The controller acknowledges all alarms activated by the Extruder1 trigger by writing the trigger’s Acknowledge All Value 99 to the Remote Ack address (Ex1RemoteAck) of the trigger.

② The PanelView writes the Acknowledge All Value 99 to the trigger’s Ack address (Ex1Ack).

③ All alarms activated by the Extruder1 trigger are acknowledged in the Alarm List.

#### Alarm List

<table>
<thead>
<tr>
<th>Extruder1</th>
<th>Msg B – Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extruder2</td>
<td>Msg B</td>
</tr>
<tr>
<td>Extruder2</td>
<td>Msg E</td>
</tr>
<tr>
<td>Extruder1</td>
<td>Msg A – Acknowledged</td>
</tr>
<tr>
<td>Extruder1</td>
<td>Msg D – Acknowledged</td>
</tr>
<tr>
<td>Extruder1</td>
<td>Msg B – Acknowledged</td>
</tr>
<tr>
<td>Extruder2</td>
<td>Msg A</td>
</tr>
</tbody>
</table>

④ The PanelView reads the value 99 from the Remote Ack address in the controller.
Controller Acknowledges All Alarms for all Triggers

The controller acknowledges all alarms in the terminal by setting a bit or value at the Ack. All Alarms tag address. The terminal sees a nonzero value at this address and then writes the Acknowledge All Value for each trigger to the Ack address for each trigger.

Optional Fields are enabled on the Alarm Setup tab and the Alarm Triggers tab.

**Alarm Configuration**
- 4 alarms are assigned to the Extruder1 trigger, each with a different trigger value
- 6 alarms are assigned to the Extruder2 trigger, each with a different trigger value
- All alarm messages are configured to display and must be acknowledged
- A Remote Ack tag, Ack tag, and Acknowledge All Value are defined for each trigger
- An Ack. All tag is defined on the Alarm Setup dialog. The controller uses this tag to acknowledge all alarms in the terminal

All alarms activated by the Extruder1 and Extruder2 triggers are acknowledged in the Alarm List.

The PanelView notifies the controller by writing
- Acknowledge All Value 99 for the Extruder1 trigger to the trigger’s Ack address (Ex1Ack)
- Acknowledge All Value 100 for the Extruder2 trigger to the trigger’s Ack address (Ex2Ack)

The controller sets a bit at the Ack. All tag address (RemoteAckAll), defined on the Alarm Setup tab, to acknowledge all active alarms for all triggers.

The PanelView reads a nonzero value at the RemoteAckAll address.
Adding Graphics

Chapter Objectives

This chapter shows how to add graphics and background text to screens. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>16–1</td>
</tr>
<tr>
<td>Graphic Objects</td>
<td>16–2</td>
</tr>
<tr>
<td>Graphic Tools</td>
<td>16–2</td>
</tr>
<tr>
<td>Drawing a Line</td>
<td>16–3</td>
</tr>
<tr>
<td>Drawing Connected Lines</td>
<td>16–4</td>
</tr>
<tr>
<td>Drawing Shapes</td>
<td>16–5</td>
</tr>
<tr>
<td>Freeform Drawings</td>
<td>16–6</td>
</tr>
<tr>
<td>Adding ISA Symbols</td>
<td>16–7</td>
</tr>
<tr>
<td>Adding Background Text</td>
<td>16–8</td>
</tr>
<tr>
<td>Importing/Exporting Bitmap Graphics</td>
<td>16–10</td>
</tr>
<tr>
<td>Using Background Graphics</td>
<td>16–16</td>
</tr>
</tbody>
</table>

Helpful Hints

When creating graphics, consider the following:

- Freehand drawings are memory intensive. For complicated drawings, create a bitmap graphic of the drawing with another source program and then import the graphic.
- Circles process more efficiently in the terminal than ellipses. Use circles whenever possible.
- Imported bitmaps are handled like global objects. The terminal stores only one copy of a bitmap image regardless of the number of links to it in an application.
- Imported bitmaps cannot exceed the number of pixels supported by the terminal display. Larger bitmaps are cropped.
- You can import/export monochrome or color bitmaps.
- On color terminals, full color bitmaps are imported as standard 16 EGA color images. If the bitmap contains more colors, each color is mapped to one of the 16 standard colors.
- On grayscale terminals, full color bitmaps are imported as 4 color (shades of gray) images.
- Color bitmaps are exported as they are stored in PanelBuilder. If a full color bitmap was reduced to 16 or 6 colors when imported, it is exported in the same format.
- When using graphics with control objects, use the Move Dynamic Objects Front command after completing an application screen. The screen will then appear the same as it would on the PanelView terminal.
Graphic Objects

PanelBuilder provides tools for drawing a variety of shapes: lines, ellipses, circles, rectangles, squares, polygons (connected lines) and freeform drawings.

In addition, you can import bitmap graphics created with other programs, use standard ISA symbols, and add text to screens.

The text tool lets you add text to a screen that’s not linked to an object.

Graphics are created similar to control and display objects. Unlike control and display objects, however, graphics can overlap.

Inside the display area of the screen, the pointer appears as a + to indicate where a line or shape appears when you start drawing.

Graphics are created by selecting commands from the Objects ➤ Graphics submenu or by selecting a tool from the toolbox.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>➔</td>
<td>Draws a straight line.</td>
</tr>
<tr>
<td></td>
<td>Draws open connected lines or simple polygons using connected straight lines.</td>
</tr>
<tr>
<td></td>
<td>Draws a rectangle or square.</td>
</tr>
<tr>
<td></td>
<td>Draws an ellipse.</td>
</tr>
<tr>
<td></td>
<td>Draws a freehand drawing.</td>
</tr>
<tr>
<td></td>
<td>Adds background text.</td>
</tr>
<tr>
<td></td>
<td>Adds a bar graph scale.</td>
</tr>
<tr>
<td></td>
<td>Opens a dialog for importing or exporting bitmap graphics.</td>
</tr>
<tr>
<td></td>
<td>Places a background graphic image.</td>
</tr>
</tbody>
</table>
Use the Line command or Line tool to draw straight lines. As you draw a line, you can drag it to any size or angle.

**To draw a line:**

1. Click the Line tool in the toolbox.
   Or choose Line from the Objects > Graphics submenu.
2. Position the pointer (+) where you want to start the line.
3. Hold down the left mouse button and drag.
   A line stretches from the starting point to the position of the pointer, changing length and position as you move the mouse.
4. When the line is the right size, release the mouse button.
5. To draw another line, move the pointer to a new location and repeat steps 3 and 4.
6. Click the right button to exit line mode.
   Or click the selection tool on the toolbox.

Use foreground colors when applying color to lines.
Use the Connected Line command or tool to draw open connected lines or shapes such as triangles and other simple polygons.

To draw connected lines:

1. Click the Connected Line tool in the toolbox.
   Or choose Connected Line from the Objects > Graphics submenu.
2. Position the pointer (+) where you want to anchor one end of the first line and click the left mouse button.
3. Move the pointer where you want to end the line and start the next line, and click the left mouse button.
   You can adjust the position of the line before clicking.
4. Repeat step 3 for each line you want to draw.
5. After drawing the last line, double-click.
6. Click the right mouse button to exit connected line mode.
   Or click the selection tool on the toolbox.
When drawing a shape you can drag it to any size, width or height.

**Note:** Circles process more efficiently than ellipses in the terminal. Whenever possible use circles.

To **create a shape**:

1. Click the appropriate tool from the toolbox.
   - Creates a rectangle or square
   - Creates an ellipse or circle

   Or choose Rectangle, Ellipse or Circle from the Objects ➤ Graphics submenu.

2. Position the pointer (+) where you want to start drawing one corner of the shape.

3. Hold down the left mouse button and drag the pointer to size the shape. Release the mouse button when the shape is the right size.

   When drawing a circle or ellipse, an imaginary rectangle surrounds the object.

4. To draw another shape, move the pointer to a new location and repeat step 3.

5. Click the right mouse button to exit shape mode.

   Or click the selection tool on the toolbox.

*To draw a square, hold down the SHIFT key as you drag.*

*To draw a circle, hold down the SHIFT key as you drag.*
You can create your own freehand drawings.

**To create a freeform drawing:**

1. Click the Freeform tool in the toolbox  
   Or choose Freeform from the Objects ➤ Graphics submenu.
2. Position the pointer where you want to start drawing.
3. Hold down the left mouse button and drag the mouse while drawing. When done drawing, release the left mouse button.
4. Click the right mouse button to exit freeform mode.  
   Or click the selection tool on the toolbox.

Freehand drawings are memory intensive. For complicated drawings, create a bitmap graphic of the drawing with another source program and then import the graphic.
PanelBuilder provides a set of standard ISA symbols that you can add to a screen. They are accessed from the ISA Symbols toolbox. See Appendix B for a description of each symbol.

ISA symbols can be moved but not sized.

To add an ISA symbol to a screen:

1. Click the symbol you want from the ISA Symbols toolbox.
2. Position the pointer (+) and click the left mouse button to place the symbol.
   The symbol is automatically selected.

3. Click the right mouse button to exit ISA Symbol mode.
   Or click the selection tool on the toolbox.

You can also place ISA symbols inside a button or multistate object. See Chapter 17 for details.

You can apply foreground and background colors to an ISA symbol.
Adding Background Text

The text tool lets you add text to a screen that’s unattached or not linked to an object. This is called background text. Examples of background text are tick-mark labels for bar graph scales, outer text for push buttons or control lists, time and date stamps, variable read outs, screen titles and so on.

Background text is handled as a separate object unless you group it with other objects.

Background text can contain up to 255 characters using the default text size and can appear anywhere on the screen. You can resize text and use different types of emphasis such as underlining, blinking, or toggling the foreground/background colors.

Text is entered using the same technique that’s used for objects that contain inner text.

To create background text:

1. Click the Text tool in the toolbox.

   Or choose Text from the Objects ➤ Graphics submenu.

2. Position the pointer and click the left mouse button to place the default text block size. Or drag the pointer to size the text block.

   The text object is selected and you are placed in inner text mode.

3. Enter text in the Text box.

   As you enter text, it’s also entered in the block. If word wrap is on, text wraps at the beginning of a word, not in the middle. (Word Wrap is set from the Format menu.) An asterisk (*) appears if the text exceeds the object size.
– To delete text, drag the pointer over the text to highlight it, then press BACKSPACE or DELETE.
– To replace text, drag the pointer over the text to highlight it, then type the new text.
– To add text, position the cursor where you want to insert text and then type the new text.

Press ENTER to start a new line. This character /∗ is inserted to indicate a new line.

4. To create another text block, repeat steps 2 and 3.
5. Click the right mouse button to exit text mode.
   Or click the selection tool in the toolbox.
6. When done, click the Inner Text tool to exit inner text mode.
   When you deselect the text block, the border becomes invisible.
7. Resize the text blocks, if necessary, so that all text fits inside.
You can use formatting commands to change the appearance of text while entering text or at a later time. For details on how to format text or insert a time, date, or variable in a text block see Chapter 17.

To edit background text:
1. Select the text block.
2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
   The format bar shows this view.

   Text: 1

3. Edit the text in the Text box.
4. Resize the text block, if necessary, so that all text fits inside.
5. When done, click the Inner Text tool to exit inner text mode.

To apply color to background text:
1. Select the text block.
2. Choose a color from the Format ▶ Foreground Color submenu.
   Or select a foreground color from the top row of the Color Palette.
The Import/Export Graphics command lets you import bitmap graphics from other programs including:

- monochrome bitmaps
- color bitmaps

Imported graphics can be used as inner graphics for button objects or as background screen objects.

Bitmap graphics are handled like global objects. If an application uses the same bitmap several times, the terminal only stores one copy of the graphic. Any changes to a bitmap affect all other instances of that graphic.

Size of Bitmaps

An imported bitmap cannot exceed the number of pixels supported by the terminal display. Larger bitmaps are cropped when imported.

Editing Bitmaps

You cannot edit an imported graphic in PanelBuilder. To edit a graphic, you must export the graphic to a file or the clipboard, edit the graphic using another program and then re-import the graphic.

When a bitmap is edited and re-imported, PanelBuilder updates all instances of that image in the application.

About Color Bitmaps

Color terminals support the 16 standard EGA colors. If you import a full color bitmap, each color is mapped to one of the 16 EGA colors. A color bitmap, reduced to 16 colors on import, is exported as a 16 color bitmap.

Grayscale terminals support 4 colors (shades of gray). If you import a full color bitmap, each color is mapped to one of 4 colors. A color bitmap, reduced to 4 colors on import, is exported as a 4 color bitmap.
From the Import/Export Graphics dialog you can:
- Import a bitmap graphic from a file (*.BMP) or the clipboard.
- View a bitmap graphic.
- Export a bitmap graphic to a file or the clipboard.
- Delete a bitmap graphic.

To open the Import/Export Graphics dialog:
- Click the Import Graphics tool in the toolbox.
- Or choose Import/Export Graphics from the File menu.

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import</td>
<td>Import a bitmap graphic (.BMP) from a file. See Appendix B for a list of bitmaps provided in the C:\AB\PBWIN\PBLIB folder.</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste a bitmap graphic from the clipboard.</td>
</tr>
<tr>
<td>Export</td>
<td>Export an imported graphic to a file.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy an imported graphic to the clipboard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete an imported graphic. ISA symbols can’t be deleted from the graphic list.</td>
</tr>
</tbody>
</table>
To import a bitmap graphic from a file:

1. Click the Import button from the Import/Export Graphics dialog. The Open dialog appears.

The File List box shows all files in the current folder of the selected type (.BMP). You can change to another drive or folder before selecting a file.

See Appendix B for a list of bitmaps that PanelBuilder provides in the C:\AB\PBWIN\PBLIB folder.

2. Select the file you want to import and click the OK button. Or double-click on the file name.

3. The Graphic Name dialog opens showing the name of the selected file.

4. In the Name box, enter a unique name for the graphic.

5. Under Color Format, specify whether you want to import the color graphic as a monochrome bitmap or 16-color bitmap.

   • If importing a monochrome bitmap, the Color Format area is dimmed.
   • If importing a color bitmap on a grayscale terminal, the Color Format area is reduced to 4 colors.

6. Click OK to exit the Graphic Name dialog.

   You return to the Import/Export Graphics dialog. The graphic appears in the list of Currently Imported Graphics.

7. Click Done to exit the Import/Export Graphics dialog.
To paste a bitmap graphic from the clipboard:

1. Copy or cut the graphic to the clipboard from the source program.

2. Run PanelBuilder and open the Import/Export Graphics dialog from the File menu.

3. Click the Paste button to import the graphic from the clipboard.

   The Graphic Name dialog opens.

4. In the Name box, enter a unique name for the graphic.

5. Under Color Format, specify whether you want to paste the color graphic as a monochrome bitmap or 16-color bitmap.

   If you are pasting a monochrome bitmap, the Color Format area is dimmed.
   - If pasting a monochrome bitmap, the Color Format area is dimmed.
   - If pasting a color bitmap on a grayscale terminal, the Color Format area is reduced to 4 colors.

6. Click the OK button.

   You return to the Import/Export Graphics dialog. The name appears in the list of Currently Imported Graphics.

7. When finished, click the Done button.
To view an imported graphic:

1. From the list of Currently Imported Graphics, select the graphic you want to view. The graphic appears in the Sample area.

2. Select another graphic. The new view replaces the previous view. You can also use the UP and DOWN arrow keys to view other graphics. Each time you press a key the view changes to another.

3. When finished, click the Done button.

To copy an imported graphic to the clipboard:

1. Select the name of the graphic you want to copy to the clipboard.

2. Click the Copy button.

   The graphic is copied to the clipboard.

3. When finished, click the Done button.

   You can now exit PanelBuilder and paste the graphic from the clipboard into another program such as Paintbrush.
To export an imported graphic to a file:

1. Select the name of the graphic you want to export.

   Color bitmaps are exported in the format they are stored in PanelBuilder. If a full color bitmap was reduced to 16 colors when imported, it is exported as a 16 color bitmap.

2. Click the Export button.

   The Save As dialog opens.

3. In the File Name box, enter a file name for saving the graphic. If you omit the file type, PanelBuilder adds .BMP.

   You can change the drive and folder before entering the file name.

4. Click OK.

   You return to the Import/Export Graphics dialog.

5. When finished, click the Done button.

To delete an imported graphic:

1. Select the graphic you want to delete from the list of Currently Imported Graphics. ISA symbols can’t be deleted.

2. Click the Delete button.

   The file is removed from the list.

3. When finished, click the Done button.
Adding Graphics

Imported bitmap graphics can appear inside a button object or as a background object on the screen. This section shows how to use an imported graphic as a background object.

**To place an imported graphic on the screen:**

1. Click the Graphic Image tool in the toolbox.
   
   Or choose Graphic Image from the Objects ➤ Graphics submenu.

2. Position the pointer where you want to place the graphic and click the left mouse button.

   ![Imported Graphic]

   The image border is selected and you’re placed in inner graphic mode.

3. Select a graphic from the Graphics list box.

   You can import graphics by clicking the icon on the format bar.

   The border is sized to the graphic and becomes invisible. The image is automatically selected.

   ![Imported Graphic]

   While the image is selected (Graphics list box is reverse video) you can view other graphics using the UP and DOWN arrow keys. Each time you press a key the current view is replaced with another.

4. Exit graphic image mode by clicking the selection tool in the toolbox.

   Or click the right mouse button.

5. Click to exit inner graphic mode.

   Or choose Inner Graphic from the Format menu.
Chapter Objectives

This chapter shows how to change the appearance of objects and text. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format Options</td>
<td>17–2</td>
</tr>
<tr>
<td>Changing the Appearance of Objects</td>
<td>17–3</td>
</tr>
<tr>
<td>Changing Object Shape</td>
<td>17–4</td>
</tr>
<tr>
<td>Changing Line Type</td>
<td>17–5</td>
</tr>
<tr>
<td>Changing Fill Pattern</td>
<td>17–6</td>
</tr>
<tr>
<td>Using the Blink Option</td>
<td>17–7</td>
</tr>
<tr>
<td>Setting Foreground/Background Colors</td>
<td>17–8</td>
</tr>
<tr>
<td>Reversing Foreground/Background Colors</td>
<td>17–9</td>
</tr>
<tr>
<td>Working with Inner Text</td>
<td>17–10</td>
</tr>
<tr>
<td>Editing Inner Text</td>
<td>17–11</td>
</tr>
<tr>
<td>Inserting Time or Date</td>
<td>17–13</td>
</tr>
<tr>
<td>Inserting a Numeric Variable</td>
<td>17–14</td>
</tr>
<tr>
<td>Inserting an ASCII Variable</td>
<td>17–16</td>
</tr>
<tr>
<td>Working with Inner Graphics</td>
<td>17–19</td>
</tr>
<tr>
<td>Adding Inner Graphic</td>
<td>17–20</td>
</tr>
<tr>
<td>Setting Foreground/Background Colors</td>
<td>17–21</td>
</tr>
<tr>
<td>Reversing Foreground/Background Colors</td>
<td>17–22</td>
</tr>
<tr>
<td>Removing Inner Graphic</td>
<td>17–23</td>
</tr>
<tr>
<td>Editing Graphics</td>
<td>17–23</td>
</tr>
<tr>
<td>Changing the Appearance of Text</td>
<td>17–24</td>
</tr>
<tr>
<td>Sizing Text</td>
<td>17–25</td>
</tr>
<tr>
<td>Aligning Text</td>
<td>17–26</td>
</tr>
<tr>
<td>Underlining Text</td>
<td>17–27</td>
</tr>
<tr>
<td>Using the Blink Option</td>
<td>17–28</td>
</tr>
<tr>
<td>Setting Foreground/Background Colors</td>
<td>17–29</td>
</tr>
<tr>
<td>Reversing Foreground/Background Colors</td>
<td>17–30</td>
</tr>
</tbody>
</table>

**ATTENTION:** Some combinations of format options could result in a control object not being visible (object blends into screen background). All touch screen controls must be visible or have a graphic showing the location of the object. Failure to do so may result in accidental or unpredictable operation.
You can change the visual characteristics of objects and text from the Format menu or the Format bar.

The Format bar has different views depending on what mode you’re in. The views are shown below.

For multistate objects, many of the formatting options can be set directly from the State tab of the object’s dialog.
Objects have visual characteristics that you can change such as:
- shape
- line type
- fill pattern
- blinking
- setting foreground/background colors
- toggling foreground/background

When an object is selected the Format bar changes to show this view.

To change an object’s appearance, select the object and then choose a command from the Format menu or click a tool on the Format bar.

Some of the options toggle on and off, others open a menu. To toggle a setting from the Format bar, click the tool once to turn it on, click it again to turn it off. The new setting remains active until you change it.

A check mark (✓) appears next to the active settings on the menu.
Changing Object Shape

You can change the shape of a button or the shape of a graphic using the shape tools. For example, you can change the shape of a push button to a circle or the shape of a rectangle to an ellipse.

Circles require less memory and process more efficiently than ellipses in the terminal.

To change a shape:
1. Select the object.
2. Click the Shape tool from the Format bar.
   Or choose Shape from the Format menu.
   The Shape submenu opens.
3. Choose the shape you want for the selected object.

The object changes shape but maintains all other characteristics such as border type, foreground/background colors and so on.

When changing an ellipse to a rectangle, the rectangle fits inside the same rectangular area as the original shape. When changing a rectangle or ellipse to a circle, the circle is resized to fit inside the rectangular area.

The only fill patterns retained when changing the shape to a circle or ellipse are white, black or none.

If you select an object that can’t be shaped, the Format commands appear dimmed to show the shape can’t be changed.
Changing Line Type

You can change the border or edge of an object using the Line Type command.

- On monochrome terminals, the line type options are:
  - black
  - white
  - none (invisible)

- On color and grayscale terminals, the line type options are:
  - solid
  - none (invisible)

To change the line type:

1. Select the object.

2. Click the Line Type tool on the Format bar.
   
   Or choose Line Type from the Format menu.

   The Line Type submenu opens.

3. Choose the line type you want for the selected object.

   The line type changes but the object maintains all other characteristics such as shape, fill pattern and so on.

If you select an object that can’t have an invisible border, the line type commands are dimmed to show the line type can’t be changed.
Changing Fill Pattern

The interior of rectangular objects can be filled with a solid color or a pattern. You can apply a different fill pattern to each state of a multistate object so that the fill pattern changes with each state. The default fill pattern is white.

On color or grayscale terminals, you can not assign fill patterns to circles or ellipses. On monochrome monitors, valid fill patterns for circles and ellipses are black, white or none.

To add a fill pattern:

1. Select the object.

2. If the object is a multistate object, select a state.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

3. Click the Fill tool on the Format bar.
   Or choose Fill Pattern from the Format menu.

4. Choose a fill option.

   After selecting the fill pattern, the pattern appears in the object. If you select an object that can’t be filled, the fill commands appear dimmed to show the fill can’t be changed.

   The fill changes but the object maintains all other characteristics such as shape, line type and so on.

   For multistate objects, you can set the fill pattern for a state directly from the State tab of the object’s dialog.
Using the Blink Option

You can toggle blinking on or off for an object (including fill pattern and border). For multistate objects you can toggle blinking on or off for each state. The blink option is not valid for list objects.

The blink rate is approximately .5 seconds and is activated when the application is running in the PanelView terminal. Blinking isn’t activated for an object during application design.

Text within the object does not blink. To activate blinking for text, enter inner text mode and then select the blink option.

To toggle blinking for an object:

1. Select the object.
2. If the object is a multistate object, select a state.
   • From the tool bar, select a state from the State box.
   • Or choose Next State or Previous State from the Format menu.
3. Click the Blink tool on the Format bar.
   Or choose Blink from the Format menu.

   Blinking is set for the object but the object maintains all other characteristics such as fill pattern, line type and so on.

   If blinking is invalid for an object, the command is dimmed.

   For multistate objects, you can activate blinking for a state directly from the State tab of the object’s dialog.
Setting Foreground/Background Colors

For color and grayscale terminals, you can change the foreground and background colors of objects from the Format menu or the color palette. The palette has either 16 colors (for color terminals) or 4 colors (for grayscale terminals).

On color terminals, the initial background color of objects is blue and the foreground is white. On grayscale terminals, the initial background color of objects is black and the foreground white.

To set the foreground and background colors of an object:

1. Select the object.
2. If the object is a multistate object, select a state.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.
3. To change the foreground color:
   - Click a color on the top row of the color palette.
   - Or choose a color from the Format ➤ Foreground Color menu.
   
   The foreground color changes to the selected color.
4. To change the background color:
   - Click a color on the bottom row of the color palette.
   - Or choose a color from the Format ➤ Background Color menu.
   
   The background color changes to the selected color.

You can also set foreground/background colors for:
- inner text
- inner graphics (monochrome bitmaps only)

If you want the background of the object to match the text or graphic, you must set the background colors separately.

For multistate objects, you can set the foreground/background colors for each state of an object from the State tab of the object’s dialog.

For list objects, the background color applies to the entire list.
Reversing Foreground/Background Colors

You can reverse the foreground/background colors of objects. For multistate objects, you can reverse the foreground/background of each state.

- On monochrome terminals, the background and foreground colors of an object toggles between black and white.

- On color and grayscale terminals, the background and foreground colors of an object toggle between the set colors.

You cannot reverse the foreground/background colors of a list object.

To reverse the foreground and background colors:

1. Select the object.

2. If the object is a multistate object, select a state.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

3. Click the Toggle Foreground/Background tool on the Format bar.
   - Or choose Toggle Fore/Background from the Format menu.

   The object colors (including fill pattern, inner text and/or inner graphic) are reversed.

You can reverse the foreground/ background colors separately for:

- inner text
- inner graphics (monochrome bitmaps only)
Working with Inner Text

Most objects are created with default inner text that can be edited and formatted. The inner text appears inside the object and is linked to the object. When you move or delete the object, the inner text is also moved or deleted.

Push buttons and multistate objects can have different inner text for each state. The text appears when the object is in the specified state.
Editing Inner Text

This section shows how to edit inner text for an object. Remember, if the object is multistate, the text appears only for the specified state.

Editing inner text for objects without states is somewhat different than for multistate or list objects. The procedures that follow describe both options.

To edit inner text for an object without states:

1. Select the object.

2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
   The Format bar shows the current text with the insertion point following the text.

   ![Format Bar](Format.png)

   For numeric data display or numeric entry objects, you’ll see a variable placeholder /*V*/ with formatting details in the text box. You can’t delete this variable but you can add text before or after.

   ![Variable Placeholder](Variable.png)

   A number is automatically assigned to each text string in an application. This number appears to the left of the Text box.

3. Edit the text.
   As you edit text, it’s also entered in the object. If word wrap is on, text wraps at the beginning of a word, not the middle. (Word Wrap is set from the Format menu.) An asterisk (*) appears if the text exceeds the object size.

   - To delete text, drag the pointer over the text to highlight it, then press BACKSPACE or DELETE.
   - To replace text, drag the pointer over the text to highlight it, then type the new text.
   - To add text, position the cursor where you want to insert text and then type the new text.

   Press ENTER to start a new line. The characters /*R*/ are inserted to indicate a new line.

4. Resize the object, if necessary, to fit all the text.

5. When done, click the Inner Text tool to exit inner text mode.
To edit inner text for a multistate or list object:

1. Select the object.

2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
   
   The Format bar shows the current text with the insertion point following the text.
   
   ![Text string number](image)

   A number is automatically assigned to each text string in an application. This number appears to the left of the Text box.

3. Select the state or entry you want to edit.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

4. Edit the text.
   
   As you edit the text, it’s also entered in the object. If word wrap is on, text wraps at the beginning of a word, not than the middle. (Word Wrap is set from the Format menu). An * appears if the text exceeds the object size.
   
   - To delete text, drag the pointer over the text to highlight it, then press BACKSPACE or DELETE.
   - To replace text, drag the pointer over the text to highlight it, then type the new text.
   - To add text, position the cursor where you want to insert text and then type the new text.
   
   Press ENTER to start a new line (except for list objects). The characters /*R*/ are inserted to indicate a new line.

5. Repeat steps 3 and 4 to edit text for another state or entry.

6. Resize the object, if necessary, to fit all the text.

When done, click the Inner Text tool to exit inner text mode.

For multistate or list objects, you can edit the text for each state directly from the State tab of the object’s dialog.
Inserting Time or Date

You can insert time or date in an object or within the text of an object. The format of the time or date is adjusted from the Terminal Setup dialog. The time displays in 12 hour or 24 hour format. The date can display in various forms of MM/DD/YY.

The time or date format is downloaded with the application to the PanelView terminal. When the application is running, the terminal displays the actual time or date.

To insert the time or date in an object or text string:

1. Select the object.
2. For a multistate object, select the state in which you want to insert the time or date.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.
3. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
   The Format bar shows the current text.

4. Click where you want to insert the time or date or use the arrow keys to position the insertion point.

   To display only the time or date, delete the text first by dragging the pointer over the text to highlight it, then press BACKSPACE or DELETE.

5. Click the Embedded Variable tool on the Format bar and choose Time or Date from the popup menu.
   Or choose Time or Date from the Format ➤ Embedded Variable menu.
   The time /T/ or date /D/ placeholder is inserted in the text box and the time or date format is inserted in the object.
6. Resize the object, if necessary, to fit all the text.
7. Click the Inner Text tool to exit inner text mode.

For multistate objects, you can add a time or date variable to the text of a specific state from the State tab of the Object’s dialog.
Inserting a Numeric Variable

You can insert a numeric variable (associated with a tag address) in an object or text string. The variable can appear with a fixed or floating point decimal, with or without zero fill.

When the application is running, the PanelView terminal reads the value stored at the tag address and displays the value.

To insert a numeric variable in an object or text string:

1. Select the object.
2. For a multistate object, select the state in which you want to insert a variable.
   - From the toolbar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.
3. Click the Inner Text tool on the toolbar.
   Or choose Inner Text from the Format menu.
   The format bar shows the current text.

4. Click where you want to insert the variable or use the arrow keys to position the insertion point.
   If you want to display the variable without text, delete the text first by dragging the pointer over the text to highlight it, then press BACKSPACE or DELETE.

5. Click the Embedded Variable tool on the Format bar and choose Variable from the popup menu.
   Or choose Variable from the Format ▶ Embedded Variable menu.
6. Set the properties of the variable.

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
</table>
| Field Width          | Specify the maximum number of digits (1 to 12) allowed in the variable.
|                      | If the Fixed Point Decimal Position is not 0, then the field width must be \( 2 > \text{Position value} \) for positive numbers. One position is for the decimal point and one position is for the digit to the left of the decimal. For negative numbers, the field width must be \( 3 > \text{Position} \). For example, to display \(-0.1234\), the field width must be 7 and decimal position 4. |
| Fill with Zeroes     | Fill empty data positions with zeroes. Otherwise empty positions are left blank. Zero Filled No Zero Fill 000321 _ _ _ 321 |
| Fixed Point Decimal  | Specify the position of the decimal point 0 to 10 places to the left of the rightmost character. Use 0 to display the value without a decimal point. |
| Floating Point Decimal| Have the controller position the decimal point. |
| Read Tag             | Specify the tag name address from which to read the variable data. |

7. Click OK when done.

A placeholder /*V:12 NOFILL FIX:0*/ is inserted in the text with embedded formatting details.

A string of characters ####### (the length of the field width) is inserted in the object as a placeholder for the variable.

8. Resize the object, if necessary, to fit the variable.

9. Click the Inner Text tool to exit inner text mode.

For multistate objects, you can add a numeric variable to the text of a specific state from the State tab of the Object’s dialog.

**To edit a numeric variable:**

1. Select the object.

2. For a multistate object, select the state containing the variable.

3. Click the Inner Text tool on the tool bar.

4. Select the /*V:12 NOFILL FIX:0*/ placeholder.

5. Click the Embedded Variable tool and choose Edit Variable to open the Variable dialog.

6. Edit the formatting options, then click OK to exit the dialog.

The /*V:6 NOFILL FIX:0*/ placeholder is updated with the new formatting details.

For multistate objects, you can edit the numeric variable directly from the State tab (Text field) of the Object’s dialog.
Inserting an ASCII Variable

You can insert an ASCII variable in an object or text string. The ASCII variable is used to display a character string sent from a controller directly on the PanelView terminal. The variable is updated whenever the string changes.

The ASCII variable can display any character in the extended character set. The characters displayed are controlled exactly as specified in the data string. Characters are processed sequentially until a null character (all bits 0) is received. Any characters after a null character are ignored.

The ASCII string is stored in the data table as a series of consecutive characters. The format of the string must be as shown below.

<table>
<thead>
<tr>
<th>Bit</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st word</td>
<td>1st character</td>
<td>2nd character</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2nd word</td>
<td>3rd character</td>
<td>4th character</td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To insert an ASCII variable in an object or text string:

1. Select the object.
2. For a multistate object, select the state in which you want to insert the ASCII variable.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.
3. Click the Inner Text tool on the tool bar or choose Inner Text from the Format menu.

   The format bar shows the current text.

4. Click where you want to insert the ASCII variable or use the arrow keys to position the insertion point.

   If you want to display the variable without text, delete the text first by dragging the pointer over the text to highlight it, then press BACKSPACE or DELETE.
5. Click the Embedded Variable tool on the Format bar and choose ASCII from the popup menu.

   Or choose ASCII from the Format ➤ Embedded Variable menu.

6. Set the properties of the variable.

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
</table>
| Field Width      | Specify the maximum number of ASCII characters (1 to 128) allowed in the variable.  
|                  | The maximum field width depends on the communication protocol used by the application.  
|                  | For: Maximum Field Width is:  
|                  | DH-485/DH+/DF1 80 characters  
|                  | Remote I/O 128 characters  
|                  | The maximum number of characters supported by a text string including the embedded ASCII variable is 255. If the number of characters is > 255, the string is truncated and an asterisk (*) appears.  
|                  | To display fewer ASCII characters than the specified field width, you must append the ASCII NULL character to the string in the controller.  
| Read Tag         | Specify the name of the tag address in the controller from which to read the ASCII characters.  
|                  | The data type of the read tag must be Character Array. The Array Size of the tag must match the field width or a validation error will occur.  |
7. Click OK when done.

A placeholder /*A:5 ASCII_Data*/ is inserted in the text with the specified field width and the name of the read tag.

```
1 TEXT/*A:6 ASCII_Data*/TEXT
```

A string of characters ###### (the length of the field width) is inserted in the object as a placeholder for the variable.

```
 TEXT#### TEXT
```

8. Resize the object, if necessary, to fit the variable.

9. Click the Inner Text tool to exit inner text mode.

For multistate objects, you can add an ASCII variable to the text of a specific state from the State tab of the Object’s dialog.

**Example ASCII Strings**

The following table provides examples of characters that are embedded in an ASCII variable of a text string on the PanelView terminal. The ASCII variable is configured with a field width of 6. If the ASCII string stored in the controller does not have the same number of characters as the field width:

- use the ASCII SP (space) character to pad a string that is less than the field width.
- use the NULL (\0) character to terminate a string that is less than the field width (or the string will not display)

<table>
<thead>
<tr>
<th>Data from Logic Controller</th>
<th>ASCII Characters Displayed on PanelView</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 E D I U M</td>
<td>textMEDIUMtext</td>
</tr>
<tr>
<td>SP H I G H SP</td>
<td>text HIGH text</td>
</tr>
<tr>
<td>SP SP L O W SP</td>
<td>text LOW text</td>
</tr>
<tr>
<td>SP L O W SP \0</td>
<td>text LOW text</td>
</tr>
<tr>
<td>L O W \0</td>
<td>textLOWtext</td>
</tr>
<tr>
<td>E X C E E D $</td>
<td>textEXCEEDtext</td>
</tr>
<tr>
<td>SP 1 . 2 5 SP</td>
<td>text 1.25 text</td>
</tr>
<tr>
<td>SP SP 3 4 5 SP</td>
<td>text 345 text</td>
</tr>
<tr>
<td>SP SP SP SP SP</td>
<td>text text</td>
</tr>
<tr>
<td>\0</td>
<td>texttext</td>
</tr>
</tbody>
</table>
To edit an ASCII variable:
1. Select the object.

2. For a multistate object, select the state containing the variable.

3. Click the Inner Text tool on the tool bar.

4. Select the /*A:6 ASCII_Data*/ placeholder.

5. Click the Embedded Variable tool and choose Edit Variable to open the Variable dialog.

6. Edit the formatting options, then click OK to exit the dialog.

The /*A:7 ASCII_Data*/ placeholder is updated.

For multistate objects, you can edit the ASCII variable directly from the State tab (Text field) of the Object’s dialog.

Working with Inner Graphics

You can add an inner graphic to a button or multistate object (not list objects). For multistate objects, you can enter a different graphic for each state.

The graphic appears only when the object is in the specified state. The inner graphic appears inside the object and is linked to the object. When you move or delete the object, the inner graphic is also moved or deleted.

The inner graphic can be an ISA symbol or a bitmap graphic created with another program. Appendix B defines the ISA symbols. For details on how to import bitmap graphics, see Chapter 16.
Adding Inner Graphic

To insert an imported bitmap or ISA symbol in an object:

1. Select the object.

2. For a multistate object, select the state to insert the graphic.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

3. To display a graphic without text, get into inner text mode and delete the text, then exit inner text mode.

4. Click the Inner Graphic tool on the tool bar.
   Or choose Inner Graphic from the Format menu.

5. Select a graphic or ISA symbol from the Graphics list box.

   The graphic is inserted in the object.

   ISA symbols are also available from the ISA Symbols toolbox. Click a symbol while in inner graphic mode to insert in object.

6. Position the graphic in the object by selecting and moving it.

7. Click the Inner Graphic tool to exit inner graphic mode.
   Or click the left mouse button outside the push button.

8. Resize the object (not graphic), if necessary. The graphic retains its relative position in the object anchored by the top left corner.

For multistate objects, you can assign a graphic to a specific state from the State tab of the Object’s dialog.

To reposition a graphic:

1. Select the object.

2. For a multistate object, select the state containing the graphic.

3. Click the Inner Graphic tool on the tool bar.

4. Select the graphic and move it.

5. Click the Inner Graphic tool to exit inner graphic mode.
Setting Foreground/Background Colors

On color and grayscale terminals, you can set the foreground and background colors of an inner graphic from the Format menu or the color palette. The background is the area containing the graphic.

On color terminals, the initial default is a blue background and a white foreground. On grayscale terminals, the initial default is a black background and a white foreground.

You can adjust the foreground/background colors of monochrome bitmaps, not color bitmaps.

To set the foreground/background colors of a graphic:

1. Select the object.
2. If the object is a multistate object, select a state.
   • From the tool bar, select a state from the State box.
   • Or choose Next State or Previous State from the Format menu.
3. Click the Inner Graphic tool on the tool bar.
   Or choose Inner Graphic from the Format menu.
4. To change the foreground color:
   • Click a color on the top row of the color palette.
   • Or choose a color from the Format ▶ Foreground Color menu.
5. To change the background color:
   • Click a color on the bottom row of the color palette.
   • Or choose a color from the Format ▶ Background Color menu.
   The background color changes to the selected color.
6. Click the Inner Graphic tool to exit Inner Graphic mode.

If you want the background of the graphic to blend in with the background of the object, set the background colors for the object and graphic to the same color.

For multistate objects, you can select foreground/background colors for a graphic from the State tab of the object’s dialog.
Reversing Foreground/Background Colors

You can reverse the foreground/background of an inner graphic.

Foreground and Background of Graphic are Reversed

You can reverse the foreground/background colors of monochrome bitmaps, not color bitmaps.

To reverse the foreground and background of a graphic:

1. Select the object.
2. Click the Inner Graphic tool on the tool bar.
3. If the object is multistate, select the state containing the graphic.
4. Click the Toggle Foreground/Background tool on the Format bar. Or choose Toggle Fore/Background from the Format menu.
   The color of the graphic and the area containing the graphic are reversed.
5. To exit inner graphic mode, click the Inner Graphic tool.
Removing an Inner Graphic

To remove an inner graphic or ISA symbol from an object:

1. Select the object.

2. For a multistate object, select the state containing the graphic.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

3. Click the Inner Graphic tool on the tool bar.
   Or choose Inner Graphic from the Format menu.
   The Format bar appears.

4. Select (None) from the Graphics list box.
   The graphic is removed.

5. Click the Inner Graphic tool to exit inner graphic mode.

Editing Graphics

The size and content of an inner graphic (bitmap or ISA symbol) cannot be changed in PanelBuilder. You must export the graphic, revise it with another program such as Paintbrush and then re-import it. You can export the graphic directly from the Format bar.

Bitmaps are handled like global objects. A bitmap image is stored once, regardless of the number of links to it. When an image is updated, PanelBuilder updates all instances of the image.

To edit a bitmap graphic or an ISA symbol:

1. Click the Import/Export Graphics tool on the Format bar.
   Or choose Import/Export Graphics from the File menu.

2. Export the graphic to a disk file or the clipboard. Chapter 16 tells how to export a graphic from the Import/Export Graphics dialog.

3. Use Paintbrush or another program to edit the bitmap graphic.

4. Import the revised image from the Import/Export Graphics dialog. It’s recommended that you change the name to differentiate the new image from the old image.

Important: Bitmaps cannot exceed the pixel size of the terminal.

5. Re-insert the graphic in object as described on page 17–20.
You can change the way text looks on a screen using various combinations of size, emphasis and alignment. From the Format menu or Format bar you can:

- size text
- align text left, right or center
- underline text
- toggle blinking on or off
- set text foreground/background colors
- toggle foreground/background colors

Text format and alignment options are applied to entire text strings not individual letters or words.

When you select an object and choose Inner Text from the Format menu or click the Inner Text tool on the tool bar the Format bar changes to this view.

Most options toggle on and off, others open a menu. To toggle a setting from the Format bar, click the tool once to turn it on, click it again to turn it off. The new setting remains active until changed.

A check mark (✓) indicates active settings for the selected text.

For multistate objects, text formatting options can be set directly from the State tab of the object’s dialog.
Sizing Text

When sizing text, you can select from a variety of sizes. If working with multistate objects you can size the text for each state. In list objects, changes to text size affect all entries in the list.

To size text:

1. Select the object whose text you want to size.

2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.

3. If the object is multistate, select a state.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

4. Click the Text Size tool on the Format bar and choose a size from the popup menu.
   Or choose a size from the Format Text Size menu.

If an external font is selected, a second set of font sizes will appear in parenthesis below the regular PanelBuilder fonts.

The entire text string is resized.

5. To set foreground/background colors, blinking, underlining or text alignment, click the appropriate tools on the Format bar.

6. To exit inner text mode, choose the Inner Text command or tool.

For multistate and list objects, you can adjust the text size from the State tab of the object’s dialog.
Aligning Text

You can align screen text or inner text of an object in three ways: left align, right align or center align.

For multistate and list objects, you can align the text differently for each state.

To change text alignment:

1. Select the object whose text you want to align.

2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.

3. If the object is multistate, select a state.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.

4. Choose an alignment option from the Format > Align Text submenu.
   Or click the appropriate align tool on the Format bar.

   The entire text string is realigned.

5. To resize, underline, set colors or activate blinking for the text, click the appropriate tools on the Format bar.

6. To exit inner text mode, choose the Inner Text command or tool.

   For multistate and list objects, you can change text alignment from the State tab of the object’s dialog.
Underlining Text

You can toggle underlining on or off for screen text or inner text of an object. For multistate or list objects, you can toggle underlining on or off for each state.

The underline option applies to an entire text string not individual letters or words in the string.

To underline text:

1. Select the object with text you want to underline.

2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.

3. If the object is multistate, select a state.
   • From the tool bar, select a state from the State box.
   • Or choose Next State or Previous State from the Format menu.

4. Click the Underline tool on the Format bar.
   Or choose Underline from the Format menu.

   The entire text string is underlined.

5. To resize, align, set colors or activate blinking for the text, click the appropriate tools on the Format bar.

6. To exit inner text mode, choose the Inner Text command or tool.
   Underlining remains active until you turn it off.

For multistate and list objects, you can underline text for a specific state from the State tab of the object’s dialog.
Using the Blink Option

You can toggle blinking on or off for screen text, inner text or the inner graphic of an object. Blinking applies to an entire text string not individual letters or words in the string. The blink option isn’t available for list objects.

The blink rate is approximately .5 seconds and is activated when the application is running in the PanelView terminal. Blinking isn’t activated for text during application design.

Only the text blinks, not the object. To activate blinking for the object, select the object and then choose Blink from the Format menu or click the Blink tool.

To toggle blinking for text:

1. Select the object with text you want to blink.
2. Click the Inner Text tool on the tool bar.
   • Or choose Inner Text from the Format menu.
3. If the object is multistate, select a state.
   • From the tool bar, select a state from the State box.
   • Or choose Next State or Previous State from the Format menu.
4. Click the Blink tool on the Format bar.
   • Or choose Blink from the Format menu.
   The entire text string blinks.
5. To resize, align, underline or set colors for the text, click the appropriate tools on the Format bar.
6. To exit inner text mode, choose the Inner Text command or tool.
   Blinking remains active until you turn it off.

For multistate objects, you can activate blinking for a specific state directly from the State tab of the object’s dialog.
Setting Foreground/Background Colors

On color and grayscale terminals, you can set the foreground and background colors of text from the Format menu or the color palette. You cannot adjust the background color for text in list objects.

To set the foreground and background colors of text:
1. Select the object.
2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
3. If the object is a multistate object, select a state.
   - From the tool bar, select a state from the State box.
   - Or choose Next State or Previous State from the Format menu.
4. To change the foreground color:
   - Click a color on the top row of the color palette.
   - Or choose a color from the Format Foreground Color menu.
   The foreground color changes to the selected color.
5. To change the background color:
   - Click a color on the bottom row of the color palette.
   - Or choose a color from the Format Background Color menu.
   The background color changes to the selected color.
6. Click the Inner Text tool to exit Inner Text mode.

If you want the text background to blend in with the object background, set the background colors for the object and text to the same color.

For multistate objects, you set the text foreground and background colors for each state from the State tab of the object’s dialog or from the color palette when the state is visible.
Reversing Foreground/Background Colors

You can reverse the background/foreground colors of screen text or the inner text of an object. For multistate objects, you can toggle the foreground/background colors of the inner text for each state. This option is not valid for list objects.

The Toggle Foreground/Background option applies to an entire text string not individual letters or words in the string.

The foreground/background colors of text toggle independently of the foreground/background colors set for the object or object state.

To reverse the foreground and background colors of text:

1. Select the object.
2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
3. If the object is multistate, select a state.
   • From the tool bar, select a state from the State box.
   • Or choose Next State or Previous State from the Format menu.
4. Click the Toggle Foreground/Background tool on the Format bar.
   Or choose Toggle Fore/Background from the Format menu.
   The color of the text string and the area containing the text string are reversed.
5. To resize, align, underline or activate blinking for the text, click the appropriate tools on the Format bar.
6. To exit inner text mode, choose the Inner Text command or tool.
Using the Text Editor

Chapter Objectives

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening the Text Editor</td>
<td>18–2</td>
</tr>
<tr>
<td>Entering New Text</td>
<td>18–3</td>
</tr>
<tr>
<td>Editing Text</td>
<td>18–4</td>
</tr>
<tr>
<td>Inserting Variables in Text</td>
<td>18–5</td>
</tr>
<tr>
<td>Sorting Text</td>
<td>18–6</td>
</tr>
<tr>
<td>Filtering Text</td>
<td>18–6</td>
</tr>
<tr>
<td>Printing Text</td>
<td>18–7</td>
</tr>
<tr>
<td>Deleting Text</td>
<td>18–8</td>
</tr>
<tr>
<td>Renumbering Text</td>
<td>18–9</td>
</tr>
<tr>
<td>Moving Text</td>
<td>18–9</td>
</tr>
<tr>
<td>Copying Text into Objects</td>
<td>18–10</td>
</tr>
</tbody>
</table>
Opening the Text Editor

The Text Editor contains a list of all text defined for the application including object text, background text, and alarm messages. Use the Text Editor to:

- enter new text (with embedded variables)
- edit text
- delete unused text
- copy text into objects
- renumber text
- filter and sort text
- print application text

To open the Text Editor:

Choose Text Editor from the Application menu.

Many text operations are performed clicking a row number and choosing a command from this menu.

<table>
<thead>
<tr>
<th>Row</th>
<th>Cell</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

The Text Editor uses a spreadsheet to simplify text editing operations. Each row identifies the following fields for a text string:

<table>
<thead>
<tr>
<th>Text Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text ID</td>
<td>Specifies a unique number for a text string.</td>
</tr>
<tr>
<td>Count</td>
<td>Specifies how many times the text string is used in the application. A count of 0 means the string is not used. This is a read only field.</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies whether the text is used in an object or as an alarm message. This is a read only field.</td>
</tr>
<tr>
<td>Text</td>
<td>Defines a text string with or without embedded variables (time, date, or numeric variable).</td>
</tr>
</tbody>
</table>
**Entering New Text**

The Text Editor lets you create new text strings which can then be used by objects in the application. This also includes text from an external font file. You can also insert variables within the text including a time, date or numeric variable.

The last row in the Text Editor contains an asterisk (*). This row is reserved for creating a new text string.

**To add a new text string as the last row in the spreadsheet:**

1. Locate the last row which contains an asterisk (*).
2. Double-click the Text field.
   The default text “New text” is highlighted.
3. Type in the new text.
   To enter a carriage return, press ENTER. The characters /*R*/ are inserted to indicate a new line.
4. Click anywhere outside of the field.
   The Text ID field is updated with the next available number. The Count field remains 0 until the text string is used by the application.

**To insert a new text string at a specific location:**

1. Select the row number where you want to insert a text string.
2. Choose Insert Text Item from the popup menu.
   A row is inserted above the selected row with the next available Text ID number.
3. Double-click the Text field.
   The default text “New text” is highlighted.
4. Type in the new text.
   To enter a carriage return, press ENTER. The characters /*R*/ are inserted to indicate a new line.
5. Click anywhere outside of the field.
   The Count field remains 0 until the text string is used by the application.
If you edit text in the Text Editor, PanelBuilder will update all occurrences of the text in the application.

**To edit a text string:**

1. Locate the text you want to edit.

2. Click in the Text field and edit the text.
   - To delete text, click once to highlight all the text and press BACKSPACE or DELETE.
   - To add text, position the cursor and type new text.
   - To insert a carriage return /*R*/, press ENTER.

3. When done, click anywhere outside of the cell.

   The text is updated wherever it is used in the application.

**To cut/copy and paste text:**

1. Click the Text field containing the text you want to copy.

2. Choose Copy or Cut from the popup menu.

   All text in the cell is placed on the clipboard.

3. Click the Text field where you want to paste the text.

4. Choose Paste from the popup menu.

   The text is pasted from the clipboard.

5. When done, click anywhere outside of the cell.

   The text is updated wherever it is used in the application.
Inserting Variables in Text

You can insert a time, date or numeric variable within a text string. The variables are downloaded to the terminal with the application.

To insert a time, date, numeric, ASCII variable in a text string:

1. Locate the text in which you want to insert a variable.
2. Double-click the Text field.
3. Position the cursor where you want to insert the variable.
4. From the popup menu, choose Embedded Variable ➤ Time, Date, Variable (for Numeric), or ASCII.

For the Time and Date variable, a placeholder is inserted in the message (/*T*/ for time, /*D*/ for date). The format of the time and date is set in the Terminal Setup dialog.

A dialog opens when Variable (p. 17–14) or ASCII (p. 17–17) is selected. The dialog defines the format of the variable in the text string. When you exit this dialog, a placeholder is inserted within the text with embedded formatting details.

To edit a numeric or ASCII variable:

1. Double-click the Text field containing the variable.
2. Click the numeric /*V:12 NOFILL FIX:0*/ or ASCII /*A:12*/ variable.
3. From the popup menu, choose Embedded Variable ➤ Edit Variable.
4. Edit the settings in the Variable dialog.
5. When done, click OK to exit dialog.

The placeholder is updated with the new format.

To delete a variable:

Click on the placeholder and choose Cut from the popup menu, or press BACKSPACE or DELETE.
Sorting Text

Sorting organizes data in columns, alphabetically or numerically. When you sort a column, rows are rearranged according to the contents of the column. For example, if you sort the Text field, all rows are rearranged alphabetically. Identical text strings appear together.

The Sort By list box lets you sort the data in these columns:
- None (no sort column)
- Text ID (numeric sort)
- Count (numeric sort)
- Type (object or alarm message)
- Text (alphabetical sort)

To sort a column or field of data:

From the Sort By list box, select a column you want to sort. The column is sorted numerically or alphabetically depending on the contents of the column.

Filtering Text

You can filter text to display or work with only a subset of text strings in the application. You can sort or print a filtered list.

To filter or select a subset of text strings:

1. Click the Filter button in the Text Editor.

The dialog displays a list of all instances where text is used in an application. Initially all options are selected.
2. Click the Clear All button to clear all check boxes.

3. Click the check boxes of the options you want in the subset.
   
   For example, to create a subset that includes all text used by Alarms and Print Only Devices, check those boxes only. To create a subset of all unused text strings, select the Unused check box. All other boxes are cleared.

4. Click OK to exit the Filter dialog.
   
   The Text Editor has filtered out all text except for the options selected in the Filter dialog.

**Printing Text**

You can print all text or a range of text stored in the Text Editor. Create a subset of text to print using the filter option. You can also sort a filtered list or range of text before printing.

The following information prints for each text string in a list format.

- Text ID (or number)
- Text

A header prints at the top of each page.

**To print application text:**

1. Select the text you want to print.
   
   - To select a single item, click the row number of the text string.
   - To select a block of text, click the row number of the first text item, hold down the left mouse button and drag the mouse until the last text item in the block is highlighted.
   - To select all text, click the Select All button.

2. Click the Print button.
   
   The standard Windows Print dialog opens.

3. Under Print Range, select the range of text items to print (All or Selection).

   Click the Print Setup button to set the default printer or to change the printer options.

4. Click OK to close the dialog.
Deleting Unused Text

You can delete text that is not used by the application. An unused text string has a 0 in the Count field.

To display all unused text in a group:
- From the Sort By list box, select Count to sort the Count field numerically. All text strings with a count of 0 will appear in a block at the end of the spreadsheet.
- Create a subset of all unused text by clearing all check boxes in the Filter dialog and then selecting the Unused check box.

To delete all unused text:
1. Click the Select All button.
2. Click the Purge button or choose Purge Text Item from the popup menu.

All unused text (count of 0) is permanently removed from the application. A popup shows the number of text items deleted.

To delete one or several unused text strings:
1. Select the rows (with a Count value of 0) to delete.
2. Click the Purge button or choose Purge Text Item from the popup menu.
Renumbering Text

To consolidate memory, renumber text strings to eliminate gaps in the numbering sequence.

To check for numbering gaps, select Text ID from the Sort By list box. All Text ID numbers are sorted numerically.

To renumber a single text string:
1. Double-click the Text ID field of the text string you want to renumber.

2. Type a unique number.

When you exit the Text Editor, a warning message will display if duplicate numbers are detected. The message indicates the row numbers containing the duplicate Text ID numbers. You must renumber the text strings before exiting the Text Editor.

To renumber all text strings:
1. Click the Select All button.

2. Click the Renumber button.

All text strings are automatically renumbered starting at 1.

To renumber a block of text strings:
1. Select the row number of the first text string in the block, hold down the left mouse button and drag the mouse until all rows in the block are highlighted.

2. Click the Renumber button.

All text strings in the block are renumbered starting with the number of the first text string. For example, a block of text numbered 80, 84, 85, 88, 89 would be renumbered 80, 81, 82, 83, 84.

Moving Text

You can rearrange the order of text by moving a text string up/down a row or to a specific location:

To move a text item up or down one row:
1. Select the row number of the text you want to move.

2. Choose Move Text Item Up or Move Text Item Down from the popup menu.

The text is moved up or down one row.
To move a text string to a specific location:

1. Select the row number of the text string you want to move.
2. Choose Move Text Item To: from the popup menu.
   A dialog opens prompting you to enter the row number where you want to move the text. The dialog shows the range of row numbers before and after the selected text.
3. In the Row Number box, type a number.
   The selected text is moved to the specified location and the rest of the rows are renumbered.

Copying Text into Objects

Text stored in the Text Editor can be copied to:
- objects
- print only message objects
- alarm messages

You can reuse the same text multiple times in an application. Only one copy of the text is stored regardless of the number of links to it.

You can access the Text Editor from the:
- Format bar while in Inner Text mode
- Alarm tab of the Alarm Editor
- State tab of a multistate or list object’s dialog

To copy text into an object while in Inner Text mode:

1. Select the object in which you want to copy the text.
2. Click the Inner Text tool on the tool bar.
   Or choose Inner Text from the Format menu.
3. For multistate objects, select the state in which you want to copy the text.
4. Click the Use Existing Text tool on the Format bar.
   Or choose Use Existing Text from the Edit menu.
   The Use Existing Text dialog opens in Read Only mode.
5. From the dialog, select the row number of the text you want to copy.
   Use the Sort By or Filter options to help you locate text.
6. Click the Apply button.
   The object text is replaced with the selected text and the Use Existing Text dialog closes.
To copy text from the State tab of an object’s dialog:

1. Select the object in which you want to copy the text.
2. Double-click the object.
3. Select the State tab.
4. Select the row number of the text you want replace with text in the Text Editor.
5. Choose Use Existing Text from the popup menu.
   The Use Existing Text dialog opens in Read Only mode.
6. From the dialog, select the row number of the text you want to copy.
   Use the Sort By or Filter options to help you locate the text.
7. Click the Apply button and then the Close button.
   The Text ID and Text fields are updated with data from the copied text and the Use Existing Text dialog closes.
8. Click OK to exit the object’s dialog.

To copy text from the Alarm tab (Alarm Setup dialog):

1. Choose Alarm Setup from the Application menu.
2. Select the Alarms tab.
3. Select the row number of the text you want to replace with text in the Text Editor.
4. Choose Use Existing Text from the popup menu.
   The Use Existing Text dialog opens in Read Only mode.
5. From the dialog, select the row number of the text you want to copy.
6. Click the Apply button and then the Close button.
   The Text ID and Text fields are updated with data from the copied text and the Use Existing Text dialog closes.
7. Click OK to exit the Alarm Setup dialog.
Chapter Objectives

This chapter shows how to enter tag information for an application project using the Tag Editor. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Tag Editor</td>
<td>19–1</td>
</tr>
<tr>
<td>Validating Tag Addresses</td>
<td>19–4</td>
</tr>
<tr>
<td>Defining Tags</td>
<td>19–5</td>
</tr>
<tr>
<td>Saving Tags</td>
<td>19–7</td>
</tr>
<tr>
<td>Viewing Tags</td>
<td>19–7</td>
</tr>
<tr>
<td>Inserting and Deleting Tags</td>
<td>19–7</td>
</tr>
<tr>
<td>Copying Tags</td>
<td>19–8</td>
</tr>
<tr>
<td>Duplicating Tags</td>
<td>19–9</td>
</tr>
<tr>
<td>Finding Tags</td>
<td>19–10</td>
</tr>
<tr>
<td>Sorting Tags</td>
<td>19–11</td>
</tr>
<tr>
<td>Printing Tags</td>
<td>19–12</td>
</tr>
<tr>
<td>Using Tools</td>
<td>19–15</td>
</tr>
<tr>
<td>Tag Import/Export Utility</td>
<td>19–15</td>
</tr>
<tr>
<td>Importing Tags</td>
<td>19–16</td>
</tr>
<tr>
<td>Handling Data Collisions</td>
<td>19–17</td>
</tr>
<tr>
<td>Exporting Tags</td>
<td>19–18</td>
</tr>
<tr>
<td>Examining Results of an Import/Export</td>
<td>19–19</td>
</tr>
<tr>
<td>Interpreting Error Messages</td>
<td>19–20</td>
</tr>
</tbody>
</table>

Using the Tag Editor

You can enter tag information in either of two ways:

**Table View**

Enter several tags at the same time in a table which has its own tool bar and columns for tag attributes. This is called the Summary View.

**Form View**

Enter a single tag from a dialog in PanelBuilder, or change from the table view to the form view.
Opening the Tag Editor

To open the table view of the Tag Editor:
Choose Tag Editor from the Application menu.

Table (Summary) View
To open the form view:
- From the table view, choose Form from the View menu.
- From a PanelBuilder dialog, enter or select a tag name and select the Edit Tag button.

Form View

Certain fields appear or disappear based on the data type of the tag you are creating in the form view. For example, if the data type is Bit, the Scaling and Data Entry Limits fields are not displayed.

If you enter data in the form view, it does not appear in the table view until you choose Refresh from the Window menu.

Navigating through the Tag Editor

To move between fields in form view or table view:
- Move the mouse pointer to the field and click the left button.
- Or press TAB to move forward through fields and SHIFT+TAB to move backward.

To change from table view to form view:
- Click the Form tool on the tool bar.
- Or choose Form from the View menu.
- Or choose Form Editor from the Tools menu.

To change from form view to table view:
- Click the Tag Editor button in the tag form view.
- Or choose Summary from the View menu.
- Or choose List Editor from the Tools menu.

Note: If you enter data in the form view, it will not appear in the table view when you switch views. Choose Refresh from the Window menu to display the new data.

To exit the Tag Editor:
Double-click the Control-menu box at the top left of the window.
- Or in the table view, choose Exit from the Project menu.
- Or in the form view, click the OK or Cancel button.
Validating Tag Addresses

Activate address validation before entering or modifying tags. Only those tags entered or modified after the option has been selected are validated. Addresses for existing tags are not validated.

To activate address validation:
Choose Address Validation from the Options menu. A check mark next to the menu item indicates that the option is activated.

Note: Address validation is always active in the form view.

The Tag Editor validates each address against the type of device specified in the Node Name field. If the address is invalid, the Tag Editor displays the following warning:

<table>
<thead>
<tr>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Return to the invalid address in the table view.</td>
</tr>
<tr>
<td>No</td>
<td>Save the tag in the database with the invalid address.</td>
</tr>
</tbody>
</table>

For information on valid addresses for a specific type of controller, refer to the user manual for that controller.

Note: If you select the IEEE Float data type for a tag and enter an incorrect address (e.g., S2:4), the tag editor does not validate the error. You may need to copy the floating point data into an integer file before downloading the application to the terminal.
## Defining Tags

To move to a specific field on the Form View, press the ALT key and type the letter that is underlined in the field name.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Valid Characters</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Tag Name         | The name of the tag | Maximum characters = 32  
A – Z, a – z, 0 – 9  
hyphen (-), underscore (_), percent (%)  | • If you type an invalid character, the Tag Editor beeps and does not display it  
• the tag name must be unique within a project  
• cannot begin with 0 – 9, hyphen (-), or percent (%)  
• tag names are not case-sensitive  
• do not use blanks, tabs, carriage returns, non-printable characters |
| Data Type        | The data format for the tag | Select one of the following:  
• bit  
• 4BCD  
• unsigned integer  
• signed integer  
• IEEE Float  
• bit array  
• character array  | • the data type must be compatible with the data format selected in the object’s dialog.  
• Alternate Methods:  
  Type the first letter of the data type. For example, type `b` for the bit data type.  
  Use the TAB key to move to the Data Type field and press ALT+↓ to display the list of available formats. |
| Array Size       | The size of the array | Maximum characters = 16  
• Bit Array is 1 - 16  
• Character Array is protocol dependent  | • the array size must be an integer.  
• do not use blanks, tabs, carriage returns, non-printable characters |
| Description      | The description of the tag | Maximum characters = 255  
• any printable  | • do not use tabs, carriage returns, non-printable characters  
• you can type the information in this field, or use the description editor. To access the description editor:  
  • Place the cursor in the description field.  
  • Click the right mouse button.  
  • Choose Editor from the menu.  
  • When finished typing/editing your description, click OK. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Valid Characters</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Node Name             | The node with which you want this tag associated                            | Maximum characters = 32                                                          | • If you type an invalid character, the Tag Editor beeps and does not display it  
• Node name cannot be identical to a tag name or terminal name  
• The node name must match the controller name entered in the Communication Setup dialog (Terminal Setup)  
• Node name cannot begin with 0 – 9, hyphen, or percent  
• Node names are not case-sensitive  
• Do not use blanks, tabs, carriage returns, non-printable characters |
| Address               | The data table address within the processor for the tag                     | Maximum characters = 32                                                          | • Do not use blanks, tabs, carriage returns, non-printable characters                                                                                                                               |
| Initial Value         | The starting value for the current tag in engineering units                 | Maximum characters = 24                                                          | • Do not use blanks, tabs, carriage returns, non-printable characters  
• Maximum precision is 6 places to the right of the decimal point for non-floating point values  
• If present, a sign (+ or −) for the number must be first (+ is the default)  
• If present, a sign for the exponent must immediately follow the e or E  
• Provides a preset value for numeric entry objects only  
• No entry = default of 0 |
| Update Frequency      | The rate at which you want the terminal to obtain data                      | • 1 – 9 where 1 is the fastest update rate                                        | Does not apply to remote I/O  
Alternate Methods:  
Type the update frequency, 1 to 9.  
Use the TAB key to move to the Update Frequency field and press ALT+↓ to display the list of available formats. |
| Scaling               | The values you want to use to convert the current tag's processor integer value ('x') to engineering units ('y') | Maximum characters = 12                                                          | • Do not use blanks, tabs, carriage returns, non-printable characters  
• Maximum precision for scale is 6 places to right of decimal point  
• Maximum precision for offset is 6 places to right of decimal point  
• If present, a sign (+ or −) for the number must be first (+ is the default)  
• If present, a sign for the exponent must immediately follow the e or E |
| Data Entry Limits     | The minimum and maximum values that can be assigned to the tag             | Maximum characters = 12                                                          | • Do not use blanks, tabs, carriage returns, non-printable characters  
• Maximum precision is 6 places to the right of the decimal point  
• If present, a sign (+ or −) for the number must be first (+ is the default)  
• If present, a sign for the exponent must immediately follow the e or E |

1 Required fields for the Table View  
2 Required fields for the Form View  
3 These fields appear only when the data type is 4BCD, signed integer, unsigned integer, IEEE Float.
Saving Tags

To save a tag definition in the form view:

- Click OK.
- Or press ENTER.
- Or press the Tag Editor button.

To close the form without saving anything, click the Cancel button.

Table View

To save a tag definition in the table view:

- Press ENTER at the end of the row.
- Or move the cursor to a different (existing) row.
- Or double-click in the Status Column for that tag.
- Or use the scroll bar or PageUp or PageDown keys to move to a different row.
- Or change to the form view.

Viewing Tags

<table>
<thead>
<tr>
<th>To display:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>all tags in the project</td>
<td>choose Summary from the View menu.</td>
</tr>
<tr>
<td>only data types of 4BCD, unsigned</td>
<td>choose BCD/Integer from the View menu.</td>
</tr>
<tr>
<td>or signed integer, or word array</td>
<td></td>
</tr>
<tr>
<td>another copy of current view</td>
<td>click or choose New from Window menu.</td>
</tr>
</tbody>
</table>

Inserting and Deleting Tags

To select a row, use the left mouse button to click in the Status Column for that row.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>insert a tag</td>
<td>click or choose Insert from Edit menu.</td>
</tr>
<tr>
<td>delete a tag</td>
<td>click or choose Delete from Edit menu.</td>
</tr>
<tr>
<td></td>
<td>The tag is deleted from the current project</td>
</tr>
<tr>
<td></td>
<td>and cannot be retrieved.</td>
</tr>
<tr>
<td>cut a tag</td>
<td>click or choose Cut from Edit menu.</td>
</tr>
<tr>
<td></td>
<td>The tag is deleted from the current project</td>
</tr>
<tr>
<td></td>
<td>but can be retrieved with the Paste command.</td>
</tr>
</tbody>
</table>
Many tags in the table view have the same data type, node name, or other attributes. Tags may be selected, copied and pasted with all their fields, or individual fields may be copied.

Since tags or their fields are copied to the Microsoft Windows clipboard, they can be pasted in another application, even an application in another project.

When a tag is copied, the new tag’s name is the same as the original tag’s name in the Tag Editor table view. An X appears in the Status column for the new tag’s row until its name is changed.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>select a field</td>
<td>use the left mouse button and click in the field.</td>
</tr>
<tr>
<td>select a single row</td>
<td>use the left mouse button and click in the Status column for that row.</td>
</tr>
<tr>
<td>select several contiguous rows</td>
<td>use the left mouse button, click in the Status column and drag the mouse down the column or hold the SHIFT key and press PAGE DOWN or PAGE UP.</td>
</tr>
<tr>
<td>select several discontiguous rows</td>
<td>use the left mouse button and click in the Status column for the first row. Press PAGE DOWN or PAGE UP. Press and hold the CTRL key and click in the Status column of the other rows that you want to select.</td>
</tr>
</tbody>
</table>

**To copy and paste tag information:**

1. Select the field or row that you want to copy.
2. Click the Copy tool on the tool bar or choose Copy from the Edit menu.
3. Move the cursor to the new position.
4. Click the Paste tool on the tool bar or choose Paste Row or Paste Field from the Edit menu.

If a row was copied or pasted, it is inserted above the current row.

If a field was copied or pasted, it replaces the contents of the field in the current row. Be careful to paste it in a field in the same column.

**To copy tags to another application:**

1. Copy the tag(s) and exit the Tag Editor.
2. Open the target application in the same or another project.
3. Open the Tag Editor table view and paste the tags in it.
Working with Tags

Duplicating Tags

Use this option when a number of tags have similar attributes but are assigned to different variables in the application. Create one tag and duplicate it as many times as needed. Then change the name and address on each new tag to suit the variable it will be assigned to.

To duplicate a tag once:
1. Select the tag name to duplicate.
2. Click the Duplicate Once tool on the tool bar or choose Duplicate Once from the Edit menu.

The Tag Editor duplicates the row and places it after the current row. The tag name is incremented according to the options specified in the Duplication dialog under the Options menu.

To duplicate several tags:
1. Select the tag name to duplicate.
2. Click the Duplicate Several tool on the tool bar or choose Duplicate Several from the Edit menu.

The Tag Editor duplicates the current row and increments the tag names according to options specified in the Duplication dialog under the Options menu.

To set the number of duplicates:
1. Choose Duplication on the Options menu.
2. Select the Increment Name check box to specify whether or not to distinguish names of duplicated tags by adding a number to the name. The default is to add a number.
3. Select a separator from the Separator list box to use between the name and number of duplicated tags.
4. Select a number (1 to 4) from the Number of Digits list box to specify the number of characters to the right of the separator.
5. Highlight the value in the Number of Duplicates text box and type a number.

The number of duplicates is also displayed in the Duplications text box on the tool bar. You can highlight and change this value without entering the Duplication dialog.

| Duplications: 3 |

Finding Tags

Use this tool or command to locate any tag or tags in the Tag Editor by name. Other attributes cannot be used in the Find dialog.

**Important:** If the active View is BCD/Integer, the Find command cannot locate tags with bit addresses.

To find a tag:

1. Click the Find tool on the tool bar or choose Find from the Edit menu.

2. In the Tag Name box, type the name of the tag to find and press ENTER.

   The Find command locates all tag names containing the characters that you type (it is not case sensitive). For example, if you enter switch, the Find command locates: switch, Switch, SWITCH, Switch_5, Limit_switch, LimitSwitch, etc.

3. Click on the appropriate button to move among the occurrences of the tag name.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Move to first occurrence in current view.</td>
</tr>
<tr>
<td>Previous</td>
<td>Move to previous occurrence.</td>
</tr>
<tr>
<td>Next</td>
<td>Move to next occurrence.</td>
</tr>
<tr>
<td>Last</td>
<td>Move to last occurrence in current view.</td>
</tr>
</tbody>
</table>

4. When done, click the Cancel button or press ESC.
Tags may be sorted on any field or any number of fields in a user-selected order. Sorted tags are rearranged in the table so editing similar tags may be done more easily.

**To sort tags:**

1. Choose Sort from the View menu.

2. Under Column, select which field(s) to sort by.
   - Double-click on a field name in the Column box.
   - Or highlight a field and then select Add.

   The Tag Editor moves the field name to the Sort Order box. You can specify any number of fields in your sort. The default (no fields in the Sort Order box) is to sort by Tag Name.

3. When all fields for the sort are entered, click OK.

   The Tag Editor sorts and displays the tags in the table view.

   Fields are sorted in the order they are added to the Sort Order box.

**To change the sort order:**

1. Highlight a field or fields in the Sort Order box.

2. Select Remove to delete them.

3. Highlight a field or fields in the Column box.

4. Select Add to append them to the end of the Sort Order list.

   Or select Cancel and start over.
Printing Tags

Table View only

| 19–12 Working with Tags |

Tags may be printed if the computer is connected to a printer and the correct drivers are installed. See the manual for the printer and the Windows manual. Make sure your printer is connected and online.

**Important:** The Print command is not active if a row is being edited (indicated by a pencil in the Status column). Select a different row (which stores the edited row) before choosing the Print command.

**To print tags:**

1. Click the Print tool on the tool bar or choose Print from the Project menu.

   ![Print tool](image)

   - **Print Setup dialog**
   - **Page Setup dialog**

   Name of current printer that will be used. See the next section to select a different printer. This field is reset to the default printer each time you print.

   ![Printer Name](image)

   - **Name of current printer**

   - **To change to a different printer, see the next section.**

2. Under Print What, specify whether you want to print All Rows in the current tag view or only selected rows.
   
   If selecting specific rows, see page 19–8 for details on how to select contiguous or noncontiguous rows.

3. Select the Print The Cover Page box to print the cover page. The cover page includes product (Allen-Bradley Tag Editor), project and view name, date and time.

4. Click **OK**.

**Print Details**

- The column width of the printed output is based on the width of the column in the Tag Editor.
- The Tag Editor prints as many columns that fit on the width of the page (minus the margins); columns that do not fit are printed on the next page. The Tag Editor does not print a column if it is less than one character wide.
- If the entire height of a row does not fit on the page, then the row is printed on the next page (each row is only one text line high).
Setting Up the Printer

To set up the printer:

1. Click the Printer Setup button from the Print dialog.

   The standard Microsoft Print Setup dialog opens. Dialog entries are based on your system configuration and installation options.

2. Select printer and determine settings.

   **Important:** Check your Microsoft Windows user manual to make sure settings are correct for your printer.

3. Click the Options button to open a dialog and select options specific to the selected printer.

4. Click OK to the Print dialog.

Setting Up the Page

To set up the page:

1. Click the Page Setup button from the Print dialog or choose Page Setup from the Project menu.

2. Under Margins, specify page margins (Top, Bottom, Left, Right). Enter a number for each margin. The measurements are in inches.
Printing Tags

3. Select the Show Gridlines box to show gridlines in the printed copy.

4. Select the Use Maximum Width for Each Column box to use the maximum width for each field.

   Clear the box if you want the printed output based on the size of the columns on the screen. The number of characters that fit in a column on the screen may be different from the printed output depending on the fonts available.

5. Enter Line 1 and Line 2 of the Header. Each line supports up to 255 characters. Use the information below to enter text.

6. Click OK to return to the Print dialog.

Entering Header Information

<table>
<thead>
<tr>
<th>To enter header text:</th>
<th>For example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>type text (this text is printed as is)</td>
<td>if you want to print this:</td>
</tr>
<tr>
<td></td>
<td><em>This is the header.</em></td>
</tr>
<tr>
<td></td>
<td>type <em>This is the header.</em></td>
</tr>
<tr>
<td>type one of the following character sequences: 1, 2</td>
<td>if you want to print this:</td>
</tr>
<tr>
<td>&amp;D = current date 3</td>
<td>2/2/95 Project 1</td>
</tr>
<tr>
<td>&amp;N = page number</td>
<td>type &amp;D &amp;P</td>
</tr>
<tr>
<td>&amp;T = current time 3</td>
<td>If you want to print a blank line, type &amp;B.</td>
</tr>
<tr>
<td>&amp;V = view name</td>
<td>If you want to print an &amp;, type &amp;. &amp;.</td>
</tr>
<tr>
<td>&amp;P = project name</td>
<td>If you enter a character sequence that is not defined, it is printed as is. For example, if you enter &amp;Z, then &amp;Z is printed.</td>
</tr>
<tr>
<td>&amp;B = space (use to print a blank line)</td>
<td></td>
</tr>
<tr>
<td>&amp;A = product name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>(Allen-Bradley Tag Editor)</td>
<td></td>
</tr>
</tbody>
</table>

1. Character sequences are not case sensitive.
2. If the expanded text is larger than 255 characters, the printed output may look distorted or cut off.
3. These values are based on Control Panel Settings. See the Microsoft Windows manual for details.

Aligning Header Information

<table>
<thead>
<tr>
<th>To:</th>
<th>Type:</th>
<th>For example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>left justify text</td>
<td>text or character sequence (header information is left justified by default)</td>
<td>For example, if you want to print this:</td>
</tr>
<tr>
<td></td>
<td>Project 1 2 2/3/95</td>
<td>type &amp;PA &amp;NA &amp;D</td>
</tr>
<tr>
<td>center text</td>
<td>&amp;l before the text or character sequence</td>
<td>text after this character sequence</td>
</tr>
<tr>
<td>right justify text</td>
<td>a second &amp;l before text or character sequence</td>
<td>text after this character sequence</td>
</tr>
</tbody>
</table>

If alignment is specified in part of a header line, make sure the text does not overlap. For example, if left aligned text runs to the center of the page, it overlaps centered text.
Using Tools

If the Status column or Tag Name column for a specific tag is selected, the Tools menu gives a list of available tools. From the list select the tool needed.

In some cases, the Tools list may also depend on what software is installed on the computer system. For example:

- List Editor is the same as the Summary command on the View menu. It brings up a new Tag Editor table view.
- Form Editor is the same as the Form command on the View menu. It brings up the Tag Form dialog for the selected tag.
- Import and Export access the Tag Import/Export Utility.

Tag Import/Export Utility

The Tag Import/Export utility copies SLC and PLC-5 tag information from a supported file format to a project and vice versa. The supported ASCII file formats are:

<table>
<thead>
<tr>
<th>This file format</th>
<th>Is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Programming Software (APS)</td>
<td>the ASCII documentation file produced by the APSIE utility. This file format is for the SLC processor only. For more information, see the APS Import/Export Utility User Manual, publication 1747-6.7.</td>
</tr>
<tr>
<td>Advanced Interface (AI) series software</td>
<td>the WINtelligent series version of the CSV format.</td>
</tr>
<tr>
<td>Comma Separated Value (CSV)</td>
<td>the comma separated value format used by software packages such as Excel. For more information, see your user manual for the software package you are using.</td>
</tr>
</tbody>
</table>

Important: The Import function does not import files created without keywords or files created with annotations.
Importing Tags

To import tags:

1. Choose Import from the Tools menu.

2. Select an Input Format (APS ASCII, AI, or CSV).
   
   When you import from APS ASCII format, the Import function automatically translates special characters in address comments (AC) used by the APS software as follows:
   
   • backslash (\) is changed to carriage return (<cr>)
   • double quotation marks (""’) are changed to a single (’)
   • tilde preceding a backslash (∼\) is changed to a backslash (\)

   AI software does not add the .AI extension on an exported comment and symbol file. PanelBuilder will not recognize an AI file without the .AI extension.

3. In the File box, type a source file or click Browse to search for a source file.

4. Under Destination, select a project and controller used by the project.

5. Click OK.

   The Reading Source File dialog opens followed by the Importing Tags to Project dialog as the tags are imported. These dialogs display the percentage complete.

   When the Import function is finished importing the tags, the Summary Report dialog opens.

6. Click OK to return to the table view.
Handling Data Collisions

If two or more tags have the same name, this dialog opens.

**Important:** The Import function does not check for duplicate addresses, only duplicate names.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discard Tags</td>
<td>Ignore conflicting tags. The tags in the project remain and the conflicting tags in the input source file are discarded.</td>
</tr>
<tr>
<td>Rename Tags</td>
<td>Rename the conflicting tags. The Import function adds the following extension to the duplicate tags: _# (where # is 1, 2, or 3) The Import function renames duplicate tag names up to 3 times. After that, if you try to import a tag with the same name, the imported tag is discarded.</td>
</tr>
<tr>
<td>Update Tags</td>
<td>Update the tags in the project with the data from the imported tags.</td>
</tr>
<tr>
<td>Abort</td>
<td>Exit the Import/Export utility and return to the Tag Editor.</td>
</tr>
</tbody>
</table>
Exporting Tags

To export tags:

1. Choose Export from the Tools menu.

2. Select an Output Format (APS ASCII, AI, or CSV).
   - When you export to an APS ASCII file:
     - If the tag name is longer than 10 characters, the Export function truncates the name.
     - If the description is longer than 50 characters, the Export function truncates the description.
     - If the special characters in the description are equivalent to those used by APS, the Export function translates them:
       carriage return (<cr>) to backslash (\)
       quotation mark (”) to double quotation marks (””)
       backslash (\) to tilde-backslash (∼)
     - If the tag name contains other special characters, the Export function deletes them.
   - When you export to an AI file:
     - If the tag name is longer than 15 characters, the Export function truncates the name.
     - If the description is longer than 75 characters, the Export function truncates the description.
   - When you export to a CSV file:
     - If the comment (description) field contains quotation marks, commas or carriage returns, the Export function puts quotation marks around the comment field.
     - If the comment field contains embedded quotation marks, the Export function changes them to double quotation marks (””).
3. Under Source, select a project and the controller associated with the project.

4. Under Destination, type a destination file in the File box or click Browse to search for a destination file.

5. Click OK.

The Exporting Tags From Project dialog opens followed by the Writing Destination File dialog as the tags are exported. These dialogs display the percentage complete.

When the Export function is finished exporting the tags, the Summary Report dialog opens.

6. Click OK to return to the table view.

**Examining the Results of an Import/Export**

To examine detailed results of an import or export, select the View Report button on the Summary Report dialog. For example, after importing a file and selecting View Report, this window appears with the results:

![Summary Report Window](image)

- Click to View the full report.
- Click to save the report to a file. If you want to print the report, you must save it to a file.

![Full Report Window](image)

- File: C:\AVI\UTIL\TEST2.TXT
- Project: proj
- Device: SLC

- Tags Processed: 104
- Errors: 77

- New Tags
  - HOME5
  - HOME5_AC
  - HOME5_AS
  - HOME5_C

Click OK.
### Interpreting Error Messages

<table>
<thead>
<tr>
<th>You get this error:</th>
<th>If you:</th>
<th>Work around:</th>
</tr>
</thead>
<tbody>
<tr>
<td>device error – device does not exist</td>
<td>request a device that does not exist</td>
<td>Click No to select or enter another device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Yes to create the device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This dialog box opens</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select the type of device, enter the device address, and then click OK.</td>
</tr>
<tr>
<td>device error – no device specified</td>
<td>forget to specify a device</td>
<td>Click OK, then select or enter a device.</td>
</tr>
<tr>
<td>device error – device not an SLC processor</td>
<td>select a device that is not an SLC processor (if you are importing an APS ASCII file)</td>
<td>Click OK and then select an SLC device.</td>
</tr>
<tr>
<td>parse error</td>
<td>try to import one of the following:</td>
<td>Click OK to abort the Tag Import/Export utility.</td>
</tr>
<tr>
<td></td>
<td>- a corrupted file</td>
<td>Choose Import from the Tools menu again and select another file or fix the bad file and reselect it.</td>
</tr>
<tr>
<td></td>
<td>- an unsupported file type or a file type other than the type you selected</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- a file that has been manually edited with mistakes</td>
<td></td>
</tr>
<tr>
<td>file error – file does not exist</td>
<td>select a source file that does not exist</td>
<td>Click OK. Select another source file or cancel.</td>
</tr>
<tr>
<td>file error – file already exists</td>
<td>select a destination file that does exist</td>
<td>Click Yes to replace the file or No to cancel the operation.</td>
</tr>
<tr>
<td>project error</td>
<td>enter a project that does not exist</td>
<td>Click OK. Select another project or cancel.</td>
</tr>
</tbody>
</table>

1. Import only
2. Export only
Terminal and Communication Setup

This chapter describes how to set communication and operating parameters for the PanelView terminal. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Setup Overview</td>
<td>20–2</td>
</tr>
<tr>
<td>Defining DH-485 Communications</td>
<td>20–3</td>
</tr>
<tr>
<td>Defining DH+ Communications</td>
<td>20–5</td>
</tr>
<tr>
<td>Defining DF1 Communications</td>
<td>20–7</td>
</tr>
<tr>
<td>Defining Remote I/O Communications</td>
<td>20–9</td>
</tr>
<tr>
<td>Defining Block Transfers</td>
<td>20–11</td>
</tr>
<tr>
<td>Configuring the Printer Port</td>
<td>20–13</td>
</tr>
<tr>
<td>Changing the Terminal Type</td>
<td>20–15</td>
</tr>
<tr>
<td>Setting Power-up Options</td>
<td>20–17</td>
</tr>
<tr>
<td>Setting Time/Date Format</td>
<td>20–19</td>
</tr>
<tr>
<td>Setting Advanced Terminal Options</td>
<td>20–21</td>
</tr>
<tr>
<td>Setting a Display Maintenance Schedule</td>
<td>20–23</td>
</tr>
<tr>
<td>Defining PLC/SLC Control Tags</td>
<td>20–24</td>
</tr>
<tr>
<td>Defining Status Tags</td>
<td>20–26</td>
</tr>
</tbody>
</table>

Note: For details on configuring DeviceNet and ControlNet communications, see the following publications:

- *DeviceNet Communications for PanelView terminals*
  Publication 2711–6.0.4
- *ControlNet Communications for PanelView terminals*
  Publication 2711–6.10
The Terminal Setup command on the Application menu opens the Terminal Setup dialog. This dialog defines both operating parameters and communication parameters for runtime operation.

The Terminal Setup dialog uses tabs to organize operations by function.

<table>
<thead>
<tr>
<th>Select this tab</th>
<th>To:</th>
</tr>
</thead>
</table>
| **Setup**       | • define run-time communication parameters for terminal and controller (accessed via Comms. Setup button)  
|                  | • change the terminal type of a PanelView device  
|                  | • specify whether to use the RS-232 serial port of the terminal for printing or downloading applications  
|                  | • configure communication and printing parameters for those terminals equipped with an RS-232 printer port  
|                  | • enable external font support (See Chapter 22) |
| **Power-Up**    | Define terminal power-up defaults including:  
|                  | • startup application screen  
|                  | • preset values (initial or last state values) to write to controller  
|                  | • screen to display on a restart (last user screen displayed or the startup screen)  
|                  | • whether to load application from memory card  
|                  | • whether to use downloaded configuration settings |
| **Advanced**    | Set other terminal options including:  
|                  | • auto repeat settings for terminal keys or touch cells.  
|                  | • display options  
|                  | • language in which to display terminal firmware messages.  
|                  | • timeout setting  
|                  | • time to condition the display of a PV900 monochrome or degauss the display of a PV1400 color terminal. |
| **Time/Date**   | Specify how the time and date will display in the terminal. |
| **Control Tags**| Define tags for PLC/SLC controlled screen changes and time/date changes. |
| **Status Tags** | Define tags for PanelView terminal controlled screen changes and time/date changes. |
Defining DH-485 Communications

This section shows how to define runtime parameters for a PanelView terminal and an SLC controller that will communicate on a DH-485 network.

DH-485 Network Using RS-485 Connection

A PanelView terminal with a DH-485 port is connected to an SLC controller using a multidrop or point-to-point connection. You will define DH-485 parameters for two devices:

- DH-485 PanelView Terminal
- SLC Controller (or MicroLogix 1000)

DH-485 Network Using RS-232 Connection

A PanelView terminal with an RS-232 port is connected to the Channel 0 port of an SLC 5/03 or 5/04 controller providing a dedicated DH-485 connection for high priority data. You will define DH-485 parameters for two devices:

- RS-232 (DH-485) PanelView Terminal
- SLC 5/03 or 5/04 Controller
To configure DH-485 communications:

1. Choose the Setup tab from the Terminal Setup dialog.

2. Verify the terminal name entered in the Terminal Name field.

3. Click the Comms. Setup button.

   The Communication Setup dialog shows the current DH-485 settings for the PanelView terminal and controller. The first time you open this dialog, default settings appear.

   The terminal name was defined when the application was created.


<table>
<thead>
<tr>
<th>Use</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Address</td>
<td>Specify the unique address (0 - 31) of the PanelView terminal on the DH-485 network. The default is 2.</td>
</tr>
<tr>
<td>Maximum Node Address</td>
<td>Specify the highest node address on the network. The default is 31. A low Maximum Node Address improves network performance.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Specify the baud rate of the DH-485 network. The options are 1200, 2400, 9600, 19.2K (default).</td>
</tr>
</tbody>
</table>

5. Under Network Nodes, edit the node parameters of the controller.

   To insert a node, right-click in any field and select Insert Node from the shortcut menu. Click in any field to edit it.

<table>
<thead>
<tr>
<th>Use</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Name</td>
<td>Enter a unique name for the controller that will communicate with the PanelView terminal on the DH-485 network.</td>
</tr>
<tr>
<td></td>
<td>• If you enter a new name/address, a device is added to the project.</td>
</tr>
<tr>
<td></td>
<td>• If you select the name of an existing device, the node address and node type automatically appear for that device.</td>
</tr>
<tr>
<td>Node Address</td>
<td>Select the node address (0 to 31) of the controller on the DH-485 network. The default is 1.</td>
</tr>
<tr>
<td>Node Type</td>
<td>Select the type of controller.</td>
</tr>
</tbody>
</table>

   To delete a node, right-click in a node field and select Delete Node from the shortcut menu. From this menu, you can also sort multiple nodes by name, address, type or only modified nodes.

   To copy, rename or delete devices from a project, see page 21–4.

6. Click OK to exit and return to Terminal Setup dialog.
Defining DH+ Communications

This section shows how to define runtime parameters for a PanelView terminal and a PLC or SLC 5/04 controller that will communicate on a DH+ link.

You will define parameters for these two devices:
- DH+ PanelView Terminal
- PLC 5 or SLC 5/04 Controller

Addressing for a DH+ application is similar to DH-485 applications except the DH+ link supports 64 nodes (0 - 77 octal); the DH-485 link supports 32 nodes. The DH+ link supports higher baud rates.

To configure DH+ communications:
1. Choose the Setup tab from the Terminal Setup dialog.
2. Verify the terminal name entered in the Terminal Name field.
3. Click the Comms. Setup button.

   The Communication Setup dialog shows the current DH+ settings for the PanelView terminal and controller. The first time you open this dialog, default settings appear.

   The terminal name was defined when the application was created.
4. Under Terminal, edit the following parameters.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Address</td>
<td>Select the station number (0 to 77 octal) of the PanelView terminal on the DH+ link.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Select the baud rate of the DH+ link. The baud rates and maximum cable lengths for each rate are:</td>
</tr>
<tr>
<td></td>
<td>57.6K 3,048 m (10,000 ft)</td>
</tr>
<tr>
<td></td>
<td>115.2K 1,524 m (5,000 ft)</td>
</tr>
<tr>
<td></td>
<td>230.4K 762 m (2,500 ft)</td>
</tr>
</tbody>
</table>

5. Under Network Nodes, edit the node parameters of the controller.

To insert a network node, right-click in the Node Name field and select Insert Node from the menu. Click in a field to edit it.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Name</td>
<td>Enter a unique name for the logic controller that will communicate with the PanelView terminal on the DH+ link.</td>
</tr>
<tr>
<td>Node Address</td>
<td>Select the station number (0 to 77 octal) of the logic controller on the DH+ link.</td>
</tr>
<tr>
<td>Node Type</td>
<td>Select the type of logic controller that will communicate with the PanelView terminal.</td>
</tr>
</tbody>
</table>

To delete a node, right-click in a node field and select Delete Node from the shortcut menu. From this menu, you can also sort multiple nodes by name, address, type or only modified nodes.

To copy, rename or delete devices from a project, use the Project Management command. See page 21–4.

6. Click OK to exit and return to the Terminal Setup dialog.
Defining DF1 Communications

This section shows how to define runtime parameters for a PanelView terminal and a controller that will communicate using DF1 full duplex communications over a point-to-point link or DF1 network.

You define parameters for these two devices:
- DF1 PanelView Terminal
- SLC, PLC or MicroLogix controller

To configure DF1 communications:
1. Choose the Setup tab from the Terminal Setup dialog.
2. Verify the terminal name entered in the Terminal Name field.
3. Click the Comms. Setup button.

The Communication Setup dialog shows the current DF1 settings for the PanelView terminal and controller. The first time you open this dialog, default settings appear.

The terminal name was defined when the application was created.
4. Under Terminal, edit the following parameters.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node Address</strong></td>
<td>Specify the node address (0 to 254 decimal) of the terminal for DF1 network communications. For network communications, click the Use Networking check box. For point-to-point communications with an SLC, PLC, MicroLogix 1000 or 1761–NET DNI module, the default node address of 64 is used.</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td>Select the baud rate of the terminal on the DF1 link. The baud rate must match the baud rate of the target device. Valid baud rates are: 1200, 2400, 4800, 9600, 19200. The default is 9600.</td>
</tr>
<tr>
<td><strong>Parity/Stop Bits</strong></td>
<td>Select the parity and number of stop bits used by the DF1 port on the terminal. The number of data bits is always 8. Your selection must match the settings of the target device. PLC controllers allow a parity of Even or None. For SLC controllers the parity is fixed at None.</td>
</tr>
<tr>
<td><strong>Error Detect</strong></td>
<td>Select the type of error detection performed on data. The options are CRC (Cyclic Redundancy Check) and BCC (Block Check Character). The default is CRC.</td>
</tr>
<tr>
<td><strong>Handshake</strong></td>
<td>Specify whether handshaking is used by the DF1 port. The default is Off or no handshaking. If handshaking is On, the CTS and RTS lines are enabled.</td>
</tr>
</tbody>
</table>

5. Under Network Nodes, edit the node parameters of the controller.

To insert a network node, right-click in the Node Name field and select Insert Node from the menu. Click in a field to edit it.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node Name</strong></td>
<td>Enter a unique name for the logic controller that will communicate with the PanelView terminal on the DF1 link.</td>
</tr>
<tr>
<td><strong>Node Address</strong></td>
<td>Select the node address (0 to 254 decimal) of the controller on the DF1 link.</td>
</tr>
<tr>
<td><strong>Node Type</strong></td>
<td>Select the type of controller that will communicate with the PanelView terminal.</td>
</tr>
</tbody>
</table>

To delete a node, right-click in a node field and select Delete Node from the shortcut menu. From this menu, you can also sort multiple nodes by name, address, type or only modified nodes.

To copy, rename or delete devices from a project, use the Project Management command. See page 21–4.

6. Click OK to exit and return to the Terminal Setup dialog.
Defining Remote I/O Communications

This section shows how to define runtime parameters for a PanelView terminal and PLC or SLC that will communicate on a Remote I/O link.

The PanelView terminal operates as a single rack on the network.

You will define parameters for these two devices:
- Remote I/O PanelView Terminal
- PLC or SLC (with 1747-SN Scanner) Controller

The following table defines the PLC/Scanner types with options supported by the Remote I/O PanelView terminal.

<table>
<thead>
<tr>
<th>Controller/Scanner</th>
<th>Lowest Rack #</th>
<th>Highest Rack #</th>
<th>Pass-Through Support</th>
<th>Block Transfer Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM PC 6008-SI</td>
<td>0</td>
<td>7</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>VME 6008-SV</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEC QBUS 6008-SQ</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC 5/11</td>
<td>3</td>
<td>3</td>
<td>All Series, All Revisions</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/15</td>
<td>1</td>
<td>3</td>
<td>Series B, Revision N or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/20</td>
<td>1</td>
<td>3</td>
<td>All Series, All Revisions</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/25</td>
<td>1</td>
<td>7</td>
<td>Series A, Revision J or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/30</td>
<td>1</td>
<td>7</td>
<td>Series A, Revision B or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/40</td>
<td>1</td>
<td>17&lt;sub&gt;octal&lt;/sub&gt;</td>
<td>Series A, Revision E or later Series B, Revision B or later</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC 5/60 PLC 5/80</td>
<td>1</td>
<td>27&lt;sub&gt;octal&lt;/sub&gt;</td>
<td>Series A, Revision E or later Series B, Revision B or later</td>
<td>Yes</td>
</tr>
<tr>
<td>SLC 1747-SN Series A</td>
<td>0</td>
<td>3</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SLC 1747-SN Series B</td>
<td>0</td>
<td>3</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Other 1771-SN Subsystem</td>
<td>1</td>
<td>7</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

To configure Remote I/O communications:
1. Select the Setup tab from the Terminal Setup dialog.
2. Verify the terminal name entered in the Terminal Name field

The terminal name was defined when the application was created.
3. Click the Comms. Setup button.

The Communication Setup dialog shows Remote I/O parameters for the PanelView terminal and the PLC/Scanner.

4. Under PLC/Scanner, edit Remote I/O parameters for the PLC.

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Specify the type of PLC controller that will communicate with the terminal on the Remote I/O network. See Table 20.A.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name for the PLC/Scanner.</td>
</tr>
<tr>
<td></td>
<td>• If you enter a new name/address, a device is added to the project.</td>
</tr>
<tr>
<td></td>
<td>• If you select the name of an existing PLC/Scanner device, the Rack address and PLC/Scanner Type automatically appear for that device.</td>
</tr>
</tbody>
</table>

To copy, rename or delete devices from a project, use the Project Management command. See page 21–4.

5. Under Terminal, edit Remote I/O parameters for the PanelView terminal.

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Specify the unique address (0 - 76 octal) of the PanelView terminal on the remote I/O link. The options are limited to the rack addresses supported by the controller/scanner.</td>
</tr>
<tr>
<td>Module Group</td>
<td>Specify the module groups used by the terminal in the rack. Each box represents 2 module groups. The module groups must be contiguous.</td>
</tr>
<tr>
<td>Last Chassis</td>
<td>Specify whether the terminal occupies the last module group (no higher module groups assigned) within the rack.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Specify the baud rate used on the Remote I/O link. The options (and maximum cable lengths) are: 57.6K 10,000 feet (default) 115.2K 5,000 feet 230.4K 2,500 feet</td>
</tr>
</tbody>
</table>

6. Click OK to save the settings and return to Terminal Setup.
Defining Block Transfers

Use block transfers on a Remote I/O link to transfer:
- data or
- applications from a computer on the DH+ network to a terminal on the Remote I/O network using Pass-Through

You can create up to 10 block transfer channels, numbered 1 – 10. Each channel is associated with a block transfer read or write instruction (BTR or BTW) in the controller ladder logic.

To define block transfers:

1. Click the Block Transfer button from the Communication Setup dialog.
   
   If the controller/scanner does not support block transfers, the Block Transfer button is dimmed.

2. Enter the block transfer parameters starting with 1.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Enable or disable the block transfer. The default is disabled.</td>
</tr>
<tr>
<td>Address</td>
<td>Specify the starting address of the block transfer in a native SLC or PLC (Remote I/O) link.</td>
</tr>
<tr>
<td>Mode</td>
<td>Specify Read or Write.</td>
</tr>
<tr>
<td>Length</td>
<td>Specify the number of words (1–64) required by a block transfer. The default is 64. A length of 63 is reserved for Pass-Through. Each block transfer must use a different starting address, length and read/write mode.</td>
</tr>
</tbody>
</table>

3. Repeat step 2 for each additional block transfer required.

4. If downloading applications from a computer on the DH+ network, you must select the Pass-Through check box.

**Note:** If Pass-Through is not supported by controller, the check box is dimmed.
5. Select a Block Transfer Timeout value (0–60 seconds).

   A value of 0 disables the timeout which means the terminal will not generate Block Transfer timeout warnings.

6. Click OK to return to the Communication Setup dialog.

The dialog below shows 2 block transfer assignments. It also shows that Pass-Through is enabled for application transfers from a DH+ network.
Configuring the Printer Port

This section shows how to configure:

- communication parameters
- print parameters

for those terminals equipped with an RS-232 serial port.

The Setup tab of the Terminal Setup dialog indicates whether the terminal has an RS-232 port. If Printing is selected in the Serial Port Usage area, the serial port is configured with the settings below.

The printer port settings are downloaded with the application if the “Use downloaded configuration settings” option is enabled on the Power-Up tab of the Terminal Setup dialog.

To configure the printer port of the PanelView terminal:

1. The selected PanelView terminal must have an RS-232 port.
2. Click the Printer Setup button from the Setup tab of the Terminal Setup dialog.

3. Specify the communication parameters for the serial printer port.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>Set the baud rate of the printer port. The baud rate must match the printer's baud rate. The options are 1200, 2400, 4800, 9600, 19200. The default is 9600.</td>
</tr>
<tr>
<td>Parity</td>
<td>Specify Even, Odd or No parity. The default is None.</td>
</tr>
<tr>
<td>Data Bits</td>
<td>Specify 7 or 8 data bits. The default is 8.</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Specify 1 or 2 stop bits. The default is 1.</td>
</tr>
<tr>
<td>Handshaking</td>
<td>Specify how handshaking is handled. The options are Software, Hardware, or None. The default is None.</td>
</tr>
</tbody>
</table>

Refer to your printer’s user manual for details on how to set communication parameters for the printer.
4. Configure print parameters for the printer.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Margin</td>
<td>Specify the left page margin for printing. The left margin must be &lt; than the page width.</td>
</tr>
<tr>
<td>Page Width</td>
<td>Specify the number of characters to print per line. Valid settings are 20–132. The default is 80 characters.</td>
</tr>
<tr>
<td>Perforation Skip Value</td>
<td>Specify the number of blank lines at the top and bottom of each page. The default is 6. The value must be &lt; the page length. A value of 0 disables this parameter. If the page length is 66 and the skip value is 5, the page is formatted as 2 blank lines, 61 printed lines, and 3 blank lines. The extra line is always at the bottom.</td>
</tr>
<tr>
<td>EOL Char</td>
<td>Specify the End of Line Character. The options are CR (Carriage Return) and CR+LF (Carriage Return and Line Feed). The default is CR.</td>
</tr>
<tr>
<td>Page Length</td>
<td>Specify the number of lines to print per page. Valid settings are 0–255. The default is 66 lines. The value of 0 indicates continuous printing with no page breaks.</td>
</tr>
<tr>
<td>New Page Control</td>
<td>Specify what controls a page break. The options are Form Feed or blank lines. The default is Form Feed.</td>
</tr>
</tbody>
</table>

5. Type the characters in the Printer Initialization String box that will initialize the printer after communications is established.

The initialization string can contain a maximum of 20 characters. The default is a Null string. Use these rules when entering string:

- to enter control characters (decimal values 0 – 31), type ^ before the character. Upper or lowercase is accepted (c or C).

<table>
<thead>
<tr>
<th>To Enter:</th>
<th>Decimal Value</th>
<th>Type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL @</td>
<td>0</td>
<td>^@</td>
</tr>
<tr>
<td>CTRL A – CTRL Z</td>
<td>1 – 26</td>
<td>^A – ^Z</td>
</tr>
<tr>
<td>CTRL [</td>
<td>27</td>
<td>^[</td>
</tr>
<tr>
<td>CTRL \</td>
<td>28</td>
<td>^\</td>
</tr>
<tr>
<td>CTRL ]</td>
<td>29</td>
<td>^]</td>
</tr>
<tr>
<td>CTRL^</td>
<td>30</td>
<td>^^</td>
</tr>
<tr>
<td>CTRL_</td>
<td>31</td>
<td>^_</td>
</tr>
</tbody>
</table>

- to enter a literal character, precede the character with a backslash \. For example, to enter ^, type \^.
- to enter decimal values between 126 – 256, precede the decimal value with the backslash \. For example, to enter the decimal equivalent of 255, type \255.
- each sequence preceded with ^ or \ represents a single character in the initialization string. For example, \255 and ^\ each represent one character in the 20 character string.

6. Click the Save as Defaults button to save the settings.

7. Click OK to exit and return to the Setup tab.
Changing the Terminal Type

You can convert an application from one terminal type to another terminal. However, you may need to modify properties of the application to make it compatible with the terminal.

Converting Application from Touch Screen to Keypad
If converting an application from a Touch (or Keypad & Touch) to a Keypad, you must assign function key input to screen objects.

Converting Application to another Terminal Type
If converting an application to a different terminal type (for example, 900 to 600), you may need to reduce the number of objects on the screen, adjust the location/size of objects, or change the grid spacing.

Converting Application to another Communication Protocol
If converting an application to a different communication protocol, (for example, Remote I/O to DH-485), you must update the terminal setup and tags appropriately.

- update the communication parameters for the PanelView terminal and controller in the Communication Setup dialog.
- update the tags (address and node name) in the Tag Editor.

Converting Application from Monochrome to Color or Grayscale
If converting a monochrome application to a color or grayscale application, the following dialog open.

Select the colors to use when converting the application.

- background color of screen (default is black)
- foreground color of objects (default is white)
- background color of objects (default is black)

If the background/foreground colors of objects were reversed, the above colors would be the opposite.

Converting Application from Color to Grayscale
If converting a color application to a grayscale application:

- screen background is converted to black
- colors are converted to the closest shade of gray
- color bitmaps are converted to grayscale bitmaps

Also, text sizes are converted to the closest matching font in the new application. You may want to resize the text.
Converting Application from Color to Monochrome

If converting a color application to a monochrome application, all colors are removed from the screen.
- screen background is converted to white
- brighter colors of objects are converted to white
- darker colors of objects are converted to black
- color bitmaps are converted to monochrome bitmaps

Also, the text sizes are converted to the closest matching size in the new application. You may want to resize the text.

Converting Application to a Terminal without Printer Support

If converting an application that supports printing (terminal has RS-232 printer port) to an application that does not support printing:
- the print attribute is removed from appropriate objects.
- an error message is generated for Print Only Objects that are used by the application (the message indicates the specific object).

To change the terminal type of a PanelView device:

1. Choose Terminal Setup from the Application menu.
2. Select the Setup tab.
   The dialog shows information associated with the terminal name when the application was first created.
3. From the Terminal Name list box, select another name if the application is to run in a different terminal.
4. Under Terminal Type Information, define the terminal in which the application will run, by choosing options in this order:
   - select a terminal from PV Type box
   - select Keypad, Touch or Keypad & Touch
   - select a Catalog number and firmware Version (only the options that fit the selected terminal type are displayed)

   The Ports area shows the ports on the selected terminal. If the terminal has an RS-232 port, the Serial Port Usage area shows whether the port is used for printing or downloading.
5. Click OK.

If the selected terminal does not use the same communication protocol as the application, you are asked if you want to convert the application to match the terminal’s protocol.
Setting Power-up Options

The Power-Up tab in the Terminal Setup dialog defines default operating parameters for the PanelView terminal on power-up:

- startup screen for application
- whether to write object preset values (initial presets or last terminal state values) to controller
- screen to display on power-up
- memory card load conditions
- configuration settings to use on first power-up after download

To set or change power-up defaults for the terminal:


2. From the Startup Screen list box, select the first screen to display when the application starts in the terminal.

3. Select the Write to Controller on Startup check box if you want to write preset values for objects to the controller on startup. The default is to not write values to the controller.

   **Note:** Remote I/O and DeviceNet terminals always write preset values to the controller on startup. The Write to Controller on Startup check box is always selected for these terminals.

4. If you select Write to Controller on Startup, you can choose either Use Terminal Presets or Use Last Terminal States.

<table>
<thead>
<tr>
<th>Select:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Terminal Presets</td>
<td>Write initial values set by application.</td>
</tr>
<tr>
<td>Use Last Terminal States</td>
<td>Write values present prior to power-up. This is the default.</td>
</tr>
</tbody>
</table>
**Note:** Terminal presets for control objects are set in the object’s dialog. These values override initial values entered in the Tag Editor except for numeric entry objects. Initial values for numeric entry objects are set in the Tag Editor.

5. Specify whether to display the Last user screen on restart or the startup screen. The default is to display the last user screen.

To display the startup screen, clear the check box.

6. Under Memory Card, specify what action the terminal should automatically take on a restart if a memory card is loaded in the terminal. The memory card stores only one application.

<table>
<thead>
<tr>
<th>Select:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Load from Card</td>
<td>Always load the application on the memory card.</td>
</tr>
<tr>
<td>Never Load from Card</td>
<td>Require the operator to load a specific application from the memory card using the Memory Card Transfers option in the Configuration Mode menu.</td>
</tr>
<tr>
<td>Load from Card if Invalid Application Detected</td>
<td>Load the application on the memory card only if the current application in the terminal is invalid.</td>
</tr>
</tbody>
</table>

If a memory card isn’t loaded or if the card contains more than one file, the terminal restarts with the application that was running before the restart.

From the terminal, you can also manually download a memory card application to the terminal by selecting Memory Card from the Configuration Screen and then the Restore From Card option.

7. Specify whether or not to Use downloaded configuration settings on the first restart after a download. The default is to use the configuration settings downloaded with the application.

To use the current settings in the terminal on a restart, click the check box until the X disappears.

8. Click OK to save the settings and exit the dialog.
Setting Time/Date Format

The Time/Date tab in the Terminal Setup dialog specifies how the time and date are displayed on the PanelView terminal.

With dates, you can vary the order of the month, day and year or change the punctuation used to separate parts of the date. You can display times in 12-hour or 24-hour format with different suffix notations such as AM for morning or PST for Pacific Standard Time.

<table>
<thead>
<tr>
<th>Date Formats</th>
<th>Time Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month/Day/Year 7/3/99</td>
<td>12-Hour Format 2:56</td>
</tr>
<tr>
<td>With Leading Zeros 07/03/99</td>
<td>With Time Zone &amp; Time Standard Designations 2:56 PM CST</td>
</tr>
<tr>
<td>Day/Month/Year 3/7/99</td>
<td>24-Hour Format 14:56</td>
</tr>
<tr>
<td>With 4-digit Year 7/3/1999</td>
<td>With Leading Zeros 02:56</td>
</tr>
<tr>
<td>Year/Month/Day 99/7/3</td>
<td>With Seconds 14:56:29</td>
</tr>
<tr>
<td>With User Defined Separator 7<em>3</em>99</td>
<td>With User Defined Separator 14<em>56</em>29</td>
</tr>
</tbody>
</table>

To activate the time/date settings in the PanelView terminal, you must enable the “Use downloaded configuration settings” option in the Power-Up tab on the Terminal Setup dialog.

**To change the time or date format used by the terminal:**

1. Select the Time/Date tab from the Terminal Setup dialog.
2. Set the options you want for the date format. The Sample area displays the format as you select options.
The following table describes the options.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Specify the order of the month (M), day (D), and year (Y). The</td>
</tr>
<tr>
<td></td>
<td>initial default is MDY.</td>
</tr>
<tr>
<td>Separator</td>
<td>Specify the character to separate the month, day and year. You</td>
</tr>
<tr>
<td></td>
<td>can enter any character as the separator. The default is the</td>
</tr>
<tr>
<td></td>
<td>slash (/).</td>
</tr>
<tr>
<td>Day/Month</td>
<td>Specify that the day or month appears as two digits. For example,</td>
</tr>
<tr>
<td>Leading Zero</td>
<td>February 7 appears as 02–07. By default leading zeros are not</td>
</tr>
<tr>
<td></td>
<td>displayed, 2-7.</td>
</tr>
<tr>
<td>Year</td>
<td>Specify the year as two digits or four digits. For example, the</td>
</tr>
<tr>
<td></td>
<td>year 1994 can display as 94 or 1994.</td>
</tr>
</tbody>
</table>

3. Set the options you want for the time format. The Sample area displays the format as you select options.

The following table describes the options.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>12-Hour</td>
<td>Display the time in numbers representing hours between 0 and 11</td>
</tr>
<tr>
<td></td>
<td>(00:00 – 11:59). The boxes to the right specify AM or PM, or other</td>
</tr>
<tr>
<td></td>
<td>notations such as CST, PST or EST.</td>
</tr>
<tr>
<td>24-Hour</td>
<td>Display the time in numbers representing hours between 0 and 23</td>
</tr>
<tr>
<td></td>
<td>(00:00 - 23:59). The box to right specifies a notation such as CST,</td>
</tr>
<tr>
<td></td>
<td>PST or EST.</td>
</tr>
<tr>
<td>Separator</td>
<td>Specify a character to separate the hours, minutes, and seconds.</td>
</tr>
<tr>
<td></td>
<td>The default separator is the colon (:).</td>
</tr>
<tr>
<td>Leading Zero</td>
<td>Display the hours before ten as a two digit number with a leading</td>
</tr>
<tr>
<td></td>
<td>zero. For example, 3:15 would display as 03:15. By default, the</td>
</tr>
<tr>
<td></td>
<td>leading zero is not displayed.</td>
</tr>
<tr>
<td>Display</td>
<td>Display seconds. The default is to display seconds.</td>
</tr>
<tr>
<td>Seconds</td>
<td></td>
</tr>
</tbody>
</table>

4. Click OK to save the settings and exit the dialog.
Setting Advanced Terminal Options

The Advanced tab in the Terminal Setup dialog sets advanced options on the PanelView terminal, including how to:

- set auto repeat settings for the terminal keys and touch cells
- set terminal display and options
- set language for terminal messages
- set timeout for objects with handshake tags
- set time to perform display maintenance of terminal

To activate the Advanced terminal options in the PanelView terminal, you must enable the “Use downloaded configuration settings” option in the Power-Up tab on the Terminal Setup dialog.

To set advanced options for the PanelView terminal:

1. Select the Advanced tab from the Terminal Setup dialog.

2. Under Touch & Key Auto Repeat, set auto repeat settings for the terminal keys and touch cells. These settings are used only by the up and down arrow keys to move the cursor in control lists and screen lists.

<table>
<thead>
<tr>
<th>Use</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Specify how fast a key or touch cell repeats when it’s pressed and held. Valid rates are 0 to 5 Hz, where:</td>
</tr>
<tr>
<td></td>
<td>0 = no repeat</td>
</tr>
<tr>
<td></td>
<td>1 = repeats every second</td>
</tr>
<tr>
<td></td>
<td>2 = repeats every 1/2 second</td>
</tr>
<tr>
<td></td>
<td>3 = repeats every 1/3 second</td>
</tr>
<tr>
<td></td>
<td>4 = repeats every 1/4 second</td>
</tr>
<tr>
<td></td>
<td>5 = repeats every 1/5 second</td>
</tr>
<tr>
<td>Delay</td>
<td>Specify how long the terminal waits after a key or touch cell is pressed before it repeats. Options are .2, .4, .6, .8, 1.0, 1.5, 2.0, 2.5 seconds. The default is .4 second.</td>
</tr>
</tbody>
</table>
3. Set Terminal Display parameters.

**For PanelView 550**

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Video</td>
<td>Enable/disable reverse video. Default is disabled.</td>
</tr>
<tr>
<td>Indicator Bar Blink</td>
<td>Enables/disables blinking of the indicator bar on the terminal. By default, the indicator bar does not blink.</td>
</tr>
<tr>
<td>Backlight</td>
<td>Set the state of the terminal backlight at startup. Select On to turn the backlight on; select Off to turn the backlight off.</td>
</tr>
</tbody>
</table>

**For other PanelView Terminals**

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Blink (Color)</td>
<td>Enable/disables blinking using the background color of the screen. By default, background blinking is disabled.</td>
</tr>
<tr>
<td>Reverse Video (monochrome &amp; grayscale)</td>
<td>Enable/disable reverse video (dark text/graphics on light background). The default is normal video (light text/graphics on dark background).</td>
</tr>
<tr>
<td>Display Intensity</td>
<td>For PV900 monochrome terminals, sets the intensity of the display. Options are 35, 40, 50, 60, 70, 80, 90, 100. The default is 100 (highest intensity).</td>
</tr>
<tr>
<td>Indicator Bar Blink</td>
<td>Enables/disables blinking of the indicator bar on the terminal. By default, the indicator bar does not blink.</td>
</tr>
<tr>
<td>Screen Saver On or Off</td>
<td>Turn the screen saver on or off. The default is off. The On setting reduces the screen intensity if user input or controller changes are not received within the specified timeout.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Set the period of time before an inactive screen enters screen saver mode. Settings: 5, 10, 15, 20, 25, 30 (minutes).</td>
</tr>
<tr>
<td>Display Intensity</td>
<td>For PV900 monochrome terminals, sets the display intensity in screen saver mode. Settings: 0, 35, 40, 50, 60, 70, 80, 90, 100.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Lists the available screen savers. The screen saver starts automatically if your terminal is inactive for a specified time.</td>
</tr>
</tbody>
</table>

4. From the System Language box, select the language in which the terminal displays error messages. The options are: French, German, Italian, Spanish, English. The default is English.

5. From the Handshake Timeout list box, select a timeout value (in seconds). For objects with handshake tags, this timeout specifies the length of time the controller has to set a handshake bit before an error message is displayed.

Handshake timeout values range from 1 to 60 seconds. The default is 4 seconds.

6. Click OK to save settings and exit dialog.
Setting a Display Maintenance Schedule

The Display Maintenance Setup dialog allows you to set a daily schedule for:

- conditioning the display of a PanelView 900 monochrome terminal to prevent image burn in.
- degaussing (or demagnetizing) the display of a PanelView 1400.

Default maintenance for these terminals occurs at 12:00 am every day. The maintenance will not start until the terminal is inactive. Conditioning of the PV900 takes approximately 30 minutes; degaussing of the PV1400 takes a few seconds.

The display maintenance schedule is downloaded with the application if the “Use downloaded configuration settings” option is enabled on the Power-Up tab of the Terminal Setup dialog.

To set a daily schedule for display maintenance:

1. Click the Maintenance button from the Advanced tab of the Terminal Setup dialog.

   This button is only available for PV900 monochrome and PV1400 color terminals.

2. Select the Enable Display Maintenance check box to enable/disable display maintenance. The default is enabled.

3. From the Hour list box, select the hour (0 – 23) at which to start the display maintenance. The hour is defined in 24-hour military time. The default is 0 or 12:00 am.

4. From the Minute list box, select the minute (0 – 59) of the hour at which to start the display maintenance.

5. Click OK to exit and return to the Advanced tab.
Defining PLC/SLC Control Tags

The PLC/SLC uses control tags to display specific screens and to control the time/date on the PanelView terminal. The time and date are updated every minute. The screen that the controller selects will override the current PanelView screen and take the operator to the current screen for that state of the operation.

To create or edit control tags:

1. Select the Control Tags tab in the Terminal Setup dialog.

2. Enter or select tag names for one or more control options. The table below defines each option.

   To clear a tag name field, highlight the text and press DELETE.

3. Click the Edit Tag button to edit the definition of a tag name or edit the definition later using the Tag Editor.

4. Click OK to save the settings and exit the dialog.

<table>
<thead>
<tr>
<th>Terminal Control Tags</th>
<th>Description</th>
<th>Valid Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Number</td>
<td>Name of tag address where the controller writes a screen number to control a screen change. For operator controlled screen changes, the Screen Number tag address must contain a 0.</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>Date</td>
<td>Names of tag addresses where the controller writes the current year, month and day for date displays. The value at the Year tag address must be 2 digits (90–99 for 1990–1999 or 00–89 for 2000–2089). To maintain Y2 compliance, the ladder logic must perform the following conversions before sending the value to the terminal: – If the year is ( \leq 1999 ), subtract 1900 – If the year is ( &gt; 1999 ), subtract 2000</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>Time</td>
<td>Names of tag addresses where the controller writes the current hour, minutes and seconds for time displays.</td>
<td>Unsigned Integer</td>
</tr>
</tbody>
</table>
Control Tags Example

In the following example, a screen control tag is used to display caution and operator information screens. The controller writes a screen number to the PanelView whenever operating parameters exceed predefined limits. The PanelView is configured with the following screen and control tag information:

Screen Number Tag:  Tag Name = Screen  
Tag Address = N7:10  

Screen 10:  Configured as Information Screen  
Screen 11:  Configured as Caution Screen  

1. The Controller monitors an automatic sorting process. A bar code reader signals the presence of a package requiring an operator’s attention. The controller logic program writes a value of 10 to address N7:10.

2. The PanelView reads the value (10) at the Screen tag (N7:10). Screen number 10 is displayed.

3. The PanelView reads the value (11) at the Screen tag (N7:10). Screen number 11 is displayed.

4. The controller writes a value of 0 to the control tag N7:10 to return control of the displayed screen back to the operator. If the control tag contains any address other than 0, the operator can not change the screen.

5. The operator responds and selects another screen. The PanelView continues to monitor the process.

6. The controller writes a value of 10 to address N7:10.

7. The PanelView reads the value (11) at the Screen tag (N7:10). Screen number 11 is displayed.

8. The controller continues to monitor the process. A jam on a conveyor requires immediate attention by the operator. The controller writes a value of 11 to address N7:10.

9. The PanelView reads the value (11) at the Screen tag (N7:10). Screen number 11 is displayed.

10. The operator responds and selects another screen. The PanelView continues to monitor the process.

System monitoring screen displayed.
Defining Status Tags

The controller uses status tags to read the status of the current screen number and date/time. The time and date are updated every minute.

To edit or create terminal status tags:

1. Select the Status Tags tab in the Terminal Setup dialog.

2. Enter or select tag names for each status option. The table below defines each option.
   - To clear a tag name field, highlight the text and press DELETE.

3. Click the Edit Tag button to edit the definition of a tag name or edit the definition later using the Tag Editor.

4. If desired, change Time/Date Output Interval (Min). Values range from 1 to 60 minutes. The default is 1 minute.
   - Setting the interval to 60 minutes reduces traffic on the network but also reduces the accuracy of the displayed time.
   - If you detect a problem with screen changes on a busy network, increase the output interval.

5. Click OK to save the settings and exit the dialog.

<table>
<thead>
<tr>
<th>Terminal Status Tags</th>
<th>Description</th>
<th>Valid Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Number</td>
<td>Name of the tag address to which the PanelView writes the current screen number.</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>Date</td>
<td>Names of tag addresses where the PanelView writes the current year, month and day. The value at the Year tag address must be 2 digits (90–99 for 1990–1999 or 00–89 for 2000–2089). The ladder logic must perform the following conversions before sending the values to the controller: – If the year is ≤ 1999, add 1900 – If the year is &gt; 1999, add 2000</td>
<td>Unsigned Integer</td>
</tr>
<tr>
<td>Time</td>
<td>Names of tag addresses to which the PanelView writes the current hour, minutes and seconds.</td>
<td>Unsigned Integer</td>
</tr>
</tbody>
</table>
Chapter Objectives

Managing Projects

This chapter contains these sections:

<table>
<thead>
<tr>
<th>Sections</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Projects</td>
<td>21–1</td>
</tr>
<tr>
<td>Managing Projects</td>
<td>21–2</td>
</tr>
<tr>
<td>Managing Devices in Projects</td>
<td>21–4</td>
</tr>
<tr>
<td>Copying a Project to Another Computer</td>
<td>21–6</td>
</tr>
<tr>
<td>Restoring a Project</td>
<td>21–7</td>
</tr>
<tr>
<td>Moving an Application to Another Computer</td>
<td>21–7</td>
</tr>
<tr>
<td>Verifying Tags and Devices in a Project</td>
<td>21–8</td>
</tr>
<tr>
<td>Adding Unknown Tags or Devices to a Project</td>
<td>21–9</td>
</tr>
<tr>
<td>Setting Preferences for Verifying Tags and Devices</td>
<td>21–10</td>
</tr>
<tr>
<td>Restoring a Project Created with a Restricted Release of PanelBuilder</td>
<td>21–11</td>
</tr>
</tbody>
</table>

About Projects

Each PanelBuilder application (.PBA file) is associated with a project, located in the C:\AB\PROJECTS folder. The project contains:

- tag definitions
- device information (terminal type and controller)

required for the terminal to communicate with data table addresses in the controller.

Tags and devices are specific to the communication protocol used by the terminal (for example, DH-485 or Remote I/O). Different applications can share a project if they use the same communication protocol.

For example, a project for a Remote I/O application requires a Remote I/O PanelView terminal, a valid PLC controller and tags with PLC formatted addresses (or SLC with SN Scanner and tags with SLC formatted addresses). A project for a DH-485 application requires a DH-485 PanelView terminal, an SLC controller and tags with SLC formatted addresses.

You can change the project associated with an application from the Project Management dialog. From this dialog, you can also copy, rename or delete projects and devices.
Managing Projects

The Project tab in the Project Management dialog lets you:

- view the current project for an open application
- change the current project for an application
- create a new project
- rename a project
- make a copy of an existing project
- delete a project

An application must be open to change the project associated with the application. For all other project operations, however, the application does not have to be open.

To manipulate projects:

1. Choose Project Management from the Application menu.

   The Project Management dialog opens.

2. Select the Projects tab.

   The Project tab shows the project that is currently used by the application and a list of existing projects.

   If an application is not opened, the Current Project field is blank.

3. Perform an operation as defined in the table on the next page.

4. Click Done.
## Project Operations

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| Change the current project | An application must be opened, to view or change the current project associated with the application.  
1. From the Current Project box, select the project you want to associate with the opened application.  
2. Click Done. You are asked to confirm the change.  
PanelBuilder validates the project for a valid terminal type and controller device. |
| Create a new project | 1. Click the New button.  
2. In the dialog that opens, enter a unique 1 to 32 character name for the new project. The name cannot start with a number or contain spaces.  
3. Click the OK button.  
The project appears in the Existing Projects list under the new name. |
| Rename a project | 1. From the Existing Devices list, select the project you want to rename.  
2. Click the Rename button.  
3. In the dialog that opens, enter a new 1 to 32 character name for the project. The name cannot start with a number or contain spaces.  
4. Click the OK button.  
The project appears in the Existing Devices list under the new name; not the old. |
| Copy a project | 1. From the Existing Devices list, select the project you want to copy.  
2. Click the Copy button.  
3. In the dialog that opens, enter a new 1 to 32 character name for the copied project. The name cannot start with a number or contain spaces.  
4. Click the OK button.  
Two versions of the project now exist; one under the original name and one under the new name. |
| Delete a project | 1. From the list of Existing Projects, select the project you want to delete. You cannot select the project currently used by the application.  
2. Click the Delete button. You are asked to confirm the deletion.  
3. Click Yes to delete the project.  
If more than one project is to be deleted, click Yes for each project or Yes to All.  
All tag definitions associated with the project are **permanently** removed.  
**Important:** Do not use DOS or Windows tools to delete projects. |
Managing Devices in Projects

Managing Devices in Projects

The Devices tab in the Project Management dialog lets you:
- view PanelView terminal devices and PLC/SLC devices that are currently defined for a project
- rename a device
- make a copy of an existing device
- delete a device

You cannot create new devices from the Project Management dialog.

- PanelView terminal devices are added to a project when an application is first created using the New Application dialog.
- Controller devices are added to a project using the Comms. Setup button on the Terminal Setup dialog.

To manipulate devices:

1. Choose Project Management from the Application menu.

   The Project Management dialog opens.

2. Select the Devices tab.

   The Devices tab shows devices currently defined in a project.

3. Perform an operation as defined in the table on the next page.

4. Click Done.
## Device Operations

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>View or edit devices for a project</td>
<td>From the Current Project box, select a project name. The Existing Devices list shows all devices (PanelView terminals and controllers) defined for the selected project.</td>
</tr>
</tbody>
</table>
| Rename a device                   | 1. From the Existing Devices list, select the device you want to rename.  
                                         2. Click the Rename button.  
                                         3. In the dialog that opens, enter a new 1 to 32 character name for the device. The name cannot start with a number or contain spaces.  
                                         4. Click the OK button.  
                                         The device appears in the Existing Devices list under the new name; not the old. |
| Copy of a device                   | 1. From the Existing Devices list, select the device you want to copy.  
                                         2. Click the Copy button.  
                                         3. In the dialog that opens, enter a new 1 to 32 character name for the copied device. The name cannot start with a number or contain spaces.  
                                         4. Click the OK button.  
                                         Two versions of the device now exist; one under the original name and one under the new name. |
| Delete a device                    | 1. From the list of Existing Devices, select the device you want to delete.  
                                         2. Click the Delete button. You are asked to confirm the deletion.  
                                         3. Click Yes.  
                                         If more than one device is to be deleted, click Yes for each device or Yes to All.  
                                         The device is permanently removed from the project. All occurrences of that device name are removed from the application. |
Because applications can share the same project, projects are portable. They can be copied from one computer to another. You may have an application on another computer that uses all or some of the tags in an existing project.

Each project and its files are stored as a separate folder in C:\AB\PROJECTS. For example, the project files for a project named PV900PRJ are stored as follows:

C:\ab\projects\PV900PRJ
    appdata.db
    appdata.mb
    appdata.px
    element.db
    element.mb
    element.px

To copy a project from one computer to another:

1. Copy the project folder and all of its files to a disk.
2. Insert the disk in the drive on the target computer.
3. Copy the project files on disk to the C:\AB\Projects.
5. Choose Project Management from the Application menu.
6. From the Current Project list, select the name of the project just copied to the computer.
7. Click Done.

When you open the application, the copied project will become the current project for the application.

Note: Translated applications (.PVA files) are downloaded to the terminal with only those project tags used by the application. When copying .PBA files to another computer, only those tags used by the application are copied with the application.
Restoring a Project

If a project is deleted accidentally, an application associated with it may be used to recreate the project.

1. Open the application.

   A dialog opens indicating that a project does not exist for the application. You are asked if the project should be recreated.

2. Select Yes. The project is recreated with all the device and tag data required by the application.

Moving an Application to Another Computer

Projects with the same name can reside on different computers. However, even though the name is the same, the projects may contain different tags or share only some tags.

Before moving an application to another computer, verify whether the project used by the application exists on the target computer.

- Search C:\ABA\Projects\ for a folder with the same project name
- Choose the Project Management command on the Application menu and search for the project name in the Existing Projects list.

If the project does not exist, open the .PBA file normally.

If the project does exist, determine if you want to use the project already on the computer or the tag information in the .PBA file.

- To use the project on the computer, select Replace None from the window below.
- To copy the tag information from the .PBA file to the computer, select Replace All.
Whenever you open an application (.PBA file), the dialog below opens to verify a one-to-one correspondence between the tags in the application and the tags in the project. The dialog then reopens to verify the devices in the application with the devices in the project.

It is possible that the application tags or devices are different than those in the project.

**For example:**

1. You transfer an application (.PBA file) from a computer to a laptop. Tag information is stored in the .PBA file. When you open the application, a project containing all the tags is created on the hard drive.

2. You edit the definition of a tag on the laptop and then save the application (.PBA file). The project on the laptop is now different than the original project copied from the computer.

3. You transfer the application (.PBA file) back to the computer. The updated project is transferred with the application.

4. When you open the application (.PBA file) on the computer, a dialog opens allowing you to update the original project.

   This dialog does not open if you are creating a new application that is not yet associated with a project.

The dialog displays the name of the first application device or tag that is different than the project. You have the following options:

<table>
<thead>
<tr>
<th>Click</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Replace the project tag or device with the application tag or device. Select Yes, if you know that a specific tag or device has been modified and you want to update the project database.</td>
</tr>
<tr>
<td>No</td>
<td>Ignore the application tag or device. Do not replace the tag or device in the project database with the application tag or device.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Replace all project tags or devices with the application tags or devices.</td>
</tr>
<tr>
<td>Replace None</td>
<td>Ignore all application tags or devices. Do not replace any tags or devices in the project.</td>
</tr>
<tr>
<td>Cancel Open</td>
<td>Cancel the open.</td>
</tr>
</tbody>
</table>

If you select No or Replace None, a dialog opens reminding you that the application may not validate because of the differences.
Adding Unknown Tags or Devices to a Project

When you open an existing application it is possible that the application devices or tags are not in the project. This section shows how to load unknown tags or devices in a project.

PanelBuilder displays the following dialog if the application you are opening contains devices (terminal/controller) or tags that do not exist in the application’s project.

The dialog displays the name of the first device or tag not found in the project. You must tell PanelBuilder what to do with unknown tags. The options are:

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Add named device or tag to project database.</td>
</tr>
<tr>
<td>No</td>
<td>Ignore device or tag, not adding it to the project database.</td>
</tr>
<tr>
<td>Add All</td>
<td>Add all unknown devices or tags to the project database.</td>
</tr>
<tr>
<td>Add None</td>
<td>Ignore all unknown devices or tags and open the application.</td>
</tr>
<tr>
<td>Cancel Open</td>
<td>Cancel the open.</td>
</tr>
</tbody>
</table>
You can control the behavior of PanelBuilder when opening an application. Choose Preferences from the Application menu.

### Show Project Database Restore Dialog

Select this check box to display the Project Database Restore dialog each time you open an application. This dialog prompts you to:

- replace duplicate tags and devices in the project database with those in the application.
- add application tags and devices to the project database if they are missing.

This is the default option. To add missing tags and replace duplicate tags in the project database without showing the Project Database dialog, disable this check box and select the other two boxes.

### Always Add Missing Tags & Devices

Select this check box and disable the first check box to add missing tags and devices to the project data database without opening the Project Database dialog. This option is equivalent to clicking the Add All button on the Project Database dialog.

### Always Replace Duplicate Tags & Devices

Select this check box and disable the first check box to replace duplicate tags and devices in the project database without opening the Project Database dialog. This option is equivalent to clicking the Replace All button on the Project Database dialog.

**Important:** If you disable all check boxes, the verification process will not occur and you may lose tag or device data.
Restoring a Project Created with a Restricted Release of PanelBuilder

If you open an application that is linked to a project created with a Restricted or Beta release of PanelBuilder, this dialog opens.

![Dialog Image]

You must delete the project and then re-open the application to ensure that the project is current. All application data is retained in the process.

To restore the project:

1. Click OK to close the above dialog.
2. Choose Project Management from the Application menu.
3. Select the Projects tab.
4. Under Existing Projects, select the project to delete.
5. Click the Delete button. You are asked to confirm the deletion.
6. Click the Done button to exit the Project Management dialog.
7. Re-open the application.

The project is recreated with all device and tag data.
Chapter Objectives

This chapter describes how to use the FontTool™ utility to create font files for PanelBuilder applications. You can access these font files in PanelBuilder to create applications for specific languages.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What You Will Learn?</td>
<td>22–1</td>
</tr>
<tr>
<td>System Requirements</td>
<td>22–2</td>
</tr>
<tr>
<td>Terminology</td>
<td>22–2</td>
</tr>
<tr>
<td>What is FontTool?</td>
<td>22–3</td>
</tr>
<tr>
<td>Input Method Editor</td>
<td>22–4</td>
</tr>
<tr>
<td>Using FontTool</td>
<td>22–5</td>
</tr>
<tr>
<td>Creating Font Files</td>
<td>22–6</td>
</tr>
<tr>
<td>Viewing Sample Text</td>
<td>22–8</td>
</tr>
<tr>
<td>Opening Font Files</td>
<td>22–8</td>
</tr>
<tr>
<td>Saving Font Files</td>
<td>22–9</td>
</tr>
<tr>
<td>Previewing and Printing Font Files</td>
<td>22–10</td>
</tr>
<tr>
<td>Creating an Application Using a Font File</td>
<td>22–11</td>
</tr>
<tr>
<td>Select Terminal Supporting External Fonts</td>
<td>22–11</td>
</tr>
<tr>
<td>Enable External Fonts</td>
<td>22–12</td>
</tr>
<tr>
<td>Create Application</td>
<td>22–13</td>
</tr>
<tr>
<td>Copy Font File to Memory Card</td>
<td>22–14</td>
</tr>
<tr>
<td>Download and Run Application</td>
<td>22–14</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>22–15</td>
</tr>
<tr>
<td>Translating Application Text in Excel</td>
<td>22–16</td>
</tr>
<tr>
<td>Using Windows Standard Fonts to Enter Western European Characters</td>
<td>22–18</td>
</tr>
</tbody>
</table>

What You Will Learn?

The chapter describes the procedures required to create an application in a specific language. You will learn how to:

- Create a font file (containing the character set) for a specific language.
- Copy the font file to a memory card. This card will be inserted into the card slot of the PanelView terminal and remain in the slot while the application is running.
- Create the application using the character set in the font file.
- Download the application to the PanelView terminal.
- Insert the memory card, containing the font file, into the card slot of the PanelView terminal and secure the card using the Memory Card Retainer (Catalog No. 2711-NMCC, -NMCD).
- Run the application on the PanelView terminal.
System Requirements

Items required to create applications in a specific language are:

- PanelBuilder V2.30 Software installed with External Font Support (loads the FontTool Utility).
- PanelView terminals running firmware V3.0 (or later).
- International Version of Windows for a specific language or Input Method Editor to enter characters for double-byte languages.
- Personal Computer with ATA or TMB240/TMB250 card drive
- PC Memory Card
  TMB-240/250 Card Drives support these cards:
  - 256K flash memory card (Catalog No. 2711-NM11)
  - 1M flash memory card (Catalog No. 2711-NM12)
  - 2M flash memory card (Catalog No. 2711-NM13)
  - 4M flash memory card (Catalog No. 2711-NM14)

ATA Card Drives support these cards:
  - 2M flash ATA card (Catalog No. 2711-NM22)
  - 4M flash ATA card (Catalog No. 2711-NM24)
  - 6M flash ATA card (Catalog No. 2711-NM26)

ATA memory cards are recommended for laptop computers.

\[\text{ATTENTION: Do not format an ATA card in a DataBook card drive or the card may be unusable.}\]

- Memory Card Retainer (Catalog No. 2711-NMCC, -NMCD)

Terminology

The following terms are used in this chapter.

Code Page

An ordered set of characters that has a numerical index (code point value) associated with each character. The term code page is generally used in the context of code pages defined by Windows™ and may also be called character set or char set.

Input Method Editor (IME)

A program that performs the conversion, usually by user-guided dictionary lookup, between keystrokes and ideographic or other characters.

Single-Byte Character Set

A character encoding where each character is represented by one byte. Single Byte Character Sets are mathematically limited to 256 characters, English, for example.
Double-Byte Character Set

Double-byte character sets are a specific form of multi-byte character sets, where some characters consist of two bytes, Chinese, for example.

Glyph

The actual shape (bit pattern, outline, etc.) of a character image, for example, an italic ‘a’ and a roman ‘a’ are 2 different glyphs representing the ‘a’ character.

What is FontTool?

The FontTool™ utility lets you create font files which are used by:

- PanelBuilder software to display text whose character glyphs reside in a font file.
  The font file must reside in the \PBWIN\FONT folder. The default installation creates an \AB\PBWIN\FONT folder.

- PanelView terminal to display the characters on the screen when the application is running. The font file must reside on a memory card inserted into a PanelView terminal.
  We recommend that you use the ATA flash cards for double-byte languages because these languages require more space.

Font Files

FontTool can create font files for any of the installed set of languages (or code pages) supported by Windows. The code page for many languages is 1252.

PanelView font files have an .OTF (Operator Terminal Font) extension and reside in the \PBWIN\FONT folder. A font file contains a set of characters in one or more sizes of the same style.

The character set (or code page) of the language you want to use must reside on your computer.
Input Method Editor

Languages that use a double-byte character set require you to run an Input Method Editor (IME) on your computer (unless you are running an International version of Windows.)

The Input Method Editor is a software utility that runs in Windows. The IME lets you enter foreign character sets in PanelBuilder as well as other applications, such as Microsoft Word or Power Point.

UnionWay™ is one example of an IME. The tool bar and input dialog for the IME is shown below.

![IME Configuration](image)

The language you select in the IME must match the code page of the font file you create in FontTool.

<table>
<thead>
<tr>
<th>For this Font File:</th>
<th>Select this IME Option:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (Traditional)</td>
<td>Big5</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>GB</td>
</tr>
<tr>
<td>Japanese</td>
<td>S-JIC or EUC</td>
</tr>
<tr>
<td>Korean (Johab)</td>
<td></td>
</tr>
<tr>
<td>Korean (Wansung)</td>
<td>KSC</td>
</tr>
<tr>
<td>Korean (Wansung-Full)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** We recommend that you select a fixed width font instead of a proportional font. A fixed width font will not interfere with the cursor when you are editing text in PanelBuilder.

If your system is not running an international version of Windows, you must run the IME to:

- select a font style when creating a font file in FontTool.
- enter/edit text while when creating a PanelBuilder application.

If the IME is not running or the code page is not available for the particular language, FontTool will generate high ASCII characters without the desired glyph characters (essentially unreadable text).
Using FontTool

This section shows how to use FontTool to create, open, save and print font (.OTF) files.

To run FontTool:

- In Windows 95, click the Start button, click Programs, click PanelBuilder, then click FontTool.
- In Windows 3.x, double-click the FontTool icon in the PanelBuilder group.

The FontTool workspace opens. Most operations are accessed from the File menu.

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Font</td>
<td>Creates a new font file.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing font file.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the font file to disk with the same name.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the font file to disk under a new file name and/or location.</td>
</tr>
<tr>
<td>Save to Memory Card</td>
<td>Saves the font file to a memory card.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints a font file.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Selects a printer and settings.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits FontTool and returns to Windows.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Bar</td>
<td>Turns the view of tool bar on or off.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Turns the view of the status bar on or off.</td>
</tr>
<tr>
<td>View Sample Text</td>
<td>Turns the view on or off for sample text.</td>
</tr>
<tr>
<td>Change Sample Text</td>
<td>Opens a dialog allowing you to change the sample text for a font file.</td>
</tr>
<tr>
<td>Underline Adjustment</td>
<td>Turns the underline adjustment on or off to allow for underlining in double-byte languages.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Displays copyright and release information for FontTool.</td>
</tr>
</tbody>
</table>
Creating Font Files

To create a font file:

1. Click the New Font tool on the tool bar or choose New Font from the File menu.

   The Locale list box contains a list of font available definitions. Available character sizes change with the font selection.

   Each font definition has a name. If the font has a subtype its name appears in parentheses, for example, Chinese (Simplified).

2. From the Locale list, select a font definition.

3. Under Available Sizes, select (or deselect) the character sizes you want to store in the font file and make available in your PanelBuilder application.

   Deselecting character sizes will reduce the amount of storage required for the font file on the computer and memory card.

4. Click OK.

   The Font dialog opens, allowing you to select a style for the font. You must select a style that is compatible with the font definition. For example, if you selected Chinese (Simplified):

   • a Chinese font must reside on the computer
   • the appropriate code page must reside on the system.
   • run the IME program with the appropriate Chinese language selected.

   If your system is running a Chinese version of Windows, an IME is not required; the correct code page is automatically available.
Note: For the following single-byte languages, select MS LineDraw under Font.
– English
– French
– Italian
– German
– Spanish

5. Select a font style.

6. Click OK to generate the font file.

The time it takes to generate the file depends on the number of characters and sizes in the definition, and your computer’s speed.

Sample text is defined for each font definition. The sample text is displayed for the font definition in the selected style. Verify that the text looks okay.

At this point, the font file is resident in memory but not on disk. The status bar located at the bottom of the FontTool window shows the size of the font file.

You must save the font file to:
- PBWIN\FONT folder to access the file when creating an application with the PanelBuilder software.
- memory card, which will be inserted in the card slot of the PanelView where the application will run.

See the section on Saving Font files.
Viewing Sample Text

You can view and/or change the sample text of a font definition before saving the font file.

1. Choose Change Sample Text from the View menu.

2. Enter new sample text.

3. Click OK. The sample text is changed for the font definition.

Opening Font Files

Font (.OTF) files are located in \PBWIN\FONT. You can open a font file to view/edit the sample text.

To open a font (.OTF) file:

1. Click the Open tool on the tool bar or choose Open from the File menu.

2. Select a file from the \PBWIN\FONT folder and click OK.

   Or double-click on the file name you want to open.

   The sample text appears for the file you open. If you don’t see any text, choose Sample Text from the View menu. This command turns the view of the text on or off.
Saving Font Files

FontTool provides 3 commands for saving files.

<table>
<thead>
<tr>
<th>Save Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves a file that was previously opened to the same file name and location.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the file with a new name and/or location, leaving the original intact.</td>
</tr>
<tr>
<td>Save to Memory Card</td>
<td>Saves the font file to a memory card located in the card drive on the computer.</td>
</tr>
</tbody>
</table>

To save a font file to the same location with the same file name:
Click the Save tool on the tool bar or choose Save from the File menu.

To save a font file under a new name and/or location:
1. Choose Save As from the File menu.

   The File Save As dialog shows the current file name and location of the font file.

   ![File Save As dialog]

   2. In the File Name box, enter a descriptive file name (up to 8 characters) with the .OTF extension.

      PanelBuilder expects to find all font .OTF files in the \PBWIN\FONT folder.

   3. Click OK.
To save a font file to a memory card:

1. Load an ATA Flash card (Catalog No. 2711-NM22, -NM24, -NM26) in the card drive on your computer.

   **Important:** To write the font file to a memory card directly from FontTool, you must use an ATA Flash card.

2. Click the Save to Memory Card tool on the tool bar or choose Save to Memory Card from the File menu.

   The dialog shows a list of Memory Card Drives detected on the computer.

3. Select the font .(OTF) file from the \PBWIN\FONT folder you want to save to a memory card.

4. Select the Memory Card Drive.

5. Click OK to save the font file to the memory card.

   **Note:** You can also save a font file to an ATA card using the Save As dialog by selecting the memory card drive from the Drive’s list.

**Printing Font Files**

You can print the sample text associated with a font file.

**To print the sample text for a font (.OTF) file:**

1. Open the font file you want to print. (Choose Open command from File menu.)

2. Click the Print on the tool bar.

   Or choose Print from the File menu.

   Use the Print Setup command on the File menu to select a different printer or change printer settings.
Creating an Application using a Font File

This section shows the steps necessary to use a font file in a PanelBuilder application.

The font file you want to use in PanelBuilder must be located in \PBWIN\FONT. For details on how to create a font file see the first section of this document.

Using font files requires:

- PanelBuilder Software V2.3 (or later). Systems running earlier versions of PanelBuilder, require an upgrade.
- PanelView terminals running firmware V3.0 (or later). Terminals with earlier firmware versions, will require a firmware upgrade.

To check the firmware running on your terminal, choose Terminal Info from the Configuration Mode menu on the terminal.

**Step 1 – Select a Terminal Supporting External Fonts**

From the New Application or Terminal Setup dialog (Application menu), select a PanelView terminal that supports external fonts. Any terminal running firmware version 3.0 (or later) supports external fonts.
Step 2 – Enable External Font Support

The External Font Setup dialog allows you to:

- enable a font file for the PanelBuilder application.
- translate (and edit) the default text that appears in the Numeric Scratch Pad of the PanelView terminal so that it appears in the correct language.

To enable external font support:

1. Choose Terminal Setup From the Application menu
2. Click the Font Setup button.

3. Check the External Font Support box to enable external fonts.
4. From the External Font File list, select a font file.

   The selected font file determines the character sizes available and the characters available for display in objects.

5. Check the Use Custom Text box to translate the English text that appears in the Numeric Scratch Pad of the PanelView terminal to the selected language. Checking this box allows you to change the wording of the prompt, if desired.

   If you do not translate the Numeric Scratch Pad prompt, it will appear in English on the terminal.

6. Click OK to exit and return to the Terminal Setup dialog.
Step 3 – Create the Application

Create your PanelBuilder application.

Text sizes for an external font file appear in parentheses on:

- Text Size menu accessed from the Format menu or the tool bar
- Text Size list in Alarm History List dialog
- Text Size field in spreadsheet editor for multistate objects

If you select a text size in parentheses, PanelBuilder uses the external font file to generate glyphs for a language on the application screen.

If you select a text size without parentheses, PanelBuilder uses its default internal font to display text on application screens.

**Important:** You cannot use external fonts and internal fonts in the same text string. However, you can use both in the same application.

PanelBuilder always uses the default internal font to display text entered in the Text Edit box on the toolbar, Text Editor, and spreadsheet editor for multistate devices. The operating system is responsible for formatting and displaying the text.

To enter text in PanelBuilder, using the character set of the external font file (for example double-byte Asian characters), you must run either an:

- International Version of Windows, or
- IME with the correct language (code page) selected.

If you are not running an IME, the operating system will display double-byte glyph characters as 2 single-byte characters.
Step 4 – Copy Font File to Memory Card

To run the application on the PanelView terminal, the font file must reside on a memory card loaded in the terminal.

To copy a font file to an ATA flash card:
(Catalog No. 2711-NM22, -NM24, -NM26)
- In FontTool, choose Save to Memory Card from File menu.
- In PanelBuilder, choose Copy Font File from File menu.
- In the Application File Transfer Utility, download an .OTF file to a DOS memory card. Click the Setup button to enter a COPY command, for example:
  
  copy \ab\pbwin\font\china_s.otf m:

  where the file china_s.otf is copied to memory card drive m:
- In DOS, use the COPY command as shown above.

To save a font file to a flash memory card:
(Catalog No. 2711-NM11, -NM12, -NM13, -NM14)
- In the Application File Transfer Utility, you can download a specific .OTF file to a DOS memory card. Click the Setup button to enter the appropriate command string to download the file. See page 23–17 for details on the command string.
- In DOS, use the appropriate command string to copy the file to a memory card. See page 23–17 for details on the command string.

Step 5 – Download and Run the Application

To run a PanelBuilder application using a font file:
- download the PanelBuilder application to a PanelView terminal.
- insert the memory card, containing the font file, in the card slot on the PanelView terminal.
- use the memory card retainer (Catalog No. 2711-NMCC, -NMCD) to prevent accidental removal of the card from card slot.

Important: The application will not run properly unless the memory card containing the font file is inserted in the PanelView terminal.
Troubleshooting

Detecting Problems with FontTool

This section covers problems you may encounter when using FontTool. If the font file is generated but the sample text does not appear, consider the following causes.

Specified code page not available

When a font file is generated, the code page for that font must be available on the computer. FontTool uses this code page to generate the characters for the font file.

The code page may not be available for the following reasons:

- English version of the Windows operating system is running but an appropriate Input Method Editor (IME) is not active.
- IME is active but the wrong language is selected (some Input Method Editors support multiple languages).
- International version of the Windows is running but is not the correct version. For example, Windows 3.1 has separate distributions for Simplified Chinese (code page=936) and Traditional Chinese (code page=950).

Selected font does not contain specified characters

If the font style (selected in the Font dialog) does not contain the correct characters, either:

- characters will not appear or
- each double-byte character appears as 2, single-byte characters.

Detecting Problems with External Fonts in PanelBuilder

This section covers problems you may encounter when using external font files with PanelBuilder.

Characters may not appear correctly in PanelBuilder for the following reasons:

- If you enter a character not in the font file, PanelBuilder displays asterisks to indicate an invalid character.
- If the code page for the font file is not available through the operating system, characters will appear correctly on the application screen, but not in the Text Edit box on the tool bar, the Text Editor, or spreadsheet editors for multistate devices.

The code page may not be available because:

- international version of Windows does not match the code page of the font file.
- language selected in the Input Method Editor does not match the code page of the font file.
- external font was not selected or supported by the PanelView.
Translating Application Text in Excel

This section shows how to translate the text for an application in Excel rather than in PanelBuilder. This may be helpful if the individual translating the text is not familiar with PanelBuilder software or PanelView terminals. Translating the application text outside of PanelBuilder simplifies the translation process.

The procedures that follow assume that the application was developed in the default PanelBuilder language. After following the procedures, the memory card containing the font file can be inserted in the terminal and the application downloaded to the terminal.

To select/copy the text to translate:

1. Open PanelBuilder.
2. Open the Text Editor by choosing Text Editor from the Application menu.
3. Purge all text not used by the application.
   - Click the Select All button.
   - Click the Purge button.
4. Click Select All again to select all the text to translate.
5. Copy the text to the clipboard.
   - Click the right mouse button.
   - Choose Copy from the popup menu.

To paste/select the text in Excel:

1. Without closing PanelBuilder, open Excel.
2. Paste the text into the Excel spreadsheet.
3. Translate the text.

To copy the translated text into PanelBuilder:

1. In Excel, copy the translated text to the clipboard.
2. Return to PanelBuilder.
3. Paste the translated text into the Text Editor.
   - Select all lines
   - Click the right mouse button.
   - Choose Paste from the popup menu.
4. Click OK to exit the Text Editor.
To create and save the font file:

1. Open FontTool.
2. From the File menu, choose New Font.
3. Select the appropriate language, sizes, and font style.
4. After the font file is generated, choose Save As from the File menu to save the font file (.OTF) in the \PBWIN\FONT folder.
5. From the File menu, choose Save to Memory Card to save the font file (.OTF) to a memory card.
6. Close FontTool.

To enable the font in PanelBuilder:

The characters will not appear correctly in the application until after you enable the font file in PanelBuilder.

1. In PanelBuilder, choose Terminal Setup from the Application menu.
2. Click the Font Setup button.
3. Select the External Fonts Enabled check box.
4. From the External Font File list, select the font file.
5. Click OK until you exit the Terminal Setup dialog.
Using Windows Standard Fonts to enter Western European Characters

Microsoft Windows standard fonts support Western European characters. You can add a language or keyboard on Windows 95 or Windows NT systems and then enter international characters directly from your keyboard.

To add a keyboard layout:
1. On the Start menu, click Settings ➤ Control Panel.
2. Double-click the Keyboard icon.
3. Click the Language tab (Windows 95) or the Input Locales tab (Windows NT).

For more details on adding keyboard layouts refer to Keyboard Layouts in the online Index of Windows Help.

To enter international characters:

<table>
<thead>
<tr>
<th>To enter this character:</th>
<th>Press:</th>
</tr>
</thead>
<tbody>
<tr>
<td>à è í ò ü Á É Í Ò Ù a é í ò ù</td>
<td>Ctrl+`; (accent grave) the letter</td>
</tr>
<tr>
<td>á é í ó ú Ý Ä É Í Õ Ý</td>
<td>Ctrl+ (apostrophe), the letter</td>
</tr>
<tr>
<td>â ê ï õ ù Á É Í Õ</td>
<td>Ctrl+Shift+^ (caret), the letter</td>
</tr>
<tr>
<td>â ñ ò õ ë Á É Í Ò Ñ</td>
<td>Ctrl+Shift+- (tilde), the letter</td>
</tr>
<tr>
<td>â é í ò ù ã Æ Í Õ Ý</td>
<td>Ctrl+Shift+: (colon), the letter</td>
</tr>
<tr>
<td>àÁ</td>
<td>Ctrl+Shift+@, a or A</td>
</tr>
<tr>
<td>æ Å</td>
<td>Ctrl+Shift+&amp;, a or A</td>
</tr>
<tr>
<td>œ OE</td>
<td>Ctrl+Shift+&amp;, o or O</td>
</tr>
<tr>
<td>ç Ç</td>
<td>Ctrl+Shift+, (comma), c or C</td>
</tr>
<tr>
<td>ð Ð</td>
<td>Ctrl+Shift+(apostrophe), d or D</td>
</tr>
<tr>
<td>ø Ø</td>
<td>Ctrl+Shift+/, o or O</td>
</tr>
<tr>
<td>ć</td>
<td>Alt+Ctrl+Shift+?</td>
</tr>
<tr>
<td>ł</td>
<td>Alt+Ctrl+Shift+!</td>
</tr>
<tr>
<td>ß</td>
<td>Ctrl+Shift+&amp;,s</td>
</tr>
</tbody>
</table>

For more details on entering international characters refer to International Characters in the online Index of Windows Help.
Validating and Transferring Applications

This chapter contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful Hints</td>
<td>23–1</td>
</tr>
<tr>
<td>Validating Applications</td>
<td>23–2</td>
</tr>
<tr>
<td>Transfer Options</td>
<td>23–6</td>
</tr>
<tr>
<td>Transfer Utilities</td>
<td>23–8</td>
</tr>
<tr>
<td>Internal DF1 Driver</td>
<td>23–9</td>
</tr>
<tr>
<td>Downloading Directly to a Terminal</td>
<td>23–10</td>
</tr>
<tr>
<td>Downloading on a Local DH+ Link</td>
<td>23–12</td>
</tr>
<tr>
<td>Downloading to a Terminal using Pass-Through</td>
<td>23–13</td>
</tr>
<tr>
<td>Downloading to a DOS Memory Card</td>
<td>23–16</td>
</tr>
<tr>
<td>Downloading to a DOS File</td>
<td>23–18</td>
</tr>
<tr>
<td>Uploading Directly from a Terminal</td>
<td>23–19</td>
</tr>
<tr>
<td>Uploading on a Local DH+ Link</td>
<td>23–21</td>
</tr>
<tr>
<td>Uploading from a Terminal Using Pass-Through</td>
<td>23–22</td>
</tr>
<tr>
<td>Using the Application File Transfer Utility</td>
<td>23–23</td>
</tr>
<tr>
<td>Decreasing Size of Application for Downloads</td>
<td>23–28</td>
</tr>
<tr>
<td>Exceeding RAM Memory in Terminal</td>
<td>23–28</td>
</tr>
</tbody>
</table>

Helpful Hints

- PanelBuilder applications are saved to .PBA files. When downloading to a PanelView terminal or a DOS file, the .PBA file is automatically translated and saved to a .PVA file.
- PanelView terminal must be physically connected to the computer through a direct or network connection before transferring files.
- Use the internal DF1 driver to transfer applications over a serial link to a terminal with an RS–232 /DF1 port.
- If downloading applications directly to a DH-485 terminal using the 1747-PIC converter, configure the appropriate RSLinx or INTERCHANGE driver.
- If downloading applications locally over a DH+ link or using Pass-Through, you must configure the appropriate RSLinx or INTERCHANGE driver on your computer.
- Applications are automatically validated (checked for errors) during the download process. You can also validate applications and correct any errors before a download.
- You can’t download a keypad application to a touch screen terminal, or a touch screen application to a keypad terminal.
- Unused text strings and tags are not downloaded with application.
- If problems occur during a transfer, refer to Appendix F for troubleshooting tips.
PanelBuilder validates and checks applications for errors when downloading. You can also check the accuracy of an application before downloading using one of these commands:

- **Validate Changes**
  Checks only changes to the application since the last validate. Changes are validated screen by screen.

- **Validate All**
  Validates the entire application.

Applications must validate successfully before you can download them to a terminal. See Appendix E for validation error messages.

**To validate an application:**

Choose Validate All or Validate Changes from the Application menu.

- If the application passes validation, the following dialog opens.

- If the application does not pass validation, the Exceptions dialog opens listing:
  - **errors** – must be corrected before downloading the application.
  - **warnings** – do not have to be corrected before downloading the application. Warnings are optional changes.

As a convenience, you can open the Exceptions dialog from the Windows menu while correcting application errors.

<table>
<thead>
<tr>
<th>Press:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Close the dialog.</td>
</tr>
<tr>
<td>GoTo</td>
<td>Opens the dialog and screen associated with highlighted error.</td>
</tr>
<tr>
<td>Print</td>
<td>Send validation messages to printer or file.</td>
</tr>
<tr>
<td>Printer Setup...</td>
<td>Define printer settings.</td>
</tr>
</tbody>
</table>
Correcting Validation Errors

To correct validation errors:

1. Select an error in the Exceptions dialog by clicking on it.

2. Click the Goto button.

   PanelBuilder opens the dialog associated with the error or the screen containing the object with an error.

   If PanelBuilder cannot navigate to the source of the selected error the GoTo button is dimmed.

   The Exceptions dialog is minimized to an icon.

3. Correct the error and close the dialog.

   Note: If the message indicates an undefined function key even though the object dialog shows a selected key, clicking OK to close the dialog resolves the error.

4. Double-click the Exceptions icon to open the Exceptions dialog.

   Or choose Exceptions from the Window menu.

5. Repeat steps 1 – 4 to correct other errors.

   The following example shows how to navigate from an error in the Exceptions dialog to the dialog or screen containing the error.
Printing Validation Messages

To send validation messages to a printer:

- a printer must be connected to your computer
- the computer must recognize the printer as a valid printer

See the Microsoft Windows User’s Guide for details on installing printers.

To set up the printer:

1. Click the Print Setup button from the Exceptions dialog.
   The standard Microsoft Print Setup dialog opens.

   ![Print Setup dialog]

   2. If the default printer is not the one in use, select a printer from the Specific Printer list box. If it is not listed see below.

   3. Set appropriate attributes for your printer.

   4. Click the Options button to enter options specific to the printer you are using. The Options dialog is different for each printer.

   5. When done, click the OK button.

   6. Click the Print button from the Exceptions dialog to print the validation messages.

   7. Click Close to exit the Exceptions dialog.

If your printer is not listed:

- Check for hardware compatibility between your printer and one of the printers listed.
- Check if your printer has an emulation mode that is compatible with one of the printers listed.
- You may need to install a print driver for your printer. Refer to the Microsoft Windows User’s Guide.
Validating and Transferring Applications

Sending Validation Messages to File

To send validation messages to a file, you must:

• add the Generic/Text Only printer to the Installed Printer list
• assign the printer to a File: port

For details on how to add Generic / Text Only on FILE: to the Installed Printers list on your computer, see the Microsoft Windows User’s Guide. This print option allows you to print text, not graphics.

To send validation messages to a file:

1. Click the Print Setup button from the Exceptions dialog.

   The standard Microsoft Print Setup dialog opens.

2. Verify that Generic / Text Only on FILE: is the selected printer under Specific Printer.

   If your application uses large text sizes, open the Options dialog and enable the Wide Carriage option.

3. Click OK to exit the Printer Setup dialog.

4. Click the Print button from the Exceptions dialog.

5. In the Output File Name box, enter the file name in which to save the validation messages.

6. Click OK to output messages to the file.

   If the file name already exists, you are given the option of overwriting it or entering another file name.

7. Click Close to exit the Exceptions dialog.
Transfer Options

You can transfer applications between a computer running PanelBuilder and one of the following:

- PanelView terminal
- Memory card
- DOS file

PanelView Terminal

Direct Connection

Downloads applications from the RS-232 connection on your computer or workstation. For connection details, see Publication 2711-6.1.

Use the Internal DF1 Driver to transfer applications directly to a PanelView terminal using the terminal’s RS-232/DF1 port.

To transfer an application directly to a DH-485 or RS-232 (DH485 protocol) terminal using the 1747-PIC converter, you must configure the 1747-PIC driver using RSLinx or INTERCHANGE software.

DH+ Local Connection

Downloads applications from a computer or workstation on the Allen-Bradley Data Highway Plus™ (DH+) link to a DH+ PanelView terminal on the link. For connection details, see Publication 2711-6.1.

A DH+ RSLinx or INTERCHANGE driver must be installed on the computer.

Pass-Through Connection

Pass-Through lets you transfer applications between a computer or workstation on a DH+ link and a terminal on a Remote I/O link or DH-485 link. Data passes through a controller, which is a bridge between the two networks. For connection details, see Publication 2711-6.1.

A DH+ RSLinx or INTERCHANGE driver must be installed on the computer.
Memory Card

Computers with an ATA card drive or DataBook TMB240/TMB250 card drives allow you to transfer applications using memory cards.

- ATA card drives use these Allen-Bradley cards: Catalog No. 2711-NM22, -NM24, -NM26. PanelView terminals running firmware 3.0 (or higher) support ATA cards.
- DataBook card drives use these Allen-Bradley cards: Catalog No. 2711-NM11, -NM12, -NM13, -NM14.

DataBook TMB240 or TMB250 card drives cannot be set up in the Windows 95 Control Panel. Follow the instructions in the DataBook User’s Guide for details on how to install the card drive.

You can also transfer applications in a terminal to a memory card using the terminal’s memory card slot. See the PanelView Terminal user manual for details. This method doesn’t require a separate card drive on your computer. Use the memory card to download applications to multiple terminals without a computer.

DOS File

You can transfer PanelBuilder applications to/from DOS files. The application is downloaded to a DOS file in a .PVA format.

Use the PanelView File Transfer (PFT) Utility to transfer DOS application files (*.PVA) between a DH-485 PanelView terminal and a computer that does not have Windows installed. PanelBuilder includes a copy of the (PFT) Utility.

Note: The PFT utility only works with DH-485 terminals. To download to a Remote I/O terminal, you must use a DF1 driver.

Before transferring files using the PFT utility, disable all serial port drivers (including the mouse and INTERCHANGE or RSLinx) that are using the same COM port as PFT.

To use PFT on a computer that does not have PanelBuilder Software installed, copy the following files from the C:\AB\PBWIN directory to a floppy disk for transport to a DOS computer:

- PFT.EXE PanelView File Transfer DOS Utility
- DEFAULT.STP PanelView File Transfer configuration file
- PIC485.EXE PanelView File Transfer PIC Module driver
- KR.EXE PanelView File Transfer KR Card driver
- <APP>.PVA User PanelView application file

Refer to the User Guide (Publication 2711-805) for instructions on using the PanelView File Transfer Utility to upload/download applications between the PanelView terminal and a personal computer in the DOS environment.
Transfer Utilities

PanelBuilder Application Menu

Most application transfers are initiated from the Application menu of the PanelBuilder software. Choose the Download or Upload command from the Application menu.

Use the Download command to download an application to a:
- PanelView terminal
- memory card
- DOS file

Use the Upload command to upload an application from a terminal.

Application File Transfer Utility

Use the Application File Transfer Utility (WINPFT.EXE or WINPFT32.EXE) to transfer applications in the Windows environment, outside of PanelBuilder. This utility is available as an icon in the PanelBuilder group. The dialogs are identical to the Download/Upload dialogs on the PanelBuilder Application menu.

Use tools or File menu commands to:
- download a .PVA application to a PanelView terminal.
  Create a .PVA file by downloading a .PBA application to a DOS file from the PanelBuilder Application menu.
- upload a .PVA application from a PanelView terminal.
- verify the application you want to download against the application loaded in the terminal

PanelView DOS File Transfer Utility

Refer to Publication 2711-805 for details on using the PanelView File Transfer (PFT) Utility to transfer applications between a computer and a PanelView terminal in the DOS environment.
Internal DF1 Driver

PanelBuilder has an Internal DF1 driver for transferring applications over a serial link to:

- PanelView terminals with an RS-232 (DF1 protocol) port, for example, DH+, DF1 or Remote I/O terminal.
- Remote I/O terminal with RS-232 (DF1 protocol) port configured for Pass-Through communications with a PLC using DF1.

The PLC 5 must be configured with the DF1 settings shown below to activate communications.

The Internal DF1 driver uses the following settings which match the fixed DF1 settings on the PanelView terminal.

Parity = None  
Baud Rate = 19200  
Error Detect = CRC

Using the Internal Drivers

The Download/Upload Application dialogs include a Communication Drivers list from which you select either:

- Internal DF1 driver or
- RSLinx or INTERCHANGE driver

To use the DF1 driver, you must unload INTERCHANGE from your system. (Exit Windows and type ABICSTOP at the DOS prompt).

If an RSLINX driver is configured for a COM port (even if the driver is not mapped for a client application), the internal DF1 driver is disabled to avoid conflicts. Delete the RSLinx driver and the internal DF1 driver becomes available.

If you select Internal DF1 driver for a terminal that does not have an RS-232/DF1 port (such as a DH-485 terminal), this message appears:

Incompatible or no communication drivers active, cannot perform file transfer operations with Operator Terminal and Operator Terminal is removed as an option under Destination.

The Setup button on the Download/Upload dialogs is active if more than one COM port is available for the internal drivers.

If you select a COM port used by another Windows application, the port is locked. Systems running Windows 3.1, display this message:

The requested COM port is not available because a hardware interrupt conflict has been detected. You must change your hardware configuration to be able to use this COM port from Windows applications.

Because the port is locked by another Windows application, this message appears in the dialog showing the download/upload status:

Error! Selected communication port not configured, in use by another Windows application, or port hardware does not exist.
Downloading Directly to a Terminal

This section shows how to download an application directly to a PanelView terminal over a serial link. Before starting the download:

- check cable connections (see Publication 2711-6.1).
- use the Internal DF1 driver to download applications to terminals with an RS-232/DF1 port.
- use the 1747-PIB (INTERCHANGE or RSLinx) driver to download applications to DH-485 terminals or RS-232 (DH-485 protocol) terminals.

To download an application using the Internal DF1 Driver:

1. Open the application you want to download.

2. Choose Download from the Application menu.

3. Select Download parameters.

   - Select Operator Terminal
   - Select Internal DF1 Driver
   - Enter name of .PVA file in which to save the translated .PBA file or click Browse to search for a file.

4. Application is validated and translated to a .PVA file.
   
   If errors or warnings are detected, the Exceptions dialog opens. You must correct errors before download can proceed. Warnings should be corrected, but the download will proceed.

5. PanelBuilder software and terminal display status of download.

6. Terminal resets, verifies and starts application.
To download an application using a DH485 Driver:

1. Open the application you want to download.

2. Choose Download from the Application menu.

3. Select the Download parameters.

   ![Download Application dialog]

   - Select Operator Terminal
   - Select RSLinx or INTERCHANGE Driver
   - Enter name of .PVA file in which to save the translated .PBA file or click Browse to search for a file.
   - Click OK to start download.

4. Application is validated and translated to a .PVA file.
   - If errors or warnings are detected, the Exceptions dialog opens. You must correct errors before download can proceed. Warnings should be corrected, but the download will proceed.

5. PanelBuilder software and terminal display status of download.

   ![File Transfer Status]

6. Terminal resets, verifies and starts application.
This section shows how to download an application from a computer on the DH+ link to a DH+ terminal on the link. The computer and terminal are each a separate station on the DH+ link.

Before downloading application:
• check cable connections. See Publication 2711-6.1
• configure the DH+ driver using RSLinx or INTERCHANGE.

Note: The computer runs at 57.6K baud forcing the DH+ link and terminal to use the same rate. Set the terminal’s DH+ network to this baud rate before downloading an application.

To download an application on a local DH+ link:

1. Open the application you want to download.

2. Choose Download from the Application menu.

3. Select the Download parameters.
   - Select Local Network Operator Terminal
   - Select RSLinx or INTERCHANGE Driver
   - Enter name of .PVA file in which to save the translated .PBA file or click Browse to search for a file.
   - Click Setup to verify node address of the PanelView. The address must match the address in the Communication Setup dialog.
   - Click OK to start download.

4. Application is validated and translated to a .PVA file.
   If errors or warnings are detected, the Exceptions dialog opens. You must correct errors before download can proceed. Warnings should be corrected, but the download will proceed.

5. PanelBuilder software and terminal display status of download.

6. Terminal resets, verifies and starts application.
Validating and Transferring Applications

Downloading to a Terminal using Pass-Through

This section shows how to download an application from a computer on the DH+ link to a terminal on a Remote I/O or DH-485 link.

Before downloading an application:

- check cable connections.
- enable Pass-Through in the Block Transfer dialog (page 20–11).
- configure the DH+ driver using RSLinx or INTERCHANGE.

**ATTENTION:** If downloading with the processor in run mode, verify the rack address of the target terminal. Downloading to an incorrect rack address may result in unexpected operation or damage to equipment.

To download an application to a terminal using Pass-Through:

1. Open the application you want to download.
2. Choose Download from the Application menu.
3. Select the Download parameters.
   - Select Operator Terminal via Pass-Through
   - Select RSLinx or INTERCHANGE Driver
   - Enter name of .PVA file in which to save the translated .PBA file or click Browse to search for a file.
4. Application is validated and translated to a .PVA file. If errors or warnings are detected, the Exceptions dialog opens. You must correct errors before download can proceed. Warnings should be corrected, but the download will proceed.
5. PanelBuilder software and terminal display status of download.
6. Terminal resets, verifies and starts application.
Remote I/O Pass-Through Setup

When you click the Setup button from the Download (or Upload) Application dialog for a Remote I/O terminal, this dialog opens.

![Remote I/O Pass-Through Setup dialog]

Note: If more than one COM port is configured with a DH+ driver, the dialog will display available ports. Select the appropriate port.

To configure Remote I/O Pass-Through parameters:

1. Define Remote I/O Pass-Through parameters as described below.
2. Click OK to return to the Application Download dialog.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Path</strong></td>
<td></td>
</tr>
<tr>
<td>Single DH+ Network</td>
<td>Transfer an application directly between a computer on the DH+ network and a PanelView terminal through a single controller.</td>
</tr>
<tr>
<td>Multiple DH+ Networks</td>
<td>Transfer an application between a computer on the local DH+ network and a PanelView terminal through a PLC controller on a remote DH+ network.</td>
</tr>
<tr>
<td>Single DF1 Network</td>
<td>Transfer an application directly between a computer and a PanelView terminal through the DF1 port on a PLC controller.</td>
</tr>
<tr>
<td><strong>Local Bridge/PLC/SLC</strong></td>
<td></td>
</tr>
<tr>
<td>Node Address</td>
<td>Specify the address (0–77octal) of the PLC on the local DH+ network to which your computer is connected (for Single DH+ Network). Specify address of Gateway device on local network (for DH+ Multiple Networks).</td>
</tr>
<tr>
<td>Link ID</td>
<td>Specify the unique ID number that identifies the local DH+ network to which your computer is connected. This field is dimmed for a Single DH+ network.</td>
</tr>
<tr>
<td><strong>Remote Bridge/PLC/SLC</strong></td>
<td></td>
</tr>
<tr>
<td>Node Address</td>
<td>Specify address (0–77octal) of the PLC on the remote DH+ network through which an application is transferred. Dimmed if Single DH+ network selected.</td>
</tr>
<tr>
<td>Link ID</td>
<td>Specify the unique ID number of the remote DH+ network through which an application is transferred. Dimmed unless Multiple DH+ Networks is selected.</td>
</tr>
<tr>
<td><strong>Operator Terminal</strong></td>
<td></td>
</tr>
<tr>
<td>SLC Scanner Slot</td>
<td>Specify the number of the slot where the SLC scanner resides. The default is the slot closest to the processor.</td>
</tr>
<tr>
<td>Starting Module</td>
<td>Specify the starting module group of the PanelView terminal in the Remote I/O rack.</td>
</tr>
<tr>
<td>Rack Address</td>
<td>Specify the address of the PanelView terminal on the Remote I/O network.</td>
</tr>
</tbody>
</table>
DH-485 Pass-Through Setup

When you click the Setup button from the Download (or Upload) Application dialog and the terminal is defined as a DH-485 terminal with an RS-232 port, this dialog opens.

![DH-485 Pass-Through Setup dialog]

**Note:** If more than one COM port is configured with a DH+ driver, the dialog will display available Ports. Select the appropriate port.

**To configure DH-485 Pass-Through parameters:**

1. Define the Pass-Through parameters as defined below.
2. Click OK to return to the Application Download dialog.

<table>
<thead>
<tr>
<th>Use:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Network</strong></td>
<td><strong>Gateway Node Address</strong> Specify the node address (0 to 76) of the SLC 5/04 controller or DH+/DH485 Gateway to which your computer is connected.</td>
</tr>
<tr>
<td></td>
<td><strong>Link ID</strong> Specify the unique ID number (1 – 65534) that identifies the computer to controller (or DH+/DH485) link on the DH+ network.</td>
</tr>
<tr>
<td><strong>Remote Network</strong></td>
<td><strong>Terminal Address</strong> Specify the node address (0 to 31) of the PanelView terminal on the DH-485 network to which you are downloading an application.</td>
</tr>
<tr>
<td></td>
<td><strong>Link ID</strong> Specify the unique ID number (1 – 65534) that identifies the link between the controller and PanelView terminal on the DH-485 network.</td>
</tr>
</tbody>
</table>
This section shows how to download an application to a DOS memory card in a .PVA format. After copying an application to a memory card, you can download it to a PanelView terminal.

To download an application to a DOS memory card:

1. Open the application you want to download.

2. Choose Download from the Application menu.

3. Select Download parameters.

   - Enter name of .PVA file in which to save the translated .PBA file or click Browse to search for file.

4. Click the Setup button to open this dialog.

   - Click OK to start download.
   - Enter or select a memory card command and then click OK. See next page for format.

5. Application is validated and translated to a .PVA file, then downloaded to the Memory Card.

   The memory card command executes a command (or batch file).
   After the command is executed, you return to Windows.
The format of the command entered in the Memory Card DOS Command Setup dialog is specific to the card drive installed in your computer.

- For ATA card drives, use the DOS COPY command, for example:
  
  ```
  COPY C:\AB\PBWIN\CONTROL.PVA \M:
  ```

  where M: is the ATA card drive on your computer.

  Memory cards compatible with the ATA card drives include Catalog No. 2711-NM22, -NM24, -NM26.

- For DataBook TMB240 or TMB250 card drives, the command string has three parameters as shown below.

  Memory cards compatible with the DataBook card drives include Catalog No. 2711-NM11, -NM12, -NM13, -NM14.

  ```
  CMD \%s DriveLetter:
  ```

  The following table describes each command parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD</td>
<td>DOS command that will download the application to the card. Memory card DOS commands are drive specific. See the instructions for your card drive.</td>
</tr>
<tr>
<td>%s</td>
<td>Wild card character which PanelBuilder replaces with the application file name entered in the File Name box in the Application Download dialog.</td>
</tr>
<tr>
<td>DriveLetter:</td>
<td>Memory card drive on your computer. The drive letter is always followed by a colon (:).</td>
</tr>
</tbody>
</table>

  After entering a command string for the first time, it automatically appears in the command list box. You can then select the command from the list box instead of entering it.
You can download applications to a file in the DOS environment which can be downloaded to a terminal later using the Windows version of the Application File Transfer Utility. The PanelBuilder application file (.PBA) is translated and downloaded to DOS with a .PVA file type.

**Note:** You can transfer the .PVA file between the computer and a DH-485 terminal in the DOS environment using the PanelView File Transfer Utility. See page 23–7.

**To download an application to a DOS file:**

1. **Open the application you want to download.**

2. **Choose Download from the Application menu.**

3. **Select Download parameters.**

   - **Select DOS File**
   - **Enter name of .PVA file in which to save the translated .PBA file or click Browse to search for file.**
   - If you enter a .PVA file without a path, the file is saved to the current default directory. To save the file to a specific folder, specify the location in the File Name box.

4. **Application is validated and translated to a .PVA file, then downloaded to a DOS file.**
   - If errors or warnings are detected, the Exceptions dialog opens. You must correct errors before download can proceed. Warnings should be corrected, but the download will proceed.

5. **Dialog opens with .PVA File Size and RAM requirements**
   - Dialog compares the file size and RAM requirements of the .PVA file with the PanelView’s file size and RAM capacity.
Validating and Transferring Applications

Uploading Directly from a Terminal

This section shows how to upload an application directly from a PanelView terminal to your computer over a serial link.

Before uploading an application:
- check cable connections. See Publication 2711-6.1
- use the Internal DF1 driver to upload applications from terminals with an RS-232/DF1 port.
- use the 1747-PIC (INTERCHANGE or RSLinx) driver to upload applications from DH-485 terminals or RS-232 (DH-485 protocol) terminals.

To upload an application using the Internal DF1 driver:

1. Choose Upload from the Application menu.

2. Select the Upload parameters.

3. PanelBuilder software and terminal display status of upload.

4. When the upload is complete, the application opens in PanelBuilder.
To upload an application using a DH485 Driver:

1. Choose Upload from the Application menu.

2. Select the Upload parameters.

   - Select Operator Terminal
   - Select RSLinx or INTERCHANGE Driver
   - Enter name of .PVA file in which to save the uploaded application or click Browse to search for a file.
   - Select the type of terminal from which you are uploading application.

   Under Presets, select:
   - Original to upload presets (initial values) defined for inputs.
   - Current States to upload current input values in terminal.

3. PanelBuilder software and terminal display status of upload.

4. When the upload is complete, the application opens in PanelBuilder.
Validating and Transferring Applications

Uploading on a Local DH+ Link

This section shows how to upload an application from a DH+ terminal on the DH+ link to your computer. The computer and terminal are each a separate station on the DH+ link.

Before uploading application:

- check cable connections. See Publication 2711-6.1
- configure the DH+ driver using RSLinx or INTERCHANGE.

**Note:** The computer runs at 57.6K baud forcing the DH+ link and terminal to use the same rate. Set the terminal’s DH+ network to this baud rate before uploading an application.

1. Choose Upload from the Application menu.

2. Select the Upload parameters.

   - Select Local Network Operator Terminal
   - Select RSLogix or INTERCHANGE Driver
   - Enter name of .PVA file in which to save the uploaded application or click Browse to search for a file.
   - Select DH+/RS232.

3. PanelBuilder software and terminal display status of upload.

4. When the upload is complete, the application opens in PanelBuilder.
Uploading from a Terminal Using Pass-Through

This section shows how to upload an application from a PanelView terminal on a Remote I/O or DH-485 link to your computer on the DH+ link.

Before uploading an application:
- check cable connections.
- enable Pass-Through in Block Transfer dialog (page 20–11).
- configure DH+ driver using RSLinx or INTERCHANGE.

To upload an application from a terminal using Pass-Through:

1. Choose Upload from the Application menu.

2. Select the Upload parameters.

   - Click Setup to configure Remote I/O or DH-485 Pass-Through parameters. See pages 23–14 and 23–15.
   - Select type of terminal from which you are uploading application.
   - Under Presets, select values to upload:
     - Original to upload presets (initial values) defined for inputs.
     - Current States to upload current input values in terminal.
   - Enter name of .PVA file in which to save uploaded application or click Browse to search for a file.

3. PanelBuilder software and terminal display status of upload.

4. When upload is complete, the application opens in PanelBuilder.
Use the Application File Transfer Utility (WINPFT.EXE) to transfer .PVA files between a terminal and a computer running Windows.

**Important:** Applications that you upload or download with this utility must be in a .PVA format.

To create a .PVA file for downloading, you must download the .PBA application to a DOS file from the Application menu of PanelBuilder. Applications uploaded from the terminal are already in a .PVA format.

**To start the Application File Transfer Utility:**

- In Windows 95, select Application File Transfer Utility from the PanelBuilder submenu under Programs on the Start menu.
- In Windows 3.x, double-click the Application File Transfer Utility icon in the PanelBuilder program group (WINPFT.EXE).

In the Application File Transfer Utility, applications are transferred from either the File menu or tool bar. The dialogs are very similar to the PanelBuilder Download/Upload dialogs.

<table>
<thead>
<tr>
<th>Choose:</th>
<th>Or Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td><img src="image" alt="Download Icon" /></td>
<td>Download a .PVA file to a PanelView terminal. To create a .PVA file, you must download the application to a DOS file from the Application menu in PanelBuilder.</td>
</tr>
<tr>
<td>Upload</td>
<td><img src="image" alt="Upload Icon" /></td>
<td>Upload an application from a PanelView terminal to a DOS (.PVA) file. To load the application in PanelBuilder, open the .PVA file from the PanelBuilder File menu. The file is translated to a .PBA file for PanelBuilder.</td>
</tr>
<tr>
<td>Verify</td>
<td><img src="image" alt="Verify Icon" /></td>
<td>Compare application in terminal with the download application to verify that differences exist.</td>
</tr>
<tr>
<td>Exit</td>
<td><img src="image" alt="Exit Icon" /></td>
<td>Exit the Application File Transfer Utility.</td>
</tr>
</tbody>
</table>
Verifying an Application

Use the Verify command to compare an application with an application loaded in a specific terminal. You might want to download an application only if it is different from the application in the terminal. The verification process checks whether the applications match.

To verify an application:

1. Click the Verify tool or choose Verify from the File menu.

2. Select Verify parameters
   - Select source terminal for the verify.
   - Select appropriate driver (Internal DF1 driver or RSLinx or INTERCHANGE driver)
   - Enter name of .PVA file to verify or click Browse to search for a .PVA file.
   - Select the type of terminal for which you are verifying a loaded application.

3. After clicking OK, the Application Verification dialog opens.
   The dialog shows whether the applications match or not.
Validating and Transferring Applications

Downloading to a PanelView Terminal

This section shows how to download a .PVA file to a PanelView terminal using the Application File Transfer Utility.

**ATTENTION:** When downloading using Pass-Through with the processor in run mode, verify the rack address of the target terminal. Downloading to an incorrect rack address may result in unexpected operation or damage to equipment.

To download an application:

1. Click the Download tool or choose Download from the File menu.
2. Select Download parameters.

   - Select target device for download.
   - Select appropriate driver
   - Enter name of .PVA file you want to download or click Browse to search for a file.
   - Check this box to download the application only if it is different from the application loaded in the terminal.

3. After clicking OK, the following dialog opens.
4. Terminal resets, verifies and starts application.
Downloading to a Memory Card

When downloading to a memory card, you can download a .PVA file or an .OTF font file (created with FontTool) to either of the following card drives:

- ATA card drive
- DataBook TMB240 or TMB250 card drive

The format of the command entered in the Memory Card DOS Command Setup dialog is specific to the card drive installed in your computer.

- For ATA card drives, use the DOS COPY command, for example:
  
  `COPY C:\AB\PBWIN\CONTROL.PVA M:`
  
  or
  
  `COPY C:\AB\PBWIN\FONT\CHINA_S.OTF M:`

  where M: is the ATA card drive on your computer.

  Memory cards compatible with the ATA card drives include Catalog No. 2711-NM22, -NM24, -NM26.

- For DataBook TMB240 or TMB250 card drives, the command string has three parameters as shown on page 23–17.

  Memory cards compatible with the DataBook card drives include Catalog No. 2711-NM11, -NM12, -NM13, -NM14.
Uploading from a PanelView Terminal

This section shows how to upload an application from a PanelView terminal. The application is stored as a DOS file with a .PVA extension.

To upload an application:

1. Click the Upload tool or choose Upload from the File menu.

2. Select Upload parameters.

   Select appropriate driver
   Enter name of .PVA file in which to save the uploaded application or click Browse to search for a file.

3. After clicking OK, the following dialog opens.

   Select terminal from which to upload application.
   Click OK to start upload.
   Depending on the Source selected, you may have to click Setup to edit/verify terminal parameters.

   Enter name of .PVA file in which to save the uploaded application or click Browse to search for a file.
   Select the type of terminal from which you are uploading application.

4. The application is saved to .PVA file and you return to the utility workspace.

5. Open .PVA application from PanelBuilder File menu.

   The .PVA file is automatically translated to a .PBA file for use in PanelBuilder.
Decreasing the Size of Application for Downloads

If the application is too large to download, the following dialog opens. The dialog displays the size of the application and the amount of available space in the PanelView terminal.

![Download Dialog]

You can reduce the size of the application by eliminating:

- PanelBuilder Application Data, including all screens and objects.
- Tag information for the application.
- Network Data, including run-time communication parameters for the PanelView terminal and controller.

Special Considerations:

- If you eliminate PanelBuilder application data, you will not be able to upload the application. The entire application must be re-created.
- If you eliminate tag data, you will be able to upload the application but will need to re-enter the tags in the Tag Editor.
- If you eliminate network data, you will be able to upload the application but must re-enter runtime communication parameters for devices in the Terminal Setup dialogs.

Exceeding RAM Memory in Terminal

The following dialog opens if the application you are downloading exceeds the RAM memory in the PanelView terminal.

![Exceeding RAM Memory Dialog]
Creating Reports

Chapter Objectives

This chapter shows how to create application reports. It contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Types of Reports</td>
<td>24–1</td>
</tr>
<tr>
<td>Connecting a Printer</td>
<td>24–1</td>
</tr>
<tr>
<td>Creating and Printing a Report</td>
<td>24–2</td>
</tr>
<tr>
<td>Changing the Report Setup</td>
<td>24–3</td>
</tr>
<tr>
<td>Setting up a Printer</td>
<td>24–5</td>
</tr>
<tr>
<td>Sending the Report to a File</td>
<td>24–6</td>
</tr>
</tbody>
</table>

Types of Reports

PanelBuilder lets you specify the types of information to include in a report.

<table>
<thead>
<tr>
<th>Report Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Includes the first page of the application description as entered in the Application Description dialog.</td>
</tr>
<tr>
<td>Object Attributes</td>
<td>Lists attributes of all objects in the application. Objects are listed by their object ID.</td>
</tr>
<tr>
<td>Text</td>
<td>Lists all text strings in the application.</td>
</tr>
<tr>
<td>Terminal Setup</td>
<td>Lists setup parameters for the PanelView Terminal.</td>
</tr>
<tr>
<td>Tag Attributes</td>
<td>Lists all tag definitions in the application.</td>
</tr>
<tr>
<td>Alarm Setup</td>
<td>Lists all alarm information defined for the application.</td>
</tr>
</tbody>
</table>

In addition, you can include screen images and a summary of objects for all screens or a range of screens in the application.

To print screen images, you need a graphics printer that’s supported by Windows.

Connecting a Printer

Refer to the user manuals supplied with your printer and computer for instructions on connecting a printer.
The Report command on the File menu lets you create a customized report documenting all or specific aspects of an application. Reports are useful for tracking application updates and changes.

To set up a report:

1. Choose Reports from the File menu.

2. Under Application, select topics to include in report by clicking the appropriate check boxes. To disable a topic, clear the box.

3. Under Screens, select screens to include in the report. Click All to include all screens or From to include a range of screens. Enter the range of screen numbers in the From and To boxes.

4. The Alarm Banner check box specifies whether you want to include the Alarm Banner with each screen. By default, the Alarm Banner is included.

5. Under Include, specify whether you want to include Screen Images and/or an Object Summary for each screen by clicking the appropriate check box. To disable an option, clear the check box.

Do not select Screen Images when printing to a file.
Changing the Report Setup

You can specify what components will appear in the page headers and title page of a report.

To change the page headers and title page:


The Report Setup dialog opens.

2. Select Header and Title Page options by clicking the appropriate check boxes in each area. To disable an option, clear the box.

<table>
<thead>
<tr>
<th>Select:</th>
<th>To print:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Name of the application.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of printout in a 24 hour format:</td>
</tr>
<tr>
<td></td>
<td>Hour / Minute / Second</td>
</tr>
<tr>
<td>Date</td>
<td>Date of printout in the format: Month / Day / Year</td>
</tr>
<tr>
<td>Page Number</td>
<td>Consecutive page numbers (includes title page).</td>
</tr>
<tr>
<td>User Defined Text</td>
<td>Up to 80 characters (including spaces) of user-defined text.</td>
</tr>
</tbody>
</table>

The next page shows where each option appears in the page header and title page of a report.

3. When done, click the OK button. Or click Cancel to exit the dialog without saving changes.
Header

The header appears on every page of a report except the title page.

Title Page

The title page is the first page printed in a report.
Setting up a Printer

To print a report, a printer must be connected to your computer and your computer must recognize the printer as a valid printer. See your Microsoft Windows User’s Guide for details on installing print drivers.

To set up the printer:

1. Click the Printer Setup button from the Report Setup dialog.

   The standard Microsoft Print Setup dialog opens.

2. Set appropriate attributes for your printer.

3. Click the Options button to enter options specific to your printer.

   The Options dialog is different for each printer type.

4. When done, click the OK button. Or click Cancel to exit the dialog without saving changes.

If your printer is not listed:

- Check for hardware compatibility between your printer and one of the printers listed.
- Check if your printer has an emulation mode that is compatible with one of the printers listed.
- You may need to install a print driver for your printer. Refer to the Microsoft Windows User’s Guide.
Sending the Report to a File

To send a report to a file, the Generic / Text Only printer must be installed and connected to the FILE: printer port on your computer. This printer driver allows you to print text, but not graphics.

You can install this printer from the Printer icon of the Control Panel window in the Program Manager. See your Microsoft Windows User’s Guide for details.

To send a report to a file:

1. Click the Print Setup button from the Report Setup dialog.

   The standard Microsoft Windows Print Setup dialog opens.

2. Under Specific Printers, select Generic / Text Only on FILE: as shown above.

   If Generic / Text Only on FILE: isn’t listed as an available option, you must install this printer option.

3. Click OK.

4. Click the Print button from the Report Setup dialog.

   The Print to File dialog opens.

5. In the Output File Name box, enter the name of the file to receive the report.

   The default location is C:\AB\PBWIN\.

6. Click OK to output report to file.

   If the file name already exists, you are given the option of overwriting it or entering another file name.

   Click Cancel at any time to abort operation.
## Command Summary

### File Menu

<table>
<thead>
<tr>
<th>Choose</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Create a new application file for a PanelView terminal.</td>
</tr>
<tr>
<td>Open...</td>
<td>Open an existing application file and display a list of all screens in the application.</td>
</tr>
<tr>
<td>Close...</td>
<td>Close the application file.</td>
</tr>
<tr>
<td>Save</td>
<td>Save changes (since the last save) to the application file and replaces the previous version stored on disk.</td>
</tr>
<tr>
<td>Save As...</td>
<td>Save a copy of the application file under a new name with all changes you made to it. The original file remains intact.</td>
</tr>
<tr>
<td>Copy Font File...</td>
<td>Copies a font file stored in PBWIN\FONT to an ATA flash card inserted in the ATA card drive on your computer.</td>
</tr>
<tr>
<td>Import/Export Graphics...</td>
<td>Import a bitmap created with another program. The bitmap can be imported from a file or the clipboard. You can also export a bitmap graphic to a file or the clipboard.</td>
</tr>
<tr>
<td>Reports...</td>
<td>Generate a customized report for an application using the default or user defined format. Reports can be printed or saved to a file.</td>
</tr>
<tr>
<td>Workstation Setup...</td>
<td>Access the INTERCHANGE Configuration Utility to configure serial communications required for transferring applications on your computer.</td>
</tr>
<tr>
<td>Exit</td>
<td>Quit PanelBuilder returning you to the Windows desktop.</td>
</tr>
</tbody>
</table>

### Screen Menu

<table>
<thead>
<tr>
<th>Choose</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Create and open a new screen in the application file.</td>
</tr>
<tr>
<td>Open...</td>
<td>Open existing screens in the application file.</td>
</tr>
<tr>
<td>Close...</td>
<td>Close the active screen.</td>
</tr>
<tr>
<td>Attributes...</td>
<td>Rename, renumber or change the background color of the active or selected screen.</td>
</tr>
<tr>
<td>Create Alarm Banner</td>
<td>Create a display in which alarm messages and alarm buttons appear. The banner is global to all screens.</td>
</tr>
</tbody>
</table>
**Edit Screen Menu**

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Screen</td>
<td>Remove selected screens from the application and place them on the clipboard. Anything you cut remains on the clipboard until you change it or exit Windows.</td>
</tr>
<tr>
<td>Copy Screen</td>
<td>Copy selected screens to the clipboard leaving the originals intact. Use this command to copy screens from one application to another or within the same application.</td>
</tr>
<tr>
<td>Paste Screen</td>
<td>Place screens that are on the clipboard into the application.</td>
</tr>
<tr>
<td>Delete Screen</td>
<td>Remove selected screens from the application without placing them on the clipboard.</td>
</tr>
</tbody>
</table>

**Edit Objects Menu**

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverse the most recent edit operation: cut, copy, paste, delete, select all, bring to front, send to back, group/ungroup/regroup.</td>
</tr>
<tr>
<td>Cut</td>
<td>Remove selected objects from the screen and place them on the clipboard. Anything cut remains on the clipboard until you change it or exit Windows.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy selected objects to the clipboard leaving the originals intact. Use to copy objects from one screen to another. Anything copied remains on the clipboard until you change it or exit Windows.</td>
</tr>
<tr>
<td>Paste</td>
<td>Place objects from the clipboard onto the screen. Objects remain on the clipboard even after the paste operation.</td>
</tr>
<tr>
<td>Delete</td>
<td>Remove selected objects from screen without placing them on the clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all objects on the screen.</td>
</tr>
<tr>
<td>Bring To Front</td>
<td>Move the selected object in front of other objects.</td>
</tr>
<tr>
<td>Send To Back</td>
<td>Move the selected object to the back of other objects.</td>
</tr>
<tr>
<td>Bring Dynamic Objects to Front</td>
<td>Move all dynamic objects in front of other objects. Use this command when done with a screen to verify what the screen will look like on the terminal.</td>
</tr>
<tr>
<td>Group</td>
<td>Group two or more objects into a single unit.</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Separate grouped objects.</td>
</tr>
<tr>
<td>Regroup</td>
<td>Reassemble a former group of objects.</td>
</tr>
<tr>
<td>Use Existing Text...</td>
<td>Open a dialog that lets you access all text strings in the application.</td>
</tr>
<tr>
<td>Object Attributes...</td>
<td>Open a dialog for the selected object allowing you to edit its attributes. You can also double-click an object to edit its attributes.</td>
</tr>
<tr>
<td>Set Object Color Defaults</td>
<td>Set default colors for objects of the same type.</td>
</tr>
</tbody>
</table>
### View Menu

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Bar</td>
<td>Toggle the tool bar on or off.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggle the status bar on or off.</td>
</tr>
<tr>
<td>Toolbox</td>
<td>Toggle a toolbox of control, display and graphic objects on or off.</td>
</tr>
<tr>
<td>ISA Symbols</td>
<td>Toggle a toolbox of ISA symbols on or off.</td>
</tr>
<tr>
<td>Color Palette</td>
<td>Toggle the color palette on or off. (Color Terminals only)</td>
</tr>
<tr>
<td>Alarm Banner Position</td>
<td>Reposition the Alarm Banner on application screens.</td>
</tr>
<tr>
<td>Keypad</td>
<td>Toggle the numeric keypad on or off for all screens.</td>
</tr>
<tr>
<td>Full Size</td>
<td>Return the screen to its full size. This command is used with Zoom In and Zoom Out.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Magnify the screen so objects look larger. You can increase the magnification several times. Each time you select Zoom In, the magnification increases to the next higher setting.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduce the magnification of the screen so objects look smaller. You can reduce the magnification several times. Each time you select Zoom Out, the screen reduces to the next lower setting.</td>
</tr>
</tbody>
</table>

### Objects Menu

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Button</td>
<td>Open a submenu to create a momentary, maintained, latched or multistate push button.</td>
</tr>
<tr>
<td>Screen Selectors</td>
<td>Open a submenu to create a goto, goto config screen or return screen button. You can also create a screen list from which a screen is selected.</td>
</tr>
<tr>
<td>Numeric Entry</td>
<td>Open a submenu that lets you create a cursor point or keypad enable button. Both objects activate a scratchpad and the terminal’s keypad for numeric data entry.</td>
</tr>
<tr>
<td>ASCII Entry</td>
<td>Open a submenu that lets you create a cursor point or keypad enable button. Both objects activate a scratchpad for entering a character string.</td>
</tr>
<tr>
<td>Control List Selectors</td>
<td>Open a submenu to create a standard or piloted control list.</td>
</tr>
<tr>
<td>Indicators</td>
<td>Open a submenu to create a multistate or list indicator.</td>
</tr>
<tr>
<td>Numeric Data Display</td>
<td>Create a numeric data display.</td>
</tr>
<tr>
<td>Bar Graph</td>
<td>Create a horizontal or vertical bar graph without scaling.</td>
</tr>
<tr>
<td>Scale</td>
<td>Create a scale with tick marks to the right, left, top or bottom of a bar graph.</td>
</tr>
<tr>
<td>Message Display</td>
<td>Create an ASCII message display for displaying status information or instructions to the operator.</td>
</tr>
<tr>
<td>Graphics</td>
<td>Open a submenu of drawing tools for creating lines, shapes, freeform drawings and background text.</td>
</tr>
<tr>
<td>List Keys</td>
<td>Open a submenu of list keys (Move Up, Move Down, Home, End, Page Up, Page Down, Backspace, Enter).</td>
</tr>
<tr>
<td>Alarm List</td>
<td>Create an alarm list which displays triggered alarms.</td>
</tr>
<tr>
<td>Alarm Buttons</td>
<td>Open a submenu of alarm buttons that you can place in the Alarm Banner (Acknowledge, Clear, Print, Clear Alarm List, Print Alarm List, Acknowledge All).</td>
</tr>
<tr>
<td>Global Object...</td>
<td>Open a dialog that lets you select a global object for placement on a screen.</td>
</tr>
</tbody>
</table>

---

1. **Required on PanelView 900/1400 Touch Screens to move the cursor in a screen or control list.**
## Align Menu

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Toggle the screen grid on or off. A check mark (✓) next to the command means the grid is active. To turn the grid off, choose the command again.</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Snap objects to grid points on the screen grid. Touch screen terminals have a Snap to Grid feature which automatically forces all controls to align with the touch grid.</td>
</tr>
<tr>
<td>Grid Attributes...</td>
<td>Set the spacing of grid lines on the X and Y-axis (in pixels) for the screen grid. Grid attributes are not adjustable on the touch grid.</td>
</tr>
<tr>
<td>Touch Grid</td>
<td>Toggle the touch grid on or off for touch screen terminals. A check mark (✓) next to the command means the touch grid is active. To turn the touch grid off, choose command again. Push buttons are moved and sized in increments of cells on the touch grid whether the grid is displayed or not.</td>
</tr>
</tbody>
</table>

## Format Menu

<table>
<thead>
<tr>
<th>Format</th>
<th>Next State</th>
<th>Change the state of a multistate or list object to the next state so that you can enter text or a graphic for that state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Previous State</td>
<td>Change the state of a multistate or list object to the previous state so that you can enter inner text or a graphic for that state.</td>
</tr>
<tr>
<td>□ Inner Text</td>
<td>Define inner text for each state of an object.</td>
<td></td>
</tr>
<tr>
<td>□ Inner Graphic</td>
<td>Select and insert a graphic for each state of a multistate object.</td>
<td></td>
</tr>
<tr>
<td>□ Text Size</td>
<td>Open a submenu to set the size of the selected text.</td>
<td></td>
</tr>
<tr>
<td>□ Align Text</td>
<td>Open a submenu to align text to the left, right or center.</td>
<td></td>
</tr>
<tr>
<td>□ Underline</td>
<td>Toggle underlining on or off for the selected text.</td>
<td></td>
</tr>
<tr>
<td>□ Word Wrap</td>
<td>Toggle word wrap on or off for the selected text.</td>
<td></td>
</tr>
<tr>
<td>□ Embedded Variable</td>
<td>Open a submenu to insert a time, date, numeric or ASCII variable in a text string. Also lets you edit a variable.</td>
<td></td>
</tr>
<tr>
<td>□ Foreground Color</td>
<td>Open a submenu to select a foreground color for an object, text or graphic.</td>
<td></td>
</tr>
<tr>
<td>□ Background Color</td>
<td>Open a submenu to select a background color for an object, text or graphic.</td>
<td></td>
</tr>
<tr>
<td>□ Toggle Fore/Background</td>
<td>Reverse the foreground and background colors of an object, text or graphic.</td>
<td></td>
</tr>
<tr>
<td>□ Blink</td>
<td>Toggle blinking on or off for the selected object or text.</td>
<td></td>
</tr>
<tr>
<td>□ Fill Pattern</td>
<td>Open a submenu to select a fill pattern for the selected objects.</td>
<td></td>
</tr>
<tr>
<td>□ Shape</td>
<td>Open a submenu to change the shape of selected objects.</td>
<td></td>
</tr>
<tr>
<td>□ Line Type</td>
<td>Open a submenu to change the edge or border type of selected object(s).</td>
<td></td>
</tr>
</tbody>
</table>
### Application Menu

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Editor...</td>
<td>Open the text editor which stores all text strings in an application. From the Text Editor, you can create, edit, filter, sort and print messages.</td>
</tr>
<tr>
<td>Tag Editor...</td>
<td>Open the tag editor to view, add or edit tag information for an application. Tag information is specific to the communication network on which the application will run.</td>
</tr>
<tr>
<td>Project Management...</td>
<td>Open the Project Management dialog to manipulate (display, create, copy, rename, delete) projects and to manipulate (create, copy, rename, delete) devices in projects.</td>
</tr>
<tr>
<td>Preferences...</td>
<td>Controls whether tags/devices in the application are validated against the project database when an application is opened.</td>
</tr>
<tr>
<td>Description...</td>
<td>Enter an application description and change the application name. Also shows when the application was last saved.</td>
</tr>
<tr>
<td>Validate Changes...</td>
<td>Validate only changes to the application since the last validate. Changes are validated on a screen by screen basis.</td>
</tr>
<tr>
<td>Validate All...</td>
<td>Check the entire application for errors or warnings. This command is useful for verifying the accuracy of an application before downloading it to a PanelView terminal.</td>
</tr>
<tr>
<td>Download...</td>
<td>Download an application to an operator terminal, memory card or file. You can also download to a terminal from a computer on the DH+ network using Pass-Through.</td>
</tr>
<tr>
<td>Upload...</td>
<td>Upload an application to PanelBuilder from a PanelView terminal using a direct connection or Pass-Through.</td>
</tr>
<tr>
<td>Terminal Setup...</td>
<td>Set runtime communication and operating parameters for the PanelView terminal including powerup options, time/date format, terminal status/control tags and advanced options such as auto repeat settings for keys or touch cells.</td>
</tr>
<tr>
<td>Alarm Setup...</td>
<td>To define alarm messages, alarm triggers and global parameters that apply to the alarm system.</td>
</tr>
<tr>
<td>Print Only Object Setup...</td>
<td>Define a print only message object. Messages are printed when triggered rather than displayed in a Message Display.</td>
</tr>
</tbody>
</table>

### Window Menu

<table>
<thead>
<tr>
<th>Choose:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exceptions...</td>
<td>Open the Exceptions dialog which displays errors created during application validation. Use this window as a reference while correcting errors.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Arrange open screens in the workspace so that they overlap each other, with the title bar of each screen remaining visible.</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Arrange open screens as horizontal tiles in the workspace.</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Arrange open screens as vertical tiles in the workspace.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arrange icons so that they are evenly spaced along the bottom of the workspace and don't overlap.</td>
</tr>
<tr>
<td>Close All</td>
<td>Close all active screens but does not close the application file.</td>
</tr>
<tr>
<td>1 Sample</td>
<td>Activate an open screen. The bottom of the Window menu displays a list of open screens. A check mark (✓) appears next to the active screen.</td>
</tr>
</tbody>
</table>
## Help Menu

<table>
<thead>
<tr>
<th>Help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Index...</td>
<td>Display a list of all available Help topics.</td>
</tr>
<tr>
<td>Command Reference...</td>
<td>Display a description of each menu command and tool in PanelBuilder.</td>
</tr>
<tr>
<td>Reference...</td>
<td>Display a list of help topics that are available for PanelBuilder.</td>
</tr>
<tr>
<td>About PanelBuilder...</td>
<td>Display copyright/release information about PanelBuilder.</td>
</tr>
</tbody>
</table>
Tool and Bitmap Summary

This appendix contains a brief description of all PanelBuilder tools that are grouped on the tool bar, format bar and toolboxes. It also provides a list of all .BMP files that PanelBuilder provides in the C:\AB\PBWIN\PBLIB directory.

### Tool Bar

#### File Tools

- **New File**: Creates a new application file.
- **Open File**: Opens a dialog that lets you open an existing application file.
- **Save File**: Saves changes to the application file.

#### Screen Tools

- **New Screen**: Creates a new application screen.
- **Open Screen**: Opens an existing application screen.

#### Edit Tools

- **Cut**: Cuts the selection and places it on the Clipboard.
- **Copy**: Copies the selection to the Clipboard.
- **Paste**: Pastes the contents of the Clipboard.
- **Undo**: Reverses the last edit operation.
## Tool Bar

### Edit Tools

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Object Attributes Icon" /></td>
<td>Object Attributes</td>
<td>Opens a dialog that lets you edit the attributes of the selected object.</td>
</tr>
<tr>
<td><img src="image" alt="Next State Previous State Icon" /></td>
<td>Next State Previous State</td>
<td>Changes the state of a multistate or list object to the next state or the previous state. The State box displays the current state.</td>
</tr>
<tr>
<td><img src="image" alt="Inner Text Icon" /></td>
<td>Inner Text</td>
<td>Adds or edits inner text for each state of an object.</td>
</tr>
<tr>
<td><img src="image" alt="Inner Graphic Icon" /></td>
<td>Inner Graphic</td>
<td>Adds or changes an inner graphic to the selected state of a multistate object.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In Icon" /></td>
<td>Zoom In</td>
<td>Increases the screen view to the next higher magnification.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out Icon" /></td>
<td>Zoom Out</td>
<td>Reduces the screen view to the next lower magnification.</td>
</tr>
</tbody>
</table>

## Format Bar

### Object Formatting Tools

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Blink Icon" /></td>
<td>Blink</td>
<td>Toggles blinking on or off for the selected object or selected state of an object.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Fore/Background Icon" /></td>
<td>Toggle Fore/Background</td>
<td>Toggles the foreground and background colors for the selected object or selected state of an object.</td>
</tr>
<tr>
<td><img src="image" alt="Fill Pattern Icon" /></td>
<td>Fill Pattern</td>
<td>Changes the fill pattern of an object or selected state of an object.</td>
</tr>
<tr>
<td><img src="image" alt="Line Type Icon" /></td>
<td>Line Type</td>
<td>Changes the line type of the selected object.</td>
</tr>
<tr>
<td><img src="image" alt="Shape Icon" /></td>
<td>Shape</td>
<td>Changes the shape of the selected object.</td>
</tr>
<tr>
<td><img src="image" alt="Group Icon" /></td>
<td>Group</td>
<td>Groups selected objects into a single unit.</td>
</tr>
<tr>
<td><img src="image" alt="Ungroup Icon" /></td>
<td>Ungroup</td>
<td>Ungroups the selected group of objects.</td>
</tr>
<tr>
<td><img src="image" alt="Bring to Front Icon" /></td>
<td>Bring to Front</td>
<td>Moves the selected object in front of other objects.</td>
</tr>
<tr>
<td><img src="image" alt="Send to Back Icon" /></td>
<td>Send to Back</td>
<td>Moves the selected object in back of other objects.</td>
</tr>
</tbody>
</table>
### Text Formatting Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blink</td>
<td>Toggles blinking on or off for the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Toggles underlining on or off for the selected text.</td>
</tr>
<tr>
<td>Toggle Fore/Background</td>
<td>Toggles the foreground and background colors of the selected text.</td>
</tr>
<tr>
<td>Text Size</td>
<td>Increases or decreases the size of the selected text.</td>
</tr>
<tr>
<td>Left Align</td>
<td>Aligns the selected text to the left.</td>
</tr>
<tr>
<td>Center Align</td>
<td>Centers the selected text.</td>
</tr>
<tr>
<td>Right Align</td>
<td>Aligns the selected text to the right.</td>
</tr>
<tr>
<td>Embedded Variable</td>
<td>Inserts a time, date, numeric or ASCII variable in a text string. Also lets you edit a variable.</td>
</tr>
<tr>
<td>Existing Text</td>
<td>Opens the Existing Text dialog.</td>
</tr>
</tbody>
</table>

**Text:** [Input Field]

### Inner Graphic Tools

**Graphics:** List of available graphics

Selects an inner graphic from a list of imported bitmaps.

**Import/Export Graphics**

Opens the Import/Export Graphics dialog.
## Toolbox

<table>
<thead>
<tr>
<th>Toolbox</th>
<th>Graphic Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection Arrow" /></td>
<td><strong>Selection Arrow</strong></td>
</tr>
<tr>
<td><img src="image" alt="Line" /></td>
<td><strong>Line</strong></td>
</tr>
<tr>
<td><img src="image" alt="Connected Lines" /></td>
<td><strong>Connected Lines</strong></td>
</tr>
<tr>
<td><img src="image" alt="Rectangle" /></td>
<td><strong>Rectangle</strong></td>
</tr>
<tr>
<td><img src="image" alt="Ellipse" /></td>
<td><strong>Ellipse</strong></td>
</tr>
<tr>
<td><img src="image" alt="Freeform" /></td>
<td><strong>Freeform</strong></td>
</tr>
<tr>
<td><img src="image" alt="Background Text" /></td>
<td><strong>Background Text</strong></td>
</tr>
<tr>
<td><img src="image" alt="Scale" /></td>
<td><strong>Scale</strong></td>
</tr>
<tr>
<td><img src="image" alt="Import/Export Graphics" /></td>
<td><strong>Import/Export Graphics</strong></td>
</tr>
<tr>
<td><img src="image" alt="Graphic Image" /></td>
<td><strong>Graphic Image</strong></td>
</tr>
</tbody>
</table>
Control and Display Tools

- **Momentary Push Button**: Creates a momentary push button.
- **Maintained Push Button**: Creates a maintained push button.
- **Latched Push Button**: Creates a latched push button.
- **Multistate Push Button**: Creates a multistate push button.
- **Go To Screen Button**: Creates a screen selector button that when pressed allows the operator to go to a specific screen.
- **Return Screen Button**: Creates a screen selector button that when pressed allows the operator to return to the previous screen.
- **Screen List Selector**: Creates a vertical list of screen controls from which the operator can select a screen.
- **Control List Selector**: Creates a vertical list of operator controls.
- **Numeric Entry Cursor Point**: Creates a cursor point object which activates a scratchpad and the keypad for numeric data entry.
- **Numeric Entry Keypad Enable**: Creates a keypad enable button which enables the keypad for numeric data entry.
- **Multistate Indicator**: Creates a multistate indicator.
- **List Indicator**: Creates a list indicator.
- **Numeric Data Display**: Creates a numeric data display.
- **Bar Graph**: Creates a horizontal or vertical bar graph that fills from the top, bottom, right or left.
- **Message Display**: Creates a message display for showing status information or operator instructions.
- **Global Object**: Opens a dialog to access control and display objects that you've set up as global objects.
List Key Tools

The following List Keys are required on PanelView 900/1400 Touch Screen terminals to move the cursor in a Control List or Screen List Selector and to select a list item.

- **Move Up**: Moves the cursor up one item in a list.
- **Move Down**: Moves the cursor down one item in a list.
- **Home**: Moves the cursor to the first item in a list.
- **End**: Moves the cursor to the last item in a list.
- **Page Up**: Moves the cursor up one page in a scrolling list.
- **Page Down**: Moves the cursor down one page in a scrolling list.
- **Backspace**: Moves the cursor to the currently highlighted selection in a list.
- **Enter**: Confirms a list selection and for a control list sends the selection to the controller.
ISA Symbols Toolbox

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Arrow</td>
<td>Cancels an ISA Symbol selection.</td>
</tr>
<tr>
<td>Horizontal Valve with Actuator</td>
<td>Draws a horizontal valve with an actuator.</td>
</tr>
<tr>
<td>Horizontal Valve Throttling Actuator</td>
<td>Draws a horizontal valve with a throttling actuator.</td>
</tr>
<tr>
<td>Horizontal Valve Manual Actuator</td>
<td>Draws a horizontal valve with a manual actuator.</td>
</tr>
<tr>
<td>Vertical Valve with Actuator</td>
<td>Draws a vertical valve with an actuator.</td>
</tr>
<tr>
<td>Vertical Valve Throttling Actuator</td>
<td>Draws a vertical valve with a throttling actuator.</td>
</tr>
<tr>
<td>Butterfly Valve</td>
<td>Draws a butterfly valve.</td>
</tr>
<tr>
<td>Check Valve</td>
<td>Draws a check valve.</td>
</tr>
<tr>
<td>Relief Valve</td>
<td>Draws a relief valve.</td>
</tr>
<tr>
<td>Liquid</td>
<td>Draws a liquid filter.</td>
</tr>
<tr>
<td>Vacuum</td>
<td>Draws a vacuum filter.</td>
</tr>
<tr>
<td>Motor</td>
<td>Draws an electrical motor.</td>
</tr>
<tr>
<td>Transformer</td>
<td>Draws an electrical transformer.</td>
</tr>
<tr>
<td>Vessel</td>
<td>Draws a vessel.</td>
</tr>
<tr>
<td>Reactor</td>
<td>Draws a reactor.</td>
</tr>
<tr>
<td>Storage Bin</td>
<td>Draws a storage bin.</td>
</tr>
<tr>
<td>Distillation Tower</td>
<td>Draws a distillation tower.</td>
</tr>
<tr>
<td>Pressure Storage Vessel</td>
<td>Draws a pressure storage vessel.</td>
</tr>
<tr>
<td>Weigh Hopper</td>
<td>Draws a weigh hopper.</td>
</tr>
<tr>
<td>Pump</td>
<td>Draws a pump.</td>
</tr>
<tr>
<td>Turbine</td>
<td>Draws a turbine.</td>
</tr>
</tbody>
</table>
Blower
- Draws a blower.

Compressor
- Draws a compressor.

Agitator
- Draws an agitator.

Conveyor
- Draws a conveyor.

Screw Conveyor
- Draws a screw conveyor.

Inline Mixer
- Draws an inline mixer.

Rotary Feeder
- Draws a rotary feeder.

Exchanger
- Draws an exchanger.

Furnace
- Draws a furnace.

Rotary Kiln
- Draws a rotary kiln.

Cyclone Separator
- Draws a cyclone separator.

Arrow-Left
- Draws a left arrowhead.

Arrow-Up
- Draws an up arrowhead.

Arrow-Right
- Draws a right arrowhead.

Arrow-Down
- Draws a down arrowhead.
This section provides a list of bitmaps that PanelBuilder provides in the C:\AB\PBWIN\PBLIB directory. These bitmaps can be imported into your application from the Import/Export Graphics dialog.
PanelBuilder Worksheets

- 550/600 Touch Screen Worksheet
- 550/600 Keypad Screen Worksheet
- 900/1000/1400 Touch Screen Worksheet
- 900/1000 Keypad Screen Worksheet
- 1400 Keypad Screen Worksheet
- Address Worksheet
PanelView 550/600 Operator Terminal
Touch Screen Worksheet

Project Name: ____________________________
Application Name: ________________________
Screen Name / Number: ____________________

F1   F2   F3   F4   F5
F6   F7   F8   F9   F10
PanelView 900/1000/1400 Terminal
Touch Screen Worksheet

Note: 900 and 1400 terminals have same number of touch cells but cell size is different.
<table>
<thead>
<tr>
<th>Word Address Tag Name</th>
<th>Decimal</th>
<th>Octal</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>17</td>
<td>16</td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>9</td>
<td>8</td>
</tr>
<tr>
<td>11</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word Address Tag Name</th>
<th>Decimal</th>
<th>Octal</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>17</td>
<td>16</td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>9</td>
<td>8</td>
</tr>
<tr>
<td>11</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word Address Tag Name</th>
<th>Decimal</th>
<th>Octal</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>17</td>
<td>16</td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>9</td>
<td>8</td>
</tr>
<tr>
<td>11</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word Address Tag Name</th>
<th>Decimal</th>
<th>Octal</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>17</td>
<td>16</td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>9</td>
<td>8</td>
</tr>
<tr>
<td>11</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
# Software Error and Warning Messages

This appendix lists messages that may appear during the configuration of an application. Messages are listed alphabetically.

<table>
<thead>
<tr>
<th>Message</th>
<th>Meaning</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB Utilities error creating project.</td>
<td>Project couldn’t be created. Cause could be full disk or a write protected network partition.</td>
<td>Check available disk space. Or verify your computers write privileges on network.</td>
</tr>
<tr>
<td>AB Utilities failed to initialize.</td>
<td>PanelBuilder could not initialize the AB Utilities during startup because SHARE.EXE is not running.</td>
<td>The PanelBuilder installation should add SHARE.EXE to your AUTOEXEC.BAT file. See README.TXT in C:\AB for details.</td>
</tr>
<tr>
<td>Application has exhausted terminal ID space.</td>
<td>The application contains more objects than the application can support.</td>
<td>Reduce the number of objects on a screen and try again.</td>
</tr>
<tr>
<td>Reduce number of objects in application and retry.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Translation Failure!</td>
<td>Error occurred while translating a .PBA application to a .PVA file for the terminal.</td>
<td>Check for validation error and warning messages. Try to download again.</td>
</tr>
<tr>
<td>Attempt to recover data from (file name) failed!</td>
<td>Attempt to load data from terminal has failed.</td>
<td>Check network connections and try again.</td>
</tr>
<tr>
<td>Error Code: (code number)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cannot create cancel dialog.</td>
<td>Couldn’t create print cancel dialog.</td>
<td>This warning doesn’t affect the print request, but you may be unable to cancel the request.</td>
</tr>
<tr>
<td>Cannot create device context.</td>
<td>Printer driver could not be accessed because of a corrupted print driver, no printer selected, or an unstable Windows environment.</td>
<td>Check the Print Setup settings and reboot computer. If the error reoccurs try another print driver or reinstall the original driver.</td>
</tr>
<tr>
<td>Cannot create error logfile (PB550ERR.LOG).</td>
<td>Error log file couldn’t be created because of a full disk or write protect condition.</td>
<td>Check available disk space or write protection.</td>
</tr>
<tr>
<td>Cannot create new TAGMAN.</td>
<td>Internal error indicates a possible low memory condition.</td>
<td>Exit the application and try again. If the error reoccurs, contact A-B support.</td>
</tr>
<tr>
<td>Cannot delete device context.</td>
<td>Printer driver couldn’t be closed. Cause could be an unstable Windows environment.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer, and try again.</td>
</tr>
<tr>
<td>Cannot find desired terminal in Terminal catalog.</td>
<td>The CATALOG.DAT file, which stores the terminal type, is missing or corrupted.</td>
<td>Contact A-B technical support.</td>
</tr>
<tr>
<td>Cannot delete error logfile (PB550ERR.LOG).</td>
<td>On startup, PanelBuilder couldn’t delete the log file. Cause could be a write protect error or a SHARE violation.</td>
<td>Check access attributes of the file. Otherwise exit Windows and reboot computer. This should clear SHARE violation. If the error reoccurs, delete PB900ERR.LOG in c:\ab\pbwin directory and try again.</td>
</tr>
<tr>
<td>Cannot find or cannot load the Application File Transfer Utility.</td>
<td>The WINPFT.EXE executable failed to load.</td>
<td>Verify that WINPFT.EXE is in the same directory as PBWIN.EXE. If the file is not there, reload the file from the installation disk.</td>
</tr>
<tr>
<td>Cannot create the abort dialog box.</td>
<td>Abort dialog couldn’t be initialized. Windows may be low on resources.</td>
<td>Close applications and try again. If error reoccurs, exit Windows, reboot and retry.</td>
</tr>
<tr>
<td>Cannot initialize print device.</td>
<td>Printer couldn’t be initialized.</td>
<td>Check the Print Setup settings and try again.</td>
</tr>
<tr>
<td>Cannot load the Protocol Translate server</td>
<td>PanelBuilder can’t load required files. Editing the PB550.INI file can cause this error.</td>
<td>Reboot computer and try again. If error continues, re-install PanelBuilder.</td>
</tr>
<tr>
<td>Cannot load the Terminal Specification server</td>
<td>PanelBuilder can’t load required files. Editing the PB550.INI file can cause this error.</td>
<td>Reboot computer and try again. If error continues, re-install PanelBuilder.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cannot load the Terminal Translate server</td>
<td>PanelBuilder can't load required files. Editing the PB900.INI file can cause this error.</td>
<td>Reboot computer and try again. If error continues, re-install PanelBuilder.</td>
</tr>
<tr>
<td>Cannot locate data for tag: (tag name).</td>
<td>Internal error.</td>
<td>Check tag information. Contact A-B technical support if error continues.</td>
</tr>
<tr>
<td>Cannot locate tag: (tag name)</td>
<td>Internal error.</td>
<td>Check tag information. Contact A-B technical support if error continues.</td>
</tr>
<tr>
<td>Cannot parse address for tag: (tag name).</td>
<td>Internal error.</td>
<td>Check tag information. Contact A-B technical support if error continues.</td>
</tr>
<tr>
<td>Cannot print line.</td>
<td>Failed to send a text string. This may be a printer error. The printout is terminated.</td>
<td>Check the Print Setup settings, Print Spooler settings and the printer.</td>
</tr>
<tr>
<td>Cannot print text string.</td>
<td>Failed to send a text string. This may be a printer error. The printout is terminated.</td>
<td>Check the Print Setup settings, Print Spooler settings and the printer.</td>
</tr>
<tr>
<td>Cannot read the Terminal Catalog datafile.</td>
<td>The CATALOG.DAT file is missing or corrupted. This file stores the terminal type that is selected when creating a new application or changing the terminal type for an application.</td>
<td>Contact A-B technical support.</td>
</tr>
<tr>
<td>Cannot renumber text with same text ID.</td>
<td>Same number was used to renumber a message. Message numbers must be unique.</td>
<td>Select a different number or cancel operation.</td>
</tr>
<tr>
<td>Cannot shutdown print device.</td>
<td>Print session couldn't be terminated.</td>
<td>Allow printout to complete.</td>
</tr>
<tr>
<td>Cannot translate unsaved applications.</td>
<td>Can't translate a .PBA file to a .PVA file until the application is saved.</td>
<td>Save the application with the default file name or save with different file name.</td>
</tr>
<tr>
<td>Cannot write to error logfile (PB550ERR.LOG).</td>
<td>Error log file couldn’t be created. Cause could be a full disk or write protect condition.</td>
<td>Check available disk space or write protection.</td>
</tr>
<tr>
<td>Cannot write to .INI, changes to editor settings will not be saved.</td>
<td>.INI file is either write protected or missing.</td>
<td>Check file for possible access locks, such as network access. PanelBuilder will continue.</td>
</tr>
<tr>
<td>Can’t delete project associated with current application</td>
<td>You can’t delete the project associated with the current application.</td>
<td>Reassign the current application to another project, then delete the project.</td>
</tr>
<tr>
<td>Compressed file open failed: (file name)</td>
<td>Couldn’t open compressed application file because of a full disk or write protect.</td>
<td>Check disk space or write protection.</td>
</tr>
<tr>
<td>Compressed file write failed: (file name)</td>
<td>Couldn’t write compressed application file. Cause may be full disk or write protect error.</td>
<td>Check disk space or write protection.</td>
</tr>
<tr>
<td>Could not open (file name) for output!</td>
<td>Couldn’t open temporary translation file because of a full disk or write protect.</td>
<td>Check disk space or write protection.</td>
</tr>
<tr>
<td>Could not retrieve PLC or Scanner data.</td>
<td>The PLC/Scanner is not configured.</td>
<td>From the Setup tab in the Terminal Setup dialog, press the Comms. Setup button and configure the PLC/Scanner type and name.</td>
</tr>
<tr>
<td>Could not retrieve terminal port data.</td>
<td>PanelBuilder couldn’t find the terminal port information necessary for download.</td>
<td>From the Setup tab (Terminal Setup dialog), press the Comms. Setup button to configure terminal.</td>
</tr>
<tr>
<td>Could not retrieve terminal network data.</td>
<td>PanelBuilder couldn’t find the network information necessary for download.</td>
<td>From the Setup tab (Terminal Setup dialog), press the Comms. Setup button to configure terminal.</td>
</tr>
<tr>
<td>Could not retrieve RIO network master data.</td>
<td>PanelBuilder couldn’t find the RIO controller information necessary for download.</td>
<td>Check the RIO controller settings and retry.</td>
</tr>
<tr>
<td>Data format unknown for tag: (tag name).</td>
<td>Internal error.</td>
<td>Check tag information. Contact A-B support if error continues.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete Project From Database. Are you sure?</td>
<td>The selected project tag database will be permanently removed.</td>
<td>Select Yes to delete the project or No to cancel operation.</td>
</tr>
<tr>
<td>Disk is full. Translated file cannot be saved.</td>
<td>Not enough disk space to save translated file during a download.</td>
<td>Check available disk space.</td>
</tr>
<tr>
<td>Enter tag name before pressing Edit Tag button.</td>
<td>Pressed Edit Tag button before entering a tag name.</td>
<td>Before pressing Edit Tag button, there must be a tag to edit (enter a tag name).</td>
</tr>
<tr>
<td>Error closing file. File may not be valid.</td>
<td>The file failed to close. Cause could be a full disk or restricted access to network.</td>
<td>Check the amount of available disk space or for valid access to network file.</td>
</tr>
<tr>
<td>Error executing application. There is not enough memory to execute &lt;program name&gt;. Please close an application.</td>
<td>There is not enough memory to start another session of PanelBuilder Configuration Software.</td>
<td>Close an application and restart PanelBuilder.</td>
</tr>
<tr>
<td>Error importing graphic file. Verify file is in correct format.</td>
<td>The graphic is too large or in the wrong format. .BMP graphic must not exceed pixel size of display.</td>
<td></td>
</tr>
<tr>
<td>Error: Invalid data, missing state data!</td>
<td>Error while reading state data. This indicates a corrupted edit session.</td>
<td>Close application without saving and retry. If error reoccurs, contact Allen-Bradley support.</td>
</tr>
<tr>
<td>Error loading the font file.</td>
<td>Font file cannot be found or read.</td>
<td>Check location and name of font file. Font file may need to be recreated.</td>
</tr>
<tr>
<td>Error reading application file. File cannot be loaded.</td>
<td>A read error occurred. File may be corrupted or a data timeout has occurred on network.</td>
<td>Check for valid access to the file. Try to load application again.</td>
</tr>
<tr>
<td>Error writing application file. Application not saved.</td>
<td>Disk is full, disk doesn’t exist or the file name is invalid.</td>
<td>Check available disk space; verify validity of file/path name; try to save application again.</td>
</tr>
<tr>
<td>Error writing application file to disk.</td>
<td>PanelBuilder was unable to write the .PVA application file.</td>
<td>Check disk space and try again.</td>
</tr>
<tr>
<td>Failure reading file during decompress. Failure writing file during decompress. Failure opening file during decompress. Failure closing file during decompress.</td>
<td>Errors occur during an upload. Cause could be internal errors or bad floppy disk.</td>
<td>Exit the application and restart. Check for bad floppy disk. If the error reoccurs, contact A-B technical support.</td>
</tr>
<tr>
<td>File close failed: (file name)</td>
<td>Upload operation couldn’t close file. Cause could be a full disk or write protection.</td>
<td>Exit application and restart windows. If the error reoccurs, contact A-B technical support.</td>
</tr>
<tr>
<td>File decompress fail: (file name)</td>
<td>Compressed application file is corrupt.</td>
<td>Try again. If the error reoccurs, contact A-B technical support.</td>
</tr>
<tr>
<td>File Error – Cannot find ISPCORE.DLL</td>
<td>PanelBuilder would not start because the default path C:\AB\BIN is missing from AUTOEXEC.BAT file.</td>
<td>Make sure your AUTOEXEC.BAT file contains the default path C:\AB\BIN.</td>
</tr>
<tr>
<td>File rename error: (file name)</td>
<td>A file exists with the same file name.</td>
<td>Check for duplicate file names and try again.</td>
</tr>
<tr>
<td>Filename Specified for Download Cannot be same as Application Filename.</td>
<td>Downloaded application using the same file name and type as the opened file. The file name or type must be different to prevent the download file from overwriting application file.</td>
<td>Specify a different file name or file type. Normally the file type for a downloaded application is .PVA.</td>
</tr>
<tr>
<td>Incompatible AB Utilities version.</td>
<td>PanelBuilder detected incorrect version of the A-B utilities software on startup.</td>
<td>Reinstall the AB Utilities disk or contact Allen-Bradley for support.</td>
</tr>
<tr>
<td>Insufficient available Windows resources to run this application. Try closing some other applications and try again.</td>
<td>There are too many applications running.</td>
<td>Close all running applications and try again.</td>
</tr>
<tr>
<td>Invalid application file. Unable to restore all objects.</td>
<td>Internal error occurred while restoring file. This may result from a file that was incorrectly written.</td>
<td>Contact Allen-Bradley customer support.</td>
</tr>
<tr>
<td>Invalid filename specified for download.</td>
<td>Invalid destination file entered for the download.</td>
<td>Enter a valid destination file name or use the Browse button to search for a file.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid Left Margin. Please select another number between 0 and 132.</td>
<td>The specified value is not a valid option.</td>
<td>Specify a value between 0 and 132.</td>
</tr>
<tr>
<td>Invalid message text number. Please select another number.</td>
<td>Number entered is invalid.</td>
<td>Backspace over entry and enter a new message number 1 to 256.</td>
</tr>
<tr>
<td>Invalid number of lines. Please select another number between 1 and 255.</td>
<td>The specified value is not a valid option.</td>
<td>Specify a value between 1 and 255.</td>
</tr>
<tr>
<td>Invalid Page Length. Please select another number between 0 and 255.</td>
<td>The specified value is not a valid option.</td>
<td>Specify a value between 0 and 255.</td>
</tr>
<tr>
<td>Invalid Page Width. Please select another number between 20 and 132.</td>
<td>The specified value is not a valid option.</td>
<td>Specify a value between 20 and 132.</td>
</tr>
<tr>
<td>Invalid Perforation Skip. Please select another number between 0 and 255.</td>
<td>The specified value is not a valid option.</td>
<td>Specify a value between 0 and 255.</td>
</tr>
<tr>
<td>Invalid queue size. Please select another number between 1 and 100.</td>
<td>The specified value is not a valid option.</td>
<td>Specify a value between 1 and 100.</td>
</tr>
<tr>
<td>Invalid screen number. Please select another number.</td>
<td>Screen number entered is invalid.</td>
<td>Backspace over entry and enter a new screen number 1 to 29,999.</td>
</tr>
<tr>
<td>Low memory condition. Scrolling may not work. Do you wish to continue?</td>
<td>Microsoft Windows is low on memory.</td>
<td>You can continue but the scroll function for the list window will not be active.</td>
</tr>
<tr>
<td>Low resource memory. Unable to create application screen list window.</td>
<td>Low memory error.</td>
<td>Close other applications and retry. If error reoccurs, exit Windows, reboot your computer, and try again.</td>
</tr>
<tr>
<td>Low resource memory. Unable to create dialog manager window.</td>
<td>Low memory error.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer and try again.</td>
</tr>
<tr>
<td>Low resource memory. Unable to create message edit window.</td>
<td>Low memory error.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer and try again.</td>
</tr>
<tr>
<td>Low resource memory. Unable to create new screen.</td>
<td>Low memory error.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer and try again.</td>
</tr>
<tr>
<td>Low resource memory. Unable to create PB frame window.</td>
<td>Low memory error.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer and try again.</td>
</tr>
<tr>
<td>Low resource memory. Unable to open screen.</td>
<td>Low memory error.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer and try again.</td>
</tr>
<tr>
<td>Low resource memory. Unable to open additional windows.</td>
<td>Low memory error.</td>
<td>Close other applications and try again. If the error reoccurs, exit Windows, reboot your computer and try again.</td>
</tr>
<tr>
<td>Maximum number of tick marks for scale is (number). Tick marks will default to (number).</td>
<td>Entered more tick marks than appropriate for the size of the scale.</td>
<td>Enter a value equal to or less than the specified value or cancel the operation.</td>
</tr>
<tr>
<td>Memory allocation failed: (file name)</td>
<td>Upload wasn’t able to allocate sufficient memory to continue.</td>
<td>Close other applications and try again.</td>
</tr>
<tr>
<td>Memory overwritten!</td>
<td>Serious corruption of memory has occurred.</td>
<td>Exit application, exit Windows and reboot your computer.</td>
</tr>
<tr>
<td>Text ID in use by other text.</td>
<td>An attempt to use a message number that is already in use.</td>
<td>Select a different number.</td>
</tr>
<tr>
<td>Text ID must start at 1.</td>
<td>0 was entered as a message number. Message numbers must start at 1.</td>
<td>Enter message number starting with 1.</td>
</tr>
<tr>
<td>Minimum number of tick marks for scale is 2. Tick marks will default to 2.</td>
<td>Entered value of 2 for scale tick-marks.</td>
<td>Enter a new value.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>No application open to associate project with.</td>
<td>Tried to associate a project without opening an application first.</td>
<td>Open an application and try again.</td>
</tr>
<tr>
<td>No data on clipboard.</td>
<td>Nothing on clipboard to paste.</td>
<td>Cut or copy object before pasting.</td>
</tr>
<tr>
<td>No default printer. Use Control Panel to install and select a default printer.</td>
<td>A default printer hasn't been configured.</td>
<td>See your Windows User’s Manual for details on how to install and select printers.</td>
</tr>
<tr>
<td>No file ID record found: (file name) Internal error detected. Cause could be a faulty disk drive or floppy disk.</td>
<td>Try again. If error reoccurs, contact Allen-Bradley technical support.</td>
<td></td>
</tr>
<tr>
<td>No memory card command specified for download.</td>
<td>Tried to download to a memory card without specifying a memory card command.</td>
<td>Select a memory card command and try to download again.</td>
</tr>
<tr>
<td>No source file specified for upload.</td>
<td>Upload requires a source file destination.</td>
<td>Enter source file name before trying again.</td>
</tr>
<tr>
<td>Not enough memory to create tool bar. Not enough memory to install tool bar. Not enough memory to load bitmap. Not enough memory to load popup menu.</td>
<td>Low memory error.</td>
<td>Close other applications and other open screens. If the error reoccurs, exit Windows and reboot your computer.</td>
</tr>
<tr>
<td>Not enough resource memory to open dialog.</td>
<td>Low memory error.</td>
<td>Close other applications and retry. If error reoccurs, exit Windows, reboot, and retry.</td>
</tr>
<tr>
<td>Note: Applications created by this demonstration version of PanelBuilder 900 will not be compatible with licensed versions.</td>
<td>Application file created using a Demo release of the configuration software will not be supported by the released version.</td>
<td>Recreate file with a released version of the PanelBuilder Configuration Software.</td>
</tr>
<tr>
<td>Objects in application have touch cells assigned. Edit object attributes before changing application type to Non-Touch.</td>
<td>When changing the terminal type from touch/keypad to keypad only, you must reassign touch cell objects to function keys.</td>
<td>For each object, change touch cell input to function key input, or delete the object.</td>
</tr>
<tr>
<td>Out of memory. Close other applications and try again. Otherwise, select cancel to quit.</td>
<td>Attempt to allocate additional memory has failed.</td>
<td>Close other Window applications and retry. If unsuccessful, PanelBuilder exits.</td>
</tr>
<tr>
<td>PanelView application size of (number) bytes exceeds maximum size of (number) bytes. You can eliminate some of the upload data and try again.</td>
<td>The application exceeds the allowable byte size.</td>
<td>Try to reduce byte size of application.</td>
</tr>
<tr>
<td>PanelView application warnings found. Continue with download?</td>
<td>Warnings found during validation.</td>
<td>The application will download and run. However, it may not operate as intended. Correct the warnings and try again.</td>
</tr>
<tr>
<td>PanelView internal tag. No parameters to edit.</td>
<td>Edit Tag button was pressed for internal tag.</td>
<td>You can’t edit internal tags.</td>
</tr>
<tr>
<td>Print manager failed.</td>
<td>Error received from print manager (spooler).</td>
<td>Check print spooler for possible errors.</td>
</tr>
<tr>
<td>Printer Initialization string can be at most 20 characters.</td>
<td>The specified printer initialization string is too long.</td>
<td>Shorten the string to 20 or less characters.</td>
</tr>
<tr>
<td>Printer setup failed.</td>
<td>Error occurred during printer setup.</td>
<td>Check validity of print driver. Reload driver if necessary.</td>
</tr>
<tr>
<td>Project already associated with current application.</td>
<td>Selected project is already associated with the current application.</td>
<td>None.</td>
</tr>
<tr>
<td>Project created for tags in application being opened. Project Name:</td>
<td>A project doesn’t exist for the uploaded application.</td>
<td>PanelBuilder creates a project for the application and fills in all the application tags.</td>
</tr>
<tr>
<td>Project does not exist.</td>
<td>Selected project that doesn’t exist.</td>
<td>Select another project name.</td>
</tr>
<tr>
<td>Project does not exist. Can’t associate.</td>
<td>Associated application with a project name that doesn’t exist.</td>
<td>Select an existing project name to link with the application or create a new project.</td>
</tr>
<tr>
<td>Project exists.</td>
<td>Entered a project name that already exists.</td>
<td>Enter another project name or use existing project.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Range minimum must be less than range maximum.</td>
<td>Minimum value entered is greater than the maximum value.</td>
<td>Enter a minimum value that's less than the maximum value.</td>
</tr>
<tr>
<td>Required network node not found.</td>
<td>The PanelView terminal is attempting to read or write to a nonexistent location.</td>
<td>Check the SLC setup and program.</td>
</tr>
<tr>
<td>Saved device data is missing or corrupted and cannot be used to update the tag database.</td>
<td>A.PVA file was uploaded without project device data.</td>
<td>Recreate all application device data.</td>
</tr>
<tr>
<td>Saved tag data is missing or corrupted and cannot be used to update the tag database.</td>
<td>A .PVA file was uploaded without project tags.</td>
<td>Recreate all application tags.</td>
</tr>
<tr>
<td>Screen number already exists. Please select another number.</td>
<td>Same screen number can't be used for more than one screen.</td>
<td>Assign a unique number (1-29,999) to screen.</td>
</tr>
<tr>
<td>Seek error: (file name)</td>
<td>Internal error detected. Cause could be a faulty disk drive or floppy disk.</td>
<td>Try again.</td>
</tr>
<tr>
<td>Selected global object on screen. Global object can only appear once on each screen.</td>
<td>Global device already appears on the screen.</td>
<td>A global device can only appear once per screen. Use a local device if needed.</td>
</tr>
<tr>
<td>Selected name in use. Enter another name.</td>
<td>Selected graphic image name that's in use.</td>
<td>Select a different graphic image.</td>
</tr>
<tr>
<td>Source file not found or cannot be opened.</td>
<td>Incorrect file name or path.</td>
<td>Verify file name and path are correct. Retry.</td>
</tr>
<tr>
<td>Tag in application being opened that does not exist in the Project.</td>
<td>The application contains one or more tags that don't exist in the associated project.</td>
<td>You are asked if you want to add the tag(s).</td>
</tr>
<tr>
<td>Tag information saved with application is incomplete. Please check tag information when application is opened.</td>
<td>Tag information is incomplete. Tag was created but doesn't contain all the necessary information.</td>
<td>Supply missing tag data in the tag editor.</td>
</tr>
<tr>
<td>Tag must be scanned with scan group.</td>
<td>The tags associated with a particular alarm are not in the same scan group.</td>
<td>Change the tag addresses for the alarm and make sure they are in the same scan group.</td>
</tr>
<tr>
<td>Target terminal cannot support an alarm banner.</td>
<td>The specified terminal does not support alarms.</td>
<td>Change the terminal type or remove alarms, alarm triggers, alarm buttons, and alarm banners from the application.</td>
</tr>
<tr>
<td>Target terminal cannot support alarm triggers.</td>
<td>The specified terminal does not support alarms.</td>
<td>Change the terminal type or remove alarms, alarm triggers, alarm buttons, and alarm banners from the application.</td>
</tr>
<tr>
<td>Target terminal cannot support alarms.</td>
<td>The specified terminal does not support alarms.</td>
<td>Change the terminal type or remove alarms, alarm triggers, alarm buttons, and alarm banners from the application.</td>
</tr>
<tr>
<td>Target terminal cannot support ASCII callouts.</td>
<td>The specified terminal type does not support ASCII callouts.</td>
<td>Use the Application Text editor to remove all ASCII callouts from the messages.</td>
</tr>
<tr>
<td>Target terminal cannot support number of alarms contained in the application.</td>
<td>The specified terminal type cannot support the number of alarms contained in the application.</td>
<td>Refer to the user manual to determine the maximum number of alarms allowed. Remove any unnecessary alarms.</td>
</tr>
<tr>
<td>Target terminal cannot support print only objects.</td>
<td>The specified terminal type does not support printing.</td>
<td>Remove all Print Only Objects from the application.</td>
</tr>
<tr>
<td>Temporary file open failed: \ (file name)</td>
<td>PanelBuilder was unable to open a temporary file during an upload. Probable cause is full disk or write protect condition.</td>
<td>Check available disk space or write protection.</td>
</tr>
<tr>
<td>Temporary file read failed: \ (file name)</td>
<td>PanelBuilder was unable to read the temporary file. The file may be locked by another application or corrupt.</td>
<td>Check if file is locked by another application. If not, contact Allen-Bradley technical support.</td>
</tr>
<tr>
<td>Terminal and computer nodes cannot have same value.</td>
<td>The terminal and personal computer can't have the same address for a DH485 transfer.</td>
<td>Make sure the terminal node address and computer node address are different.</td>
</tr>
<tr>
<td>The existing alarm banner will be overwritten. Do you wish to continue?</td>
<td>Pasting an alarm banner will overwrite any existing banner.</td>
<td>Specify whether you want to continue or cancel the operation.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>The PanelView terminal can only use 255 screens, no more screens can be created.</td>
<td>The maximum number of screens is 255.</td>
<td></td>
</tr>
<tr>
<td>The specified path for the translated file is invalid. The translated application file could not be opened.</td>
<td>File could not be opened during a download.</td>
<td>Check path of specified file.</td>
</tr>
<tr>
<td>Too many files currently open. Translated application file cannot be opened.</td>
<td>File could not be opened because too many other files or programs are open.</td>
<td>Close other files or applications and try again.</td>
</tr>
<tr>
<td>Unable to create application file. Check if disk write protected.</td>
<td>Disk may be write protected or network partition has read only access.</td>
<td>If writing to floppy, check write protect. If writing to a network file, verify write privileges.</td>
</tr>
<tr>
<td>Unable to load configuration utility.</td>
<td>Could not load the InterChange Config. utility.</td>
<td>Check that INTERCHANGE Software is installed.</td>
</tr>
<tr>
<td>Unable to load file. Not a PanelBuilder file or file is corrupted.</td>
<td>File did not pass the Cyclic Redundancy Check (CRC). This may occur if the file is of the wrong type or contains corrupted data.</td>
<td>Check that the file is a .PBA file (not .PVA). If file is corrupted, it must be recreated.</td>
</tr>
<tr>
<td>Unable to load file. Application file created with incompatible version of PanelBuilder.</td>
<td>Application file was created using a newer release of the configuration software.</td>
<td>Recreate file with a released version of PanelBuilder Configuration Software.</td>
</tr>
<tr>
<td>Unable to load font file (file name). Display on the screen may not be correct. You may need to re-install PanelBuilder.</td>
<td>The font file could not be found in its normal location or is an invalid font file.</td>
<td>Check the name and location of the font file.</td>
</tr>
<tr>
<td>Unable to load help file.</td>
<td>Low memory error.</td>
<td>Close other Window applications and retry. If unsuccessful, the program will exit. You can’t recover from this error.</td>
</tr>
<tr>
<td>Unable to load PanelView terminal fonts. Font file PB900.FON must be in same directory as PBWIN.EXE.</td>
<td>Font file is not in its normal location.</td>
<td>Move the PB900.FON file into the same directory as PBWIN.EXE (AB\PBWIN).</td>
</tr>
<tr>
<td>Unable to open exceptions window.</td>
<td>Microsoft Windows is out of resources or user memory.</td>
<td>Close other applications and retry. If error reoccurs, exit Windows, reboot, and retry.</td>
</tr>
<tr>
<td>UNABLE TO OPEN FILE. This file was created by PanelBuilder 900 demonstration software.</td>
<td>Application file was created using a Demo release of the PanelBuilder configuration software.</td>
<td>Recreate file with a released version of PanelBuilder Configuration Software.</td>
</tr>
<tr>
<td>Unable to open file for reading. File not loaded.</td>
<td>Read error may occur if a file is corrupted or a data timeout has occurred on network.</td>
<td>Check for valid access to file. Try to load application again.</td>
</tr>
<tr>
<td>Unable to open screen list window.</td>
<td>Microsoft Windows is out of resources or user memory.</td>
<td>Close other applications and retry. If error reoccurs, exit Windows, reboot, and retry.</td>
</tr>
<tr>
<td>Unexpected EOF or Error: (file name)</td>
<td>File error. Operation will not continue.</td>
<td>Check for corrupted file.</td>
</tr>
<tr>
<td>Upload data may be corrupted. Save application again and retry download.</td>
<td>Internal error detected.</td>
<td>Cancel download, resave application and retry download. If error reoccurs, call Allen-Bradley technical support.</td>
</tr>
<tr>
<td>Validating, translating and downloading application.</td>
<td>Message appears during downloads.</td>
<td>Press the Cancel button to cancel the download or continue with download.</td>
</tr>
<tr>
<td>Value out of range.</td>
<td>Entered value is not in acceptable range.</td>
<td>Enter a value within acceptable ranges.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Min/Max Range Values must be between 0 and 65535.</td>
<td>Value entered that's not within the valid range.</td>
<td>Enter a new value within valid range.</td>
</tr>
<tr>
<td>Min/Max Range Values must be between 0 and 9999.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min/Max Range Values must be between 0 and (value).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min/Max Range Values must be between -32768 and 32767.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min/Max Range Values must be between -99,999,997,952 and 999,999,995,904</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min/Max Range Values must be binary (a combination of 0 and 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write access denied for the specified translation file or current directory</td>
<td>File or directory could not be accessed.</td>
<td>Check write access.</td>
</tr>
<tr>
<td>You must assign an input F-Key.</td>
<td>Object must be assigned a function key.</td>
<td>Assign available function key to object.</td>
</tr>
<tr>
<td>You must assign an input F-Key or turn the view on.</td>
<td>Object must be assigned a function key or the object view must be turned on.</td>
<td>Assign available function key to object or turn the object view on.</td>
</tr>
<tr>
<td>You must select a valid terminal and firmware combination.</td>
<td>The terminal you selected is not compatible with the firmware specified.</td>
<td>Make sure terminal and firmware are compatible.</td>
</tr>
</tbody>
</table>
## Validation Messages

This appendix lists error messages that appear during a validation or download operation. Messages are listed alphabetically.

<table>
<thead>
<tr>
<th>Validation Message</th>
<th>Meaning</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack Tag must have BCD, signed int, or unsigned int data type.</td>
<td>An invalid data type was selected for the alarm acknowledge tag.</td>
<td>Change tags or the data type. Valid data types are BCD, signed integer, or unsigned integer.</td>
</tr>
<tr>
<td>Ack Tag range must be greater than or equal to trigger range.</td>
<td>The number of bits in the ack tag's data length must be greater than or equal to the number of data bits for the trigger.</td>
<td>Increase the number of bits in the Alarm Acknowledge tag.</td>
</tr>
<tr>
<td>Acknowledge all value must be greater than highest bit position for this trigger.</td>
<td>For bit and least significant bit alarm triggers, the acknowledge all bit position must be at least one greater than the highest bit specified for the alarm.</td>
<td>Increase the bit position specified for the acknowledge all field.</td>
</tr>
<tr>
<td>Acknowledge all value used as alarm trigger value/bit.</td>
<td>Acknowledge all value for the trigger is the same as one of the values that triggers an alarm.</td>
<td>Choose a unique value/bit for the acknowledge all value.</td>
</tr>
<tr>
<td>Address overlaps Block Transfer/Pass Thru Control Byte</td>
<td>A tag is assigned the same address as the Block Transfer Control Byte (the lowest accessible byte in the discrete I/O rack).</td>
<td>Enter a different address for the tag in the Tag Editor or disable block transfers (if not using BTs) in the Block Transfer dialog.</td>
</tr>
<tr>
<td>Alarm List queue size too large for remaining NVRAM space.</td>
<td>The specified size of the alarm list queue is too large for the available memory.</td>
<td>Specify a smaller alarm list queue size.</td>
</tr>
<tr>
<td>Alarm requiring acknowledgement must be displayed.</td>
<td>An alarm acknowledge button is defined but the alarm is not enabled for display.</td>
<td>Enable the alarm for display.</td>
</tr>
<tr>
<td>Alarm Trigger cannot be the same as the acknowledge or handshake tags.</td>
<td>The alarm trigger is assigned the same tag name as the Ack or Handshake tag.</td>
<td>Change the tag names so they are unique.</td>
</tr>
<tr>
<td>Alarms requiring acknowledgement cannot be acknowledged individually from the alarm list without the Enter list key.</td>
<td>An alarm that can be acknowledged in the alarm list does not have an Enter list key on the screen.</td>
<td>Add an Enter list key to the specified screen.</td>
</tr>
<tr>
<td>All states in this object refuse operator entry.</td>
<td>All states of the piloted control list have an access of &quot;Controller Only&quot; or &quot;None&quot;. This is illegal.</td>
<td>Open the object's dialog and change the access for some of the states to &quot;User and Controller&quot; or &quot;User Only&quot;.</td>
</tr>
<tr>
<td>An alarm ack button must exist.</td>
<td>There is an alarm that requires and acknowledgement (ack) button.</td>
<td>Add an alarm acknowledge button to the alarm banner.</td>
</tr>
<tr>
<td>An alarm clear button must exist</td>
<td>An alarm that does not require acknowledgement exists. A clear button must be defined to clear the alarm.</td>
<td>Add alarm clear button to the alarm banner.</td>
</tr>
<tr>
<td>An alarm banner must exist.</td>
<td>An alarm banner is not defined and an alarm is enabled for display.</td>
<td>Turn off the display for the alarm or create an alarm banner for the application.</td>
</tr>
<tr>
<td>Application translation failed – a Screen uses too many Terminal Resources.</td>
<td>A screen contains too many controls and indicators.</td>
<td>Redesign the screen with fewer control or indicator objects.</td>
</tr>
<tr>
<td>Application type does not match terminal type. Re-configure in Terminal Setup.</td>
<td>The application is configured for Remote I/O or DH-485 communications but the selected terminal type does match.</td>
<td>From the Setup tab in Terminal Setup, select a terminal type that matches the application. Or convert the application to match the terminal type. Then update the tags.</td>
</tr>
<tr>
<td>At least one alarm must be configured to use this object.</td>
<td>An alarm device exists which requires an alarm to be configured.</td>
<td>Remove the device or add alarms to the application.</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bit positions for this trigger should be contiguous.</td>
<td>For fastest operation, all alarms within a trigger should use successive bits (i.e. 1,2,3,4 as opposed to 1,3,5,6)</td>
<td>Change the bits used for triggering so they are contiguous for this trigger.</td>
</tr>
<tr>
<td>Bit position out of range for this trigger.</td>
<td>The bit position specified for the alarm trigger exceeds the number of positions supported by the trigger’s data type/length.</td>
<td>Move the alarm to another trigger or change the trigger’s data type/length.</td>
</tr>
<tr>
<td>Block Transfer Channel Number: (Num) – Length is Invalid.</td>
<td>The block transfer length is defined as 0 or exceeds the maximum of 64.</td>
<td>In the Block transfer dialog, correct the invalid length of a block transfer.</td>
</tr>
<tr>
<td>Cannot use Bit Array tags with LSB triggering in FMW 1.00-1.xx.</td>
<td>A bit array has been specified as a Least Significant Bit trigger.</td>
<td>Select a different data type.</td>
</tr>
<tr>
<td>Cannot use Internal Tags with LSB triggering.</td>
<td>An internal tag is specified for use with Least Significant Bit triggering of an indicator.</td>
<td>Select a non-internal tag.</td>
</tr>
<tr>
<td>Cannot write to output of discrete rack</td>
<td>The write tag of a control object is assigned a discrete rack output address. The PanelView cannot write data to a controller output.</td>
<td>Change the address of the write tag (controller input) or use a different write tag for the object.</td>
</tr>
<tr>
<td>Can’t trigger off of an internal tag.</td>
<td>Internal tag specified as a trigger.</td>
<td>Select a non-internal tag.</td>
</tr>
<tr>
<td>Copying Font File...</td>
<td>Status message displayed while saving a font file to disk or memory.</td>
<td>Wait for save operation to complete.</td>
</tr>
<tr>
<td>Custom text for numeric scratch pad (Enter value) text is limited to (number) characters</td>
<td>Text is limited to 30/15 for characters when single/double byte is selected.</td>
<td>Reduce text or change font size.</td>
</tr>
<tr>
<td>Custom text for numeric scratch pad (to) text is limited to (number) characters</td>
<td>Text is limited to 4/2 for characters when single/double byte is selected.</td>
<td>Reduce text or change font size.</td>
</tr>
<tr>
<td>Data bit (Num) number out of range</td>
<td>The bit number assigned to an object state is out of range.</td>
<td>Open the object’s dialog and select a different bit number for the object state.</td>
</tr>
<tr>
<td>Data value (value) is out of range</td>
<td>The value entered for an object state is not within the valid range for the data type.</td>
<td>Open the object’s dialog and enter a valid value for the state.</td>
</tr>
<tr>
<td>Decimal position must be less than field width by at least 2 digits.</td>
<td>The decimal position for a numeric data display or variable is &gt; than the field width -2.</td>
<td>Open the object’s dialog and select a decimal position that is less than the field width.</td>
</tr>
<tr>
<td>Decimal position (number) out of range</td>
<td>The decimal position for a numeric data display or variable is invalid for the field width.</td>
<td>Open the object’s dialog and enter a decimal position that’s valid for the field width.</td>
</tr>
<tr>
<td>Device (name) has node address outside valid range 1 - 31</td>
<td>The device has an incorrect DH-485 node address.</td>
<td>From the Setup tab in Terminal Setup, press the Comms. Setup button to correct the DH-485 node address.</td>
</tr>
<tr>
<td>Device too small for Text display</td>
<td>An object is too small to display the inner text.</td>
<td>Change the size of the object or use a smaller text size.</td>
</tr>
<tr>
<td>Duplicate alarm values or bits exist within trigger.</td>
<td>More than one alarm uses the same trigger value/bit.</td>
<td>Change the alarm trigger bits/values so they are not identical.</td>
</tr>
<tr>
<td>Duplicate data bit number (number) in state (number)</td>
<td>The same bit number is assigned to two states of an object.</td>
<td>Open the object’s dialog and select a different bit number for one of the states.</td>
</tr>
<tr>
<td>Duplicate data value (value) in state (number)</td>
<td>The same value is assigned to two states of an object.</td>
<td>Open object’s dialog and enter a different value for one of the states.</td>
</tr>
<tr>
<td>Duplicate Tags Write tag (name) is already in use</td>
<td>Two objects contain the same write tag. Control objects cannot use the same write tag address.</td>
<td>Select another write tag for one of the objects.</td>
</tr>
<tr>
<td>Dynamic object obscured by another object, appearance on terminal may differ.</td>
<td>A dynamic object is obscured by another object when redrawn on the terminal because of data updated in controller. The object that is obscuring the dynamic object is erased.</td>
<td>Move the object.</td>
</tr>
<tr>
<td>Field length (number) out of range</td>
<td>The field width for a numeric data display or variable is invalid.</td>
<td>Open the object’s dialog and enter a valid field width.</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Font file is not successfully loaded</td>
<td>Font file cannot be read.</td>
<td>Check the (file name).otf file to make sure it is the latest file created from FontTool.</td>
</tr>
<tr>
<td>Font file must contain 16 high font to customize numeric scratch pad text.</td>
<td>Font file does not contain 16 high font.</td>
<td>Create font file with 16 high font, refer to terminal font setup dialog.</td>
</tr>
<tr>
<td>Foreground and background colors must be different.</td>
<td>The foreground and background colors for this object are the same.</td>
<td>Change colors so they are not identical.</td>
</tr>
<tr>
<td>Function key not assigned</td>
<td>The object is configured for function key input but isn’t assigned to a specific function key.</td>
<td>Open the object’s dialog and select a function key.</td>
</tr>
<tr>
<td>Function key (number) not valid</td>
<td>The specified object is assigned an invalid function key.</td>
<td>Open the object’s dialog and assign a valid function key.</td>
</tr>
<tr>
<td>Function key (number) used twice</td>
<td>The same function key is assigned to two different objects on the same screen.</td>
<td>Open one of the object’s dialog and assign a different function key.</td>
</tr>
<tr>
<td>Graphic foreground color is the same as its background color.</td>
<td>Graphic foreground color is the same as text background color.</td>
<td>Change colors so they are not identical.</td>
</tr>
<tr>
<td>Graphic (name) not found</td>
<td>An object or object state is assigned an inner graphic that no longer exists.</td>
<td>Select another inner graphic for the object or import a bit map graphic with the same name.</td>
</tr>
<tr>
<td>Handshake tag not found</td>
<td>The handshake tag is undefined for a latched push button object.</td>
<td>Open the object’s dialog and assign a handshake tag name.</td>
</tr>
<tr>
<td>Height (value) is out of range</td>
<td>The height of the object is invalid.</td>
<td>Resize the object.</td>
</tr>
<tr>
<td>Hold time (value) is out of range</td>
<td>The hold time entered for a momentary push button is invalid.</td>
<td>Open the object’s dialog and select a hold time from the Hold Time list box.</td>
</tr>
<tr>
<td>Illegal font size for this type of device.</td>
<td>An internal font size with the same height as the currently selected external font does not exist for a device having a list cursor or an acknowledge icon.</td>
<td>Make sure that an internal font size exists with the same height as the currently selected external font.</td>
</tr>
<tr>
<td>(Initial, Min, Max, Scale or Offset) value of (value) not valid or not in range</td>
<td>The value entered for the initial value, min/max value, or scale/offset value is invalid or out of range for the tag data type.</td>
<td>Enter a value that is within the valid range for the data type.</td>
</tr>
<tr>
<td>Initial Value entry of (value) for tag (name) may result in out of range data value</td>
<td>Initial value specified for the tag is not within the min/max data entry limits entered in the Tag Editor.</td>
<td>Enter an initial value that is within the valid min/max range for the tag.</td>
</tr>
<tr>
<td>Initial Value entry of (value) for tag (name) will yield controller Initial Value of (value) due to scaling and rounding</td>
<td>A warning that indicates the initial value sent to the controller will be rounded because of the precision of the scale factor.</td>
<td>Action is not required unless a rounded value is unacceptable.</td>
</tr>
<tr>
<td>Initial Value of (value) for tag (name) yields an Out of Range controller Initial Value of (value)</td>
<td>Initial value specified for the tag is not within the valid range for the data type.</td>
<td>Enter an initial value that is valid.</td>
</tr>
<tr>
<td>Invalid length, Bit Arrays cannot cross word boundaries.</td>
<td>The length of a bit array exceeds 16 bits.</td>
<td>Change the starting bit number for the bit array or change the array size in Tag Editor.</td>
</tr>
<tr>
<td>Loading external font file...</td>
<td>Status message displayed when loading external font.</td>
<td>Wait until operation is complete.</td>
</tr>
<tr>
<td>Logic controller is not configured for Block Transfers. Terminal’s RIO Port setup requires Block Transfer support.</td>
<td>The terminal is configured to use Block Transfers but the controller is not.</td>
<td>From the Setup tab (Terminal Setup dialog), press the Comms. Setup button. Verify that the selected controller supports block transfers. If the controller supports block transfers, press the Block Transfer button and verify that block transfers are defined.</td>
</tr>
<tr>
<td>Max entry limit of (value) for tag (name) may result in out of range data value</td>
<td>The max data entry limit value entered in the Tag Editor lets you enter a number resulting in an out of range value on the logic controller.</td>
<td>Enter a valid maximum data entry limit in the form view of the tag editor.</td>
</tr>
<tr>
<td>Min entry limit of (value) for tag (name) may result in out of range data value</td>
<td>The min data entry limit value entered in the tag editor lets you enter a number resulting in an out of range value on the logic controller.</td>
<td>Enter a valid minimum data entry limit in the form view of the tag editor.</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>Min range (value) is greater than max range (value)</td>
<td>The minimum value for a bar graph is set to a value that's greater than the maximum value.</td>
<td>Open the object's dialog and re-enter valid min/max range values.</td>
</tr>
<tr>
<td>Min value (value) is greater than the max value (value)</td>
<td>The min setting is greater than the max setting for data entry limits of a tag.</td>
<td>From the form view of the tag editor, make sure the min data entry limit is less than the max data entry limit for the tag.</td>
</tr>
<tr>
<td>Missing acknowledge tag.</td>
<td>Acknowledge handshake tag is defined without an acknowledge tag.</td>
<td>Define an acknowledge tag for the trigger.</td>
</tr>
<tr>
<td>Missing or invalid screen assignment</td>
<td>A screen selector object has a missing or invalid screen assignment.</td>
<td>Open the object’s dialog and reassign screen.</td>
</tr>
<tr>
<td>Missing notification or handshake tag</td>
<td>Notification and handshake tags are used together. One of the tags is missing.</td>
<td>Enter the missing tag.</td>
</tr>
<tr>
<td>Missing remote acknowledge tag.</td>
<td>Remote acknowledge handshaking tag is defined without a remote acknowledge tag.</td>
<td>Define a remote acknowledge handshake tag in the Alarm Setup dialog.</td>
</tr>
<tr>
<td>Missing remote clear tag.</td>
<td>A remote clear handshake tag was defined, but the remote clear tag was not defined.</td>
<td>Specify a remote clear tag in the Alarm Setup dialog.</td>
</tr>
<tr>
<td>Msg (text) variable at Position (text number)</td>
<td>Indicates an error with an inner text string.</td>
<td>Open the Use Existing Text dialog and locate the message. Correct the error.</td>
</tr>
<tr>
<td>Name is not valid</td>
<td>The specified screen name is invalid. A valid screen name has 1 to 32 characters.</td>
<td>Rename the specified screen.</td>
</tr>
<tr>
<td>Network (name) has no RIO master device found in project.</td>
<td>A remote I/O master device (PLC/SLC) is not defined for the Remote I/O terminal.</td>
<td>From the Setup tab (Terminal Setup dialog), press the Comms. Setup button to define PLC or SLC controller.</td>
</tr>
<tr>
<td>Nonexistent trigger specified.</td>
<td>The trigger specified for this alarm does not exist.</td>
<td>Use a valid trigger name in the alarm definition.</td>
</tr>
<tr>
<td>No objects in application</td>
<td>The application doesn’t have any objects. This is a warning.</td>
<td>Exit the application or create screens with objects.</td>
</tr>
<tr>
<td>No objects on screen</td>
<td>The application contains an empty screen (without objects). This is a warning.</td>
<td>Delete the screen or add objects (and tag information) to screen before downloading.</td>
</tr>
<tr>
<td>No screens in application.</td>
<td>The application doesn’t have any screens. This is a warning.</td>
<td>Exit the application or create screens with objects.</td>
</tr>
<tr>
<td>No start-up screen assigned, default to screen (name)</td>
<td>A startup screen wasn’t assigned for the application so a default screen was selected.</td>
<td>Open the Terminal Setup dialog to select another startup screen (if necessary).</td>
</tr>
<tr>
<td>Node address of (value) is not valid</td>
<td>The node address of the node associated with the tag has not been entered or is invalid.</td>
<td>From the Setup tab (Terminal Setup), press the Comms. Setup button to check the node address.</td>
</tr>
<tr>
<td>Number of lines per alarm (number) is greater than number of lines in object (number).</td>
<td>The number of lines specified for alarms in the alarm list device exceeds the number of lines available within the list device.</td>
<td>Make the alarm list device larger or reduce the number of lines to display per alarm.</td>
</tr>
<tr>
<td>Number is not unique</td>
<td>Two screens have the same number. Screen numbers must be unique.</td>
<td>Renumber one of the screens using the Rename command on the Screen menu.</td>
</tr>
<tr>
<td>Object foreground color is the same as its background color.</td>
<td>Graphic foreground color is the same as text background color, making the graphic a large solid rectangle.</td>
<td>Change colors so that they are not identical.</td>
</tr>
<tr>
<td>Object (right, left, top, bottom edge) – location (Num)</td>
<td>One or more edges of an object is off the screen.</td>
<td>Move or size the object as appropriate.</td>
</tr>
<tr>
<td>Object has invalid function key or view assignment</td>
<td>The object doesn’t have an assigned function key for operator input.</td>
<td>Open the object’s dialog and assign an available function key.</td>
</tr>
<tr>
<td>Object has invalid function key, touch cell, or view assignment</td>
<td>The object isn’t assigned a function key or touch cell for operator input.</td>
<td>Open the object’s dialog and select function key or touch cell for operator input.</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Object not on touch cell boundary</td>
<td>A touch object doesn’t align with touch cells. This can occur if the user assigns touch cell input after the object has been sized.</td>
<td>Resize object or move object until it snaps to grid.</td>
</tr>
<tr>
<td>Object requires function key or touch assignment</td>
<td>The specified object isn’t assigned a function key or touch cell for operator input.</td>
<td>Open the object’s dialog and assign a function key and/or touch cell.</td>
</tr>
<tr>
<td>Object too small to display text.</td>
<td>The height of the object is too small to display the first line of text.</td>
<td>Increase the height of the object.</td>
</tr>
<tr>
<td>Overlapping control objects</td>
<td>Two objects are overlapping on the screen.</td>
<td>Access the screen and reposition or resize the objects so they don’t overlap.</td>
</tr>
<tr>
<td>PLC or Scanner not configured in Terminal Setup – Comms. Setup</td>
<td>The PLC/Scanner with which the terminal will communicate is not configured in Terminal Setup (Communication Setup dialog).</td>
<td>From the Setup tab in Terminal Setup, press the Comms. Setup button to configure the PLC/Scanner type and name.</td>
</tr>
<tr>
<td>PLC or Scanner not found in Project Database</td>
<td>The PLC/Scanner with which the terminal will communicate is not defined in Terminal Setup (Communication Setup dialog).</td>
<td>From the Setup tab in Terminal Setup, press the Comms. Setup button to define the PLC/Scanner type and name.</td>
</tr>
<tr>
<td>Print Only Objects do not support printing of double-byte characters.</td>
<td>Double-byte font selected for print only object.</td>
<td>Select a single byte size font.</td>
</tr>
<tr>
<td>Project database has not been defined for the application</td>
<td>The application is not linked to a tag database.</td>
<td>Open the Project Management dialog (Application menu) and either create a project or link an existing project to the application.</td>
</tr>
<tr>
<td>Read tag not defined</td>
<td>A read tag has not been defined for the object.</td>
<td>Open the object’s dialog and assign a read tag.</td>
</tr>
<tr>
<td>Rack number of the Terminal is not supported by the Logic Controller</td>
<td>The rack number assigned to the Remote I/O PanelView terminal exceeds the rack number supported by the controller or is set at 0 which is not supported by the controller.</td>
<td>From the Setup tab in the Terminal Setup dialog, press the Comms. Setup button and reconfigure the rack number.</td>
</tr>
<tr>
<td>Required Tag fields missing or incomplete.</td>
<td>Tag has no type, node name, or address specified.</td>
<td>Complete tag information in the Tag Editor.</td>
</tr>
<tr>
<td>Remote Ack tag range must be greater than or equal to trigger range.</td>
<td>A bit array size for the Remote Acknowledge tag was specified that is less than the Trigger’s bit array.</td>
<td>Make sure the bit array size for the Remote Ack tag is greater than or equal to the bit array for the trigger.</td>
</tr>
<tr>
<td>Saved device data is missing or corrupted and cannot be used to update the device database.</td>
<td>The device data did not pass the CRC check and will not be used to update the project database.</td>
<td>Use Communication Setup to recreate devices.</td>
</tr>
<tr>
<td>Saved tag data is missing or corrupted and cannot be used to update the tag database.</td>
<td>The tag data does not pass the CRC check and will not be used to update the tag database.</td>
<td>Use the Tag Editor to recreate the tags.</td>
</tr>
<tr>
<td>(Scale factor) value of (value) has too many significant digits.</td>
<td>A scale factor was entered with more than 4 significant digits.</td>
<td>Enter a valid scale factor.</td>
</tr>
<tr>
<td>Search and control tags are required for Piloted Control Lists.</td>
<td>Either a search tag and/or a control tag was not defined for a pilot control list. Both are required.</td>
<td>Open the object’s dialog and enter the missing search tag and/or control tag.</td>
</tr>
<tr>
<td>Slot Number of Address does not match other tags</td>
<td>A tag has a different slot number than other tags in the application. An application can only access tags from one slot of an SLC.</td>
<td>Verify that all tags in the application use the same SLC controller slot number.</td>
</tr>
<tr>
<td>Startup screen must be assigned to an existing screen</td>
<td>Startup screen assigned to a nonexistent screen in the application. The screen may have been deleted.</td>
<td>Select the Power-up tab from Terminal Setup dialog and reassign the startup screen.</td>
</tr>
<tr>
<td>State number (number) out of range</td>
<td>An object has an invalid state number.</td>
<td>Select the object, open the List Management dialog and delete the invalid state(s).</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tag does not have a valid address in the terminals assigned Discrete Rack or Block Transfers.</td>
<td>The tag address is not in the I/O rack or the block transfer(s) configured for the terminal.</td>
<td>Enter the correct tag address in Tag Editor or reconfigure parameters in the Terminal Setup (Communication Setup) dialog.</td>
</tr>
<tr>
<td>Tag (name) Initial Value entry must be integer.</td>
<td>The initial value for the specified tag was entered with a decimal point (1.5). The initial value must be an integer.</td>
<td>Enter an integer for the initial value.</td>
</tr>
<tr>
<td>Tag (name) is not included in the Alarm Trigger’s scan group.</td>
<td>Rem Ack tag or embedded tag in alarm message is not in the alarm trigger’s scan group.</td>
<td>Verify the alarm trigger has a lower address than the remote tag or embedded tags.</td>
</tr>
<tr>
<td>Tag (name) must be of type Bit</td>
<td>A value type tag was selected where a bit tag must be used.</td>
<td>Select an appropriate tag.</td>
</tr>
<tr>
<td>Tag (name) must be of type Value</td>
<td>A bit tag was selected where a value tag must be used.</td>
<td>Select an appropriate tag.</td>
</tr>
<tr>
<td>Tag (name) – No Device in Project Database to match Nodename (name)</td>
<td>The Project database does not have a device matching the node name for the specified tag.</td>
<td>Use Communication Setup to add the device with the specified node name to the project or enter the correct node name for the tag in the Tag Editor.</td>
</tr>
<tr>
<td>Tag not of type Value or Bit</td>
<td>An inappropriate tag was selected.</td>
<td>Select an appropriate tag.</td>
</tr>
<tr>
<td>Tag/Object data type mismatch.</td>
<td>Data type of an object entered in the tag editor must be compatible with the data format of the value entered in the object’s dialog.</td>
<td>Correct the discrepancy by opening the object’s dialog or accessing the object’s tag information.</td>
</tr>
<tr>
<td>Tag references device (name). This is not the Logic Controller selected in Terminal Setup – Comms. Setup</td>
<td>The node name field in the Tag Editor references a controller that is invalid or does not match the controller name in Terminal Setup (Communication Setup dialog).</td>
<td>Change the node name to match the controller name in the Communication Setup dialog or select the correct controller name in the Communication Setup dialog.</td>
</tr>
<tr>
<td>Target terminal can only handle (number) list devices on one screen.</td>
<td>Screen contains more list objects than the terminal can handle.</td>
<td>Remove one or more of the list objects from the screen.</td>
</tr>
<tr>
<td>Terminal (name) has no RIO Block Transfer Channel Information in the Project Database</td>
<td>Block transfers have not been defined for the Remote I/O terminal.</td>
<td>From the Setup tab in the Terminal Setup dialog, press the Comms. Setup button. Then press the Block Transfer button to define block transfer assignments for the terminal.</td>
</tr>
<tr>
<td>Terminal (name) has no RIO Rack Module Group Information in the Project Database.</td>
<td>The terminal is not assigned to a rack or module groups in the rack.</td>
<td>From the Setup tab (Terminal Setup dialog), press the Comms. Setup button to define the rack and module group for the terminal.</td>
</tr>
<tr>
<td>Terminal (name) is not configured in Terminal Setup – Comms. Setup</td>
<td>Communication parameters have not been defined for the terminal name defined on the Setup tab in the Terminal Setup dialog.</td>
<td>From the Setup tab (Terminal Setup dialog), press the Comms. Setup button to define communication parameters for the terminal.</td>
</tr>
<tr>
<td>Terminal (name) is not configured in Terminal Setup – Comms. Setup – Type Unknown</td>
<td>The terminal is not configured properly.</td>
<td>Open the Project Management dialog and delete the terminal device from the project. Then open the Terminal Setup dialog and reconfigure the terminal.</td>
</tr>
<tr>
<td>Terminal (name) is not configured in Terminal Setup–Comms. Setup–No Runtime Comm. Port</td>
<td>The terminal is not configured properly.</td>
<td>Open the Project Management dialog and delete the terminal device from the project. Then open the Terminal Setup dialog and reconfigure the terminal.</td>
</tr>
<tr>
<td>Terminal (name) is not configured in Terminal Setup – Comms. Setup – Runtime Comm. Port Not in Project database.</td>
<td>The terminal is not configured properly.</td>
<td>Open the Project Management dialog and delete the terminal device from the project. Then open the Terminal Setup dialog and reconfigure the terminal.</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminal (name) is not configured in Terminal Setup – Comms. Setup – Runtime Comm. Port is wrong type.</td>
<td>The terminal is not configured properly.</td>
<td>Open the Project Management dialog and delete the terminal device from the project. Then open the Terminal Setup dialog and reconfigure the terminal.</td>
</tr>
<tr>
<td>Terminal (name) max node number (value) not valid</td>
<td>The maximum node number is invalid. The maximum node number must be in the range of the terminal node number to 31.</td>
<td>From the Setup tab in the Terminal Setup dialog, press the Comms. Setup button to change the maximum node number.</td>
</tr>
<tr>
<td>Terminal name not assigned</td>
<td>The terminal isn’t assigned a terminal name.</td>
<td>From the Setup tab in the Terminal Setup dialog, enter a name for the terminal.</td>
</tr>
<tr>
<td>Terminal (name) node number is not valid</td>
<td>The node number of the terminal must be in the range of 1 to 31.</td>
<td>From the Setup tab in the Terminal Setup dialog, press Comms. Setup button to change the node number of the terminal.</td>
</tr>
<tr>
<td>Terminal selected in Terminal Setup does not match Application type.</td>
<td>The wrong catalog number was selected for the terminal name in Terminal Setup.</td>
<td>From the Terminal Setup dialog, select the correct terminal type to match the application (DH-485 or Remote I/O).</td>
</tr>
<tr>
<td>Terminal Status and Control cannot use the same tag for the same purpose.</td>
<td>The same tag is being used for a control tag and a status tag in the Terminal Setup dialog. Control and status tags must be different.</td>
<td>From the Control or Status tab in Terminal Setup correct the tag duplication.</td>
</tr>
<tr>
<td>Text foreground color is the same as its background color.</td>
<td>Text foreground and background colors are the same making the text invisible.</td>
<td>Change foreground and background colors so they are not identical.</td>
</tr>
<tr>
<td>Text string contains character(s) from external font file, selected font size is invalid.</td>
<td>Double byte external font is in use and text contains double byte characters while an internal font size is selected.</td>
<td>Specify an external font size.</td>
</tr>
<tr>
<td>The address string data type does not match the tag data type</td>
<td>The tag address doesn’t match the data type of the tag. For example, the tag address is B3:0/2 but the tag data type is signed integer.</td>
<td>From the tag editor, correct the mismatch between the tag address and the data type of the tag.</td>
</tr>
<tr>
<td>The initial state in this device refuses operator entry.</td>
<td>The initial (power-up) state for the piloted control list does not allow operator access.</td>
<td>Open the object’s dialog and set the initial state Access to “User and LC” or “User Only”.</td>
</tr>
<tr>
<td>The remote tags must be different from each other.</td>
<td>Each remote tag must be unique for an alarm setup.</td>
<td>Make the remote tags unique within the application.</td>
</tr>
<tr>
<td>Time Format does not support double-byte characters.</td>
<td>Double-byte font selected for Time Format.</td>
<td>Select a single byte size font.</td>
</tr>
<tr>
<td>Trigger and Remote Ack Tag have different tag types.</td>
<td>The data type for these tags are not identical.</td>
<td>Change the tag data types so they are the same.</td>
</tr>
<tr>
<td>Trigger cannot be same as the acknowledge or handshake tags.</td>
<td>The trigger tag is the same as the acknowledge or handshake tag for this trigger.</td>
<td>Specify a unique tag for trigger, acknowledge and handshake tags.</td>
</tr>
<tr>
<td>Trigger Name not Unique</td>
<td>Two triggers are using the same trigger tag name.</td>
<td>Change trigger tag names so they are not the same.</td>
</tr>
<tr>
<td>Trigger Tag duplication</td>
<td>Two triggers are using the same trigger tag name.</td>
<td>Change trigger tag names so they are not the same.</td>
</tr>
<tr>
<td>Trigger Tag same as LC Clear All Tag.</td>
<td>The Trigger Tag is the same as the Clear All tag specified on the Alarm Setup screen.</td>
<td>Change tags so they are not identical.</td>
</tr>
<tr>
<td>Trigger’s Ack Tag same as LC Ack All Tag</td>
<td>The Trigger Alarm Ack Tag is the same as the Ack All tag specified on the Alarm Setup screen.</td>
<td>Change tags so they are not identical.</td>
</tr>
<tr>
<td>Trigger’s Remote Ack Tag same as LC Ack All Tag.</td>
<td>The alarm trigger’s remote acknowledgment tag is the same as the controller Ack All tag.</td>
<td>Change tags so they are not identical.</td>
</tr>
<tr>
<td>Unable to initialize Protocol Translation Server. Invalid address for Block Transfer Channel Num (number)</td>
<td>The address of the block transfer is invalid. You may have entered a PLC address where an SLC address was expected or an SLC address where a PLC address was expected.</td>
<td>In the Block Transfer dialog, enter the correct address for the specified block transfer number.</td>
</tr>
<tr>
<td>Validation Message</td>
<td>Meaning</td>
<td>What to do</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unable to load (file) or one of its components</td>
<td>PanelBuilder cannot open specified file.</td>
<td>Verify that path contains AB\BIN. Reboot computer and try again.</td>
</tr>
<tr>
<td>Unknown graphic image</td>
<td>An object or object state is assigned an inner graphic that no longer exists.</td>
<td>Select another inner graphic for the object or import a bit map graphic with the same name.</td>
</tr>
<tr>
<td>Unused Block Transfer Channel will be removed.</td>
<td>A block transfer defined in the Block Transfer dialog is not used by the application.</td>
<td>Remove it from the application or reference it.</td>
</tr>
<tr>
<td>Unused Trigger</td>
<td>This alarm trigger is not being used by any alarms and will not be downloaded to the terminal.</td>
<td>Remove the trigger or use it in an alarm.</td>
</tr>
<tr>
<td>Used as indicator will display data written by a control device using the same tag</td>
<td>Warning that PanelView is using data from write tag of control object to display data for indicator.</td>
<td>Nothing. Using the same write tag data for the indicator eliminates ladder logic required to move data from the write tag to read tag.</td>
</tr>
<tr>
<td>(Scale, Offset, Max, Min, or Initial) value of (tag name) not valid or not in range</td>
<td>A tag attribute isn’t configured properly.</td>
<td>Open the Tag Editor from the Application menu and change tag attributes as necessary.</td>
</tr>
<tr>
<td>Minimum array length of (tag) required for object state data</td>
<td>The bit array length of the tag is smaller than required.</td>
<td>Change values for the object's states or increase the bit array size in the Tag Editor.</td>
</tr>
<tr>
<td>Width (value) is out of range</td>
<td>The width of the object is invalid.</td>
<td>Resize the object.</td>
</tr>
<tr>
<td>Write tag not defined</td>
<td>A write tag has not been defined for object.</td>
<td>Open object’s dialog and assign a write tag.</td>
</tr>
<tr>
<td>Write and search tags must be different in Piloted Control Lists.</td>
<td>A Piloted Control List will not function if the search tag and write tag are the same.</td>
<td>Open the object’s dialog and change either the write tag or search tag.</td>
</tr>
</tbody>
</table>
Troubleshooting

This appendix contains tips to assist with troubleshooting if problems occur when:

- Starting PanelBuilder
- Downloading to a DOS File
- Downloading using INTERCHANGE Drivers

Many computers contain power management options and utilities that affect computer COM ports:

- POWER.EXE in AUTOEXEC.BAT or CONFIG.SYS
- option in CMOS setup
- Windows utility
- Power icon in Control Panel of Windows 95 (set to None)

For troubleshooting information on your PanelView terminal, see the Operator Terminals manual.

Running Windows 95

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When rebooting your computer after installing PanelBuilder/INTERCHANGE software, you get a Windows protection error and your computer locks up.</td>
<td>The C:\WINDOWS\SYSTEM directory contains the files VDF1.386 and V485.386.</td>
<td>Reboot the computer in Safe Mode and delete the VDF1.386 and V485.386 files. To enter Safe Mode, press the F5 key when the boot message &quot;Starting Windows 95&quot; appears.</td>
</tr>
</tbody>
</table>
### Starting PanelBuilder

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to load CMSERV.DLL or one of its components.</td>
<td>PanelBuilder cannot load CMSERV.DLL or one of its components because SHARE.EXE is not running.</td>
<td>Add SHARE.EXE to your AUTOEXEC.BAT file or execute SHARE manually. See the README.TXT file in C:\AB for more details.</td>
</tr>
<tr>
<td>PanelBuilder finds the wrong PXENGWIN.DLL file when searching the DOS PATH variable before finding the correct file in C:\AB\BIN.</td>
<td></td>
<td>Enter C:\AB\BIN as the first item in the PATH statement.</td>
</tr>
</tbody>
</table>
| Related files left in the C:\AB\PROJECTS directory. | Do the following:  
1. Exit the PanelBuilder software.  
2. Delete these files from the C:\AB\PROJECTS directory. 
   PARADOX.LCK 
   PDOXUSRS.LCK 
   These files are created when PanelBuilder is started and should be deleted when the software is exited. | |
| The [Paradox Engine] section in the file C:\WINDOWS\WIN.INI is incorrect. | Check that C:\WINDOWS\WIN.INI contains these lines: 
[Paradox Engine] 
UserName=ISPCore 
NetNamePath=C:\AB\PROJECTS 
NetName=2 
ShareLocal=YES 
PX35Locking=NO 
MaxTables=64 
RecBufs=128 
MaxLocks=32 
MaxFiles=64 
SwapSize=256 | |
| AB Utilities failed to initialize | PanelBuilder could not initialize the AB Utilities during startup because SHARE.EXE is not running. | Add SHARE.EXE to your AUTOEXEC.BAT file or execute SHARE manually. See the README.TXT file in C:\AB for more details. |

### General Download Errors

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application file length does not match the header record.</td>
<td>When verifying the CRC of the .PVA file, the file length did not match the length stored in the file. This typically occurs when you download a file that was truncated by an aborted upload.</td>
<td>Specify a valid .PVA file.</td>
</tr>
<tr>
<td>Application file CRC is incorrect.</td>
<td>The CRC of the .PVA file does not match the CRC stored in the file.</td>
<td>Specify a valid .PVA file.</td>
</tr>
<tr>
<td>In Windows NT/4.0, the following error occurs during a download: “Abnormal termination”.</td>
<td>The operating system needs to be upgraded to Service Pack 2 (or later).</td>
<td>Install Service Pack 2 (or later) on your computer.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Downloading to a DOS File

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When downloading an application to a DOS file in PanelBuilder, you get this message: “Unable to load WPFTDLL.DLL or one of its components.”</td>
<td>INTERCHANGE is not installed on computer. INTERCHANGE must be installed, however, you are not required to load INTERCHANGE communication drivers.</td>
<td>Exit Windows and reinstall PanelBuilder to install INTERCHANGE on your computer.</td>
</tr>
<tr>
<td>File(s) are missing or not found.</td>
<td>1. Verify that the path statement in AUTOEXEC.BAT includes C:\RSI\IC\BIN or C:\ABIC\BIN. 2. Verify that the environment variable in AUTOEXEC.BAT is set to ABIC_CONFIG=C:\RSI\IC\BIN or C:\ABIC\BIN 3. Verify that WPFTDLL.DLL is in C:\AB\PBWIN. 4. Verify that DTLKTW.DLL is in C:\RSI\IC\BIN or C:\ABIC\BIN.</td>
<td></td>
</tr>
</tbody>
</table>

### Downloading with the PanelView File Transfer Utility

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot download or upload an application using the PFT utility.</td>
<td>INTERCHANGE is running and using the same COM port that was specified in the PFT configuration setup file (DEFAULT.STP).</td>
<td>1. Type ABICSTOP at the DOS prompt. For example: C:&gt;ABICSTOP 2. Comment the following lines in the C:\WINDOWS\SYSTEM.INI file: [386Enh] ;Device=VDF1.386 ;COM1IRQ=4 or ;COM2IRQ=3 ;COM1VDF1 or ;COM2VDF1 or [386Enh] ;Device=V485.386 ;COM1IRQ=4 or ;COM2IRQ=3 ;COM1VDF1 or ;COM2VDF1</td>
</tr>
</tbody>
</table>

### Downloading Using the WINPFT Utility

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to perform verify operation, Incorrect Terminal Series/Revision</td>
<td>The File Transfer Utility (WINPFT) cannot verify the application loaded in a DH-485 or RS-232 terminal because the firmware version is earlier than V1.06.</td>
<td>Upgrade the terminal’s firmware.</td>
</tr>
<tr>
<td>Unable to perform verify operation, Download operation continuing...</td>
<td>PanelBuilder could not verify the application loaded in a DH-485 or RS-232 terminal before the download (Download only if different from current application box is checked). The terminal’s firmware is earlier than V1.06. The download is successful.</td>
<td>Upgrade the terminal’s firmware.</td>
</tr>
<tr>
<td>When downloading to an Operator Terminal, this message appears: “Error! Transfer Timeout! Communication with terminal lost”</td>
<td>Interference from other programs in a multitasking operating system.</td>
<td>Stop other programs running on the computer, especially if running Windows 95.</td>
</tr>
</tbody>
</table>
### Downloading with INTERCHANGE

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When choosing the Download command from the Application menu, you get this message: “Unable to load WPFTDLL.DLL or one of its components.”</td>
<td>INTERCHANGE is not installed on computer. INTERCHANGE must be installed, however, you are not required to load INTERCHANGE communication drivers.</td>
<td>Exit Windows and reinstall PanelBuilder to install INTERCHANGE on your computer.</td>
</tr>
</tbody>
</table>
| File(s) are missing or not found. | 1. Verify that the path statement in AUTOEXEC.BAT includes C:\RSI\IC\BIN or C:\ABIC\BIN.  
2. Verify that the environment variable in AUTOEXEC.BAT is set to ABIC_CONFIG=C:\RSI\IC\BIN or C:\ABIC\BIN  
3. Verify that WPFTDLL.DLL is in C:\AB\PBWIN.  
4. Verify that DTLKTW.DLL is in C:\RSI\IC\BIN or C:\ABIC\BIN. | |
| When choosing the Download command from the Application menu, Operator Terminal does not appear as a Destination option in the Application Download dialog. | The C:\WINDOWS\SYSTEM.INI file contains a driver conflict. | Check the C:\WINDOWS\SYSTEM.INI file. Here is a correct example of the file. 

```
[Boot]
comm.drv=comm.drv ;not COM.DRV or DH485.DRV or ICOMCOMM.DRV
mouse.drv=mouse.drv

[386Enh]
DEVICE=V485.386 or DEVICE=VDF1.386
COM1V485 or COM2V485 or COM1VDF1 or COM2VDF1
;DEVICE=C:\ICOM\WINLINX\VDDELINX.386 ;commented out
DEVICE=*VCD ;should not be commented out
```
| ABICRUN.BAT was not run before starting WINDOWS. | | Verify that the AUTOEXEC.BAT file contains: 
CALL ABICRUN.BAT and not REM CALL ABICRUN.BAT 
Exit Windows and run ABICRUN.BAT. |
| When downloading to an Operator Terminal you get this error: “Destination device node is not active” | In the INTERCHANGE Device Config. utility, the station address of the PIC on COM driver is set to the same address as the PanelView terminal. | Using the INTERCHANGE Device Configuration Utility, set the Station Address to 0 for the PIC on COM Port driver. |
| In the INTERCHANGE Device Config. utility, the incorrect Interrupt (IRQ) is set for the COM Port. | Set the correct Interrupt for the COM port. 
COM Port 1 requires an Interrupt (IRQ) of 4. 
COM Port 2 requires an Interrupt (IRQ) of 3. | |
<p>| The Catalog No. 1747-PIC module is not receiving power. | The 1747-PIC module requires 24V DC supplied by the SLC processor or Catalog No. 1747-NP1 power supply. The PanelView does not supply power to the PIC module. | |
| Incorrect cabling. | Check the cable. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When downloading to an Operator Terminal you get this error: “Transfer Aborted – unable to send commands to terminal”</td>
<td>In the INTERCHANGE Device. Config. Utility, the incorrect Interrupt (IRQ) is set for the COM Port.</td>
<td>Set the correct Interrupt for the COM port. COM Port 1 typically uses Interrupt (IRQ) of 4. COM Port 2 typically uses Interrupt (IRQ) of 3.</td>
</tr>
<tr>
<td></td>
<td>In the INTERCHANGE Device. Config. Utility, the baud rate or another driver parameter is set incorrectly.</td>
<td>Set the correct baud rate or other driver parameter. To check the PanelView terminal’s communication parameters, select Communication Setup from the terminal’s Configuration Mode menu.</td>
</tr>
<tr>
<td></td>
<td>Incorrect cabling.</td>
<td>Check the cable.</td>
</tr>
<tr>
<td>When downloading to an Operator Terminal you get this error: “Command Failed – PCCCSTS02, Remote station did not acknowledge command.”</td>
<td>In the INTERCHANGE Device. Config. Utility, parameters for the DF1 on COM Port driver are incorrectly set.</td>
<td>Parameters for the DF1 on COM Port drivers must be set to: Error Detect=CRC Parity=None Baud Rate=19200</td>
</tr>
<tr>
<td>INTERCHANGE Command Failure PCCCEXT17—Timed out; 1771 backplane module not responding</td>
<td>During a Remote I/O transfer, PanelBuilder was unable to get a response to a command. Probable causes are: disconnected node device, high network activity; low baud rate.</td>
<td>Verify that the PanelView terminal has a valid Remote I/O network connection and that its application matches the controller’s block transfer ladder logic. Retry the operation.</td>
</tr>
<tr>
<td>RNA: Error $C00A placing device #n online</td>
<td>INTERCHANGE could not start the driver associated with port #n of your computer.</td>
<td>Use the INTERCHANGE Device Configuration Utility to check the driver configuration. The driver may be set for a different baud rate than the physical network.</td>
</tr>
<tr>
<td>The currently installed INTERCHANGE driver cannot download to the selected terminal.</td>
<td>The type of network transfer you are attempting requires a different driver than the one currently loaded on your computer.</td>
<td>Configure the appropriate driver using the INTERCHANGE Device Configuration Utility and then reboot computer.</td>
</tr>
<tr>
<td>When downloading an application on a network using a KA5 bridge (DH+&lt;&gt;DH485), the download does not exit properly.</td>
<td>The download completes but does not exit properly.</td>
<td>When the download is complete, select the CANCEL button on the Download dialog.</td>
</tr>
<tr>
<td>Gateway device node is not active.</td>
<td>A Gateway device was not found at the specified node address on the local network.</td>
<td>Verify that a Gateway device is at the specified address or change the node address in the File Transfer Setup dialog to match the terminal’s network address.</td>
</tr>
<tr>
<td>Local Gateway device does not support bridging operations or remote network device is not an operator terminal.</td>
<td>The local gateway device cannot pass commands to another physical network or the device on the remote network is not an Operator Terminal.</td>
<td>In the File Transfer Setup dialog (page , verify that you have entered the correct Gateway Node Address, Terminal Node Address, and Link ID numbers.</td>
</tr>
<tr>
<td>Local network device is not an operator terminal.</td>
<td>The specified device on the local network is not an operator terminal.</td>
<td>Check the node address of the PanelView terminal in the File Transfer Setup dialog.</td>
</tr>
</tbody>
</table>

### Downloading with RSLinx

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Windows 95, this error occurs during a download: “Unable to start AB-KT=1 because duplicate nodes were found on the network”.</td>
<td>The computer running the RSLinx driver is assigned the same node address as another computer running RSLinx on the network.</td>
<td>Run RSLinx and change the node address for one of the computers.</td>
</tr>
</tbody>
</table>
This section lists and defines errors and messages that may occur when the INTERCHANGE Software is started or stopped. These errors are printed to the standard output when CFG_KT.EXE, CFG_485.EXE, CFG_DF1.EXE, or RNA.EXE are executed.

**Errors and Informational Messages from CFG_KT.EXE, CFG-485.EXE and CFG_DF1.EXE**

The following errors and messages are generated by CFG_KT.EXE, CFG_485.EXE and CFG_DF1.EXE. “XXX” represents the strings “KT”, “485”, and “DF1”. If an error/information message is only applicable to one of CFG_KT.EXE, CFG_485.EXE or CFG_DF1.EXE, the applicable program will appear as the first string of the error/information message.

These messages occur normally at startup. They indicate the location where the INTERCHANGE Software was installed.

CFG_XXX (0000) TSR configured, no errors detected
CFG_XXX (001A) Reading device configuration from C:\RSI\IC\BIN\CFG_KT.INI
CFG_XXX (001B) Reading diagnostic and protocol files from C:\RSI\IC\BIN

This message occurs normally at shutdown.

CFG_XXX (0001) TSR terminated, no longer resident in memory.

This message indicates an invalid version of DOS is loaded. Consult the INTERCHANGE User Manual for valid and compatible versions of DOS.

CFG_XXX (0002) TSR not ready, invalid version of DOS

Binary files downloaded to your communication card are incompatible with the INTERCHANGE Software installed on your system. Re-install the INTERCHANGE Software.

CFG_XXX (0003) TSR not configured, invalid version of KT protocol file

The indicated file could not be found. Check to ensure that the path and/or file exist.

CFG_XXX (0004) TSR not configured, error opening file <filename>

The indicated file was found but could not be read. Check the permissions on the file.

CFG_XXX (0005) TSR not configured, error reading file <filename>
The indicated command or parameter in CFG_KT.INI is invalid. Correct your CFG_KT.INI file and restart the INTERCHANGE Software.

CFG_XXX (0007) TSR not configured, invalid line; <command>
CFG_XXX (0008) TSR not configured, invalid parameter; <parameter>
CFG_XXX (0009) TSR not configured, invalid 'memory' parameter <parameter>
CFG_XXX (000a) TSR not configured, invalid 'interrupt' parameter <parameter>

Not enough memory was available to configure the DTL_KT TSR. Obtain more free memory on your computer and restart the INTERCHANGE Software.

CFG_KT (000b) TSR not configured, unable to allocate memory

An error occurred when configuring the DTL_XXX TSR. The DTL_XXX TSR may already be running. Shut down and restart the INTERCHANGE Software to correct the problem.

CFG_XXX (000c) TSR not configured, 'TSR' parameter already in use
CFG_XXX (000d) TSR not configured, no KT(s) could be initialized

Commonly caused by one of the following:

1. no communication cards are specified in CFG_KT.INI.
2. the software or hardware setting of the memory address for your communication card does not match that entered in the CFG_KT.INI file.
3. the environment variable ABIC_CONFIG, points to a location which has an invalid or nonexistent CFG_KT.INI file.

The executable CFG_XXX.EXE has previously been run to configure the DTL_XXX TSR. It is not necessary to run CFG_XXX.EXE again, however, it has caused no harm to do so.

CFG_XXX (000e) TSR already configured, no action taken

Your installation may have been unsuccessful. Re-install the INTERCHANGE Software and restart the INTERCHANGE Software. If this error still occurs, contact your Rockwell Software Inc. Global Technical Support Representative.

CFG_XXX (000f) TSR version is incompatible with this executable

Caused by one of the following:
1. DTL_XXX TSR could not be de-installed. Issue the uninstall command again (CFG_XXX -u).

2. An attempt was made to uninstall the DTL_XXX driver (CFG_XXX -u) when it was not installed.

The DTL_XXX TSR could not be de-installed. Issue the uninstall command again (CFG_XXX -u).

CFG_XXX (0011) TSR still running, unable to deinstall

The 1784-KT2 communication card must have its memory and interrupt software configured before INTERCHANGE Software is run. Make sure you have configured your 1784-KT2 for a memory address and that this memory address matches that entered in the CFG_KT.INI file.

CFG_XXX (0012) KT not found at specified 'memory' (KT2 only)

These errors occur during communication card diagnostics. The execution of these diagnostics is controlled by the statement SELFTEST=OFF in CFG_KT.INI. If this line is commented out, the diagnostics are run by default. If this line is uncommented and says SELFTEST=ON, the diagnostics are run. To stop the diagnostics from running, ensure that this line is not commented out and says SELFTEST=OFF. The most common cause for these errors is that the software or hardware setting of the memory address for your communication card does not match that entered into CFG_KT.INI for the type of card you are using.

CFG_KT (0013) KT memory diagnostic RAM 0 error
CFG_KT (0014) KT memory diagnostic RAM 1 error
CFG_KT (0015) KT counter diagnostic error
CFG_KT (0016) KT timer diagnostic error
CFG_KT (0017) KT serial diagnostic error
CFG_KT (0018) KT protocol downloading error
CFG_KT (0019) KT dualport memory error

If these errors occur, contact your Rockwell Software Inc. Global Technical Support Representative.

CFG_KT (001d) Undefined error
CFG_KT (001e) Undefined error
CFG_KT (001f) Undefined error
Errors and Informational Messages Specific to CFG_485.EXE

This error indicates the Virtual Driver for DH485 isn’t running.

CFG_485 (0020) DH485 Fatal Error; V485 Driver not installed.

These errors indicate problems setting up the COM port.

CFG_485 (0021) DH485 Serial Communication Port not found.
CFG_485 (0022) DH485 Link Layer attach error.
CFG_485 (0023) DH485 Link Layer initialization error.
CFG_485 (0024) DH485 Link Layer configuration error.

This error indicates a conflict over which COM port is to be used.

CFG_485 (0025) DH485 CFG_KT.INI and SYSTEM.INI comm port inconsistency.

This error indicates that the driver did not exit cleanly.

CFG_485 (0026) DH485 Fatal Error during Link Layer Cleanup.

Errors and Informational Messages Specific to CFG_DF1.EXE

This error indicates the Virtual Driver for DF1 isn’t running.

CFG_DF1 (0020) DF1 Fatal Error; VDF1 Driver not installed.

These errors indicate problems setting up the COM port.

CFG_DF1 (0021) DF1 Serial Communication Port not found.
CFG_DF1 (0022) DF1 Link Layer attach error.
CFG_DF1 (0023) DF1 Link Layer initialization error.
CFG_DF1 (0024) DF1 Link Layer configuration error.

This error indicates a conflict over which COM port is to be used.

CFG_DF1 (0025) DF1 CFG_KT.INI and SYSTEM.INI comm port inconsistency.

This error indicates that the driver did not exit cleanly.

CFG_DF1 (0026) DF1 Fatal Error during Link Layer Cleanup.
Errors and Informational Messages from RNA.EXE

This message occurs normally at shutdown.

RNA removed from memory.

This parameter for the -b argument (indicating number of solicited message buffers to use) given on the command line for RNA.EXE was out of allowed message range of 1 to 40. A default of 20 solicited buffers will be used.

RNA: -b must be 1-40, using default of 20

The format of the options given on the command line for RNA.EXE were invalid. Correct the option(s) and start RNA.EXE again.

RNA: illegal option — <option>
RNA: invalid option
RNA: invalid option (option); must begin with ‘–’
RNA: option requires an argument — <option>

The number of packet buffers, <num> requested on the command line cannot be created. If your buffers were loaded into upper DOS memory (the default), your upper DOS memory may be full. Specify -e0 on the RNA.EXE command line to force the buffers to use low DOS memory.

RNA: ERROR – cannot create <num> packet buffers

The number of unsolicited buffers, <num>, requested on the command line cannot be created. If your buffers were loaded into upper DOS memory (by no additional command line options), it may be full. Specify -e0 on the RNA.EXE command line to force the buffers to use low DOS memory.

RNA: ERROR – cannot create <num> unsolicited data items.

The RNATSR was loaded from DOS. It cannot be uninstalled with Windows running. Exit to DOS to uninstall the RNATSR.

RNA: RNATSR loaded before Windows, cannot uninstall from Windows

Other TSRs have been installed after the RNATSR. They must be removed from memory before the RNATSR can be uninstalled.

RNA: Cannot uninstall RNATSR; not at end of INT 2F chain

The RNATSR must be installed before running RNA.EXE.

RNA: RNATSR is not installed.
Troubleshooting

You must run and install the card driver (DTL_KT.EXE and CFG_KT.EXE) before running the RNATSR and RNA.

RNA: ERROR — no card drivers installed

RNA.EXE has already been run.

RNA: ERROR — RNATSR <version> is already running

Your installation may have been unsuccessful. Re-install and restart the INTERCHANGE Software. If this error still occurs, contact your Rockwell Software Inc. Global Technical Support Representative.

RNA: ERROR — wrong version of KT driver

If either of these errors occur, call your Rockwell Software Inc. Global Technical Support Representative.

RNA: Internal error. KTTSR_ATTACH returns <num1> instead of <num2>

RNA: Internal error — no driver has port <num>

These errors can occur if there was difficulty creating the packet buffers or unsolicited table at startup. If that is the case, an error was displayed at startup as well.

RNA: Error %X freeing the packet buffers

RNA: Error %X freeing the unsolicited table

RNA: WARNING — no ports available on driver #x
# Internal Read Only Tags

This appendix lists internal tags of PanelBuilder. These tags can be used for objects that read tag addresses such as an indicator.

## General Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Read_AppByteFree</td>
<td>Unsigned Int</td>
<td>0 to 114623 (PV550)</td>
<td>Bytes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 to 245695 (PV600)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 to 245695 (PV900M) Series D or earlier</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 to 1032128 (PV900M) Series E or later</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 to 1032128 (PV900C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 to 1032128 (PV1000G/PV1000C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 to 1032128 (PV1400)</td>
<td></td>
</tr>
<tr>
<td>@Read_AppByteUsed</td>
<td>Unsigned Int</td>
<td>0 to 1032128</td>
<td>Bytes</td>
</tr>
<tr>
<td>@Read_Backlight</td>
<td>Unsigned Int</td>
<td>0 or 1</td>
<td>0 = Off , 1 = On</td>
</tr>
<tr>
<td>@Read_ClockDate</td>
<td>Unsigned Int</td>
<td>1 to 31</td>
<td></td>
</tr>
<tr>
<td>@Read_ClockHours</td>
<td>Unsigned Int</td>
<td>0 to 23</td>
<td></td>
</tr>
<tr>
<td>@Read_ClockMinutes</td>
<td>Unsigned Int</td>
<td>0 to 59</td>
<td></td>
</tr>
<tr>
<td>@Read_ClockMonth</td>
<td>Unsigned Int</td>
<td>1 to 12</td>
<td></td>
</tr>
<tr>
<td>@Read_ClockSeconds</td>
<td>Unsigned Int</td>
<td>0 to 59</td>
<td></td>
</tr>
<tr>
<td>@Read_ClockYear</td>
<td>Unsigned Int</td>
<td>0 to 99</td>
<td>0 to 89 (2000 to 2089)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>90 to 99 (1990 to 1999)</td>
</tr>
<tr>
<td>@Read_CommStatus</td>
<td>Unsigned Int</td>
<td>1 or 2</td>
<td>1 = Comm is connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Comm is disconnected</td>
</tr>
<tr>
<td>@Read_CurrentLang</td>
<td>Unsigned Int</td>
<td>0 to 4</td>
<td>0 = French, 1 = German, 2 = Italian</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = Spanish, 4 = English (Default)</td>
</tr>
<tr>
<td>@Read_FaultStatus</td>
<td>Unsigned Int</td>
<td>0, 1 or 2</td>
<td>0 = Normal, 1 = Unable to run</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Functions but unable to run application</td>
</tr>
<tr>
<td>@Read_KeyRepeatDelay</td>
<td>Unsigned Int</td>
<td>0 to 7</td>
<td>0 = No repeat (default), 1 = Every second</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Every 1/2 second, 3 = Every 1/3 second</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 = Every 1/4 second, 5 = Every 1/5 second</td>
</tr>
<tr>
<td>@Read_KeyRepeatRate</td>
<td>Unsigned Int</td>
<td>0 to 5</td>
<td></td>
</tr>
<tr>
<td>@Read_MemCardStatus</td>
<td>Unsigned Int</td>
<td>0 to 3</td>
<td>0 = Valid memory card format</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Incorrect memory card format</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = No memory card installed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = No applications on memory card</td>
</tr>
</tbody>
</table>

## PV550 Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Read_LCDContrast</td>
<td>Unsigned Int</td>
<td>0 to 15</td>
<td></td>
</tr>
<tr>
<td>@Read_LCDRevVideo</td>
<td>Unsigned Int</td>
<td>0 or 1</td>
<td>0 = White displays on black background</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Black displays on white background</td>
</tr>
</tbody>
</table>
### PV900M/1000G Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read_DisplayOnTime</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Minutes the terminal display has been running</td>
</tr>
<tr>
<td>Read_LCDIntensity</td>
<td>Unsigned Integer</td>
<td>1 to 100</td>
<td></td>
</tr>
<tr>
<td>Read_LCDRevVideo</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td></td>
</tr>
<tr>
<td>Read_ScrnCond_Hour</td>
<td>Unsigned Integer</td>
<td>0 to 23</td>
<td>Combined with <code>Read_ScrnCond_Min</code> to determine the time of day to start conditioner.</td>
</tr>
<tr>
<td>Read_ScrnCond_Min</td>
<td>Unsigned Integer</td>
<td>0 to 59</td>
<td>Combined with <code>Read_ScrnCond_Hour</code> to determine the time of day to start conditioner.</td>
</tr>
<tr>
<td>Read_ScrnCond_Mode</td>
<td>Unsigned Integer</td>
<td>0 to 1</td>
<td></td>
</tr>
<tr>
<td>Read_ScrnSave_Intensity</td>
<td>Unsigned Integer</td>
<td>0 to 100</td>
<td></td>
</tr>
<tr>
<td>Read_ScrnSave_Mode</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0=Off, 1=On, 2=Timed</td>
</tr>
<tr>
<td>Read_ScrnSave_Time</td>
<td>Unsigned Integer</td>
<td>1 to 1800</td>
<td>Screen save timeout in seconds.</td>
</tr>
<tr>
<td>Read_TermOnTime</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Minutes the terminal CPU has been running.</td>
</tr>
</tbody>
</table>

### PV600C/900C/1000C Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read_DisplayOnTime</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Minutes the terminal display has been running</td>
</tr>
<tr>
<td>Read_LCDIntensity</td>
<td>Unsigned Integer</td>
<td>10 to 100</td>
<td>Percent of display intensity (900C range is 50–100%)</td>
</tr>
<tr>
<td>Read_ScrnCond_Hour</td>
<td>Unsigned Integer</td>
<td>0 to 23</td>
<td>Not used</td>
</tr>
<tr>
<td>Read_ScrnCond_Min</td>
<td>Unsigned Integer</td>
<td>0 to 59</td>
<td>Not used</td>
</tr>
<tr>
<td>Read_ScrnCond_Mode</td>
<td>Unsigned Integer</td>
<td>0 to 1</td>
<td>Not used</td>
</tr>
<tr>
<td>Read_ScrnSave_Intensity</td>
<td>Unsigned Integer</td>
<td>0 to 100</td>
<td>Percent of display intensity</td>
</tr>
<tr>
<td>Read_ScrnSave_Mode</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0=Off, 1=On, 2=Timed</td>
</tr>
<tr>
<td>Read_ScrnSave_Time</td>
<td>Unsigned Integer</td>
<td>1 to 1800</td>
<td>Screen save timeout in seconds.</td>
</tr>
<tr>
<td>Read_TermOnTime</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Minutes the terminal CPU has been running.</td>
</tr>
</tbody>
</table>

### PV1400 Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read_DisplayOnTime</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Minutes the terminal display has been running</td>
</tr>
<tr>
<td>Read_LCDIntensity</td>
<td>Unsigned Integer</td>
<td>25 to 100</td>
<td>Percent of display intensity</td>
</tr>
<tr>
<td>Read_Degauss_Hour</td>
<td>Unsigned Integer</td>
<td>0 to 23</td>
<td>Combined with <code>Read_Degauss_Min</code> to determine time of day to start conditioner.</td>
</tr>
<tr>
<td>Read_Degauss_Min</td>
<td>Unsigned Integer</td>
<td>0 to 59</td>
<td>Combined with <code>Read_Degauss_Hour</code> to determine the time of day to start conditioner.</td>
</tr>
<tr>
<td>Read_Degauss_Mode</td>
<td>Unsigned Integer</td>
<td>0 to 1</td>
<td>0=Disabled, 1=Enabled</td>
</tr>
<tr>
<td>Read_ScrnSave_Intensity</td>
<td>Unsigned Integer</td>
<td>0 to 100</td>
<td>Percent of display intensity</td>
</tr>
<tr>
<td>Read_ScrnSave_Mode</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0=Off, 1=On, 2=Timed</td>
</tr>
<tr>
<td>Read_ScrnSave_Time</td>
<td>Unsigned Integer</td>
<td>1 to 1800</td>
<td>Screen save timeout in seconds.</td>
</tr>
<tr>
<td>Read_TermOnTime</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Minutes the terminal CPU has been running.</td>
</tr>
</tbody>
</table>
### DH-485 Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Read_BaudRate</td>
<td>Unsigned Integer</td>
<td>1 to 4</td>
<td>1 = 1200, 2 = 2400, 3 = 9600, 4 = 19200</td>
</tr>
<tr>
<td>@Read_MaxNodeAddress</td>
<td>Unsigned Integer</td>
<td>1 to 31</td>
<td></td>
</tr>
<tr>
<td>@Read_MemCardStatus</td>
<td>Unsigned Integer</td>
<td>0 to 3</td>
<td>0 = Valid memory card format, 1 = Incorrect memory card format, 2 = No memory card installed, 3 = No applications on memory card</td>
</tr>
<tr>
<td>@Read_NodeAddress</td>
<td>Unsigned Integer</td>
<td>0 to 31</td>
<td>0 = Communication link is ok, 1 = PanelView terminal is off the link, 2 = Scanned node not found, 4 = I/O error (Invalid I/O form controller), 5 = Duplicate node address</td>
</tr>
<tr>
<td>@Read_SerCommStatus</td>
<td>Unsigned Integer</td>
<td>0 to 5</td>
<td>0 = Communications active, 1 = Timeout in block transfer write from PLC, 2 = Timeout in block transfer read, 4 = Timeout in both block transfer write and block transfer read, 8 = PLC offline, 16 = PLC offline, 17 = Pass-Through occurring, 32 = Communication with PLC failed, 64 = Bad rack setup, 128 = PanelView RIO hardware failed startup tests failed</td>
</tr>
</tbody>
</table>

### Remote I/O Tags

<table>
<thead>
<tr>
<th>Remote I/O Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@SRIO_RackNumber</td>
<td>Unsigned Integer</td>
<td>0 to 62</td>
<td></td>
</tr>
<tr>
<td>@SRIO_RackSize</td>
<td>Unsigned Integer</td>
<td>0 to 3</td>
<td>0 = 1/4, 1 = 1/2, 2 = 3/4, 3 = Full</td>
</tr>
<tr>
<td>@SRIO_DataRate</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0 = 57.6K, 1 = 115.2K, 2 = 230.4K</td>
</tr>
<tr>
<td>@SRIO_Module</td>
<td>Unsigned Integer</td>
<td>0 to 3</td>
<td>0 = Module Group 0, 1, 1 = Module Group 2, 2 = Module Group 4, 3 = Module Group 6, 7</td>
</tr>
<tr>
<td>@SRIO_LastRack</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = False, 1 = True</td>
</tr>
<tr>
<td>@SRIO_BlockTransferReadEnable</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = Disable, 1 = Enable</td>
</tr>
<tr>
<td>@SRIO_BlockTransferWriteEnable</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = Disable, 1 = Enable</td>
</tr>
<tr>
<td>@SRIO_BlockTransferTimeout</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>0 = No Timeout, 1 to 65535 (in milliseconds)</td>
</tr>
<tr>
<td>@SRIO_PassThruEnabled</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = Disable, 1 = Enable</td>
</tr>
<tr>
<td>@Read_SerCommStatus</td>
<td>Unsigned Integer</td>
<td>1 to 128</td>
<td>1 = Communications active, 2 = Timeout in block transfer write from PLC, 4 = Timeout in block transfer read, 8 = Timeout in both block transfer write and block transfer read, 16 = PLC offline, 17 = Pass-Through occurring, 32 = Communication with PLC failed, 64 = Bad rack setup, 128 = PanelView RIO hardware failed startup tests failed</td>
</tr>
</tbody>
</table>
ControlNet Tags

You can display the Network Update Time (NUT), UMAX Node, SMAX Node and other data on a screen by assigning one of the following read only tags to a display object. You must use an ASCII display for tags with a string data type.

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Read_DCNUTime</td>
<td>Unsigned Integer</td>
<td>Network Update Time (NUT) in milliseconds.</td>
</tr>
<tr>
<td>@Read_DCUMAX</td>
<td>Unsigned Integer</td>
<td>Unscheduled Maximum (UMAX) node address</td>
</tr>
<tr>
<td>@Read_DCSMAX</td>
<td>Unsigned Integer</td>
<td>Scheduled Maximum (SMAX) node address</td>
</tr>
<tr>
<td>@Read_curDCAddress</td>
<td>Unsigned Integer</td>
<td>Current Node Address</td>
</tr>
<tr>
<td>@Read_DCASNNumber</td>
<td>String</td>
<td>CIP/ASA serial number of the PanelView</td>
</tr>
<tr>
<td>@Read_DCCommStatus</td>
<td>Unsigned Integer</td>
<td>Communication status number</td>
</tr>
<tr>
<td>@Read_DC FirmwareRev</td>
<td>String</td>
<td>ControlNet firmware revision number</td>
</tr>
<tr>
<td>@Read_DCNewAddress</td>
<td>Unsigned Integer</td>
<td>Terminal address to use after a reset</td>
</tr>
<tr>
<td>@Read_DCProtocol</td>
<td>String</td>
<td>Firmware build date</td>
</tr>
<tr>
<td>@Read_DC Redundancy</td>
<td>Unsigned Integer</td>
<td>LED status number. Indicates status of A and B cables.</td>
</tr>
<tr>
<td>@Read_DC ScanDelay</td>
<td>Unsigned Integer</td>
<td>Scan delay in milliseconds (time between reads)</td>
</tr>
</tbody>
</table>

DeviceNet Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Read_DCBO1</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = Hold in Reset, 1 = Reset and Continue Comms.</td>
</tr>
<tr>
<td>@Read_DCCommStatus</td>
<td>Unsigned Integer</td>
<td>0 to 13</td>
<td>0 = No connection 1 = Connection timed out. 3 = Cannot obtain Explicit-Client tag 4 = Zero length I/O message received 5 = Message overrun 11 = No network power 12 = Dup MAC failure 13 = Bus–Off interrupt occurred</td>
</tr>
<tr>
<td>@Read_DCInputSize</td>
<td>Unsigned Integer</td>
<td>0 to 64</td>
<td>Number of words sent to scanner from PanelView with each I/O scan.</td>
</tr>
<tr>
<td>@Read_DCOutputSize</td>
<td>Unsigned Integer</td>
<td>0 to 64</td>
<td>Number of words sent to PanelView from scanner with each I/O scan.</td>
</tr>
<tr>
<td>@Read_DC ScanDelay</td>
<td>Unsigned Integer</td>
<td>0 to 65535</td>
<td>Delay scan of the Explicit-Client tags</td>
</tr>
<tr>
<td>@Read_DCAddress</td>
<td>Unsigned Integer</td>
<td>0 to 63</td>
<td>Address of PanelView on DeviceNet link.</td>
</tr>
<tr>
<td>@Read_DC BaudRate</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0 = 125 Kbps, 1 = 255 Kbps, 2 = 500 Kbps</td>
</tr>
</tbody>
</table>

DF1 Tags

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Data Type</th>
<th>Value Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Read_DFX_ErrorDetectOption</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = BCC, 1 = CRC</td>
</tr>
<tr>
<td>@Read_DFX_HandshakeOption</td>
<td>Unsigned Integer</td>
<td>0 or 1</td>
<td>0 = Off, 1 = On</td>
</tr>
<tr>
<td>@Read_DFX_Parity</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0 = None, 1 = Even, 2 = Odd</td>
</tr>
<tr>
<td>@Read_DFX_NodeAddress</td>
<td>Unsigned Integer</td>
<td>0 to 253</td>
<td>0 = Connected, 1 = Offline, 2 = Hardware Failure</td>
</tr>
<tr>
<td>@Read_DFX_StopBits</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0 = 1 Stop Bit, 2 = 2 Stop Bits</td>
</tr>
<tr>
<td>@Read_BaudRate</td>
<td>Unsigned Integer</td>
<td>2 to 6</td>
<td>2 = 1200, 3 = 2400, 4 = 4800, 5 = 9600, 6 = 19200</td>
</tr>
<tr>
<td>@Read_SerCommStatus</td>
<td>Unsigned Integer</td>
<td>0 to 2</td>
<td>0 = Connected, 1 = Offline, 2 = Hardware Failure</td>
</tr>
<tr>
<td>@Read_DFX NodeAddress</td>
<td>Unsigned Integer</td>
<td>0 to 253</td>
<td>0 to 253</td>
</tr>
</tbody>
</table>
Using ASCII Characters

This appendix contains the ASCII Character Set and the Extended ASCII Character set. You can access extended ASCII characters:

- directly within PanelBuilder
- using the Windows Character Map Utility

Fields not downloaded with an application such as tag name, screen name, and screen descriptions use the Windows character set not the extended character set in this appendix.

To access extended ASCII characters within PanelBuilder:

1. Select an object.
2. Enter inner text mode.
3. Hold down the ALT key and enter the 4-digit decimal equivalent of the extended character using the numeric keypad.
   You’ll find the decimal equivalents of the extended ASCII characters on the next page. Because Windows requires you to enter 4 digits, add a 0 to the beginning of each number.
4. When you release the ALT key, the extended character appears in the text box.

For example, to enter the character equivalent to decimal 235, hold down the ALT key and enter 0235 on the numeric keypad.

Extended character equivalent of decimal 0235

To access extended characters using the Character Map utility:

1. Select and copy characters to the clipboard from the Windows Character Map dialog.
2. From your PanelBuilder application, select an object.
3. Enter inner text mode.
4. Use the Paste command or Paste tool to paste the characters from the clipboard into the text box.
# ASCII Character Set

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>000</td>
<td>00</td>
<td>NUL</td>
<td>CTRL @</td>
<td>32</td>
<td>040</td>
<td>20</td>
<td>SP</td>
<td></td>
<td>64</td>
<td>100</td>
<td>40</td>
<td>@</td>
</tr>
<tr>
<td>1</td>
<td>001</td>
<td>01</td>
<td>SOH</td>
<td>CTRL A</td>
<td>33</td>
<td>041</td>
<td>21</td>
<td>!</td>
<td></td>
<td>65</td>
<td>101</td>
<td>41</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>002</td>
<td>02</td>
<td>STX</td>
<td>CTRL B</td>
<td>34</td>
<td>042</td>
<td>22</td>
<td>&quot;</td>
<td></td>
<td>66</td>
<td>102</td>
<td>42</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>003</td>
<td>03</td>
<td>ETX</td>
<td>CTRL C</td>
<td>35</td>
<td>043</td>
<td>23</td>
<td>#</td>
<td></td>
<td>67</td>
<td>103</td>
<td>43</td>
<td>C</td>
</tr>
<tr>
<td>4</td>
<td>004</td>
<td>04</td>
<td>EOT</td>
<td>CTRL D</td>
<td>36</td>
<td>044</td>
<td>24</td>
<td>$</td>
<td></td>
<td>68</td>
<td>104</td>
<td>44</td>
<td>D</td>
</tr>
<tr>
<td>5</td>
<td>005</td>
<td>05</td>
<td>ENQ</td>
<td>CTRL E</td>
<td>37</td>
<td>045</td>
<td>25</td>
<td>%</td>
<td></td>
<td>69</td>
<td>105</td>
<td>45</td>
<td>E</td>
</tr>
<tr>
<td>6</td>
<td>006</td>
<td>06</td>
<td>ACK</td>
<td>CTRL F</td>
<td>38</td>
<td>046</td>
<td>26</td>
<td>&amp;</td>
<td></td>
<td>70</td>
<td>106</td>
<td>46</td>
<td>F</td>
</tr>
<tr>
<td>7</td>
<td>007</td>
<td>07</td>
<td>BEL</td>
<td>CTRL G</td>
<td>39</td>
<td>047</td>
<td>27</td>
<td>'</td>
<td></td>
<td>71</td>
<td>107</td>
<td>47</td>
<td>G</td>
</tr>
<tr>
<td>8</td>
<td>010</td>
<td>08</td>
<td>BS</td>
<td>CTRL H</td>
<td>40</td>
<td>050</td>
<td>28</td>
<td>(</td>
<td></td>
<td>72</td>
<td>110</td>
<td>48</td>
<td>H</td>
</tr>
<tr>
<td>9</td>
<td>011</td>
<td>09</td>
<td>HT</td>
<td>CTRL I</td>
<td>41</td>
<td>051</td>
<td>29</td>
<td>)</td>
<td></td>
<td>73</td>
<td>111</td>
<td>49</td>
<td>I</td>
</tr>
<tr>
<td>10</td>
<td>012</td>
<td>0A</td>
<td>LF</td>
<td>CTRL J</td>
<td>42</td>
<td>052</td>
<td>2A</td>
<td>*</td>
<td></td>
<td>74</td>
<td>112</td>
<td>4A</td>
<td>J</td>
</tr>
<tr>
<td>11</td>
<td>013</td>
<td>0B</td>
<td>VT</td>
<td>CTRL K</td>
<td>43</td>
<td>053</td>
<td>2B</td>
<td>+</td>
<td></td>
<td>75</td>
<td>113</td>
<td>4B</td>
<td>K</td>
</tr>
<tr>
<td>12</td>
<td>014</td>
<td>0C</td>
<td>FF</td>
<td>CTRL L</td>
<td>44</td>
<td>054</td>
<td>2C</td>
<td>.</td>
<td></td>
<td>76</td>
<td>114</td>
<td>4C</td>
<td>L</td>
</tr>
<tr>
<td>13</td>
<td>015</td>
<td>0D</td>
<td>CR</td>
<td>CTRL M</td>
<td>45</td>
<td>055</td>
<td>2D</td>
<td>-</td>
<td></td>
<td>77</td>
<td>115</td>
<td>4D</td>
<td>M</td>
</tr>
<tr>
<td>14</td>
<td>016</td>
<td>0E</td>
<td>SO</td>
<td>CTRL N</td>
<td>46</td>
<td>056</td>
<td>2E</td>
<td>,</td>
<td></td>
<td>78</td>
<td>116</td>
<td>4E</td>
<td>N</td>
</tr>
<tr>
<td>15</td>
<td>017</td>
<td>0F</td>
<td>SI</td>
<td>CTRL O</td>
<td>47</td>
<td>057</td>
<td>2F</td>
<td>/</td>
<td></td>
<td>79</td>
<td>117</td>
<td>4F</td>
<td>O</td>
</tr>
<tr>
<td>16</td>
<td>020</td>
<td>10</td>
<td>DLE</td>
<td>CTRL P</td>
<td>48</td>
<td>060</td>
<td>30</td>
<td>0</td>
<td></td>
<td>80</td>
<td>120</td>
<td>50</td>
<td>P</td>
</tr>
<tr>
<td>17</td>
<td>021</td>
<td>11</td>
<td>DC1</td>
<td>CTRL Q</td>
<td>49</td>
<td>061</td>
<td>31</td>
<td>1</td>
<td></td>
<td>81</td>
<td>121</td>
<td>51</td>
<td>Q</td>
</tr>
<tr>
<td>18</td>
<td>022</td>
<td>12</td>
<td>DC2</td>
<td>CTRL R</td>
<td>50</td>
<td>062</td>
<td>32</td>
<td>2</td>
<td></td>
<td>82</td>
<td>122</td>
<td>52</td>
<td>R</td>
</tr>
<tr>
<td>19</td>
<td>023</td>
<td>13</td>
<td>DC3</td>
<td>CTRL S</td>
<td>51</td>
<td>063</td>
<td>33</td>
<td>3</td>
<td></td>
<td>83</td>
<td>123</td>
<td>53</td>
<td>S</td>
</tr>
<tr>
<td>20</td>
<td>024</td>
<td>14</td>
<td>DC4</td>
<td>CTRL T</td>
<td>52</td>
<td>064</td>
<td>34</td>
<td>4</td>
<td></td>
<td>84</td>
<td>124</td>
<td>54</td>
<td>T</td>
</tr>
<tr>
<td>21</td>
<td>025</td>
<td>15</td>
<td>NAK</td>
<td>CTRL U</td>
<td>53</td>
<td>065</td>
<td>35</td>
<td>5</td>
<td></td>
<td>85</td>
<td>125</td>
<td>55</td>
<td>U</td>
</tr>
<tr>
<td>22</td>
<td>026</td>
<td>16</td>
<td>SYN</td>
<td>CTRL V</td>
<td>54</td>
<td>066</td>
<td>36</td>
<td>6</td>
<td></td>
<td>86</td>
<td>126</td>
<td>56</td>
<td>V</td>
</tr>
<tr>
<td>23</td>
<td>027</td>
<td>17</td>
<td>ETB</td>
<td>CTRL W</td>
<td>55</td>
<td>067</td>
<td>37</td>
<td>7</td>
<td></td>
<td>87</td>
<td>127</td>
<td>57</td>
<td>W</td>
</tr>
<tr>
<td>24</td>
<td>030</td>
<td>18</td>
<td>CAN</td>
<td>CTRL X</td>
<td>56</td>
<td>070</td>
<td>38</td>
<td>8</td>
<td></td>
<td>88</td>
<td>130</td>
<td>58</td>
<td>X</td>
</tr>
<tr>
<td>25</td>
<td>031</td>
<td>19</td>
<td>EM</td>
<td>CTRL Y</td>
<td>57</td>
<td>071</td>
<td>39</td>
<td>9</td>
<td></td>
<td>89</td>
<td>131</td>
<td>59</td>
<td>Y</td>
</tr>
<tr>
<td>26</td>
<td>032</td>
<td>1A</td>
<td>SUB</td>
<td>CTRL Z</td>
<td>58</td>
<td>072</td>
<td>3A</td>
<td>:</td>
<td></td>
<td>90</td>
<td>132</td>
<td>5A</td>
<td>Z</td>
</tr>
<tr>
<td>27</td>
<td>033</td>
<td>1B</td>
<td>ESC</td>
<td>CTRL [</td>
<td>59</td>
<td>073</td>
<td>3B</td>
<td>;</td>
<td></td>
<td>91</td>
<td>133</td>
<td>5B</td>
<td>[</td>
</tr>
<tr>
<td>28</td>
<td>034</td>
<td>1C</td>
<td>FS</td>
<td>CTRL \</td>
<td>60</td>
<td>074</td>
<td>3C</td>
<td>&lt;</td>
<td></td>
<td>92</td>
<td>134</td>
<td>5C</td>
<td>\</td>
</tr>
<tr>
<td>29</td>
<td>035</td>
<td>1D</td>
<td>GS</td>
<td>CTRL ]</td>
<td>61</td>
<td>075</td>
<td>3D</td>
<td>=</td>
<td></td>
<td>93</td>
<td>135</td>
<td>5D</td>
<td>]</td>
</tr>
<tr>
<td>30</td>
<td>036</td>
<td>1E</td>
<td>RS</td>
<td>CTRL ^</td>
<td>62</td>
<td>076</td>
<td>3E</td>
<td>&gt;</td>
<td></td>
<td>94</td>
<td>136</td>
<td>5E</td>
<td>^</td>
</tr>
<tr>
<td>31</td>
<td>037</td>
<td>1F</td>
<td>US</td>
<td>CTRL _</td>
<td>63</td>
<td>077</td>
<td>3F</td>
<td>?</td>
<td></td>
<td>95</td>
<td>137</td>
<td>5F</td>
<td>_</td>
</tr>
</tbody>
</table>

Publication 2711-6.0
## Extended ASCII Character Set

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>128</td>
<td>200</td>
<td>80</td>
<td>Ç</td>
<td>180</td>
<td>240</td>
<td>A0</td>
<td>â</td>
<td>192</td>
<td>300</td>
<td>C0</td>
<td>L</td>
<td>224</td>
<td>340</td>
<td>E0</td>
<td>α</td>
</tr>
<tr>
<td>129</td>
<td>201</td>
<td>81</td>
<td>û</td>
<td>161</td>
<td>241</td>
<td>A1</td>
<td>ì</td>
<td>193</td>
<td>301</td>
<td>C1</td>
<td>¡</td>
<td>225</td>
<td>341</td>
<td>E1</td>
<td>β</td>
</tr>
<tr>
<td>130</td>
<td>202</td>
<td>82</td>
<td>é</td>
<td>162</td>
<td>242</td>
<td>A2</td>
<td>ò</td>
<td>194</td>
<td>302</td>
<td>C2</td>
<td>¿</td>
<td>226</td>
<td>342</td>
<td>E2</td>
<td>Γ</td>
</tr>
<tr>
<td>131</td>
<td>203</td>
<td>83</td>
<td>ă</td>
<td>163</td>
<td>243</td>
<td>A3</td>
<td>ú</td>
<td>195</td>
<td>303</td>
<td>C3</td>
<td>+</td>
<td>227</td>
<td>343</td>
<td>E3</td>
<td>π</td>
</tr>
<tr>
<td>132</td>
<td>204</td>
<td>84</td>
<td>ä</td>
<td>164</td>
<td>244</td>
<td>A4</td>
<td>ņ</td>
<td>196</td>
<td>304</td>
<td>C4</td>
<td>−</td>
<td>228</td>
<td>344</td>
<td>E4</td>
<td>Σ</td>
</tr>
<tr>
<td>133</td>
<td>205</td>
<td>85</td>
<td>à</td>
<td>165</td>
<td>245</td>
<td>A5</td>
<td>Ñ</td>
<td>197</td>
<td>305</td>
<td>C5</td>
<td>+</td>
<td>229</td>
<td>345</td>
<td>E5</td>
<td>σ</td>
</tr>
<tr>
<td>134</td>
<td>206</td>
<td>86</td>
<td>â</td>
<td>166</td>
<td>246</td>
<td>A6</td>
<td>ü</td>
<td>198</td>
<td>306</td>
<td>C6</td>
<td>±</td>
<td>230</td>
<td>346</td>
<td>E6</td>
<td>μ</td>
</tr>
<tr>
<td>135</td>
<td>207</td>
<td>87</td>
<td>ç</td>
<td>167</td>
<td>247</td>
<td>A7</td>
<td>ø</td>
<td>199</td>
<td>307</td>
<td>C7</td>
<td>±</td>
<td>231</td>
<td>347</td>
<td>E7</td>
<td>ρ</td>
</tr>
<tr>
<td>136</td>
<td>210</td>
<td>88</td>
<td>ē</td>
<td>168</td>
<td>250</td>
<td>A8</td>
<td>ơ</td>
<td>200</td>
<td>310</td>
<td>C8</td>
<td>±</td>
<td>232</td>
<td>350</td>
<td>E8</td>
<td>Φ</td>
</tr>
<tr>
<td>137</td>
<td>211</td>
<td>89</td>
<td>ē</td>
<td>169</td>
<td>251</td>
<td>A9</td>
<td>ń</td>
<td>201</td>
<td>311</td>
<td>C9</td>
<td>±</td>
<td>233</td>
<td>351</td>
<td>E9</td>
<td>θ</td>
</tr>
<tr>
<td>138</td>
<td>212</td>
<td>8A</td>
<td>ē</td>
<td>170</td>
<td>252</td>
<td>AA</td>
<td>ń</td>
<td>202</td>
<td>312</td>
<td>CA</td>
<td>±</td>
<td>234</td>
<td>352</td>
<td>EA</td>
<td>Ω</td>
</tr>
<tr>
<td>139</td>
<td>213</td>
<td>8B</td>
<td>ē</td>
<td>171</td>
<td>253</td>
<td>AB</td>
<td>1/2</td>
<td>203</td>
<td>313</td>
<td>CB</td>
<td>±</td>
<td>235</td>
<td>353</td>
<td>EB</td>
<td>δ</td>
</tr>
<tr>
<td>140</td>
<td>214</td>
<td>8C</td>
<td>ē</td>
<td>172</td>
<td>254</td>
<td>AC</td>
<td>1/4</td>
<td>204</td>
<td>314</td>
<td>CC</td>
<td>±</td>
<td>236</td>
<td>354</td>
<td>EC</td>
<td>≈</td>
</tr>
<tr>
<td>141</td>
<td>215</td>
<td>8D</td>
<td>ē</td>
<td>173</td>
<td>255</td>
<td>AD</td>
<td>1/8</td>
<td>205</td>
<td>315</td>
<td>CD</td>
<td>±</td>
<td>237</td>
<td>355</td>
<td>ED</td>
<td>⊗</td>
</tr>
<tr>
<td>142</td>
<td>216</td>
<td>8E</td>
<td>Ĕ</td>
<td>174</td>
<td>256</td>
<td>AE</td>
<td>&lt;&lt;</td>
<td>206</td>
<td>316</td>
<td>CE</td>
<td>±</td>
<td>238</td>
<td>356</td>
<td>EE</td>
<td>⊘</td>
</tr>
<tr>
<td>143</td>
<td>217</td>
<td>8F</td>
<td>Ĕ</td>
<td>175</td>
<td>257</td>
<td>AF</td>
<td>&gt;&gt;</td>
<td>207</td>
<td>317</td>
<td>CF</td>
<td>±</td>
<td>239</td>
<td>357</td>
<td>EF</td>
<td>⊙</td>
</tr>
<tr>
<td>144</td>
<td>220</td>
<td>90</td>
<td>É</td>
<td>176</td>
<td>260</td>
<td>B0</td>
<td>208</td>
<td>320</td>
<td>D0</td>
<td>±</td>
<td>240</td>
<td>360</td>
<td>F0</td>
<td>≠</td>
<td></td>
</tr>
<tr>
<td>145</td>
<td>221</td>
<td>91</td>
<td>È</td>
<td>177</td>
<td>261</td>
<td>B1</td>
<td>209</td>
<td>321</td>
<td>D1</td>
<td>±</td>
<td>241</td>
<td>361</td>
<td>F1</td>
<td>±</td>
<td></td>
</tr>
<tr>
<td>146</td>
<td>222</td>
<td>92</td>
<td>Æ</td>
<td>178</td>
<td>262</td>
<td>B2</td>
<td>210</td>
<td>322</td>
<td>D2</td>
<td>±</td>
<td>242</td>
<td>362</td>
<td>F2</td>
<td>≯</td>
<td></td>
</tr>
<tr>
<td>147</td>
<td>223</td>
<td>93</td>
<td>Ö</td>
<td>179</td>
<td>263</td>
<td>B3</td>
<td>211</td>
<td>323</td>
<td>D3</td>
<td>±</td>
<td>243</td>
<td>363</td>
<td>F3</td>
<td>≤</td>
<td></td>
</tr>
<tr>
<td>148</td>
<td>224</td>
<td>94</td>
<td>Ö</td>
<td>180</td>
<td>264</td>
<td>B4</td>
<td>212</td>
<td>324</td>
<td>D4</td>
<td>±</td>
<td>244</td>
<td>364</td>
<td>F4</td>
<td>≮</td>
<td></td>
</tr>
<tr>
<td>149</td>
<td>225</td>
<td>95</td>
<td>ò</td>
<td>181</td>
<td>265</td>
<td>B5</td>
<td>213</td>
<td>325</td>
<td>D5</td>
<td>±</td>
<td>245</td>
<td>365</td>
<td>F5</td>
<td>≯</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>226</td>
<td>96</td>
<td>û</td>
<td>182</td>
<td>266</td>
<td>B6</td>
<td>214</td>
<td>326</td>
<td>D6</td>
<td>±</td>
<td>246</td>
<td>366</td>
<td>F6</td>
<td>≮</td>
<td></td>
</tr>
<tr>
<td>151</td>
<td>227</td>
<td>97</td>
<td>û</td>
<td>183</td>
<td>267</td>
<td>B7</td>
<td>215</td>
<td>327</td>
<td>D7</td>
<td>±</td>
<td>247</td>
<td>367</td>
<td>F7</td>
<td>≯</td>
<td></td>
</tr>
<tr>
<td>152</td>
<td>230</td>
<td>98</td>
<td>ŕ</td>
<td>184</td>
<td>270</td>
<td>B8</td>
<td>216</td>
<td>330</td>
<td>D8</td>
<td>±</td>
<td>248</td>
<td>370</td>
<td>F8</td>
<td>≮</td>
<td></td>
</tr>
<tr>
<td>153</td>
<td>231</td>
<td>99</td>
<td>Ö</td>
<td>185</td>
<td>271</td>
<td>B9</td>
<td>217</td>
<td>331</td>
<td>D9</td>
<td>±</td>
<td>249</td>
<td>371</td>
<td>F9</td>
<td>≤</td>
<td></td>
</tr>
<tr>
<td>154</td>
<td>232</td>
<td>9A</td>
<td>Ü</td>
<td>186</td>
<td>272</td>
<td>BA</td>
<td>218</td>
<td>332</td>
<td>DA</td>
<td>±</td>
<td>250</td>
<td>372</td>
<td>FA</td>
<td>≯</td>
<td></td>
</tr>
<tr>
<td>155</td>
<td>233</td>
<td>9B</td>
<td>ç</td>
<td>187</td>
<td>273</td>
<td>BB</td>
<td>219</td>
<td>333</td>
<td>DB</td>
<td>±</td>
<td>251</td>
<td>373</td>
<td>FB</td>
<td>≮</td>
<td></td>
</tr>
<tr>
<td>156</td>
<td>234</td>
<td>9C</td>
<td>£</td>
<td>188</td>
<td>274</td>
<td>BC</td>
<td>220</td>
<td>334</td>
<td>DC</td>
<td>±</td>
<td>252</td>
<td>374</td>
<td>FC</td>
<td>≯</td>
<td></td>
</tr>
<tr>
<td>157</td>
<td>235</td>
<td>9D</td>
<td>¥</td>
<td>189</td>
<td>275</td>
<td>BD</td>
<td>221</td>
<td>335</td>
<td>DD</td>
<td>±</td>
<td>253</td>
<td>375</td>
<td>FD</td>
<td>≮</td>
<td></td>
</tr>
<tr>
<td>158</td>
<td>236</td>
<td>9E</td>
<td>Př</td>
<td>190</td>
<td>276</td>
<td>BE</td>
<td>222</td>
<td>336</td>
<td>DE</td>
<td>±</td>
<td>254</td>
<td>376</td>
<td>FE</td>
<td>≯</td>
<td></td>
</tr>
<tr>
<td>159</td>
<td>237</td>
<td>9F</td>
<td>ʃ</td>
<td>191</td>
<td>277</td>
<td>BF</td>
<td>223</td>
<td>337</td>
<td>DF</td>
<td>±</td>
<td>255</td>
<td>377</td>
<td>FF</td>
<td>≮</td>
<td></td>
</tr>
</tbody>
</table>
Glossary

**active** – The window (application file or screen) or object that is currently selected. Only one window can be active at a time. If a window is active, its title bar is highlighted to differentiate it from other windows. If an object is active, it has handles. Windows or objects that are not selected are inactive.

**application** – In the context of PanelBuilder, an application is a logical arrangement of screens which replace the functions of a control panel of buttons, switches and indicators. The application runs in a PanelView terminal.

**application file** – File containing configuration information for the PanelView terminal. Files exist as either a PanelBuilder application (.PBA file type) or a PanelView application (.PVA file type). Files transferred to a terminal are in a .PVA format. Files within PanelBuilder are in a .PBA format.

**application file window** – The window containing a list of all application screens in a PanelBuilder application file.

**application screen window** – The window that looks like a PanelView terminal on which control panel objects are placed. An application contains a logical arrangement of screens.

**ATA card** – Advanced Technology Attachment (ATA), Intelligent Drive Electronics (IDE), PC Cards (formerly PCMCIA) combine the drive controller and memory storage device. ATA cards can be accessed with standard Copy or Delete commands on a personal computer. The card looks like a hard drive to the user. You can use the card on a variety of computers without any special setup.

**attributes** – In the context of PanelBuilder, information that describes how an object will interact with the controller and how it appears on the PanelView terminal.

**auto repeat** – A function where a button press/release is automatically repeated when the button is held down for more than \( \frac{1}{2} \) second.

**background text** – Screen text that is unattached or not linked to an object.

**baud** – A rate at which a transmission occurs. One baud equals one bit per second.
bit – The smallest unit of information in the binary numbering system. A bit is represented by the digits 0 and 1.

bitmap – An image stored as a pattern of dots (or pixels).

byte – A sequence of 8 consecutive bits that are treated as a single value.

cascade – A way of arranging opens windows (application file and screens) in the workspace so that they overlap each other, with the title bar of each visible.

choose – To use a mouse or keyboard to pick an item that begins an action in PanelBuilder. You choose commands on the menus or tools to perform tasks.

click – To press and release the mouse button quickly.

color palette – A fixed set of the 16 standard EGA colors which are used to apply color to the foreground and background of objects, text and graphics.

command – A menu item that you choose to carry out an action. You choose a command from a menu or click a tool on one of the tool bars.

command button – A button that carries out an action in a dialog box. A command button has a label that describes the action to carry out (Close, Cancel). Choosing a command button followed by ellipsis (Options...) opens another dialog.

control panel – 1) A panel which may contain instruments or user-operated switches. 2) In the PanelView terminal, objects that allow an operator to access and control plant operations through manipulation of the controller data table.

controller, programmable – Refer to programmable controller.

copy – To put a copy of the selected object or screen onto the Clipboard so that you can transfer it to another location.

cut – To move the selected object or screen onto the Clipboard.

DF1 – A peer-to-peer protocol that combines features of ANSI X3.28-1976 specification subcategories D1 (data transparency) and F1 (two-way simultaneous transmission with embedded responses).

**DH+™ link**—Data Highway Plus™ link. An Allen-Bradley token-passing baseband link for a local area network.

**dialog**—A window that opens temporarily to request information. Dialogs have options you must choose before PanelBuilder can carry out a command.

**dimmed**—Unavailable or disabled. A dimmed button or command is displayed in light gray instead of black, and it cannot be chosen.

**double-click**—To rapidly press and release a mouse button twice without moving the mouse. Double-clicking carries out an action like opening a dialog box.

**download**—The process of transferring an application from the computer running PanelBuilder to a PanelView terminal, PC memory card or DOS file.

**drag**—To move an item on the screen by selecting the item and then pressing and holding down the mouse button while moving the mouse.

**dynamic object**—An object that interacts with a controller address.

**format bar**—A horizontal bar that appears below the tool bar. The format bar contains tools for formatting objects and text. Commands on the format menu carry out the same action as the tools on the format bar.

**function keys**—A set of keys (labeled F1–F10, F1–F16 or F1-F21) on the PanelView terminals that are used to initiate a function.

**import**—To bring a bitmap graphic into PanelBuilder from another package.

**inner text**—Text that appears inside an object that’s linked to the object. When an object is moved or deleted so is the inner text.

**ISA**—Refers to Instrumentation Society of America.

**keypad**—18 keys on the PanelView terminal used to enter data.

**memory card**—A storage medium similar to a PC memory card which can store a PanelBuilder application.

**menu**—A list of available commands in the PanelBuilder application. Menu names appear in the menu bar at the top of the window.

**menu bar**—The horizontal bar containing the names of PanelBuilder menus. It appears below the title bar.
node – A device on a DH485 network which has a unique address (0 to 31)

node address – A unique value (0 to 31) assigned to each device on a DH485 network. Addressing allows communications between devices. All data transfers are assigned a destination address.

object – In the context of PanelBuilder, an individual component of an application screen. Each object replaces the function of a button, switch or indicator on a control panel. Objects include controls, displays and graphics.

object attributes – See attributes.

PanelBuilder Software – A Microsoft Windows based program used to develop an application to run in a PanelView terminal.

PanelView Terminal – An Allen-Bradley keypad, touch screen, or touch screen and keypad terminal which runs a PanelBuilder application. The terminal provides the operator interface to the logic controller when the application is executing.

Pass-Through – Means of transferring data between a computer on the DH+ network and a PanelView terminal on the Remote I/O network. A PLC-5 controller acts as a bridge between the two networks.

paste – To copy the contents of the Clipboard.

PC – Personal Computer memory card.

PLC – Acronym for Programmable Logic Controller, an Allen-Bradley trademark.

point– To move the pointer on a screen until it rests on the item you want to select.

pointer – The arrow-shaped cursor on the screen that follows the movement of the mouse and indicates which area of the screen will be affected when you press the mouse button. The pointer changes shape during certain tasks. Also known as mouse pointer.

preset value – A value loaded into a controller data table when an application is first started.

project – A database of tag definitions and device information associated with an application.
**programmable controller** – A device used to replace relay logic used for sequencing, timing, and counting. Instead of physical wiring devices such as relays, push buttons and limit switches, a programmable controller tests the state of inputs and sets outputs according to stored programs.

**remote I/O link** – A serial link for carrying I/O data between a PLC or SLC processor/scanner and remote I/O adapters. Also supports transfer the block transfer of data that is moved using block transfer ladder instructions.

**save** – The process of transferring data stored in memory to a disk file.

**scratchpad** – Data entry window that opens when numeric entry objects are activated.

**screen** – See application screen or touch screen.

**select** – To mark an item so that a subsequent action can be carried out. You usually select an item by clicking it with a mouse or pressing a key. After selecting an item, you choose the action that you want to affect the item. See choose.

**SLC** – Allen-Bradley trademark for Small Logic Controllers.

**static object** – An object that doesn’t interact with a controller address.

**status bar** – The horizontal bar at the bottom of the window that tells you what PanelBuilder is doing at the moment.

**tag** – A group of parameters that define a controller address within a processor and how it interacts with a PanelBuilder object.

**tile** – A way of arranging open windows (application file window or application screens) so that no windows overlap but all are visible. Each window takes up a portion of a screen.

**tool bar** – The horizontal bar that appears below the title bar. The tool bar contains tools for frequently used commands. You click on a tool to carry out an action. Some tools complete the action immediately; others place you in a mode to complete the action.

**touch cell** – One of 128 or 384 rectangular areas on the display of a PanelView terminal that can sense when touched. The PanelView 550/600 has 128 touch cells; the 900/1400 has 384 touch cells.

**touch screen** – A screen with touch cells that respond when touched.
upload – The process of transferring an application from a PanelView terminal or memory card to the computer running PanelBuilder.

validate – The process of checking an application for warnings and errors. Applications that are validated successfully can be downloaded.

verify – The process the PanelView uses to check an application for errors.

workspace – The area of the window that displays the information contained in the PanelBuilder application.

zoom – Enlarging or reducing the view of the screen so that objects look larger or smaller than their actual size. Changing the view affects the appearance of objects, not their actual size.
A
Addressing, 3–12
Alarms
Clear Button, 1–7
Alarms
Acknowledge, 1–7, 15–3
Acknowledge All Alarms, 15–27
Acknowledge All Handshake Tags, 15–27
Acknowledge All Value, 15–23
Acknowledge Tag, 15–23
Adding Variable Data, 15–21
Alarm List, 1–7, 15–4, 15–9
Alarm List Examples, 15–5
Banner, 15–2, 15–6
Banner Position, 15–8
Buttons, 15–3
Clear Alarm, 1–7, 15–3
Clear Alarm List, 1–7, 15–3
Clear All Alarms Tag, 15–27
Clear All Handshake Tags, 15–27
Clearing Banner, 15–2
Creating, 15–16
Defining Triggers, 15–14
Fields, 15–17
Global Acknowledge, 15–3
Global Parameters, 15–12
Handshake Tag, 15–23
Message Display, 15–7
Optional Tags, 15–22
Overview, 1–3, 15–1
Print, 1–7, 15–3
Print Alarm List, 1–7, 15–3
Remote Acknowledge Tag, 15–23
Remote Handshake Tag, 15–23
Remote Tags, 15–26
Trigger, 15–15
Using Existing Text, 15–20
Align Menu, Commands, A–5
Align Text Tools, B–3
Aligning Objects
Screen Grid
Resizing Grid, 7–6
Snapping Objects to Grid, 7–6
Touch Grid, 7–5
Application
Application Name, 6–3
Changing Application Name, 6–8
Changing Protocols, 7–22
Closing, 6–21
Converting, 20–15
Converting Between Color and Grayscale, 6–18, 20–15
Converting Between Color and Monochrome, 6–18
Copying Color to Grayscale, 7–22
Copying Color to Monochrome, 7–21
Copying Monochrome to Grayscale, 7–21
Copying Touch Screen to Keypad, 7–22
Creating New, 6–3
Description, 1–1, 6–9
File Icon, 5–3
File Window, 5–3
Moving to Another Computer, 21–7
Multilingual, 22–1
Opening Existing, 6–5
Planning, 3–1–3–14, 4–1–4–14
Project Name, 6–3
Reducing Size of, 23–28
Renaming, 6–8
Reports, 24–1
Saving, 6–20
Screen Icon, 5–3
Screen Window, 5–3
Terminal Type, 6–3
Text, 18–2
Typical Screens, 1–5
Validating, 23–2
Version Information, 6–8
Application File Transfer Utility
Downloading Application, 23–25
Uploading an Application, 23–27
Verifying an Application, 23–24
WINPFT, 23–23
Application Menu, Commands, A–5
ASCII Chart, Extended Characters, H–1
ASCII Entry
Creating Keypad Enable, 10–16
Cursor Point, 10–12
Dialog, 10–17
Display Tag, 10–18
Input, 10–17
Mask Characters, 10–18
Notification and Handshake Tags, 10–18
Scratchpad for 550 Touch Terminals, 10–14
Scratchpad for Keypad Terminals, 10–13
Scratchpad for Touch Terminals, 10–15
Scratchpad in other Languages, 10–16
Show Current String, 10–18
String Width, 10–18
Write Tag, 10–18
ASCII Variable, 7–17, 17–16, 18–5
Attributes
ASCII Entry, 10–17
Bar Graphs, 12–5
Control List, 9–6
Editing, 7–14
Latched Push Button, 8–4
List Indicator, 12–20
List Keys, 9–12, 11–9
Maintained Push Button, 8–4
Attributes
Message Display, 13–6
Momentary Push Button, 8–4
Multistate Indicator, 12–14
Multistate Push Button, 8–4
Numeric Data Display, 12–10
Numeric Entry, 10–7
Scale, 12–7
Screen List Selector, 11–6
Viewing, 7–14

Audience, Intended, P–1
Auto Repeat Settings, 20–21

B
Background Objects
Graphics, 16–16
ISA Symbols, 16–7
Text, 1–7, 16–8
Backlight, Terminal Setup, 20–22
Backspace List Key, 9–12, 11–9
Banner, Alarms, 15–2, 15–6
Bar Graphs
Attributes, 12–5, 12–7
this is how level12 wraps around to the following line, 7–5
Creating, 12–5
Data Ranges, 12–6
Description, 1–6
Dialog, 12–5, 12–7
Error State, 12–3
Examples, 12–4
Fill Direction, 12–6
Read Tag, 12–6
Scale, 12–7
Scaling, 12–2
Tick–Mark Labels, 12–8
Bit Array, 3–11

Bitmaps
Color, 16–10
Editing, 16–10, 17–23
Exporting, 16–10, 16–14
Importing, 16–10, 16–12
Maximum Size, 16–10

Blinking
for Objects, 17–7
for Text, 17–28

Block Transfers
Control List Block Write Tag, 9–3
Controllers Supporting, 4–7
Defining, 4–12, 20–11
Enabling or Disabling, 4–12
Example, 4–11
for Communicating Data, 20–11
for Pass–Through, 20–11
Helpful Hints, 4–13
Length, 4–12
Multiple Block Transfers, 4–15
Piloted Control List Block Write Tag, 9–8
Read, 4–12, 4–13, 20–11
Setting Up, 4–12
Starting Address, 4–12
Write, 4–12, 4–14, 20–11
Bring Dynamic Objects to Front, 7–11

C
Character Array, 3–11

Color
Adding to Background Text, 16–9
Background, 5–8
Bitmaps, 16–10
Converting Color to Grayscale, 6–19, 20–15
Converting Color to Monochrome, 6–19
Converting Monochrome to Color, 20–15
Foreground, 5–8
Palette, 1–3
Setting Defaults, 7–13
Setting Foreground/Background, 17–8
Setting Graphic Foreground/Background, 17–21
Text, 17–29
Using Palette, 5–8

Command Conventions, 5–4
Check Mark, 5–4
Choosing, 5–4
Dimmed Command, 5–4
Ellipsis (...), 5–4
Triangle, 5–4
Using Key Combination, 5–4

Communications
Adding a Card, 2–17
Block Transfers, 4–11
DF1, 4–4
DH+, 4–3
DH–485, 4–2
Discrete I/O, 4–9
Remote I/O, 4–6
Terminal Ports, 4–1
Transferring Multiple Blocks, 4–15

Contact Types, 8–2
Contents, of Manual, P–2

Control List
Attributes, 9–6
Configuring States, 7–15
Creating, 9–5
Data Types, 9–7
Description, 1–6
Dialog, 9–6
Helpful Hints, 9–1
Illustrating, 9–4
Inactive State, 9–3
Initial State, 9–6
List Keys, 9–12
Piloted Control List, 9–2
Piloted Control Tag, 9–8
Search Tag, 9–8
Setting Number of Entries, 9–10
Standard Control List, 9–2
Using Enter Key to Confirm Selection, 9–9
Using Multiple Lists, 9–5
Using Wrap Around, 9–9
Write Tag, 9–7
Control Tags
  PLC/SLC Screen Changes, 20–24–20–28
  PLC/SLC Time or Date Changes, 20–24–20–28
Control–Menu Box, 5–2
Controllers, Data File Access, 3–7
Conventions, P–3
Copying
  Color to Monochrome, 7–21
  Monochrome to Color, 7–21
  Screens, 6–15, 6–16
  Tags, 19–8
to a different protocol, 7–22
  Touch Screen to Keypad, 7–22
Cursor Point
  ASCII Data Entry, 1–6, 10–12
  Numeric Data Entry, 1–6, 10–2
Cutting and Pasting, Screens, 6–17

D
Data Formats, PanelView Tag, 3–9
Data Scaling, Data Entry Variables, 10–4
Data Types, 3–8
Date
  Inserting in Object, 17–13
  Inserting in Text String, 17–13, 18–5
Decimal Point, Numeric Data Displays, 12–11
Deleting
  Objects, 7–22
  Objects from Function Keys, 7–22
  Screens, 6–15
Description
  Entering for Application, 6–9
  Entering for Object, 7–18
Deselecting Objects, 7–8
Devices, Replacing, 21–8
DF1 Communications, 4–4, 20–7
  Baud Rate, 4–4, 20–8
  Controller Node Address, 4–4, 20–8
  Controller Node Name, 4–4, 20–8
  Controller Node Type, 4–4, 20–8
  Error Detect, 4–4, 20–8
  Handshaking, 4–4, 20–8
  Parity/Stop Bits, 4–4, 20–8
  Setting Runtime Parameters, 4–4, 20–8
  Terminal Node Address, 4–4, 20–8
  DF1 Driver, 2–7, 2–11, 2–12, 23–9
  DH+ Communications, 20–5
  Baud Rate, 4–3, 20–6
  Controller Name, 4–3, 20–6
  Controller Node Address, 4–3, 20–6
  Setting Runtime Parameters, 4–3, 20–6
  Terminal Node Address, 4–3, 20–6
DH–485 Communications, 20–3
  Baud Rate, 4–2, 20–4
  INTERCHANGE Driver, 2–13
  Maximum Node Address, 4–2, 20–4
  RSLogix Driver, 2–8
  Setting Runtime Parameters, 4–2, 20–4
  SLC Controller Name, 20–4
  SLC Controller Node Address, 4–2, 20–4
  Terminal Node Address, 4–2, 20–4
  Using RS–232 Connection, 20–3
  Using RS–485 Connection, 20–3
Dialog Boxes
  Conventions, 5–9
  Illustrated, 5–9
  Moving, 5–9
Discrete I/O, 4–9
  Example, 4–10
Display, Maintenance Schedule, 20–23
Display Intensity, 20–22
DOS File, Application Transfer, 23–7
Downloading Application
  Directly to Terminal, 23–6, 23–10
  on Local DH+ Link, 23–12
  Reducing Size of File, 23–28
  to DOS File, 23–6, 23–18
  to Memory Card, 23–6, 23–16
  using DH485 Driver, 23–11
  using Internal DF1 Driver, 23–9
  using Pass–Through, 23–13
Dragging Objects, 7–9
Draw Pointer, 7–3
Drivers
  INTERCHANGE Software, 2–10
  Internal DF1 Driver, 23–9
  RSLogix Software, 2–7
Duplicating Tags, 19–9
Dynamic Objects, 1–6
Index–4

E
Edit Objects Menu, Commands, A–2
Edit Screen Menu, Commands, A–2
Editor
  Spreadsheet, 1–2, 5–10
  Tag, 1–3
Embedded Variables, 7–17
  Inserting ASCII variable, 17–17
  Inserting Numeric, 17–14
  Inserting Time or Date, 17–13
End List Key, 9–12, 11–9
Enter List Key, 9–12, 11–9
Error, Messages, D–1
Error State
  for Bar Graphs, 12–3
  for List Indicators, 12–3
  for Message Displays, 13–5
  for Multistate Indicators, 12–3
  for Numeric Data Displays, 12–3
Errors
  Correcting Validation, 23–3
  Specific to CFG_485.EXE, F–9
  Specific to CFG_DF1.EXE, F–9
  Specific to RNA.EXE, F–10
  Tag, 19–20
Examples
  Alarm List, 15–5
  Application Screens, 1–5
  Bar Graph Scaling, 12–2
  Bar Graphs, 12–4
  Bit/LSBit Triggered Alarms, 15–19
  Block Transfer Read, 4–13
  Block Transfer Write, 4–14
  Control List, 9–4
  Control Tags, 20–25
  Data Entry Scaling, 10–4
  Discrete I/O, 4–10
  Global Objects, 14–2
  List Indicator, 12–18
  Message Displays, 13–2, 13–3
  Multistate Indicator, 12–12
  Numeric Entry Controls, 10–3
  Numeric Data Display Scaling, 12–2
  Numeric Entry Handshake Tags, 10–11
  Scaling Precision and Rounding, 10–6
  Using the Remote Ack Tag, 15–24
  Value Triggered Alarms, 15–18
Exiting PanelBuilder, 6–21
Exporting Graphics, 16–11
  to a Disk File, 16–15
  to the Clipboard, 16–14
Extended ASCII Characters, H–1

F
File Menu, Commands, A–1
Fill Options, 17–3, 17–6
Finding Tags, 19–10
Font Files, 22–3
  Code Page, 22–2
  Copying to Memory Card, 22–14
  Detecting Problems, 22–16
  Double–Byte Character Set, 22–3
  Enabling in PanelBuilder, 22–11
  Glyph, 22–3
  Input Method Editor, 22–2
  Single–Byte Character Set, 22–2
  Translating text in Excel, 22–19
  Using to Create Application, 22–11, 22–13
FontTool, 2–6, 22–1
  Creating Font Files, 22–6
  Detecting Problems, 22–15
  Font Files, 22–3
  Input Method Editor, 22–4
  Opening Font Files, 22–8
  Printing Font Files, 22–10
  Saving Font Files, 22–9
  Using, 22–5
  Viewing Sample Text, 22–8
Foreground/Background
  for Color Graphics, 17–22
  for Objects, 17–9
  for Text, 17–30
Form View, Tag Editor, 19–3
Format Bar, 5–2, 5–6, 17–2
  Inner Graphic Mode, 5–6, 17–2
  Graphics List Box, B–3
  Import/Export Graphics Tool, B–3
  Inner Text Mode, 5–6, 17–2
Object Formatting
  Blink Tool, B–2
  Fill Pattern Tool, B–2
  Line Tool, B–2
  Shape Tool, B–2
  Toggle Fore/Background Tool, B–2
Object Mode, 5–6, 17–2
Text Formatting
  Blink Tool, B–3
  Center Align Tool, B–3
  Embedded Variable Tool, B–3
  Existing Text Tool, B–3
  Left Align Tool, B–3
  Right Align Tool, B–3
  Text Box, B–3
  Text Size Tool, B–3
  Toggle Fore/Background Tool, B–3
  Underline Tool, B–3
Index–5

Publication 2711–6.0

Format Menu, Commands, A–4
Formatting Objects, 7–13
Function Keys, Deleting Objects, 7–22

G

Global Objects
Accessing, 14–5
Copying, 14–3
Creating, 14–1
Defining, 14–4
Example, 14–2
Grouped Objects, 7–10
Moving and Resizing, 14–6
Global Technical Support (GTS), Information Required, 5–14
Goto Config Screen Button
Attributes, 11–4
Creating, 11–3
Description, 1–6, 11–2
Goto Screen Button
Attributes, 11–4
Creating, 11–3
Description, 1–6, 11–2
Dialog, 11–4
Graphic Tools, 16–2
Background Text Tool, B–4
Circle Tool, 16–5
Connected Lines Tool, B–4
Ellipse Tool, 16–5, B–4
Freeform Tool, 16–6, B–4
Graphic Image Tool, B–4
Import/Export Graphics Tool, B–4
Line Tool, B–4
Rectangle Tool, B–4
Scale Tool, B–4
Selection Arrow, B–4
Text Tool, 16–8
Graphics, 1–7
Background, 16–16
Helpful Hints, 16–1
Inner, 17–20
ISA Symbols, B–7
Objects, 16–2
Setting Foreground/background Colors, 17–21
Grids
Screen Grid, 7–6
Touch Grid, 7–5
Grouped Objects, 7–10

H

Handshake Timeout, 20–22
Help
Buttons, 5–14
Commands, A–6

I

Icons
Application File, 6–13
Application Screens, 6–13
Opening, 6–13
Importing Graphics, 16–11
Deleting, 16–15
Editing, 16–11, 17–23
From a Disk File, 16–12
From the Clipboard, 16–13
Viewing Imported Graphics, 16–14
Initial Values
for Control List Selectors, 9–6
for Numeric Entry Controls, 10–5
for Push Buttons, 8–5
Tag Editor Field, 19–6
Terminal Presets, 20–17
Inner Graphics, 17–10, 17–19
Adding, 17–20
Editing Bitmap or ISA Symbol, 17–23
Moving, 17–20
Removing, 17–23
Selecting a State, 17–20
Using Bit Map, 17–20
Using ISA Symbol, 17–20
Inner Text, 17–10, 17–19
Accessing Extended ASCII Characters, H–1
Editing, 17–11, 17–12
for Multistate or List Objects, 17–12
For Objects Without States, 17–11
Push Buttons, 8–3
Selecting a State, 17–11, 17–12
Using Existing Text, 18–2
Using Word Wrap, 17–11, 17–12
Installing PanelBuilder, 2–4
Intended Audience, P–1
INTERCHANGE Communication Software, 2–2
Accessing Drivers, 2–10
Advanced Parameters, 2–15
Configuring Drivers, 2–11
Conflicts with Drivers, 2–16
Disabling, 2–16
Editing Drivers, 2–14
Installing, 2–4
Other Software Using, 2–17
Removing Drivers, 2–14
Troubleshooting, F–6
Internal Read Only Tags, G–1
ISA Symbols Toolbox, 7–2, 16–7, B–7
K

Keypad Enable
   ASCII Data Entry, 1–6, 10–12
   Numeric Data Entry, 1–6, 10–2
   Numeric Entry, 10–7

L

Language, Terminal Messages, 20–22
Latched Push Buttons
   Attributes, 8–4
   Creating, 8–4
   Description, 1–6, 8–2
Least Significant Bit Trigger
   List Indicator, 12–19
   Message Displays, 13–4
   Multistate Indicator, 12–13
List Indicator
   Attributes, 12–20
   Configuring States, 7–15
   Creating, 12–20
   Data Ranges, 12–23
   Description, 12–18
   Dialog, 12–20
   Error State, 12–3
   Examples, 12–18
   Least Significant Bit Trigger, 12–19
   Setting Number of States, 12–22
   Triggering a State, 12–19
List Keys
   Backspace Key, 1–7, 9–12, 11–9
   Control List, 9–2, 9–12
   Creating, 9–12, 11–9
   Dialog, 9–12, 11–9
   End Key, 1–7
   Enter Key, 1–7, 9–12, 11–9
   Home Key, 1–7, 9–12, 11–9
   Move Down Key, 1–7, 9–12, 11–9
   Move Up Key, 1–7, 9–12, 11–9
   Page Down Key, 1–7, 9–12, 11–9
   Page Up Key, 1–7, 9–12, 11–9
   Screen List, 11–9

M

Maintained Push Buttons
   Attributes, 8–4
   Creating, 8–4
   Description, 1–6, 8–2
Maintenance Schedule, Display, 20–23
Manual
   Contents, P–2
   Conventions, P–3
   Related Publications, P–3

Maximize Button, 5–2
Memory, Hints on Reducing, 3–14
Memory Cards, 23–7
   ATA, 22–2
   DataBook, 22–2
   Downloading Application, 23–16
   using a retainer, 22–14
Menu Bar, 5–2
Menus, Conventions, 5–4
Message Displays
   Alarms, 15–7
   Attributes, 13–6
   Configuring States, 7–15
   Creating, 13–6
   Data Types, 13–7
   Description, 1–6
   Dialog, 13–6
   Error State, 13–5
   Examples, 13–2
   Helpful Hints, 13–1
   Inserting a Variable, 13–9
   Least Significant Bit Trigger, 13–4
   Read Tag, 13–7
   Setting Number of Messages, 13–8
   Triggering Messages, 13–4
Message Editor, 18–2
Messages
   Error and Warning, D–1
   Software, D–1
   Validation, E–1
Minimize Button, 5–2
Momentary Push Buttons
   Attributes, 8–4
   Creating, 8–4
   Description, 1–6, 8–2
Mouse Pointer, 5–2, 7–3
Move Down List Key, 9–12, 11–9
Move Up List Key, 9–12, 11–9
Moving Objects, 7–9
Multilingual Support, 22–1
Multistate Indicator
   Attributes, 12–14
   Configuring States, 7–15, 12–16
   Creating, 12–14
   Data Ranges, 12–17
   Description, 1–6, 12–12
   Dialog, 12–14
   Error State, 12–3
   Examples, 12–12
   Least Significant Bit Trigger, 12–13
   Read Tag, 12–15
   Setting Number of States, 12–16

Publication 2711–6.0
Index–7

Publication 2711–6.0

Triggering a State, 12–13
Types, 12–12

Multistate Push Buttons
Attributes, 8–4
Configuring States, 7–15
Creating, 8–4
Description, 1–6, 8–2
Setting Number of States, 8–8, 8–9

N

Numeric Data Display
Attributes, 12–10
Creating, 12–9
Decimal Point, 12–11
Description, 1–6
Error State, 12–3
Read Tag, 12–11
Scaled, 12–2
Types of, 12–9
Without Scaling, 12–2

Numeric Entry
Cursor Point, 10–2, 10–7
Cursor Point Example, 10–3
Dialog, 10–7
Display, 10–9
Format, 10–10
Handshake and Notification Tags, 10–11
Input, 10–8
Keypad Enable, 10–2
Keypad Enable Example, 10–3
Scaling Data, 10–4
Scratchpad, 10–2
Write Tag, 10–8

Numeric Variable, 7–17, 17–14, 18–5

O

Object Formatting
Changing Fill Pattern, 17–6
Changing Line Type, 17–5
Changing Shape, 17–4
Using Foreground/Background, 17–9

Objects
Accessing, 7–2
Aligning, 7–5
Background, 7–16
Bring to Front, 7–11
Configuring States, 7–15
Copying, 7–20
Creating in Display Area, 7–3, 7–4
Creating on Function Keys, 7–3, 7–7
Cutting, 7–21
Default Size, 7–4
Deleting, 7–22
Description, 7–18

Deselecting, 7–8
Dragging, 7–9
Dynamic or Static, 1–6
Editing Attributes, 7–14
Fill, 7–16
Foreground, 7–16
Formatting, 7–13, 17–3
Global, 14–1, 14–5
Grouped, 7–10
Linking to Controller Data File, 3–6
Move to Back, 7–11
Moving, 7–9
Pasting, 7–21
Regrouping, 7–10
Resizing, 7–9
Selecting, 7–8
Selecting Multiple, 7–8
Setting Default Colors, 7–13
Sizing, 7–9
Stacking, 7–11
Text, 7–16
Turning View On or Off, 7–19
Types, 1–6
Ungrouping, 7–10
Viewing Attributes, 7–14
Zooming, 7–11

Objects Menu, Commands, A–3

P

Page Down List Key, 9–12, 11–9
Page Up List Key, 9–12, 11–9
Palette, Using Color, 5–8
PanelBuilder
Defaults, 5–13
Description, 1–1
Exiting, 6–21
Installing, 2–4
Preferences, 1–2
Starting, 6–2
System Requirements, 2–1
PanelBuilder Windows, 5–2
Application File Window, 5–3
Application Screen Window, 5–3

PanelView
Advanced Terminal Setup, 20–21
Converting Applications, 6–18
Features, 1–2
Screen Worksheets, C–1
Terminal Display Settings, 20–22
Terminal Setup, 20–2
Pass–Through
Communication Drivers, 23–14, 23–22
DH–485 Setup, 23–15
Enabling, 4–12, 20–11
Remote I/O setup, 23–14
Timeout, 4–12, 20–11
Uploading From Terminal, 23–22

Pasting
Objects, 7–20
Screens, 6–15, 6–16, 6–17

Piloted Control List, 9–2
Block Write Start Tag, 9–3
Inactive States, 9–3

Power–Up Options
Memory Card Load Conditions, 20–17
Preset Values, 20–17
Restart Screen, 20–17
Startup Screen, 20–17
Use Downloaded Settings, 20–17

Precision, of Scaled Values, 10–6
Preferences, 1–2
When Opening an Application, 6–7, 21–10

Preset Values
for Control Objects, 20–18
On Power–Up, 20–2
Write Initial Values, 20–17

Print Only Objects
Configuring Print Messages, 13–10
Copying a Print Object, 13–12
Deleting a Print Object, 13–12
Editing a Print Object, 13–12
Renaming a Print Object, 13–12

Printing
Configuring Printer Port, 20–13
Initialization String, 20–14
Print Only Message, 13–10
Reports, 24–5
Tags, 19–12
Text, 18–7
Validation Messages, 23–2, 23–4

Projects
Changing, 21–2
Copying a Device, 21–5
Copying a Project, 21–3
Copying to Another Computer, 21–6
Creating a Project, 21–3
Deleting a Device, 21–5
Deleting a Project, 21–3
Description, 1–1, 21–1
Loading Unknown Devices, 21–9, 21–10
Loading Unknown Tags, 21–9
Renaming a Device, 21–5
Renaming a Project, 21–3
Replacing Duplicate Devices, 21–8
Replacing Duplicate Tags, 21–8

Restoring, 21–7, 21–11
Verifying an Application when Opened, 6–7, 21–10
Viewing Devices, 21–5

Publications, Related, P–3

Push Button Controls
Contact Types, 8–2
Contacts, 8–5
Data Types, 8–5
Default Inner Text, 8–3
Entering State Values, 8–10
Handshake Tag, 8–7
Hold Time, 8–5
Indicator Tag, 8–6
Initial State, 8–5
Inner Text and Graphics, 8–3
Latched, 8–2, 8–4
Maintained, 8–2, 8–4
Momentary, 8–2, 8–4
Multistate, 8–2, 8–4
Write Tag, 8–6

R
Regrouping Objects, 7–10
Related Publications, P–3

Remote I/O Communications, 4–6
Baud Rate, 4–8, 20–10
Block Transfers, 4–6, 4–8, 20–10
Communication Loss, 4–16
Controller Name, 4–8, 20–10
Controller Types, 4–7, 20–9
Discrete I/O, 4–6, 4–9
Last Chassis, 4–8, 20–10
Module Groups, 4–6, 4–8, 20–10
Pass–Through, 23–14
Rack Sizes, 4–6, 4–7
Terminal Rack Address, 4–8, 20–10

Remote Tags, Alarms, 15–26
Renaming Application, 6–8
Reports, 24–1
Adjusting Format, 24–3
Connecting to Printer, 24–1
Creating, 24–2
Options, 24–1
Overview, 1–3
Printer Setup, 24–5
Sending to a File, 24–6

Resizing Objects, 7–9
Resizing Screen Grid, 7–6
Restoring, Projects, 21–7, 21–11
Return Screen Button
Attributes, 11–4
Creating, 11–3
Description, 11–2
Dialog, 11–4
Reversing Edit Operation, 7–22
Rounding, of Scaled Values, 10–6
RSLogix Communication Software, 2–2
Accessing, 2–7
Configuring Drivers, 2–7
Installing, 2–6
Mapping Drivers to Ports, 2–9

Screen List Selector
Attributes, 11–6
Configuring States, 7–15
Creating, 11–5
Description, 1–6, 11–2
Dialog, 11–6
Selecting Screen Names, 11–8
Setting Number of List Entries, 11–7
Using Multiple Lists, 11–2
Screen Menu, Illustrated, A–1
Screen Menu, Commands, A–1
Screen Number to PLC/SLC, 20–26
Screen Saver, 20–22
Display Intensity, 20–22
Screen Selectors
Goto Config Screen Button, 1–6, 11–2
Goto Screen Button, 1–6, 11–2
Helpful Hints, 11–1
List, 1–6
Return Screen, 1–6
Return Screen Button, 11–2
Screen List Selector, 11–2
Screen Menu, Commands, A–1
Screen Number to PLC/SLC, 20–26
Screen Saver, 20–22
Display Intensity, 20–22
Screen Selectors
Goto Config Screen Button, 1–6, 11–2
Goto Screen Button, 1–6, 11–2
Helpful Hints, 11–1
List, 1–6
Return Screen, 1–6
Return Screen Button, 11–2
Screen List Selector, 11–2
Screen Menu, Illustrated, A–1
Screen Menu, Commands, A–1
Screen Number to PLC/SLC, 20–26
Screen Saver, 20–22
Display Intensity, 20–22
Screen Selectors
Goto Config Screen Button, 1–6, 11–2
Goto Screen Button, 1–6, 11–2
Helpful Hints, 11–1
List, 1–6
Return Screen, 1–6
Return Screen Button, 11–2
Screen List Selector, 11–2
Screen Selectors
Goto Config Screen Button, 1–6, 11–2
Goto Screen Button, 1–6, 11–2
Helpful Hints, 11–1
List, 1–6
Return Screen, 1–6
Return Screen Button, 11–2
Screen List Selector, 11–2
Screens
Activating, 6–13
Arranging, 6–13
Closing, 6–14
Converting Copied, 6–18
Copying, 6–15, 6–16
Cutting and Pasting, 6–17
Deleting, 6–15
Opening Existing, 6–11
Opening Multiple, 6–12
Opening New, 6–10
Opening Single, 6–11
Reducing to Icons, 6–13
Renaming, 6–14
Search Tag, Piloted Control Lists, 9–8
Selecting Objects
Multiple Objects, 7–8

Single Objects, 7–8
Sizing Objects, 7–9
Spreadsheet Editor, 1–2
Add/Insert/Delete Row, 5–13
Changing Column Order, 5–12
Changing Column Width, 5–11
Changing Row Height, 5–11
Cut/Copy/Paste, 5–12
Using, 5–10
Stacking Objects
Bring to Front, 7–11
Move Dynamic Objects to Front, 7–11
Move to Back, 7–11
Standard Control List, 9–2
States
Control List, 9–10
List Indicator, 12–22
Multistate Indicator, 12–16
Operations Performed On, 7–17
Push Button, 8–8
Screen List Selector, 11–7
Static Objects, 1–6
Status Bar, 5–2
Status Tags
Screen Number Status, 20–26–20–30
Time or Date Status, 20–26–20–30
Support, Technical, P–4
Symbols, ISA, B–7
System Requirements, 2–1

Table View, Tag Editor, 19–1
Tag Editor, 1–3
Changing Between Views, 19–3
Description, 19–2
Form View, 19–3
Import/Export Utility, 19–15
Navigating, 19–3
Table View, 19–1
Tool Bar, 19–1, 19–3
Using Tools, 19–15
Validating Tags, 19–4
Tags
Address, 19–5
Array Size, 19–5
Control, 20–25
Copying, 19–8
Data Entry Limits, 19–5
Data Types, 19–5
Defining, 3–13
Duplicating, 19–9
Exporting, 19–18
Finding, 19–10

Publication 2711–6.0
Index–10

Tags
Having the Same Name, 19–17
Import/Export Errors, 19–20
Importing, 19–16
Initial Value, 19–5
Inserting and Deleting, 19–7
Internal Read Only, G–1
Node Name, 19–5
Printing, 19–12
Replacing, 21–8
Saving Form View, 19–7
Saving Table View, 19–7
Scaling, 19–5
Sorting, 19–11
Status, 20–26
Tag Description, 19–5
Tag Name, 19–5
Update Frequency, 19–5
Validating, 19–4
Viewing, 19–7

Technical Support, Information Required, 5–14

Terminal Preset Values, 20–2, 20–17, 20–18

Terminal Setup
Advanced Options, 20–21
Auto Repeat Settings, 20–21
Backlight, 20–22
Control Tags, 20–24–20–28
Display Intensity, 20–22
Handshake Timeout, 20–22
Language Selection, 20–22
Overview, 20–2
Power–Up Options, 20–17
Preset Values, 20–2, 20–17, 20–18
Reverse Video, 20–22
Screen Saver, 20–22
Status Tags, 20–26–20–30
Time/Date Formats, 20–19

Text
Adding New, 18–3
Aligning, 17–26
Background, 1–7, 7–16, 16–8, 16–9
Blink, 7–16
Color, 16–9
Copy/Paste, 18–4
Copying, 18–10
Deleting Unused, 18–8
Editing, 18–4
Filtering, 18–6
Foreground, 7–16
Foreground/Background Colors, 17–29
Formatting, 17–24
Inner, 17–12
Moving, 18–9
Printing, 18–7
Renumbering, 18–9
Sizing, 7–16, 17–25
Sorting, 18–6
Underline, 7–16
Text Formatting, 17–24
Aligning Text, 17–26
Sizing Text, 17–25
Underlining Text, 17–27
Using the Blink Option, 17–28
Using the Color Foreground/Background Option, 17–30

Tick–Mark Labels, 12–8

Time
Inserting in Object, 17–13
Inserting in Text String, 17–13, 18–5

Time/Date Setup, 20–19

Title Bar, 5–2

Tool Bar, 5–2, 5–5
Copy Tool, B–1
Cut Tool, B–1
Edit Attributes Tool, B–2
Inner Graphic Tool, B–2
Inner Text Tool, B–2
New File Tool, B–1
New Screen Tool, B–1
Next State or Previous State Tool, B–2
Open File Tool, B–1
Open Screen Tool, B–1
Paste Tool, B–1
Save File Tool, B–1
Undo Tool, B–1
Zoom In Tool, B–2
Zoom Out Tool, B–2

Toolbox
Background Text Tool, B–4
Backspace Key, B–6
Bar Graph Tool, B–5
Connect Lines Tool, B–4
Control List Tool, B–5
Controls, Displays and Graphics, 5–7, 7–2
Ellipse Tool, B–4
Enter Key, B–6
Freeform Tool, B–4
Global Object Tool, B–5
Go To Screen Button Tool, B–5
Graphic Image Tool, B–4
Graphics, 7–2
Home Key, B–6
Illustrated, B–4
Import/Export Graphics Tool, B–4
ISA Symbols, 5–7, 7–2, 16–7
ISA symbols, B–7
Latched Push Button Tool, B–5
Line Tool, B–4
List Indicator Tool, B–5
Maintained Push Button Tool, B–5
Message Display Tool, B–5
Toolbox
   Momentary Push Button Tool, B–5
   Move Down Key, B–6
   Move Up Key, B–6
   Multistate Indicator Tool, B–5
   Multistate Push Button Tool, B–5
   Numeric Data Display Tool, B–5
   Numeric Input Cursor Tool, B–5
   Page Down Key, B–6
   Page Up Key, B–6
   Rectangle Tool, B–4
   Return Screen Button Tool, B–5
   Scale Tool, B–4
   Screen List Selector Tool, B–5
   Selection Arrow, B–4
   Turning On or Off, 5–7

Touch Grid, 7–5
Transfer Error Messages, F–1
Transfer Utilities
   Application File Transfer Utility, 23–8
   Application Menu, 23–8
   PanelView File Transfer Utility, 23–8
Troubleshooting
   Download Errors, F–2
   Downloading to a DOS File Errors, F–3
   Downloading with INTERCHANGE, F–4
   Downloading with PanelView File Transfer Utility, F–3
   Downloading with WINPFT Utility, F–3
   Error Messages, D–1
   INTERCHANGE Communications Software, F–6
   Messages Specific to CFG_485.EXE, F–9
   Messages Specific to CFG_DF1.EXE, F–9
   Messages Specific to RNA.EXE, F–10
   Running Windows 95, F–1
   Starting PanelBuilder, F–2

U
   Underline, 7–16
   Ungrouping Objects, 7–10
   Uploading Application
      Directly from Terminal, 23–19
      on Local DH+ Link, 23–21
      using DH485 Driver, 23–20
      using Internal DF1 Driver, 23–9, 23–19
      using Pass–Through, 23–22

V
   Validating Application
      Correcting Errors, 23–3
      Dialog, 23–2
      Sending Messages to File, 23–5
      Sending Messages to Printer, 23–2
   Validation Messages, E–1
      Printing, 23–2
      Sending to a File, 23–5
      Setting Up Printer, 23–4
   Values, Initial, 10–5
   Variables
      Adding in Text Editor, 18–5
      Adding to Alarms, 15–21
      ASCII, 1–6, 17–16
      Embedded, 7–17
      in a Message, 13–9
      Numeric, 1–6, 17–14
      Scaling Data, 10–4
      Time or Date, 17–13
   View Menu, Commands, A–3
   View Option, 7–19
   Viewing Tags, 19–7

W
   Warning Messages, D–1
   Window Border, 5–2
   Window Menu, Commands, A–5
   Windows Environment, 5–1
   WINPFT, Application File Transfer Utility, 23–23
   Word Wrap, 7–16, 17–11, 17–12
   Worksheets, 3–5, C–1

Z
   Zooming
      Enlarging View, 7–11
      Reducing View, 7–11
PanelBuilder Tools

Tool Bar

Format Bar in Object View

Format Bar in Text View

Format Bar in Graphics View

Rockwell Automation helps its customers receive a superior return on their investment by bringing together leading brands in industrial automation, creating a broad spectrum of easy-to-integrate products including control logic, sensors, man-machine interface, motors, power devices and software. These are supported by local technical resources available worldwide, a global network of system solutions providers, and the advanced technology resources of Rockwell International.